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Objectives 
 

 

After studying this unit, you will be able to: 

• Understanding and Introduction of computers 

• Discussion of computer evolution 

• Explanation the all generation of computers 
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Notes • Understanding of block diagram of computers 

• Understanding of memory and its type 

 

Introduction 
 

 

The word ‚computer‛ comes from the word ‚compute‛, which means, ‚to calculate‛. Hence, 

people usually use a computer to be a calculating device that can perform arithmetic 

operations at high speed. In fact, the original objective for inventing a computer was to 

create a fast calculating machine. However, more than 80% of work done by computers today 

is of non-mathematical or non-numerical nature. Hence, to define computer merely as a 

calculating device is to ignore over 80% of its functions. 

More accurately, we can define a computer as a device that operates upon data. Data can be 

anything like bio-data, hence computer is used for short listing candidates for recruiting; 

marks obtained by students in when used for preparing results; details (name, age, sex, etc.) 

of passengers when used for or railway reservations: or number of different parameters 

when used for solving scientific problems, etc. 

Hence, data comes in various shapes and sizes depending upon the type of computer 

application. A computer can and retrieves data as and when desired. The fact that computers 

process data is so fundamental that have started calling it a data processor. 

The name data processor is more inclusive because modern computers not only compute in 

the usual sense but also perform other functions with data that flows to and from them. For 

example, data processors may gather data from various incoming sources, merge (process 

of mixing or putting together) them all, sort (process of arranging in some of sequence— 

ascending or descending) them in the desired order, and finally print them in desired format. 

Notice that none of these operations involves arithmetic computations in the usual sense but 

a computer is the most suitable device for performing them. 

 

People usually consider a computer to be a calculating device that can 

perform arithmetic operations at high speed. It is also known as a data 

processor because it not only computes in the usual sense but also 

performs other functions with the data. 

 
The activity of processing data using a computer is called data processing. Data processing 

consists of three sub-activities: capturing input data, manipulating the data, and managing 

output results. As used in data processing, information is data arranged in an order and form 

that is useful to people receiving it. Hence, data is raw material used as input to data 

processing and information is processed data obtained as output of data processing. 
 

1.1 Characteristics of Computers 
 

Increasing popularity of computers has proved that it is a very powerful and useful tool. 

The power and useful of this popular tool are mainly due to its following characteristics: 

1. Automatic. An automatic machine works by itself without human intervention. 

Computers automatic machines because once started on a job, they carry out the job 

(normally without a human assistance) until it is finished. However, computers being 

machines cannot start themselves and cannot go out and find their own problems and 

solutions. We need to instruct a computer using coded instructions that specify exactly 

how it will do a particular job. Some of the other characteristics of computers (such 

as speed and accuracy) are because they are automatic and work on a problem without 

any human intervention. 



2. Speed. A computer is a very fast device. It can perform in a few seconds, the amount 

of work that a human being can do in an entire year if he/she worked day and night 

and did nothing else. In other words, a computer can do in a few minutes what would 

take a man his entire life time while talking about the speed of a computer we do not 

talk in terms of seconds or even milliseconds (10–3) but in terms of microseconds (106), 

nanoseconds (10–9), and even picoseconds (10–12). A powerful computer is capable of 

performing several billion (l09) simple arithmetic operations per second. 

3. Accuracy. In addition to being very fast, computers are very accurate. Accuracy of a 

computer is consistently high and the degree of its accuracy depends upon its design. 

A computer performs even calculation with the same accuracy. However, errors can 

occur in a computer. These errors are mainly due to human rather than technological 

weaknesses. For example, errors may occur due to imprecise thinking by a programmer 

(a person who writes instructions for a computer to solve a particular problem) or 

incorrect input data. We often refer to computer errors caused due to incorrect input 

data or unreliable programs as garbage-in-garbage-out (GIGO). 

4. Diligence. Unlike human beings, a computer is free from monotony, tiredness, and 

lack of concentration. It can continuously work for hours without creating any error 

and without grumbling. Hence, computers score over human beings in doing routine 

type of jobs that require great accuracy. If ten million calculations have to be performed, 

a computer will perform the last one with exactly the same accuracy and speed as the 

first one. 

5. Versatility. Versatility is one of the most wonderful things about a computer. One 

moment it is preparing results of an examination, next moment it is busy preparing 

electricity bills, and in between, it may be helping an office secretary to trace an 

important letter in seconds. All that is required to change its talent is to slip in a new 

program (a sequence of instructions for the computer) into it. In brief, a computer is 

capable of performing almost any task, if the task can be reduced to a finite series of 

logical steps. 

6. Power of Remembering. As a human being acquires new knowledge, his/her brain 

subconsciously selects what it feels to be important and worth retaining in memory. 

The brain relegates unimportant details to back of mind or just forgets them. This is 

not the case with computers. A computer can store and recall any amount of information 

because of its secondary storage (a type of detachable memory) capability. It can retain 

a piece of information as long as a user desires and the user can recall the information 

whenever required. Even after several years, a user can recall exactly the same 

information that he/she had stored in the computer several years ago. A computer 

forgets or looses creation information only when a user asks it to do so. Hence, it is 

entirely up to the user to make a computer retain or forget some information. 

No IQ. A computer is not a magical device. It possesses no intelligence of its own. Its 

IQ is zero, at least until today. It has to be told what to do and in what sequence. Hence, 

only a user determines—at tasks a computer will perform. A computer cannot take its 

own decision in this regard. 

No Feelings. Computers are devoid of emotions. They have no feelings and no 

instincts because they are Machines. Although men have succeeded in building a 

memory for computer, but no computer processes the equivalent of a human heart and 

soul. Based on our feelings, taste, knowledge, and experience we often make certain 

judgments in our day-to-day life whereas, computers cannot make judgments on their 

own. They make judgments based on the instructions given to them in the form of 

programs that are written by us (human beings). 

Notes 



Notes 1.2 Evolution of Computers 
 

Necessity is the mother of invention. The saying holds true for computers too. Computers 

were invented because of man’s search for fast and accurate calculating devices. 

Basic Pascal invented the first mechanical adding machine in 1642. Later, in the year 1671, 

Baron Gottfried Wilhelm von Leibniz of Germany invented the first calculator for 

multiplication. Keyboard machines originated States around 1880 and we use them even 

today. Around the same period, Herman Hollerith came up with concept of punched 

cards that were extensively used as input medium in computers even in late 1970s. 

Machines and calculators made their appearance in Europe and America towards the end 

of the century. 

Charles Babbage, a nineteenth century Professor at Cambridge University, is considered the 

father of modern digital computers. He had employed a group of clerks for preparing 

mathematical and statistical tables. Babbage had to spend several hours checking these tables 

because even utmost care and precautions could not eliminate human errors. Soon he became 

dissatisfied and exasperated with this type of monotonous job. As a result, he started 

thinking about building a machine that could compute tables guaranteed to be error-free. 

In this process, Babbage designed a ‚Difference Engine‛ in the year 1822 that could produce 

reliable tables. In 1842, Babbage came out with his new idea of a completely automatic 

Analytical Engine for performing basic arithmetic functions for any mathematical problem 

at an average speed of 60 additions per minute. Unfortunately, he was unable to produce 

a working model of this machine because the precision engineering required to manufacture 

the machine was not available during that period. However, his efforts established a number 

of principles that are fundamental to the design of any digital computer. In order to have 

a better idea of the evolution of computers it is worthwhile to discuss of the well-known 

early computers. These are as follows: 

1. The Mark I Computer (1937-44). Also known as Automatic Sequence Controlled 

calculator, this was the first fully automatic calculating machine designed by Howard 

A. Aiken of Harvard University in collaboration with IBM (International Business 

Machines) Corporation. It was an electro-mechanical device (used both electronic and 

mechanical components) based on the techniques already developed for punched card 

machines. 

Although this machine proved to be extremely reliable, it was very complex in design 

and huge in size. It used over 3000 electrically actuated switches to control its operations 

and was approximately feet long and 8 feet high. It was capable of performing five 

basic arithmetic operations: addition, subtraction, multiplication, division, and table 

reference on numbers as big as 23 decimal digits. It took approximately 0.3 second to 

add two numbers and 4.5 seconds for multiplication of two numbers. Obviously, the 

machine was very slow as compared to today’s computers. 

2. The Atanasoff-Berry Computer (1939-42). Dr. John Atanasoff developed an electronic 

machine to solve certain mathematical equations. The machine was called the Atanasoff- 

Berry Computer, or ABC, after its inventor’s name and his assistant, Clifford Berry. 

It used 45 vacuum tubes for internal logic and capacitors for storage. 

3. The ENIAC (1943-46). The Electronic Numerical Integrator And Calculator (ENIAC) 

was the first all electronic computer. It was constructed at the Moore School of 

Engineering of the University of Pennsylvania, U.S.A. by a design team led by Professors 

J. Presper Eckert and John Mauchly. 

The team developed ENIAC because of military needs. It was used for many years to 

solve ballistic related problems. It took up wall space in a 20 x 40 square feet room 



and used 18,000 vacuum tubes it could add two numbers in 200 microseconds and 

multiply them in 2000 microseconds. 

4. The EDVAC (1946-52). A major drawback of ENIAC was that its programs were 

wired on boards that made it difficult to change the programs. Dr. John Von 

Neumann later introduced the ‚stored program‛ concept that helped in overcoming 

this problem. The basic idea behind this concept is that a sequence of instructions 

and data can be stored in the memory of a computer for automatically directing 

the flow of operations. This feature considerably influenced the development of 

modern digital computers because of the ease with which different programs can 

be loaded and executed on the same computer. Due to this feature, we often refer 

to modern digital computers as stored program digital computers. The Electronic 

Discrete Variable Automatic Computer (EDVAC) used the stored’ program concept 

in its design. Von Neumann also has a share of the credit for introducing the idea 

of storing both instructions and data in binary form (a system that uses only two digits— 

0 and I to represent all characters), instead of decimal numbers or human readable 

words. 

5. The EDSAC (1947-49). Almost simultaneously with EDVAC of U.S.A., the Britishers 

developed the Electronic Delay Storage Automatic Calculator (EDSAC). The machine 

executed its first program in May 1949. In this machine, addition operations took 1500 

microseconds and multiplication operation: took 4000 microseconds. A group of scientists 

headed by Professor Maurice Wilkes at the Cambridge University Mathematical 

Laboratory developed this machine. 

6. The UNIVAC I (1951). The Universal Automatic Computer (UNIVAC) was the first 

digital computer that was not ‚one of a kind‛. Many UNIVAC machines were produced, 

the first of which was installed in the Census Bureau in 1951 and was used continuously 

for 10 years. The first business use of a computer, a UNIVAC I, was by General Electric 

Corporation in 1954. In 1952, the International Business Machines (IBM) Corporation 

introduced the IBM-701 commercial computer. In rapid succession, improved models 

of the UNIVAC I and other 700-series machines were introduced. In 1953, IBM produced 

the IBM-650, and sold over 1000 of these computers. UNIVAC marked the arrival of 

commercially available digital computers for business and scientific applications. 

 

Some of the well-known early computers are the MARK 1 (1937-44), the 

ATANASOFF-BERRY (1939-42), the ENIAC (1943-46), the EDVAC (1946– 

52), the EDSAC (1947-49) and the UNIVAC I (1951). 

Notes 

 

1.3 Computer Generations 

Generation in computer talk is a step in technology. It provides a framework for the growth 

of computer industry. Originally, the term ‚generation‛ was used to distinguish between 

varying hardware technologies but it has now been extended to include both hardware and 

software that together make up a computer system. 

The custom of referring to computer era in terms of generations came into wide use only 

after 1964. There are totally five computer generations known till today. Below we describe 

each generation along with its identifying characteristics. Although there is a certain amount 

of overlap between different generations, the approximate period shown against each are 

normally accepted. 

During description of various computer generations, you will come across several new 

terminologies and computer jargons that you may not be able to understand properly. 

However, the idea here is to provide you an overview of the major developments and 

technologies during the five generations of computers. Subsequent chapters will cover these 
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Give brief description about the first genration computer. 

Notes developments and technologies in detail. The objective of this section is mainly to provide 

an overview of what all you are going to learn in this entire book. 

1.3.1 First Generation (1942-1955) 

We have already discussed about some of the early computers—ENIAC, EDVAC, EDSAC, 

UNIVAC 1, and IBM 701. These machines and others of their time used thousands of vacuum 

tubes. A vacuum tube [see Figure 1.1](a)] was a fragile glass device, which used filaments 

as a source of electronics and could control and amplify electronic signals. It was the only high- 

speed electronic switching device available in those days. These vacuum tubes computer could 

perform computations in milliseconds and were referred to as first-generation computers. 

The memory of these computers used electromagnetic relays, and all data and instructions 

were fed into the system from punched cards. The instructions were written in machine and 

assembly languages because high-level programming languages were introduced much 

later. Since machine and assembly languages are very difficult to work with, only a few 

specialists understood how to program these early computers. 

Characteristic features of first-generation computers are as follows: 

1. They were the fastest calculating devices of their time. 

2. They were too bulky in size, requiring large rooms for installation. 

3. They used thousands of vacuum tubes that emitted large amount of heat and burnt out 

frequently. Hence, the rooms/areas in which these computers were located had to be 

properly air-conditioned. 

4. Each vacuum tube consumed about half a watt of power. Since a computer typically 

used more than ten thousand vacuum tubes, power consumption of these computers 

was very high. 

5. As vacuum tubes used filaments, they had a limited life. Because a computer used 

thousand of vacuum tubes, these computers were prone to frequent hardware failures. 

6. Due to low mean time between failures, these computers required constant maintenance. 

7. In these computers, thousands of individual components were assembled manually by 

hand in to electronic circuits. Hence, commercial production of these computers was 

difficult and costly. 

8. Since these computers were difficult to program and use, they had limited commercial 

use. 

 

1.3.2 Second Generation (1955-1964) 

John Bardeen, Willian Shockley, and Walter Brattain invented a new electronic switching 

device called transistor [see Figure 1.1(b)] at Bell Laboratories in 1947. Transistors soon 

proved to be a better electronic switching device than vacuum tubes due to their following 

properties: 

1. They were more rugged and easier to handle than tubes since they were made of 

germanium semiconductor material rather than glass. 
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2. They were highly reliable as compared to tubes since they had no parts like a filament 

that could burn out. 

3. They could switch much faster (almost ten times faster) than tubes. Hence, switching 

circuits made of transistors could operate much faster than their counterparts made of 

tubes. 

4. They consumed almost one-tenth the power consumed by tube. 

5. They were much smaller than a tube. 

6. They were less expensive to produce. 

7. They dissipated much less heat as compared to vacuum tubes. 

The second-generation computers were manufactured using transistors instead of vacuum 

tubes. Due to the properties of transistors listed above, these computers were more powerful, 

more reliable, less expensive, smaller, and cooler to operate than the first-generation computers. 

They used magnetic cores for main memory, and magnetic disk and tape as secondary 

storage media. Punched cards were still popular and widely used for preparing and feeding 

programs and data to these computers. 

On software front, high-level programming languages (like FORTRAN, COBOL, ALGOL, 

and SNOBOL) and batch operating system emerged during second-generation. High-level 

programming languages were easier for people to understand and work with than assembly 

or machine languages making second-generation computers easier to program and use 

than first-generation computers. Introduction of batch operating system enabled multiple 

jobs to be batched together and submitted at a time. A batch operating system causes 

automatic transition from one job to another as soon as the former job completes. This 

concept helped in reducing human intervention while processing multiple jobs resulting 

in faster processing, enhanced throughput, and easier operation of second-generation 

computers. 

The first-generation computers were mainly used for scientific computations. However, the 

second-generation computers were increasingly used in business and industry for commercial 

data processing applications like payroll, inventory control, marketing, and production 

planning. 

Characteristic features of second-generation computers are as follows: 

1. They were more than ten times faster than the first-generation computers. 

2. They were smaller than first-generation computers and required smaller space. 

3. They consumed less power and dissipated less heat than the first-generation computers. 

The rooms/areas in which the second-generation computers were located still required 

to be properly air conditioned. 

4. They were more reliable and less prone to hardware failures than the first generation 

computers. 

5. They had faster and larger primary and secondary storage as compared to first- 

generation computers. 

6. They were easier to program and use than the first-generation computers. Hence, they 

had wider commercial use. 

7. In these computers, thousands of individual transistors had to be assembled manually 

by hand into electronic circuits making commercial production of these computers 

difficult and costly. 

Notes 
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 Figure 1.1: Electronic Devices Used for Manufacturing Computers of Different  
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1.3.3 Third Generation (1964-1975) 

In 1958, Jack Clair Kilby and Robert Noyce invented the first integrated circuit. Integrated 

circuits (called ICs) are circuits consisting of several electronic components like transistors, 

resistors, and capacitors grown on a single chip of silicon eliminating wired interconnection 

between components. The IC technology was also known, 0 technologies because it made 

it possible to integrate larger number of circuit components into very small (less than 5 mm 

square) surface of silicon, known as ‚chip‛ *see Figure l.l(c)+. Initially the integrated circuits 

contained only about ten to twenty components. This technology was named small scale 

integration (SSI). Later with the advancement in technology for manufacturing ICs, it became 

possible to integrate up to about components on a single chip. This technology came to be 

known as medium scale integration (MSI). 

Computers built using integrated circuits characterized the third generation. Earlier ones 

used SSI technology and later used MSI technology. ICs were smaller, less expensive to 

produce, more rugged and reliable, faster in operations, dissipated less heat, and consumed 

less power than circuits built by wiring electronic components manually. Hence third- 

generation computers were more powerful, more reliable, less expensive, smaller, and 

cooler to operate than second-generation computers. 

Parallel advancements in storage technologies allowed construction of larger magnetic 

core based random access memory as well as larger capacity magnetic disks and tapes. 

Hence, third-generation computers typically had few megabytes (less than 5 Megabytes) 

of main memory and magnetic disks capable of storing few tens of megabytes of data per 

disk drive. 

On software front, standardization of high-level programming languages, timesharing 

operating systems, unbundling of software from hardware, and creation of an independent 

software industry happened during third generation. FORTRAN and COBOL were the most 

popular high-level programming languages in those days. American National Standards 

Institute (ANSI) standardized them in 1966 and 1968 respectively, and the standardized 

versions were called ANSI FORTRAN and ANSI COBOL. The idea was that as long as 

programmers follows these standards in program writing, a program could be run on any 

computer with an ANSI FORTRAN or ANSI COBOL compiler. Some more high-level 
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these were PL/1, PASCAL, and BASIC. 

We saw that second-generation computers used batch operating system. In these systems, users 

had to prepare their data and programs and then submit them to a computer centre for 

processing. The operator at the computer centre collected these user jobs and fed them to a 

computer in batches at scheduled intervals. The respective users then collected their job’s 

output from the computer centre. The inevitable delay resulting from this batch processing 

approach was very frustrating to some users, especially programmers, because often they had 

to wait for days to locate and correct a few program errors. To rectify this situation, John 

Kemeny and Thomas Kurtz of Dartmouth College introduced the concept of timesharing 

operating system. Timesharing operating system enables multiple users to directly access and 

share computing resources simultaneously in a manner that each user feels that no one else 

is using the computer. This is accomplished by using a large number of independent relatively 

low-speed, on-line terminals connected to the main computer simultaneously. Introduction of 

timesharing concept helped in drastically improving the productivity of programmers and 

made on-line systems feasible, resulting in new on-line applications like airline reservation 

systems, interactive query systems, etc. 

Until 1965, computer manufacturers sold their hardware along with all associated software 

without any separate charges for software. For example, buyers received language translators 

for all languages supported on a computer they purchased. From user’s standpoint, software 

was free. However, the situation changed in 1969 when IBM and other computer manufacturers 

began to price their hardware and software products separately. This unbundling of software 

from hardware gave users an opportunity to invest only in software of their need and value. 

For example, now buyers could purchase only the language translators they needed and not 

all language translators supported on the purchased computer. This led to the creation of 

many new software houses and the beginning of an independent software industry. 

Development and introduction of minicomputers also took place during the third-generation 

period. Computers built until the early 1960s were mainframe systems that only very large 

companies could afford to purchase and use. Clearly, a need existed for low-cost smaller 

computers to fill the gaps left by the bigger, faster, and costlier mainframe systems. Several 

innovators recognized this need and formed new firms in the 1960s to produce smaller 

computers. Digital Equipment Corporation (DEC) introduced the first commercially available 

minicomputer, the PDP-8 (Programmed Data Processor), in 1965. It could easily fit in the 

corner of a room and did not require attention of a full-time computer operator. It used 

timesharing operating system and a number of users could access it simultaneously from 

different locations in the same building. Its cost was about one-fourth the cost of a traditional 

mainframe system making it possible for smaller companies to afford computers. It confirmed 

the tremendous demand for small computers for business and scientific applications, and by 

1971, there were more than 25 computer manufacturers in minicomputer market. 

Characteristic features of third-generation computers are as follows: 

1. They were more powerful than second-generation computers. They were capable of 

performing about one million instructions per second. 

2. They were smaller than second-generation computers requiring smaller space. 

3. They consumed less power and dissipated less heat than second-generation computers. 

The rooms/areas in which third-generation computers were located still required to 

be properly air-conditioned. 
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Notes 4. They were more reliable and less prone to hardware failures than second-generation 

computers requiring lower maintenance cost. 

5. They had faster and larger primary and secondary storage as compared to second- 

generation computers. 

6. They were general-purpose machines suitable for both scientific and commercial 

applications. 

7. There manufacturing did not require manual assembly of individual components into 

electronic circuits resulting in reduced human labor and cost involved at assembly 

stage. Hence, commercial production of these systems was easier and cheaper. However, 

highly sophisticated technology and expensive setup was required for the manufacture 

of IC chips. 

8. Standardization of high-level programming languages allowed programs written for 

one computer to be easily ported to and executed on another computer. 

9. Timesharing operating system allowed interactive usage and simultaneous use of these 

systems by multiple users. 

10. Timesharing operating system helped in drastically improving the productivity of 

programmers down the time and cost of program development by several fold. 

11. Timesharing operating system also made on-line systems feasible resulting in usage 

of these systems oil-line applications. 

12. Unbundling of software from hardware gave users of these systems an opportunity to 

invest only in software of their need and value. 

13. Minicomputers of third-generation made computers affordable even by smaller 

companies. 

1.3.4 Fourth Generation (1975-1989) 

Average of electronic components packed on a silicon chip doubled each year after 1965. This 

progress soon led to the era of large scale integration (ISI) when it was possible to integrate 

over 30,000 electronic components on a single chip, followed by very large scale integration 

(VLSI) when it was possible to integrate about one million electronic components on a single 

chip. This progress led   to   a   dramatic   development   —   creation   of   a   microprocessor. 

A microprocessor contains all circuits needed to perform arithmetic logic and control: functions, 

the core activities of all computers, on a single chip. Hence, it became possible to build a 

complete computer with a Microprocessor, a few additional primary storage chips, and other 

support circuitry. It started a new social revolution—personal computer (PC) revolution. 

Overnight computers became incredibly compact. They become inexpensive to make, and 

suddenly it became possible for anyone to own a computer. 

During forth generation, semiconductor memories replaced magnetic core memories resulting 

in large random access memories with very fast access time. On the other hand, hard disks 

became cheaper, smaller, and larger in capacity. In addition to magnetic tapes, floppy disks 

became very popular as a portable medium for porting programs and data from one computer 

system to another. 

Another significant development during fourth-generation period was spread of high-speed 

computer networking enabling interconnection of multiple computers to enable them to 

communicate and share data. Local area networks (LANs) became popular for connecting 
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(WANs) became popular for connecting computers located at larger distances. This gave rise 

to networks computers and distributed systems. 

On software front several new developments emerged to match the new technologies of 

fourth generation. For examples, several new operating systems were developed for PCs. 

Notable among these were MS-DOS, MS-windows, and apple’s propriety OS. Since PCs were 

for individuals who were not computer professionals, companies developed graphical user 

interfaces for making computers more user friendly (easier to use). A graphical user interface 

((U1) provides icons (pictures) and menus (list of choices) that users can select with a mouse. 

This enables new computer users to learn to use a PC quickly. Several new PC-based 

applications were also developed to make PCs a powerful tool. Notable among these were 

powerful word processing packages that allowed easy development of documents, spreadsheet 

package that allowed easy manipulation and analysis of data organized in columns and 

rows, and graphics packages that allowed easy drawing of pictures and diagrams. Another 

very useful concept that became popular during fourth-generation period was that of multiple 

windows on a single terminal screen. This feature allowed users to see the current state of’ 

several applications simultaneously in separate windows on same terminal screen. During 

fourth-generation period, UNIX operating system and C programming language also became 

very popular. 

Characteristic features of fourth-generation computers are as follows: 

1. PCs were smaller and cheaper than mainframes or minicomputers of third generation. 

2. Although the fourth-generation mainframes required proper air-conditioning of the 

rooms/areas in which they were located, no air-conditioning was required for PCs. 

3. They consumed less power than third-generation computers. 

4. They were more reliable and less prone to hardware failures than third-generation 

computers requiring negligible maintenance cost. 

5. They had faster and larger primary and secondary storage as compared to third- 

generation computers. 

6. They were general-purpose machines. 

7. Their manufacturing did not require manual assembly of individual components into 

electronic circuits resulting in reduced human labour and cost involved at assembly 

stage. Hence, commercial production of these systems was easier and cheaper. However, 

highly sophisticated technology and expensive setup was required for manufacturing 

LSI and VLSI chips. 

8. Use of standard high-level programming languages allowed programs written for one 

computer to be easily ported to and executed on another computer. 

9. Graphical user interface (GUI) enabled new users to quickly learn how to use computers. 

10. PC-based applications made PCs a powerful tool for both office and home usage. 

11. Network of computers enabled sharing of resources like disks, printers, etc. among 

multiple computers and their users. They also enabled several new types of applications 

involving interaction among computer users at geographically distant locations. 

Computer Supported Cooperative Working (CSCW), or groupware is one such application 

in which multiple members working on a single project and located at distant locations 

cooperate with each other by using a network of computers. 
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Notes 12. In addition to unbundled software, these systems also used add-on hardware feature 

that allowed users to invest only in the hardware configuration and software of their 

need and value. 

13. PCs of fourth generation made computers affordable even by individuals for their 

personal use at home. 

1.3.5 Fifth Generation (1989-Present) 

The trend of further miniaturization of electronic components, dramatic increase in power 

of microprocessor-chips, and increase in capacity of main memory and hard disk continued 

during fifth generation. VLSI technology came ULSI ((Ultra Large Scale Integration) technology 

in fifth generation resulting in production of Microprocessor chips having ten million 

electronic components. In fact, the speed of microprocessors and the size of main memory 

and hard disk doubled almost every eighteen months. As a result, many features found 

in the CPUs of large mainframe systems of third- and fourth-generation systems became 

part of microprocessor architecture in fifth generation. This ultimately resulted in availability 

of very powerful and compact computers becoming available at cheaper rates and death 

of traditional large mainframe systems. Due to this fast space of advancement in computer 

technology, we see more compact and more powerful computers being introduced almost 

every year at more or less the same price or even cheaper. Notable among these are 

portable notebook computers that give the power of a PC to their users even while 

travelling, powerful desktop PCs and workstations, powerful servers, and very powerful 

supercomputers. 

Storage technology also advanced very fast making larger and larger main memory and disk 

storage available in newly introduced systems. During fifth generation, optical disks also 

emerged as a popular portable mass storage D-ROM (Compact Disk - Read Only Memory). 

During fifth generation, there was tremendous outgrowth of computer networks. 

Communication technologies become faster day-by-day and more and more computers were 

networked together. This trend resulted in emergence and popularity of the Internet and 

associated technologies and applications. The Internet made it possible for computer users 

sitting across the globe to communicate with each other within minutes by use of electronic 

mail (known as e-mail) facility. A vast ocean of information became readily available to 

computer users through the World Wide Web (known as WWW). Moreover, several new 

types of exciting applications like e-commerce, virtual libraries, virtual classrooms, distance 

education, etc., emerged during the period. 

Tremendous processing power and massive storage capacity of fifth-generation computers 

also made them a very popular tool for a wide range of multimedia applications that deal 

with information containing text, graphics animation, audio, and video data. In general, the 

data size of multimedia information is much larger than textual information because 

representation of graphics, animation, audio, or video media in digital form requires larger 

number of bits than that required for representation of textual information. 

Characteristic features of fifth-generation computers are as follows: 

1. Portable PCs (called notebook computers) are much smaller and handy than PCs of 

fourth generation allowing users to use computing facility even while travelling. 

2. Fifth-generation desktop PCs and workstations are several times more powerful than 

PCs of fourth generation. 



13 

 

 

3. Although fifth-generation mainframes require proper air-conditioning of the rooms/ 

areas in which they are located, no air-conditioning is normally required for notebook 

computers, desktop PCs, and workstations. 

4. They consume less power than their predecessors do. 

5. They are more reliable and less prone to hardware failures   than their predecessors 

were, requiring negligible maintenance cost. 

6. Many of the large-scale fifth-generation systems have hot-plug feature that enables a 

failed component to be replaced with a new one without the need to shutdown the 

system. Hence, the uptime of these systems is very high. 

7. They have faster and larger primary and secondary storage as compared to their 

predecessors. 

8. They are general-purpose machines. 

9. Their manufacturing does not require manual assembly of individual components into 

electronic circuits resulting in reduced human labour and cost involved at assembly 

stage. Hence, commercial production of these systems is easier and cheaper. However, 

highly sophisticated technology and expensive setup (affordable only by a few 

organizations in the world) is required for manufacturing IJLSI chips. 

10. Use of standard high-level programming languages allows programs written for one 

computer to be easily ported to and executed on another computer. 

11. More user-friendly interfaces with multimedia features make the systems easier to 

learn and use by anyone, including children. 

12. Newer and more powerful applications, including multimedia applications, make the 

systems more useful in every occupation. 

13. Explosion in the size of the Internet coupled with Internet-based tools and applications 

have made these systems influence the life of even common people. 

14. These systems also use the concept of unbundled software and add-on hardware 

allowing the users to invest only in the hardware configuration and software of their 

need and value. 

15. With so many types of computers in all price ranges today, we have a computer for 

almost any type of user whether the user is a child or a world-fame scientist. 

We have looked at the history of computing divided into five generations and we have seen 

how quickly things have changed in the last few decades. Technological progress in this area 

is continuing at the same rate even now. In fact, the fastest-growth period in the history of 

computing may be still ahead. 

 
An integrated circuit (IC) is a small electronic device made out of a 

semiconductor material. The first integrated circuit was developed in the 

1950s by Jack Kilby of Texas Instruments and Robert Noyce of Fairchild 

Semiconductor. 

Notes 

 

 

 

 
Describe the main different of first generation computer and third 

generation computer. 
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• Control Unit 

• Central Processing Unit 

These are shown in Figure 1.2. 

A computer can process data, pictures, sound and graphics. They can solve highly complicated 

problems quickly and accurately. 

1.4.1 Input Unit 

Computers need to receive data and instruction in order to solve any problem. Therefore, 

we need to input the data and instructions into the computers. The input unit consists of one 

or more input devices. Keyboard is the one of the most commonly used input devices. Other 

commonly used input devices are the mouse, floppy disk drive, magnetic tape, etc. All the 

input devices perform the following functions: 

• Accept the data and instructions from the outside world. 

Figure 1.2: Block Diagram of Computer 

Output unit Storage Input Unit 

Output Processing Input 

Notes 1.4 Block Diagram of Computer 
 

The basic components of a computer are: 

• Input Unit 

• Output Unit 

• Memory/Storage   Unit 

• Arithmetic Logic Unit 
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• Convert it to a form that the computer can understand. 

• Supply the converted data to the computer system for further processing. 

1.4.2 Storage Unit 

The storage unit of the computer holds data and instructions that are entered through the 

input unit, before they are processed. It preserves the intermediate and final results before 

these are sent to the output devices. It also saves the data for the later use. The various 

storage devices of a computer system are divided into two categories: 



15 

 

 

1. Primary Storage: Stores and provides very fast. This memory is generally used to hold 

the program being currently executed in the computer, the data being received from 

the input unit, the intermediate and final results of the program. The primary memory 

is temporary in nature. The data is lost, when the computer is switched off. In order 

to store the data permanently, the data has to be transferred to the secondary memory. 

The cost of the primary storage is more compared to the secondary storage. Therefore, 

most computers have limited primary storage capacity. 

2. Secondary Storage: Secondary storage is used like an archive. It stores several programs, 

documents, data bases etc. The programs that you run on the computer are first transferred 

to the primary memory before it is actually run. Whenever the results are saved, again 

they get stored in the secondary memory. The secondary memory is slower and cheaper 

than the primary memory. Some of the commonly used secondary memory devices are 

Hard disk, CD, etc. 

1.4.3 Memory Size 

All digital computers use the binary system, i.e. 0’s and 1’s. Each character or a number is 

represented by an 8 bit code. The set of 8 bits is called a byte. A character occupies 1 byte space. 

A numeric occupies 2 byte space. Byte is the space occupied in the memory. The size of the 

primary storage is specified in KB (Kilobytes) or MB (Megabyte). One KB is equal to 1024 bytes 

and one MB is equal to 1000 KB. The size of the primary storage in a typical PC usually starts 

at 16 MB. PCs having 32 MB, 48 MB, 128 MB, 256 MB memory are quite common. 

1.4.4 Output Unit 

The output unit of a computer provides the information and results of a computation to outside 

world. Printers, Visual Display Unit (VDU) are the commonly used output devices. Other 

commonly used output devices are floppy disk drive, hard disk drive and magnetic tape drive. 

1.4.5 Arithmetic Logical Unit 

All calculations are performed in the Arithmetic Logic Unit (ALU) of the computer. It also 

does comparison and takes decision. The ALU can perform basic operations such as addition, 

subtraction, multiplication, division, etc and does logic operations viz, >, <, =, ‘etc. Whenever 

calculations are required, the control unit transfers the data from storage unit to ALU once 

the computations are done, the results are transferred to the storage unit by the control unit 

and then it is send to the output unit for displaying results. 

1.4.6 Control Unit 

It controls all other units in the computer. The control unit instructs the input unit, where 

to store the data after receiving it from the user. It controls the flow of data and instructions 

from the storage unit to ALU. It also controls the flow of results from the ALU to the storage 

unit. The control unit is generally referred as the central nervous system of the computer 

that control and synchronizes its working. 

1.4.7 Central Processing Unit 

The control unit and ALU of the computer are together known as the Central Processing Unit 

(CPU). The CPU is like brain performs the following functions: 

• It performs all calculations. 

• It takes all decisions. 

• It controls all units of the computer. 

Notes 
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Success Story of First Generation Computers 

I 
t is the Bendix G-15 General Purpose Digital Computer, a First Generation computer 
introduced in 1956. 

Bendix introduced their G-15 in 1956. It was not the first Bendix computing machine. They 
introduced a model named the D-12, in 1954. However, the D-12 was a digital differential 
analyser and not a general purpose computer. 

The G-15 was superceded by the second generation (transistorised) Bendix G-20. 

The Bendix G-15 was a fairly sophisticated, medium size computer for its day. It used 
a magnetic drum for internal memory storage and had 180 tube packages and 300 
germanium diode packages for logical circuitry. Cooling was by internal forced air. 

Storage on the Magnetic Drum comprised 2160 words in twenty channels of 108 words 
each. Average access time was 4.5 milliseconds. In addition, there were 16 words of fast- 
access storagein four channels of 4 words each, with average access time of 0.54 
milliseconds; and eight words in registers consisting of 1 one-word command register, 
1 one-word arithmetic register, and 3 two-word arithmetic registers for double-precision 
operations. 

Notes A PC may have CPU-IC such as Intel 8088, 80286, 80386, 80486, Celeron, Pentium, Pentium 
Pro, Pentium II, Pentium III, Pentium IV, Dual Core, and AMD etc. 

 

 

The activity of processing data using a computer is called data processing. 

Data is raw material used as input to data processing and information is 

processed data obtained as output of data processing. 

 
 

Contd... 
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A 108-word buffer channel on the magnetic drum allowed input-output to proceed 
simultaneously with computation. 

Word size was 29 bits, allowing single- 
precision numbers of seven decimal digits 
plus sign during input-output and twenty 
nine binary digits internally, and double- 
precision numbers of fourteen decimal digits 
plus sign during input-output, fifty eight 
binary digits internally. 

Each machine language instruction specified 
the address of the operand and the address 
of the next instruction. Double-length 
arithmetic registers permitted the 
programming of double-precision operations 
with the same ease as single-precision ones. 

An interpreter called Intercom 1000 and a 
compiler called Algo provided simpler 
alternatives to machine language 
programming. Algo followed the principles 
set forth in the international algorithmic 
language, Algol, and permitted the 
programmer to state a problem in algebraic 
form. The Bendix Corporation claimed to be 
the first manufacturer to introduce a 
programming system patterned on Algol. 

The basic computation times, in 
milliseconds, were as follows (including the 
time required for the computer to read the 
command prior to its execution). The time 

 

 

range for multiplication and division 
represents the range between single decimal digit precision and maximum precision. 

External Storage was provided on searchable paper tape (2,500 words per magazine) and, 

optionally, on one to four, magnetic tape units with 300,000 words per tape unit reel. 

Questions: 

1. What is the purpose of developing the first generation computer? 

2. What is its basic computation times? 

 

1.5 Summary 

Notes 

 

• The word computer comes from the word ‚compute‛, which means, ‚to calculate‛. 

• Then characteristics of computer discuss which include Automatic Machine, Speed, 

Accuracy, Diligence, Versatility, Power of Remembering. 

• Computer generation like First Generation (1942-1955), Second Generation (1955-1964), 

Third Generation (1964-1975), Fourth Generation (1975-1989) and Fifth Generation (1989- 

Present). 

• Block Diagram of Computer means sub part of computer like input, output and 

memory devices. 

• The control processing unit is combination of ALO and Au. 
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Notes 1.6 Keywords 
 

Data processing: The activity of processing data using a computer is called data processing. 

Generation: Originally, the term ‚generation‛ was used to distinguish between varying 

hardware technologies but it has now been extended to include both hardware and software 

that together make up a computer system. 

Integrated circuits: They are usually called ICs or chips. They are complex circuits which 

have been etched onto tiny chips of semiconductor (silicon). The chip is packaged in a plastic 

holder with pins spaced on a 0.1" (2.54 mm) grid which will fit the holes on stripboard and 

breadboards. Very fine wires inside the package link the chip to the pins. 

Medium scale integration (MSI): Medium-Scale Integration is a term used in electronic chip 

manufacturing industry. An integrated circuit which contained hundreds of transistors on 

each chip, called Medium-Scale Integration (MSI). 

Small-scale integration” (SSI): The first integrated circuits contained only a few transistors. 

Called ‚Small-Scale Integration‛ (SSI), they used circuits containing transistors numbering 

in the tens. 

Storage unit: The storage unit of the computer holds data and instructions that are entered 

through the input unit, before they are processed. It preserves the intermediate and final 

results before these are sent to the output devices. 

Very-large-scale integration (VLSI): It is the process of creating integrated circuits by 

combining thousands of transistors into a single chip. 

 

 
 

1. Explain all computer generation. 

 

 

1.7 Self-Assessment Questions 
 

1. Computer’s third generation is from<<<<. to <<<< 

(a) 1955-1964 (b) 1964-1975 

(c) 1942-1955 (d) 1975-1989 

2. Developed an electronic machine to solve certain mathematical equations. 

(a) Dr John Atanasoff (b) Herman Hollerith 

(c) Professors J. Presper Eckert (d) All of these 

3. The activity of processing data using a computer is called Data handling. 

(a) True (b) False 

4. ULSI stands for<<<< 

(a) Ultra Located Scale Integration 

(b) Ultra Large Scale Itegartion 

5. Portable PCs also called <<<<< 

(a) Book computer (b) Notebook computers 
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6. The second generation computers were manufactured by using <<<< 

(a) Vacuum tubes (b) Transistors 

(c) IC Chip (d) None of above 

7. ANSI stands for<<<< 

(a) American National Standards Institute 

(b) Asia National Standards Institute 
 

1.8 Review Questions 

Notes 

 

1. What is a computer? Why is it also known as a data processor? 

2. What is data processing? Differentiate between data and information. Which is more 

useful to the people and why? 

3. List and explain some important characteristics of a computer. 

4. What is garbage-in-garbage-out? 

5. Who is known as the father of modern digital computers and why? 

6. Who invented the concept of stored program? Why is this concept so important? 

7. Why are modern digital computers often referred to as stored program digital 

computers? 

8. Which was the first commercially produced computer? When and where was it first 

installed? 

9. Write full form of following abbreviations used in computer terminology: IBM, ENIAC, 

EDVAC, EDSAC, UNIVAC. 

10. What is ‚generation‛ in computer terminology? How many computer generations are 

there till date? 

11. List the various computer generations along with the key characteristics of computers 

of each generation. 

12. List key hardware technologies used in building computers of each of the five generations. 

13. List key software technologies used in building computers of each of the five generations. 

14. What is an IC? How does it help in reducing the size computers? 

15. Why were first- and second-generation computers more difficult and costlier to produce 

commercially that computer of subsequent generations? 

16. Name the technologies used for constructing main memory in first-, second-, third-, 

and fourth-generation computers. 

17. Name the secondary storage media popularly used, i.e. first-, second-, third-, fourth-, and 

firth-generation computers. 

18. What is a microprocessor? How did it revolutionize the computer industry? 

19. Name some applications that emerged due to emergence of computer networks. 

20. Name some applications that emerged due to emergence of the Internet. 

21. Name some representative computer systems of each of the five computer generations. 
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1.9 Further Readings 

4. (b) 

 
 

 

Fundamental Computer Concepts, William S. Davis. 

Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister. 

http://books.google.co.in/bkshp?hl=en 

Notes Answers to Self-Assessment Questions 

 1. (b)  2. (a) 3. (b) 

 5. (b)  6. (b) 7. (a) 

 

http://books.google.co.in/bkshp?hl=en
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Objectives 

After studying this unit, you will be able to: 

• Understand the concept of Data representation in binary number, Octal number and 

Hexadecimal number system 

• Discussed how to concert are number system to another 

• Explain the short cut method for octal to binary conversion, Binary to Hexadecimal 

Conversion and Hexadecimal to Binary Conversion. 
 

Introduction 

While the basic memory unit in a digital computer is the bit, holding a value of 1 or 0, 

or equivalently ON or OFF, most information of interest to the user requires more than 

a simple bi-valued representation. Thus, it is practical to form groups of bits, each consisting 

of some carefully chosen number of bits, and design the computer hardware to deal with 

these groups as complete units. In modern computers the most basic group consists of 8 
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Notes bits, called the byte. Most computers implement groupings of two bytes, 4 bytes, and 8 

bytes. 
 

2.1 Data Representations 
 

In order to discuss how data is processed by a computer, we should first understand the form 

in which data is stored in its memory. 

There are two basic types of data which are stored and processed by computers, namely 

character and numbers. Characters include letters and special symbols. For example, computer 

may be programmed to read a list of names, sort them in alphabetical order and print the 

sorted list. A list of names, such as VINEET, PRADIP, GANESH read by an input unit would 

be stored in memory, sorted by the program in alphabetical order and printed the strings 

being VINEET, PRADIP and GANESH. 

The other type of data is decimal numbers such as 1234, 456 etc. Numbers are processed using 

arithmetic operations such add, subtract, multiply and divide. In this case, we assign values 

to numbers and the processing results in new values. 

The characters and numbers fed to a computer, and the output from the computer, must be 

in a form which is usable by people. For this purpose natural language symbols and decimal 

digit are appropriate. These constitute the external data representation. On the other hand, 

the representation of data inside a computer must match the technology used by the 

computer to store and process data. Thus we should first determine the most appropriate 

internal representation to internal representation and vice versa. 

2.1.1 Binary Number System 

Binary number system is like decimal number system, except that the base is 2, instead of 10. 

We can use only two symbols or digit (0 and 1) in this number system. Note that the largest 

single digit is 1(one less than the base) each position in a binary number represents a power 

of the base (2). Hence, in this system, the rightmost position, is units (20) position, the position 

from the right is 2’s (21) position, and proceeding in this way, we have 4’s (22) position, 8’s 

(23) position, 16’s (24) position, and so on. Therefore, decimal equivalent of binary number 

10101(written as l010l2) is: 

(1 x 24) + (O x 23) + (1 x 22) + (0 x 21) + (1 x 20) = 16 + 0 + 4 + 0 + 1 = 21 

In order to be specific about which system we are referring to, it is a common practice to 

indicate the base as a subscript. Hence, we write:, 

101012=2110 

The short form of ‚binary digit‛ is bit. Hence, a ‚bit‛ in computer terminology means either 

a 0 or 1. 

An n-bit number is a binary number consisting of `n’ bits. Figure 1.3 lists all 3-bit numbers along 

with their decimal equivalent. Remember that we have only two digits, 0 and 1, in binary 

number system and hence, binary equivalent of decimal number 2 has to be stated as 10 (read 

as one, zero). Another important point to note is that with 3 bits (positions), only 8(23 ) different 

patterns of 0s and 1s are possible, and it may be seen from Figure 1.3 that a 3-bit number can 

have one of the 8 values in the range 0 to 7. In fact, any decimal number in the range 0 to 

2n-1 can be represented in binary form as an n-bit number. 



Unit 2: Introduction to Data Representations 

23 

 

 

 
Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Every computer stores numbers, letters, and other special characters in binary form. There 

are several occasions when computer professionals need to know the raw data contained in 

a computer’s memory. A commonly used way of doing this is to print memory contents on 

a printer. This printout is called a memory dump. Memory dumps, which are in binary 

numbers, would have many pages of 0s and 1s. Working with these numbers would be very 

difficult and error prone for computer professionals. Hence, two number systems—octal and 

hexadecimal, are often used as shortcut notations for binary. These number systems and their 

relationship with binary number system are explained below. 

2.1.2 Octal Number System 

In octal number system, the base is 8. Hence, there are only eight symbols or digits: 0, 1, 

2, 3, 4, 5, 6, and 7 (8 and 9 do not exist in this system). The largest single digit is 7 (one less 

than the base 8). Each position in an octal number represents a power of the base (8). 

Therefore, decimal equivalent of octal number 2057 (written as 20578), is: 

(2 x 83) + (0 x 82) + (5 x 81) + (7 x 80) =1024 + 0 + 40 + 7=1071 Hence, 20578 = 107110 

Observe that since there are only 8 digits in octal number system, 3 bits (23 = 8) are sufficient 

to represent any octal number in binary (see Figure 1.3). 

2.1.3 Hexadecimal Number System 

In hexadecimal number system, the base is 16. Hence, there are 16 symbols or digits. The 

first 10 digits are the same digits of decimal number system - 0, 1, 2, 3, 4, 5, 6, 7, 8, and 9. 

The remaining six digits are denoted by the symbols A, B, C, D, E, and F, representing 

decimal values 10, 11, 12, 13, 14, and 15, respectively. Hence, the largest single digit is F or 

15 (one less than the base 16). Each position in hexadecimal number system represents a 

power of the base (16). Therefore, decimal equivalent of hexadecimal number lAF (written 

as (1AF16) is: 23 (1 x 162-) + (A x 161) + (F x 160) = (1 x 256) + (10 x 16) + (15 x 1)=256 + 160 

+15 = 431 Hence, IAF16= 43110 

Observe that since there are only 16 digits in hexadecimal number system, 4 bits (24 = 16) 

are sufficient to represent any hexadecimal number in binary. 

 
In our day-to-day life, we use the decimal number system. In this system, 

base is equal to 10 because there are altogether ten symbols or digits (0, 

1, 2, 3, 4, 5, 6, 7, 8, and 9). 

 Figure 2.1: Bit Numbers with Their Decimal Values  

   

  

 000 0  

001 1 

010 2 

011 3 

100 4 

101 5 

110 6 

111 7 
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Notes 2.2 Converting from One Number System to Another 

 

Numbers expressed in decimal number system are much more meaningful to us, than are 

numbers expressed in any other number system. This is because we have been using decimal 

numbers in our day-to-day life, right from childhood; however, we can represent any 

number in one number system in any other number system. Because the input and final 

output values are to be in decimal, computer professionals are often required to convert 

number in other systems to decimal and vice-versa. Many methods can be used to convert 

numbers from one base to another. A method of converting from another base to decimal, 

and a method of converting from decimal to another base are described below. 

2.2.1 Converting from Another Base to Decimal 

The following steps are used to convert a number in any other base to a base 10 (decimal) 
number: 

Step 1: Determine the column (positional) value of each digit (this depends on the 
position of the digit and the base of the number system). 

Step 2: Multiply the obtained column values (in Step 1) by the digits in the corresponding 
columns. 

Step 3: Sum up the products calculated in Step 2. The total is the equivalent value in 
decimal. 

 

1: 110012 = ?10 

Step 1: Determine column Values 

Column Number Column 

(From Right) 20 = 1 

1 21 = 2 

2 22 = 4 

3 23 = 8 

4 24 = 16 

Step 2: Multiply the column values by the corresponding column digits. 

16 8 4 2 1 

x1 x1 x0 x0 x1 

16 8 0 0 1 

Step 3: Sum up the products 

16 + 8 + 0 + 0 + 1 = 25 

Hence, 110012=2510 
 

2: 47068 = ? 10 

Step 1: Determine column values 

Column Number Column 

(From Right) 

1 80 = 1 

2 81 = 8 

3 82 = 64 

4 83 = 512 
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Hence, 47068 = 250210 

 
3: 1AC16 = ? 10 

 

1AC16=1 x 162 + A x 161 + C x 160 

=1 x 256 + 10 x 16 + 12 x 1 

=256 +160 +12 

=42810 

 

4: 40527=?10 

 

40527 = 4 x 73 + 0 x 72 + 5 x 71 + 2 x 70 

= 4 x 343 + 0 x 49 + 5 x 7 +2 x 1 

= 1372 + 0 + 35 + 2 = 140910 

 
5: 40526=?10 

 

40526 = 4 x 63 + 0 x 62 + 5 x 61 + 2 x 60 

= 4 x 216 + 0 x 36 + 5 x 6 +2 x 1 

= 864 + 0 + 30 +2 

= 89610 

6: 110014 
 

110014= 1 x 44 +1 x 43 + 0 x 42 +1 x 41 + l x 40 

Comparing this results with the result obtained in Example 4, we find 

that although the digits (4052) are the same for both the numbers, their 

decimal equivalents are different. This is decause the number system, 

whereas the number in Example 5 is represented in base 6 number 

system. 

 
Step 2: Multiply the column values by the corressponding column digits Notes 

 

512 

x 4 

64 

x 7 

8 

x 0 

1 

x 6 

2048 448 0 6 

 

Step 3: Sum up the products 

2048 + 448 + 0 + 6 = 2502 
 

= 1 x 256 + 1 x 64 + 0 x 16 + 0 x 4 + l x l 

= 256 + 64 + 0 + 0 + 1 

= 32110 

Compare the result with the result obtained in Example 1. 
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Notes                     7: 1AC13=? 10 

lAC13= 1 x 132 +A x 131     +C x 130 

= 1 x 169 + 10 x 13 + 12 x 1 

= 31110 

Compare the result with the result obtained in Example 3 

2.2.2 Converting from Decimal to Another Base (Division-Remainder 
Technique) 

The following steps are used to convert a base 10 (decimal) number to a number in another 
base 

Step 1: Divide the decimal number by the value of the new base. 

Step 2: Record the remainder from Step I as the rightmost digit (least significant digit) 
of the new base number. 

Step 3: Divide the quotient of the previous division by the new base. 

Step 4: Record the remainder from Step 3 as the next digit (to the left) of the new base 
number. Repeat Steps 3 and 4, recording remainders from right to left, until the 
quotient becomes zero in Step 3. Note that the last remainder, thus obtained, will 
be the most significant digit of the new base number. 

 
Steps 1 and 2: 25/2 = 12 and remainder 1 

Steps 3 and 4: 12/2 = 6 and remainder 0 

Steps 3 and 4: 6/2 = 3 and remainder 0 

Steps 3 and 4: 3/2 = 1 and remainder I 

Steps 3 and 4: 1/2 = 0 and remainder 1. 

As mentioned in Steps 2 and 4, the remainders are now arranged in the 

reverse order, making the first remainder the least significant digit (LSD) 

and the last remainder the most significant digit (MSD). 

Hence, 2510= 110012 

Compare the result with the result obtained in above Example 1. 

2.2.3 Converting from a Base Other Than 10 to Another Base Other 
Than 10 

The following steps are used to convert a number in a base other than 10, to number base 

other than 10: 

Step 1: Convert the original number to a base (decimal) number. 

Step 2: Convert the decimal number obtained in step 1 to the new base number. 

 
5456 = ?4 

Step 1: Convert from base 6 to base 10 

545= 5 x 62 + 4 x 61 + 5 x 60 

= 5 x 36 + 4 x 6 + 5 x 1 

= 180 +24 + 5 

= 20910 
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20910 = 31014 

Therefore, 5456=20910=31014 

Hence, 5466=31014 

Above example illustrates the method of converting a binary number to an octal number. 

Shortcut method for binary to octal Conversion. The following steps are used in this method: 

Step 1: Divide the binary digits into groups of three (starting from the right). 

Step 2: Convert each group of three binary digit to one octal digit. Since there are only 8 

digits (0 to 7) in octal number system, 3 bits (23 = 8) are sufficient to represent any octal 

number in binary to decimal conversion method in this step. 

 

                   1011102=? 8 

Step 1: Divide the binary digits into groups of 3, starting the right (LSD). 

101 110 

Step 2: Convert each group into one digit of octal (use binary- to- decimal 
conversion method). 

1012      = 1 x 22 + 0 x 21 + 1 x 20 1102= 1 x 22 +1 x 21 + 0 x 20 

= 4 + 0 + 1 4 + 2 + 0 

= 58 68 

Hence, 1011102 = 568 
 

2.2.4 Shortcut Method for Octal to Binary Conversion 

The following steps are used in this method: 

Step 1: Convert each octal digit to a 3 digit binary number (the octal digits may be treated 
as decimal numbers for this conversion). 

Step 2: Combine all the resulting binary groups (of 3 digits each) into a single binary 
number. 

 

                   5628 = ? 2 

Step 1: Convert each octal digit to 3 Binary digits. 

58 = 1012 

68 = 1102 

28 – 0102 

Step 2: Convert 20910 
 

4 209 

to base 4 
 

Remainder 

Notes 

52 1  

  13 0  

  3  1  

0 3  
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Notes Step 2: Combine the binary groups. 
 

 

5628 = 
101 

5 

110 

6 

010 
 

 

2 
 

Hence, 5628 = 1011100102 

2.2.5 Shortcut Method for Binary to Hexadecimal Conversion 

The following steps are used in this method: 

Step 1: Divide the binary digits into groups of four (starting from the right). 

Step 2: Convert each group of four binary digits to one hexadecimal digit. Remember that 

hexadecimal digits 0 to 9 are equal to decimal digits 0 to 9 and hexadecimal digits 

A to F are equal to decimal values 10 to 15. Hence, for this step, we use binary to 

decimal conversion procedure and represent decimal values 10 to 15 as hexadecimal 

A to F. 

 
For binary to hexadecimal conversion we have to remember that 

hexadecimal digits 0 to 9 are equal to decimal digits 0 to 9 and hexadecimal 

digits A to F are equal to decimal values 10 to 15. Hence, for this step, we 

use binary to decimal conversion procedure and represent decimal values 

10 to 15 as hexadecimal A to F. 

 

110100112=? 16 

Step 1: Divide the binary digit into groups of 4, starting from the right 
(LSD) 

1101 0011 

Step 2: Convert each group of 4 binary digit to 1 hexadecimal digit 

11012   = 1x23 +1x22+0x21+1 x 2 00112 = 0x23+0x22+1x21+1x20 

=  8+4+0+1 = 0+0+2+1 

=  1310 = 316 

= D16 

Hence, 110100112 = D316 

2.2.6 Shortcut Method for Hexadecimal to Binary Conversion 

The following steps are used in this method: 

Step 1: Convert decimal equivalent of each hexadecimal digit to 4 binary digits. 

Step 2: Combine all resulting binary groups (4 digits each) into a single binary number. 

 
2AB16=? 2 

Step 1: Convert decimal equivalent each hexadecimal digit to 4 binary 
digits. 

216 = 210 = 00102 

A16= 1010= 10102 

B16 = 1110= 10112 



Unit 2: Introduction to Data Representations 

29 

 

 

 
Step 2: Combine the binary groups. Notes 

0010 
2AB16= 

2
 

 

0010 

A 

 

1011 
 

 

B 

Hence, 2AB16 = 0010101010112 

Figure 1.4 summarizes the relationship among decimal, hexadecimal, binary, and octal 

number systems. Note that the maximum value for a single digit of octal (7) is equal to the 

maximum value of three digits of binary. The value range of one digit of octal duplicates 

the value range of three digits of binary. If we substitute octal digits for binary digits, the 

substitution is on a one-to-three basis. Hence, computers that print octal numbers instead 

binary, while taking memory dump, save one-third of printing space and time. 

Similarly, note that the maximum value of one digit in hexadecimal is equal to the maximum 

value of four digits in binary. Hence, the value range of one digit of hexadecimal is 

equivalent to the value range of four digits of binary. Therefore, hexadecimal shortcut 

notation is a one-to-four reduction in space and time required for memory dump. 
 

    

 Figure 2.2: Relati onship Among Decimal, Hexadecimal, Binary and Octal 
Number Systems 

 

  

 Decimal Hexadecimal Binary Octal  

0 0 0 0 

1 1 1 1 

2 2 10 2 

3 3 11 3 

4 4 100 4 

5 5 111 5 

6 6 110 6 

7 7 111 7 

8 8 1000 10 

9 9 1001 11 

10 A 1010 12 

11 B 1011 13 

12 C 1100 14 

13 D 1101 15 

14 E 1110 16 

15 F 1111 17 

16 10 10000 20 
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Notes  

 
Graphical Representation of Data 

 
nce we have data organized in tabular form we can represent it as a graph. We 

are going to build a basic histogram (also called, for the time being, a bar graph 

or frequency distribution graph) using Excel Chart Wizard. Again, there are 

numerous approaches to building and modifying graphs; the method shown below is just 

one, and not necessarily the most correct, easiest, or clearest for everyone. 

Mechanics of constructing a basic histogram 

1. Highlight values in the frequency (/) column (don’t include the total), E3:E9, and click 

on the chart wizard icon. (Now might be a good time to turn on the ScreenTips 

associated with the cursor. The command is in Tools-Customize-Option. ScreenTips 

are sometimes handy when constructing graphs. The tips show themselves about 1.5 

seconds after you point to items such as an icon. 

 

 

 

 

 

 

 

 

 

2. In Chart Wizard Step 1, select Standard Types, Column (you can play with Custom 

Charts at your leisure). Select the upper left box. Then use ‚next‛ to go to Step 2. 

Or you can double click on the box to go to the next step. 
 

 
 

3. Step 2 in Chart Wizard causes problems for some students. You have the start of 
graph but there is much to do to get it just the way we want it. 

 

Contd... 

 

 

 
Standard Types     Custom Types 

 

Chart type: Chart sub-type:   

Bar 

Line 

Pie 

XY (Scatter) 

Area 

Doughnut 

Radar 

Surface 

Bubble 

Stock 

O 
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   Data Range     Series   

Students 

     English Biology Calculus Physics History 

      Courses   

  Data range: =Sheet2!$1:$B$6  

  Series in:  Rows   

 Columns   

 
 

    Cancel < Back Next >       Finish   

  Source Data  

 
   Data Range         Series  

 

300 
 

250 
 

200 
 

150 
 

100 
 

50 
 

0 

 Series   

 Monthly  

 Smoothed  
   Name:   Smoothed  

  Values: =MonSunspot!$D$9:$D$3081  

 
     Add Remove   

 
 

 Category (X) axis labels:  =MonSunspot!$D$9:$B$3081  

  Cancel    < Back Next >      Finish   

4 

4 

3 

3 

2 

2 

1 

1 

5 

0 

Monthly 

Smoothed 

 
(a) The Data Range dialog box is fairly self-explanatory. Notice the ‚Series in: Column‛ 

button is marked. Also notice the ‚=Sibling!‛ in the Data Range box; this indicates 

what worksheet the data is on. We don’t really need it in this example but it is 

necessary when we are working with more than one worksheet in an Excel 

workbook. 

Notes 

 

 

 
 

 
 

 

 

 

 

 

 

 

 

 
(b) Now click the ‚Series‛ tab at the top. This is where we set up some  of the X- 

axis format. ‚Series 1‛ refers to the data and is associated with both the chart 

legend and title. We’ll give it a name here just to try it out (we’ll modify it later 

however). Type ‚Siblings‛ in the empty Name space. You’re done in that box 

(don’t hit enter yet or you’ll go to step 3). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Contd... 

Class sizes 

H
u
m

b
e
r 
o
f 
S

tu
d
e
n
ts

 

1
7

4
9

 
 1

7
6
6
 

1
7
8
1
 

1
8

0
0

 
 1

8
1
7

 

1
8

3
4

 

1
8
5
1
 

 1
8

6
7

 

1
8

8
4

 
 1

9
0
1
 

1
9
1
6
 

 1
9
1
5
 

1
9
5
2
 

 1
9
6
9
 

1
9
8
6
 

2
0
0
3
 



Unit 2: Introduction to Data Representations 

32 

 

 

 
Notes (c) Move your cursor to the Category X-axis labels box. This is an important feature; 

we assign the labels or categories to the X-axis here. One way is to type in the 

cells that contain our label names (or categories or numbers). Use the cells D3:D9 

since they are the values of our random variables. You can use the red arrows 

or simply put your cursor in the box and highlight the appropriate cells. Click 

on ‚next‛ to go to Chart Wizard step 3. 

4. In Chart Wizard Step 3 we continue formatting and labeling the graph. You don’t 

have to get it exactly right in this step as it is easy to modify the graph later. Title 

the graph ‚Number of Siblings‛. Label the X-axis, ‚No. of Siblings‛, and label the Y-

axis ‚No. of Students‛. Notice the other tabs at the top of this dialog box—Axes, 

Gridlines, Legend, etc. Look at each of these and experiment. Click on Next to go 

to the last step. 

5. Step 4 in Chart Wizard asks whether we want the chart on the worksheet we are 

working with, in this case, Siblings, or put the graph on a new worksheet. Leave it 

on the ‚Siblings‛ worksheet and finish. 

6. Adjust the graph to a convenient size. You do that by dragging the black squares, 

called sizing handles, found around the chart. If those squares aren’t there, you can 

make them appear by selecting the chart with a mouse click. Then reposition the 

chart to a convenient place on your worksheet. 

7. You should now have a graph similar to the one below. Don’t worry too much if 

yours isn’t perfect. Part of your assignment for this module is to change it anyway. 

 

 

 

 

 

 

 

 

 

Questions: 

1. Explain the concept of Histogram. 

2. What is graphical representation of data? 

 
 

2.3 Summary 
 

• In octal number system their are only eight symbols or digits i.e. 0, 1, 2, 3, 4, 5, 6, 

7, 8. 

• In hexadecimal number system each position represent a power of the base 16. 

• Graphical representation of data i.e. bar graph, excel chart wizard etc. 
 

2.4 Keywords 
 

Binary number system: It is like a decimal number system, except that the base is 2, instead 
of 10 which use only two symbols (0 and 1). 

n-bit number: An n-bit number is a binary number consisting of ‘n’ bits. 

Decimal number system: In this system, base is equal to 10 because there are altogether 
ten symbols or digits (0, 1, 2, 3, 4, 5, 6, 7, 8, and 9). 

Number of Siblings 
12 
10 

8 
6 
4 
2 
0 

0 1 2 3 4 5 6 
No. of Siblings 

siblings 

N
o

. 
o
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S
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1. The value range of one digit of octal duplicates the value range of three digits of 
binary. 

(a) True (b) False 

2. A powerful computer is capable of performing several billion (109) arithmetic operation 
per second. 

(a) True (b) False 

3. 3-digits bit number, i.e. 101 has <<<<decimal equivalent. 

(a) 6 (b) 8 

(c) 2 (d) 5 

4. Memory dump is a printout of memory contents on a paper. 

(a) True (b) False 
 

2.6 Review Questions 
 

1. Find decimal equivalent of following binary numbers: 

2. Find octal equivalent of the binary numbers of Question 22. 

3. Find hexadecimal equivalent of the binary numbers of Question 22. 

 
Memory dump: A commonly used way of doing this is to print memory contents on a 
printer. This printout is called a memory dump. 

 

 
1. Explain one number system to another Conversion. 

Notes 

 

 
 

2.5 Self-Assessment Questions 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
(a) 1101011 

(b) 1000 

(c) 10110011 

(d) 11011101 

(e) 1110101 

(f) 1000 

(g) 10110001100 

(h) 110001 

(i) 1010101100 

(j) 111 

 

 
 

4. Convert the following numbers to decimal numbers: 

(a) 1101102 (b) 25736 

(c)   2A3B16 (d) 12349 

5. Carry out the following  conversions: 

(a)  1256 =?4 (b) 249 = ?3 

(c) ABC16=?8 
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http://books.google.co.in/bkshp?hl=en 

 
Notes Answers to Self-Assessment Questions 

1. (a) 2. (a) 3. (d) 4. (a) 
 

2.7 Further Readings 
 

 

Fundamental Computer Concepts, William S. Davis. 

Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister. 

 

http://books.google.co.in/bkshp?hl=en
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Objectives 
 

After studying this unit, you will be able to: 

• Understand the unit memory 

• Discussed the various types of memory 

• Explain the random access memory 

• Discussed the read only memory 

• Explained programmable red only memory 

• Discussed about the checked memory and its components. 
 

Introduction 
 

CPU contains necessary circuitry for data processing controlling other components of the 

computer. However, one thing it does not have built into it is the place to store programs 

and data needed during data processing. CPU contains several registers for storing data and 

instructions but they can store only a few bytes at a time. They are just sufficient to hold 

only one or two instructions with corresponding data. If the instructions and data of a 

program being executed by a CPU were to reside in secondary storage like a disk, and 

fetched and loaded one by one into CPU registers as the program execution proceeded, this 

would lead to the CPU being idle most of the time. This is because there is a large speed 

mismatch between the rate at which CPU can process data and the rate at which data can 

be transferred from disk to CPU registers. For example, a CPU can process data at a rate 

of about 5 nanosecond/byte and a disk reader can read data at a speed of about 5 

CONTENTS 
 

Objectives 

Introduction 

3.1 Unit of Memory 

3.2 Types of Memory 

3.2.1 RAM 

3.2.2 ROM 

3.2.3 PROM 

3.2.4 EPROM 
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3.4 Keywords 
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3.6 Review Questions 

3.7 Further Readings 
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How many bytes in 2 GB describe with example? 

 
Notes microseconds/byte. Hence, within the time in which a disk can supply one byte of data 

a CPU can process 1000 bytes. This would lead to a very slow overall performance even 

if a computer used  a very fast CPU. To overcome this problem, there is a need to have 

a reasonably large storage space that can hold the instructions and data of the program(s) 

on which CPU is currently working time to fetch and load data from this storage space 

into CPU registers must also be very small as compared to that space from disk storage 

to reduce the speed mismatch problem with CPU speed. Every computer has such a storage 

space known as primary storage, main memory, or simply memory. It is a temporary 

storage area built into the computer hardware. Instructions and data of a program reside 

mainly in this area when CPU is executing the program. Physically, this memory consists 

of some integrated circuit (IC) chips either on the motherboard or on a small circuit board 

attached to the motherboard of a computer system. This built-in memory allows CPU to 

store and retrieve data very quickly. The rate of fetching data from this memory is of the 

order of 50 nanoseconds/byte. Hence, the rate of data fetching from main memory is about 

100 times faster than that from a high speed secondary storage like disk. 
 

3.1 Unit of Memory 

Starting with the Unit of memory, you can see the difference between things like a ‚Kilobyte‛ 

and a ‚Megabyte‛ and other computer  memory terms. 

The charts below will give you a clear understanding of: 

 

Name Symbol Binary 

Measurement 

Decimal 

Measurement 

Number 

of Bytes 

Equal to 

kilobyte KB 2^10 10^3 1,024 1,024 bytes 

megabyte MB 2^20 10^6 1,048,576 1,024 KB 

gigabyte GB 2^30 10^9 1,073,741,824 1,024 MB 

terabyte TB 2^40 10^12 1,099,511,627,776 1,024 GB 

petabyte PB 2^50 10^15 1,125,899,906,842,624 1,024 TB 

exabyte EB 2^60 10^18 1,152,921,504,606,846,976 1,024 PB 

zettabyte ZB 2^70 10^21 1,180,591,620,717,411,303,424 1,024 EB 

yottabyte YB 2^80 10^24 1,208,925,819,614,629,174,706,176 1,024 ZB 

 

3.2 Types of Memory 
 

RAM, ROM, PROM and EPROM 
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3.2.1 Random Access Memory (RAM) 

When people talk about computer memory, they usually mean the volatile RAM memory. 

Physically, this memory consists of some integrated circuit (IC) chips (see Figure 1.1) either 

on the motherboard or on a small circuit board attached to the motherboard. A computer’s 

motherboard is designed in a manner that its memory capacity can be enhanced easily by 

adding more memory chips. Hence, if you decide to have more memory than your computer 

currently has, you can buy more memory chips and plug them in the empty memory slots 

on the motherboard. Service engineers normally do this job. The additional RAM chips 

which plug into special sockets on the motherboard, are known as single in-line memory 

modules (SIMMs). 

Notes 

 

 
 

 

 

 

 

 

 

 

 

 

3.2.2 Read-Only Memory (ROM) 

A special type of RAM, called read-only memory (ROM), is a non-volatile memory chip in 

which data is stored permanently and cannot be altered by usual programs. In fact, storing 

data permanently into this kind of memory is called ‚burning in the data‛ because data in 

such memory is stored by using fuse-links. Once a fuse link is burnt, it is permanent. Data 

stored in a ROM chip can only be read and used—they cannot be changed. This is the reason 

why it is called read-only memory (ROM). Since ROM chips are non-volatile, data stored in 

a ROM are not lost when power is switched off or interrupted unlike in the case of a volatile 

RAM chip. ROM is also known as field stores, permanent stores, or dead stores. 

ROMs are mainly used to store programs and data that do not change and are frequently used. 

Most basic computer operations are carried out by wired electronic circuits. However, several 

higher-level and frequently used operations require very complicated electronic circuits for 

their implementation. Hence, instead of building electronic circuits for these operations, 

special programs are written to perform them. These programs are called micro programs 

because they deal with low-level machine functions and are essentially substitutes for additional 

hardware. ROMs are used by computer manufacturers to store these micro-programs so that 

they cannot be modified by the users. 

A good example of a micro-program is the set of instructions needed to make a computer 

system ready to use when it is powered on. This micro-program, called ‘’system boot 

program‛, contains a set of start-up instructions to check if the system hardware like 

memory, I/O devices, etc. are functioning properly. It looks for an operating system and 

loads its core part in the volatile RAM of the system to produce the initial display-screen 

prompt. Note that this micro-program is used every time the computer is switched on and 

needs to be retained when the computer is switched off. Hence, ROM is an ideal storage for 

storing it. 

Figure 3.1: Random Access Memories (RAM) 
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Figure 3.3: Programmable Read-Only Memory (PROM) 

 
Notes 

 

 

 

 

 

 

 

 

 

3.2.3 Programmable Read-Only Memory (PROM) 

There are two types of read-only memory (ROM) - manufacturer-programmed and user- 

programmed. A manufacturer –programmed ROM is one in which data is burnt in by the 

manufacturer of the electronic equipment in which it is used. For example, a personal 

computer manufacturer may store the system boot program permanently in a ROM chip 

located on the motherboard of each PC manufactured by it. Similarly, a printer manufacturer 

may store the printer controller software in a ROM chip located on the circuit board of each 

manufactured by it. Manufacturer-programmed ROMs are used mainly in those cases where 

the demand for such programmed ROMs is large. Note that manufacturer-programmed ROM 

chips are supplied by the manufacturers of electronic equipment and it is not possible for 

a user to modify the programs or data stored in a ROM chip. On the other hand, a user- 

programmed ROM is one in which a user can load and store ‚read-only‛ programs and data. 

That is, it is possible for a user to ‚customize‛ a system by converting his/her programs 

to micro-programs and storing them in a user-programmed ROM chip. Such a ROM is 

commonly known as Programmable Read-Only Memory (EPROM) because a user can program 

it. Once the user programs are stored in a PROM chip they can be executed usually in a 

fraction of the time previously required. PROMs are programmed to record information 

using a special device known as PROM-programmer. However, once the chip has been 

programmed, the PROM become a ROM. That is, the information recorded in it can only be 

read (it cannot be changed). PROM is also non-volatile storage, i.e., the stored information 

remains intact even if power is switched off or interrupted. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.2.4 Erasable Programmable Only Memory (EPROM) 

Once information is stored in a ROM or PROM chip it cannot be altered. Erasable 

Programmable Read-Only Memory (EPROM) overcomes this problem. As the name implies, 

Figure 3.2: Read-Only Memory (ROM) 
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it is possible to erase information stored in an EPROM chip and the chip can be reprogrammed 

to store new information. EPROMs are often used by R&D personnel (experimenters) who 

frequently change the micro-programs to test the efficiency of a computer system with new 

programs. EPROMs are also useful for those applications in which one may like to store a 

program in a ROM that would normally not change but under some unforeseen conditions, 

one may like to alter it. When an EPROM is in use, information stored in it can only be 

‚read‛ and the information remains in  the chip until it is  erased. 

EPROM chips are of two types—one in which the stored information is erased by exposing 

the chip for some time of ultraviolet light and the other one in which the stored information 

is erased by using high voltage electric pulses is known as Ultra Violet EPROM ((UVEPROAM) 

and the latter is known as Electrically EPROM (EEPROM).It is easier to alter information 

stored in an EEPROM chip as compared to an UVEPROM chip. EPROM is also known as flash 

memory because of the ease with which programs stored in it can be altered. Flash memory 

is used in many new 1/O and storage devices like USB (Universal Serial Bus) pen drive and 

MP3 music player. 

Notes 

 

 
 

 

 

 

 

 

 

 
3.2.5 Cache Memory 

Use of main memory helps in minimizing disk-processor speed mismatch to a large extent 

because the rate of data fetching by a computer’s CPU from its main memory is about 100 

times faster than that from a high-speed secondary storage like disk. However, even with 

the use of main memory, memory-processor speed mismatch becomes a bottleneck in the 

speed with which the CPU can process instructions because there is a 1 to 10 speed mismatch 

between the processor and memory. That is, the rate at which data can be fetched from 

memory is about 10 times slower than the rate at which CPU can process data. Obviously,  

the overall performance of a processor can be improved greatly by minimizing the memory- 

processor speed mismatch. Cache memory (pronounced ‚cash‛ memory) is commonly used 

for this purpose. It is an extremely fast, small memory between CPU and main memory 

whose access time is closer to the processing speed of CPU. It acts as a high-speed buffer 

between CPU and main memory and is used to temporarily store very active data and 

instructions during processing. Since cache memory is faster than main memory, processing 

speed is improved by making the data and instructions needed for current processing 

available in the cache. Cache memory is an extremely fast and small memory between CPU 

and main memory. Its access time is closer to the processing speed of CPU. It acts as a high- 

speed buffer between CPU and main memory and is used to temporarily store very active 

data and instructions during processing. 

Figure 3.4: Erasable Programmable Only Memory (EPROM) 
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What is different between catch memory and RAM? 
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Timeline of Computer Memory 
 

1834: Charles Babbage begins build his ‘‘Analytical Engine’’, Precursor to the computer. 

It uses read-only memory in the form of punch cards. 

1932: Gustav Tauschek invents drum memory in Austria. 

1936: Konrad Zuse applies for a patent for his mechanical memory to be used in his 

computer. This computer memory is based on sliding metal parts. 

1939: Hepmut Schreyer invents a prototype memory using neon lamps. 

1942: The Atanasoff-Berry Computer has 60 50-bit words of memory in the form of 

capacitors mounted on two revolving drums. For secondary memory it uses punch 

cards. 

1947: Frederick Viehe of Los Angeles, applies for a patent for an invention that uses 

magnetic core memory, Magnetic drum memory is independently invented by 

several people. 

1949: Jay Forrester conceives the idea of magnetic core memory as it is to become 

commonly used, with a grid of wires used to address the cores. The first practical 

form manifests in 1952-53 and renders obsolete previous types of computer memory. 

1950: Ferranti Ltd. completes the first commercial computer with 256 40-bit words of 

main memory and 16K words of drum memory. Only eight were sold. 

1951: Jay Forrester files a patent for matrix core memory. 

1952: The EDVAC computer is completed with 1024 44-bit words of ultrasonic memory. 

Acore memory module is added to the ENIAC computer. 

1955: An Wang was issued U.S. patent #2,708,722 with 34 claims for magnetic memory 

core. 

1966: Hewlett-Packard releases their HP2116A real-time computer with 8K of memory. 

The newly formed Intel starts sell a semiconductor chip with 2,000 bits of memory. 

1968: USPTO grants patent 3,387,286 to IBM’s Robert Dennard for a one-transistor DRAM 

cell. DRAM stands for Dynamic RAM (Random Access Memory) or Dynamic 

Contd... 

Figure 3.5: Cache Memory 
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3.3 Summary 
 

• CPU contains necessary circuitry for data processing. 

• Computer mother board is designed in a manner that its, memory capacity can be 

enhanced easily by adding more memory chips. 

• Micro programs, they are the special programs for building electronic circuit to 

perform operations. 

• Manufacturer programmed; ROM is one in which data is burn in the menu facture of 

electronic unit/equipment in which it is used. 
 

3.4 Keywords 
 

Single line memory modules: The additional RAM clip which plug into special sockets on the 

mother board. 

PROM: Programed Rom is one in which data is burnt in by the manufacturer of the 

electronic equipment in which it is used. 

Ultra violet EP-ROM (UVEPOAN): It is one in which the stored information is erased by 

using high voltage electric pulses. 

Cache memory: It is used to temporarily store very active data and instructions during 

processing. 

 

 

1. Define output device. 

2. Define all Secondary storage devices. 

 

 

3.5 Self-Assessment Questions 

1. The additional RAM chips which plug into special sockets on the mother board are 

known as 

(a) SIMMs (b) SIMs 

(c) PROM (d) All of these 

2. These are two types of read-only memory (ROM) manufacture-programmed and user 

program. 

(a) True (b) False 

3. Which programme are mainly used to store programme and data that do not changed 

are frequently used. 

(a) RAMs (b) ROMs 

Random Access Memory. DRAM will become the standard memory chip for 

personal computurs replacing magnetic core memory. 
 

Questions: 

1. Give the name of Analytical Engine beginner. 

2. Tell the time line of 8 KB memory computer. 
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Notes 4. PROM is one in which data is burnt in by the manufacturer of the electronic equipment 

in which it is used. 

(a) True (b) False 

5. Megabytes (MB) is equal to 1,048,576 (220). 

(a) True (b) False 
 

3.6 Review Questions 
 

 

 

 

 

 

 

 

 

 
 

(a) 

1. Explain unit of memory. 

2. Define memory and its types. 

3. What is ROM? Explain with suitable figure. 

4. What is EPROM? Explain with suitable examples. 
 

5. Difference between RAM and ROM. 
 

Answers for Self-Assessment Questions 

1. (a) 2. (a) 3. (b) 4. 

5. (a) 
 

3.7   Further Readings 

Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister. 

A Study of Computer Fundamental, Shu-Jung Yi. 

http://books.google.co.in/bkshp?hl=en 

http://books.google.co.in/bkshp?hl=en
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Notes 

 
 

 
‚Save‛, your entire work is stored in RAM. However, once you power off your machine, that 

work is completely erased, and the only copy remaining is on the secondary storage device 

where you saved it, such as internal or external hard disk drive, optical drives for CDs or 

DVDs, or USB flash drive. 

Primary storage of a computer system has following limitations: 

1. Limited Capacity. It is often necessary to store many millions, sometimes billions, and 

even trillions, of bytes of data in a computer. Unfortunately, the storage capacity of 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Objectives 

After studying this unit, you will be able to: 

• Explaion of the secondary storage device 

• Understanding of input and output devices in computer 

• Know ledge and understanding of latest input devices in market 

• Knowledge of latest output devices in market 
 

4.1 Secondary Storage Devices 
 

Secondary storage devices, as indicated by the name, save data after it has been saved by the 

primary storage device, usually referred to as RAM (Random Access Memory). From the 

moment you start typing a letter in Microsoft Word, for example, and until you click on 
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Notes primary storage of today’s computers is not sufficient to store the large volume of data 

handled by most data processing centers. 

2. Volatile. Primary storage is volatile and the data stored in it is lost when power is 

turned off or interrupted. However, computer systems need to store data on permanent 

basis for several days, several months, or even several years. 

As a result, additional memory, called auxiliary memory or secondary storage, is used with 

most computer system. Secondary storage is non-volatile and has lower cost per bit stored 

but it generally has an operating speed far slower than that of primary storage. It is used 

primarily to store large volume of data on permanent basis that can be partially transferred 

to primary storage, whenever required for processing. 

Over the years, several devices and media have been used as secondary storage in computer 

systems. Many of them such as punched paper tape and punched cards have become obsolete 

now. They are magnetic tape, magnetic disk, optical disk, and memory storage devices. In 

this chapter, you will learn about the terminologies, principles of operation, uses, and trade- 

offs of different types of secondary storage devices. 

4.1.1 Sequential and Direct-Access Devices 

Several different devices can be used as a secondary storage device but the one selected for 

a particular application depends mainly upon how the stored information needs to be 

accessed. There are two methods of accessing information—sequential or serial access, and 

direct or random access. A sequential-access storage device is one in which the arrival at 

desired location may be preceded by sequencing through other location so that access time 

varies according to location. That is, information on a sequential-access device can be 

retrieved in the same sequence only in which it is stored. Sequential processing is suitable 

for such applications like preparation of monthly pay slips, monthly electricity bills, etc. 

where most, if not all, of the data records need to be processed one after another. In these 

applications, data records for every employee or customer needs to be processed at scheduled 

intervals (in this case monthly). However, while working with a sequential-access device for 

if an address is required out of order, it can be reached only by searching through all the 

addresses stored before. For instance, data stored at the last few locations cannot be accessed 

until all preceding locations in the sequence have been traversed. This is analogous to a 

music tape cassette. If 10 songs are recorded on a music tape and you want to listen to (or 

access) the eighth song, you Must first listen to (or access) the seven songs coming before 

your favorite song. Your player may ‚fast forward‛ the tape quickly past the first seven 

songs but the first seven songs are still accessed, although, not fully played. fn the same way, 

to access the 28" data record stored on a sequential-access device a computer must first access 

(although not process) the first 27 data records. Magnetic tape is an example of a sequential- 

access storage device. In many applications, we need to access information in a more direct 

manner than sequential-access device allow. For example, in a computerized bank, at any 

instance, it may be required to determine the exact balance in the savings account of a 

customer. Similarly, in a computerized airline ticket booking system immediate access may 

be required to reservation system records to find out if seats are currently available on a 

particular flight in such applications, if we use a sequential-access device for data storage, 

the time taken to access the desired information may be long enough to cause frustration 

to the customer. Secondary storage devices exist that permit access to individual information 

in a more direct or immediate manner. These direct-access devices are also called random- 

access devices because out of all the information stored, any randomly chosen piece of 

information can be accessed immediately. Hence, a random-access storage device is one in 

which any location in the device may be selected at random, access to the information stored 

is direct, and approximately equal access time is required for each location. This is analogous 

to a music CD. If 10 songs are recorded on a music CD and you want listen (or access) the 

sixth song, you need not listen to or fast-forward the five songs coming before your favorite 

song. All you have to do is select track number six on the player and the player directly 
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moves the pickup arm access the CD to the groove where the sixth song begins and starts 

playing. Magnetic disks, optical disks, and memory storage devices are examples of direct- 

access storage devices. 

4.1.1.1 Hard Disks 

Hard disks are the primary on-line secondary storage device for most computer systems 

today. They are made of rigid metal (frequently aluminum) platters and come in many sizes 

ranging from 1 to 14-inch diameter. 

Notes 
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Figure 4.1: Hard Disks 

Types of Hard Disks 

Depending on how they are packaged, hard disks are normally categorized into three types: 

1. Zip/Bernoulli Disk. It consists of a single hard disk platter encased in a plastic cartridge. 

The disk commonly of 3H-inch size having storage capacity of about 100 MB.  The 

storage capacity slightly varies depending on the formatting style used by a computer 

system with which it is used. Its disk drive, called zip drive, may be of portable or fixed 

type. The fixed type is part of a computer system permanently connected to it. The 

portable type can be brought and connected to a computer for the duration of use and 

can then be disconnected and  taken away. A zip disk can  be easily  loaded/unloaded 

into a zip drive just as we insert/remove a floppy disk in a floppy disk drive or a video 

cassette in a VCR. 

 Plastic container   

Hard disk platters   

Lid of the plastic 
container 

Figure 4.2: A Disk Pack 
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Notes 2. Disk Pack. It consists of multiple (two or more) hard disk platters mounted on a single 

central shaft. All the disks revolve together at the same speed. Its disk drive has a 

separate read/write head for each usable disk surface (recall that when multiple disks 

are used together in a disk device, the upper surface of the topmost disk and the lower 

surface of the bottommost disk are sometimes not used). Its disk drive is of 

interchangeable type and allows loading/unloading of different disk packs as and 

when they are to be used. When not in use, a disk pack is stored off-line in a plastic 

case (see Figure 4.2). This gives virtually unlimited storage capacity to disk packs. 

3. Winchester Disk. A Winchester disk consists of multiple (two or more) hard disk platters 

mounted on a single central shaft. However, unlike a disk pack drive, a Winchester disk 

drive is of fixed type That is, its hard disk platters and disk drive are sealed together 

in a contamination-free container and cannot be separated from each other. Hence, 

Winchester disks have limited capacity. However, for the same number of disk platters 

of the same size. Winchester disks can have larger storage capacity than disk packs due 

to following reasons: 

(a) As both disk platters and disk drive are permanently sealed together, all surfaces 

of all disk platters (including the upper surface of the topmost platter and the 

lower surface of the bottommost platter) are used for data recording in a 

Winchester disk. That is. For a Winchester disk with four platters there are eight 

usable surfaces as opposed to six surfaces in case of a disk pack with four 

platters. 

(b) The contamination-free environment allows Winchester disks to employ greater 

precision of data recording and accessing, resulting in greater data storage density 

than interchangeable disk packs. 

Winchester disks were so named after the 30-30 Winchester rifle because the early Winchester 

disk systems had two 30-MB disks. Storage capacity of today’s Winchester disks ranges from 

a few tens of megabytes to a few gigabytes (l09 bytes). 

4.1.1.2 Flash Drive (Pen Drive) 

Flash drive is a compact device of the size of a pen, comes in various shapes and stylish 

designs (such as pen shape, wallet shape, etc.), and may have different added features (such 

as with a camera, with a built-in N1P3lWMA/FM Radio play back for music on the go, etc.). 

It enables easy transport of data from one computer to another. It is a plug-and-play device 

that simply plugs into a USB (Universal Serial Bus) port of a computer. The computer detects 

it automatically as removable drive. Now one can read, write, copy, delete, and move data 

from the computer’s hard disk drive to the flash drive or from the flash drive to the hard 

disk drive. One can even run applications, view videos, or play MP3 files from it directly. 

Once done, it can be simply plugged out of the USB port of the computer and kept into the 

pocket for being carried anywhere. A flash drive does not require any battery cable, or 

software, and is compatible with most PCs, desktop, and laptop computers with USB 2.0 port. 

All these features make it ideal external data storage for mobile people to carry or transfer 

data from one computer to another. As the name implies, it is based on flush memory storage 

technology Recall that flash is non-volatile, Electrically Erasable Programmable Read Only 

Memory (EEPROM) chip. It is a highly Aid-state storage having data retention capability of 

more than 10 years. 

Available storage capacities are 8MB, 16MB, 64MB, 128MB, 256MB, 512MB, 1GB, 2GB, 4GB, 

and 8GB. A : of 16MB capacity has 5600 times more storage capacity than a IAMB floppy 

disk. 
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Figure 4.3 shows a flash drive. It has a main body and usually a port connector cover. The 

cover is removed or port connector is pushed out when the drive is to be plugged into the 

USB port of’ a computer. The main body usually has a write protect tab, a read/write LED 

(Light Emitting Diode) indicator, and a strap hole. Some manufacturers also provide software 

to be used with the drive. 

4.1.2 Optical Disk Drive 

An optical disk is mounted on an optical disk drive for reading/writing of information on 

it. An optical disk drive contains all the mechanical, electrical, and electronic components 

for holding an optical disk and for reading/writing of information on it. That is, it contains 

the tray on which the disk is kept, read/write laser beams assembly and motor to rotate 

the disk. Figure 4.4. shows an optical disk drive. 

Access Time 

Figure 4.4: Optical Disk Drive 

 
Notes 

 

 

 

 

 

 

 
 

Optical disk drives are slower (have larger access time) than magnetic disk drives due to 

following reasons: 

1. The sectors of an optical disk are arranged on a continuous spiral track. This data 

organization results in slower random access of a sector than the concentric tracks 

organization (used by magnetic disks) because in case of concentric tracks, sectors are 

always found on a given track at a fixed distance from the center. 

 Figure 4.3: A Flash Drive (pen drive)  
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Notes 2. In case of optical disks, each sector has the same length regardless of its position from 

the center. This data organization requires a more complicated drive mechanism 

because disk’s rotation speed must vary inversely with the radius. That is, the drive 

must slow down disk’s rotation speed to read/write sectors towards the outside of the 

disk and speed it up to read/write sectors towards the center of the disk. This access 

mechanism leads to slower data access (larger access time) as compared to magnetic 

disks in which case the disks rotate at a constant speed irrespective of the location of 

the data to be accessed. 

3. Since optical disk is a removable media, it is prone to scratches, dust, sticky prints 

(including fingerprints), etc. while handling. This causes the read mechanism to employ 

error correction mechanisms, like re-read, varying angular velocity, data reconstruction 

using parity, etc. 

4. The entire read/write and disk assembly is not a sealed unit. Hence, the disk drive 

cannot spin the disk at fast speed as it may damage the disk and other parts. 

Access times for optical disks are in the range of 100 to 300 milliseconds. Compare this 

with the access times of floppy disks, which are in the range of 100 to 200 milliseconds, 

and that of hard disks, which are in the range of 10 to 30 milliseconds. 

4.1.2.1 Types of Optical Disks 

All optical disks are round platters. They come in different sizes and capacities. Commonly 

used types of optical disk are CD-ROM, WORM (CD-R), CD-RW, and DVD disks. They are 

described below. 

CD-ROM 

CD-ROM stands for Compact Disk-Read-Only-Memory. It is a spin-off of audio CD technology 

and works much like audio CDs used in music systems. In fact, if your computer has sound 

card and speakers, you can play audio CDs with your computer. 

CD-ROM disk is a shiny, silver color metal disk usually of 5/4-inch (12 cm) diameter. It is 

made of polycarbonate plastic and thin layer of pure aluminum is applied to make the 

surface reflective. For some very good quality disks, gold layer is used. A thin layer of 

lacquer protects it. It has storage capacity of about 650 Megabytes or 700 Megabytes in newer 

ones. It is so called because of its large storage capacity on a compact-size disk and because 

it is a read-only storage medium. ‚That is, these disks come pre-recorded and information 

stored on them cannot be altered. 

Since an optical disk is read from the center to outer edge, several sizes are possible. Apart 

from the most common 120mm 74/8 minute disk having storage capacity of 650 MB to 700 

MB, 80mm 21 minute disk (called Mini-CD) having 184 MB storage is also available. They 

can be used with the disk drive of a 120 mm   disk.   Mini   CDs   are   designed    in 

various fancy shapes like round, oval, triangle, etc., while ensuring that the storage area is 

affected. 

WORM Disk/CD-Recordable (CD-R) Disks 

WORM stands for write-once, read-many. WORM disks allow users to create their own CD- 

ROM disks by using a CD-recordable (CD-R) drive attached to a computer as a regular 

peripheral device. WORM disks look like standard CD-ROM disks, are purchased blank, and 

later encoded using a CD-R drive. The information recorded on a WORM disk by a CD-R 

drive can be read by any ordinary CD-ROM drive. As the name implies, data can be written 

only once on a WORM disk but can be read many times. That is, like a CD-ROM disk, once 
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data has been etched on the surface of a WORM disk it becomes permanent and can be read 

but never altered. However, all the data to be recorded on a WORM disk can be written on 

its surface in multiple recording sessions. The session after the first one are always additive 

and cannot alter the etched/burned information of earlier sessions. The information added 

in a session can be hidden in a subsequent session by creating the File Allocation Table (FAT 

at a new location but the etchings on the surface cannot be removed. Such disk is called Multi- 

Session Disk. Laser beam technology (discussed earlier) is used for data recording/ reading. 

CD Read/Write (CD-RW) Disk 

A CD Read/Write (CD-RW) disk is very similar to a WORM disk with the exception that 

you can erase the previous content and write on it multiple times. Such disks use metallic 

alloy layer. Laser beam changes the chemical property during writing (or burn process) 

changing reflectivity at desired places. The land-pit difference on CD-RW is not significant 

and hence CD drives have to be compatible to read such disks. A CD-RW disk usually has 

a lifetime of 100 or more erase-write cycle. A disk written once can be erased by changing 

by the chemical property again and then it can be written on to afresh. CD-RW drives have 

such erase capability. CD-RW disks are little expensive than CD-R disks but are a great cost 

saver because they can be reused many times due to their erase capability. 

Digital Video (or Versatile) Disk (DVD) 

DVD was designed primarily to store and distribute movies. However, it is fast becoming 

mainstream optical disk as prices are reducing and need for large capacity storage is increasing. 

It is similar to CD-ROM in principle but is denser in recording data. It follows Eight-to- 

Fourteen Modulation Plus %1Plus) encoding as compared to Eight-to-Fourteen Modulation 

(EFM) encoding used by CD-ROM. There are variants of DVD—single-layer disk and double- 

layer disk. Single-layer disk has storage capacity of 4.7GB, whereas, double-layer disk has 

storage capacity of 8.5 GB. 

• Like CD-ROM, DVD also has many types—DVD-R/RW, DVD+R/RW, DVD-Video, 

and DVD-Audio. DVD-Video is now the most dominant movie storage format used. 

It allows storage of video in 4:3 or 16:9 aspect ratios in MPEG-2 video format using 

NTSC or PAL resolution. It may be of interest to note that NTSC has resolution of 

720 x 576 and PAL has resolution of 720 x 576. The audio is usually Dolby Digital (AC- 

3) or Digital Theater system (DTS) and can be either monaural or 5.1 Surround Sound. 

DVD has enough space to store movie and support multi-lingual subtitles, multi-lingual 

audio, multiple camera, angles etc. It also supports region marking to protect against piracy 

and use of DVD from one region to another. It also supports Content Protection for 

Prerecorded Media (CPPM) security technique to safe guard against n; etc. 

4.1.2.2 Advantages and Limitations of Optical Disks 

Advantages 

1. Cost-per-bit of storage for optical disks is very low because of their low cost and high 

storage density. Additional cost benefit comes from the fact that some optical disks can 

be erased and reused many times. 

2. Use of a single spiral track makes optical disks an ideal storage medium for reading 

large blocks of sequential data such as audio or video. 

Notes 
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Notes 3. Optical disk drives do not have any mechanical read/write heads to rub against or 

crash into the disk surface. This makes optical disks more reliable storage medium 

than magnetic tapes or magnetic disks. 

4. Optical disks have data storage life in excess of 30 years. This makes them better 

storage medium for data archiving as compared to magnetic tapes or magnetic disks. 

5. Since data once stored on CD-ROM/WROM disks becomes permanent, the danger of 

stored data getting inadvertently erased/overwritten is not there. 

6. Due to their compact size and lightweight, optical disks are easy to handle, store, and 

port from one place to another. 

7. Audio CDs can be played on a computer having a CD-ROM drive along with a sound 

card and speakers. This allows computer systems to be also used as music systems, 

whenever desired. 

8. A computer having a DVD drive can be used to play DVDs allowing it to be used for 

watching videos such as movies. 

Limitations 

1. CD-ROM and WORM disks are read-only (permanent) storage medium. Data once 

recorded, cannot be erased. Hence, they cannot be reused. 

2. Data access speed for optical disks is slower than magnetic disks. 

3. Optical disks require more complicated drive mechanism than magnetic disks due to 

the need to have laser generating source and detection lens that require precision 

engineering and careful handling. 

4. Since optical disk is a removable media, it is prone to scratches, dust, sticky prints 

(including fingerprints), etc. while handling. Hence, they need careful handling. 

5. When used for off-line storage, they should be labeled properly for easy identification. 

4.1.2.3 Uses of Optical Disks 

Optical disks are used for following purposes: 

1. For distributing large amounts of data at low cost. For example, a complete encyclopedia, 

dictionary, world atlas, dictionary of quotations, biographies of great people, information 

about all educational institutions of a particular type in a country, etc. are often 

distributed on CD-ROM disks. 

2. For distribution of electronic version of conference proceedings, journals, magazines, 

books, product catalogs, etc. 

3. For distribution of audio such as songs. 

4. For distribution of new or upgraded versions of software products by software vendors. 

5. For storage and distribution of wide variety of multimedia applications such as video 

games. 

6. For archiving of data not used frequently but which may be used occasionally. 

7. WORM disks are often used by end-user companies to make permanent storage of their 

own proprietary information. For example, many banks use them for making a 

permanent record of their daily transactions. 

8. DVDs have become a popular medium for distribution of movies. 
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4.2 Input/Output  Device 
 

 

To be useful, a computer system needs to communicate with its external environment (its 

users). The input-output devices (abbreviated UO devices) provide this capability to a computer 

system (See Figure 4.5). They are know as peripheral devices because they surround a computerís 

CPU and memory. Input devices are used. enter data from outside world into primary 

storage, and output devices supply the results of processing from primary storage to users. 

A wide  variety  of I/O  devices  is now available.  For a  particular application,  one  type may 

be more suitable than another type. Some devices are used for both input and output 

function. 

Notes 

 

Figure 4.5: Illustrating the Role of I/O Devices in a Computer System 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
It is important to note that the speed of I/O devices is very slow as compared to the speed 

of primary storage and CPU. This is because their speed in most cases depends on the 

movement of mechanical parts, and the pote7_jriLl for improvement in speed  of such  parts 

is limited. It is, therefore, difficult to produce I/O devices that can match processor and 

memory speeds, and there is a constant demand for faster and faster I/O devices. 

4.2.1 Input Devices 

An input device is an electromechanical device that accepts data from outside world and 

translates them into a computer can   interpret. Several input devices are available today. They 

can be broadly classified into following categories: 

• Keyboard devices 

• Point-and-draw devices 

• Data scanning devices 
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Figure 4.6: The Layout of Keys on a QWERTY Keyboard 

 
 

Notes • Digitizer 

• Electronic cards based devices 

• Speech recognition devices 

• Vision based devices 

Various types of input devices along with their applications are described below. 

4.2.1.1 Keyboard Devices 

Keyboard devices are the most commonly used input devices today. They allow data entry 

into a computer system by pressing a set of keys (labeled buttons) neatly mounted on a 

keyboard connected to a computer system. The popular keyboard used today is the 101-keys 

QWERTY keyboard. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.2.1.2 Point and Draw Device 

Interaction with computers was initially restricted mainly to text mode. However, it was 

soon realized that interacting with computers in text-mode is cumbersome and time- 

consuming. Hence, a new type of user interface called graphical user interface (GUI), was 

devised for interacting with computers. A GUI provides a screen with icons (small images 

on the screen) or menus and allows a user to make rapid selections from them to give 

instructions to a computer. For efficient utilization, OUI requires an input device that can 

be used rapidly point to and select a graphic icon or menu item from the multiple options 

displayed on the screen. The keyboard though usable, was found to be inconvenient and 

unsuitable for this requirement. Hence, research efforts to find a suitable input device to 

meet this requirement gave birth to several input devices like mouse, track ball, joystick, 

light pen, and touch screen. Later it was realized that many of these devices, like mouse 

and light pen, could also be used very effectively to create graphic elements on the screen 

such as lines, curves, and freehand shapes. With this new ability, these devices came to be 

known as point-and-draw devices. These input devices have made computers a much more 

easily usable tool establishing them as a versatile tool for a wide range of users including 

children, illiterate citizens, and graphic designers. Some commonly used point-and-draw 

devices are described below. 
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The graphical cursor is displayed as a variety of symbols such as an arrow, a wrist a 

pointing finger etc. Depending on the application, the text and graphics cursor may be 

displayed on the screen at the same time. The graphics cursor, irrespective of its size and 

shape, has a pixel-size point that is considered the point of reference to decide where the 

cursor is positioned on the screen. This point is called hot-spot of the graphics cursor when 

the hot-spot is positioned at a menu item or an icon, the graphics cursor is said to point 

Figure 4.7: Point and Draw Device 
Notes 

4.2.1.3 Mouse 

Mouse is the most popular point-and-draw device. It is a must-have input device on modern 

personal computers and workstations because they support GUI as their primary user 

interface. A mouse is a small hand-held  device that fits in a userís palm comfortably. It rolls 

on a small bearing and has one or more buttons on  the top.  When a mouse that is connected 

to  a user terminal is rolled on a flat surface,  a graphics cursor moves on  the terminal screen 

in the direction of the mouseís movement. Since all movements of the mouse are reproduced 

by the graphics cursor on the screen, you can move the graphics cursor at a menu item or 

an icon by moving the mouse. 

Figure 4.8: Mouse 
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Notes to that menu item or icon. With a click of the mouse’s button, the system can then be 

notified of this choice. Note that notifying the system of a particular choice, out of the 

various options provided by the software, is much easier a mouse than pressing various 

key combinations. With proper software, a mouse can also be used to draw picture on the 

screen and edit text. 

The roller-ball based mouse is now being replaced with optical sensor based mouse. The 

optical sensor mouse has a light source with a sensor arranged in such a fashion that the 

light coming from the source is detected by the sensor after reflection from the surface. 

The on-board electronics on the mouse uses the reflection differences to calculate the 

direction and speed of movement and notifies the computer system. The optical sensor 

mouse is more sensitive, easier, and smoother to use. Another innovation in mouse is to 

have user-programmable buttons on the sides and the middle button on top is replaced 

with a wheel that can be rotated as scroll to scroll the screen display and can also be 

pressed as a button. 

4.2.1.4 Data Scanning Devices 

Data scanning devices are input devices used for direct data entry into a computer system 

from source documents. Some of them are also capable of recognizing marks or characters. 

These devices have following characteristics: 

1. They eliminate the need for manual entry of data by human beings. Automatic entry 

of data with their use improves data accuracy and increases timeliness of the information 

processed. 

2. They demand high quality of input documents because of direct data entry from source 

documents. Documents that are typed poorly, have strikeovers, or have erasures are 

normally rejected. 

3. Form design, and ink specification usually becomes more critical with the use of these 

devices than when keyboard devices are used to key in data from forms. Data scanning 

devices are of many types. Commonly used ones are described below. 

Image Scanner 

An image scanner is an input device that translates paper documents into an electronic 

format that can be stored in computer. The input documents may be typed text, pictures, 

graphics, or even handwritten material. This input device has been found to be very useful 

in preserving paper documents in electronic form. A copy of a document stored in a 

computer in this manner will never deteriorate in quality or become yellow with age, and 

can be displayed or printed, whenever desired. The stored images can even be altered and 

manipulated in interesting ways, if the computer has image-processing-software. 

Image scanners come in various shapes and sizes. Two commonly used types are: 

I. Flatbed scanner. A flatbed scanner is like a copier machine consisting of a box having 

a glass plate on its top and a lid that covers the glass plate. A document to be scanned 

is placed upside down on the glass plate. A light source, situated below the glass 

plate, moves horizontally from one end to another when activated. After scanning 

one line, the light beam moves up a little and scans the next line. The process is 

repeated for all the lines. It takes about 20 seconds to scan a document of size 21 cm 

x 28 cm. 



 

 

Figure 4.10: A Hand-held Scanner 
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2. Hand-held scanner. A hand-held scanner has a set of light emitting diodes encased in 

a small case that can be held in hand conveniently (See Figure 4.10). To scan a document, 

the scanner is dragged slowly over it from its one end to the other end with its light 

on. The scanner has to be dragged very steadily and carefully, otherwise the conversion 

of the document into its equivalent bit map will not be correct. Due to this reason, hand- 

held scanners are used only in cases where high accuracy is not needed. They are also 

used when the volume of documents to be scanned is low. They are much cheaper than 

flatbed scanners. 
 

 

 

 

 

 

 

 

 

 

 
Optical Character Recognition (OCR) Device 

When image scanners are used for inputting text documents (typed or handwritten), they 

have following two limitations: 

1. Since a scanned input document is stored as an image, instead of text, it is not possible 

to do any word processing of the document (the computer cannot interpret the stored 

document as letters, numbers and special characters). 

2. Storage space required for storing the document as an image is much more than that 

required for storing the same document as a text. For example, a page of printed text 

having 2000 characters can be stored as 2000 bytes by using the ASCII representation. 

A bitmap-image representation of the same document will require 10 to 15 times more 

storage depending on the resolution (granularity) of grid points. 

OCR technology is used to overcome these limitations. In this case, the scanner is equipped 

with character recognition software (called OCR software) that converts the bitmap images 

of characters to equivalent ASCII codes. That is, the scanner first creates the bitmap image 

of the document and then the OCR software translate the array of grid points into ASCII 

text that the computer can interpret as letters, numbers, and special characters. 
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Figure 4.9: A Flatbed Scanner 



 

 

Figure 4.11: OCR-A Fonts 

Magnetic-Ink Character Recognition (MICR) 

MICR is similar to OCR. It is used by  banking  industry for  faster processing  of large volume 

of cheques handled every day by this industry. A bank cheque has bankís identification code 

(name, branch, etc.), account number, and cheque number pre-printed (encoded) on it by 

using characters from a special character set. A special ink containing particles of iron oxide 

(that can be magnetized) is used for pre-printing the characters on the cheque. Figure 4.12 

shows a sample cheque that employs MICR technology. 

Figure 4.12: Magnetic-Ink Character Recognition (MICR) 

Computer Fundamentals 

 
 

Notes OCR software is  extremely complex  because  it is  difficult  to  make  a computer  recognize 

an unlimited number of typefaces and fonts. Hence, these software are designed to recognize 

texts written using standard type fonts (called OCR fonts). Two such standard fonts  are OCR- 

A (American standard) and OCR-B (European standard). Figure 4.11  shows,  OCR-A fonts. 

Note that if the document contains italics or bold face letters, or fonts other  than that for 

which the OCR software has been designed, the OCR software will not work effectively. 
 

 

When a customer presents a filled-in cheque at a bank, a bank employee manually  enters 

(keys in) the customer supplied information including  the amount written on  the cheque. 

This cheque is then processed by using an (MICR reader-sorter that can recognize magnetic 

ink characters. The MICR reader-sorter reads the pre-printed data on the cheques, and sorts 

the cheques for distribution to other banks or for further processing. 
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The most commonly  used  character  set by MICR  devices is known  as E13B  font consisting 

of numerals 0 to 9 and four special characters (See Figure 4.12). Coded data in the form of 

these fonts are transferred from cheques to a computer by an MICR reader-sorter. As the 

cheques enter the reading unit, they pass  through a magnetic  field causing  the particles  in 

the ink to be magnetized. Read heads then interpret these characters by examining their 

shapes. The sorter is used to sort the cheques into different pockets according to their 

identification code numbers. 

Digitizer 

A digitizer is an input device used for converting (digitizing) pictures, maps, and rawings 

into digital form forstorage in   computers.   For   example, the x and y   coordinates   of points 

in a drawing may be stored in   digital form. This enables   re-creation of the drawing from 

the stored information and easy incorporation of changes in the drawing, whenever required. 

A digitizer consists of a digitizing tablet (also known as graphics tablet) associated with a 

stylus (See Figure 4.13). The digitizing tablet is a flat surface that contains hundreds of fine 

copper wires forming a grid. Each copper wire receives electric pulses. The digitizing tablet 

can be spread over a working  table and is connected  to a computer.  The  stylus  a like a pen 

or a lens-like cursor with a cross hair and button. It is connected to the tablet and can be 

pressed down at a point on the tablet to input the (x, y) coordinates of the point. On moving 

the stylus on the tablet, a cursor on computerís screen moves simultaneously to a corresponding 

position on the screen to provide visual feedback to the operator. This enables the operator 

to draw sketches directly or to input sketched drawings very easily. Inputting drawings or 

developing sketches by using a digitizer is further simplified by the fact that poorly sketched 

lines, arcs, and other graphical objects are automatically input as mathematically precise 

objects like straight lines and smooth curves. 

Digitizers are used commonly in  the area of Computer Aided Design (CAD) by architects 

and engineers to design cars, buildings, medical devices, robots, mechanical parts, etc. They 

are also used in the area of Geographical Information System (GIS) for digitizing of maps 

available in paper form. 

Notes 

 

 
 
 
 
 
 
 
 
 
 
 
 

 

4.2.2 Output Devices 

An output device is an electromechanical device that accepts data from a computer and 

translates them into a form suitable for use by outside world (users). Several output devices 

are available today. They can be broadly classified into following categories: 

1. Monitors 4.   Screen image projector 
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Figure 4.13: Digitizer 



 

 

Figure 4.14: A Video Display Terminal Consists of a Monitor and a Keyboard 
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Notes 2.     Printers 5.   Voice response system 

3.    plotters 

These types of output devices along with their applications are described in next page. 

Output devices generate computer output that can be broadly classified into following two 

types: 

l. Soft-copy output. A soft-copy output is not produced on a paper or some material that 

can be touched and carried for being shown to others. They are temporary in nature. 

For example, content displayed on a terminal screen, or words spoken out by a voice 

response system are S011-copy output. 

2. Hard-copy output. A hard-copy output is produced on a paper or some material that 

can be touched and carried for being shown to others. They are permanent in nature 

and can be kept in paper files or can be looked later when the person is not using a 

computer. For example. output produced on paper by printers or plotters are hard- 

copy output. 

4.2.2.1 Monitors 

Monitors are the most popular output devices used today for producing soft-copy output. 

They display the generated output on a television like screen. A monitor is associated 

usually with a keyboard and together they form a video display terminal (VDT). A VDT (often 

referred to as just terminal) is the most popular input/output (I/O) device used with today’s 

computers. It serves as both an input and output device. The keyboard is used for input to 

a computer and the monitor is used to display the output from the computer. The name 

‚terminal‛ comes from the fact that a terminal is at the terminus or end of a communication 

path. 

Two basic types of monitors used today are cathode-ray-tube (CRT) and LCD (Liquid Crystal 

Display) .flat-panel. CRT monitors work much like a television screen and are used with non- 

portable computer systems. On the other hand, LCD flat-panel monitors are thinner, lighter. 

and are used commonly with portable computer systems like notebook computers. With 

gradual reduction in price of LCD flat panel monitors, they are used increasingly with non- 

portable desktop computer systems also. They are also preferred because they occupy less 

table space. 
 



 

 

4.2.2.2 LCD Monitor 

LCD stands for Liquid Crystal Display, referring to the technology behind these popular flat 

panel monitors. An LCD monitor is distinguishable from a traditional CRT monitor as the 

latter has a bulky footprint with a depth of several inches and a   weight   13-23 

kilograms or more, while LCDs are commonly 1-3 inches (2.5-7.5 cm) thick and weigh less 

than 4.5 k. 

LCD displays were used on laptop computers before the technology improved enough to 

make the jump to desktop monitors. An LCD monitor consists of five layers: a backlight, a 

sheet of polarized glass, a ‚mask‛ of colored pixels, a layer of liquid crystal solution responsive 

to a wired grid of x, y coordinates, and a second polarized sheet of glass. By manipulating 

the orientations of crystals through precise electrical charges of varying degrees and voltages, 

the crystals act like tiny shutters, opening or closing in response to the stimulus, thereby 

allowing degrees of light that have passed through specific colored pixels to illuminate the 

screen, creating a picture. 

Notes 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
4.2.2.3 Printers 

Printers are the most popular output devices used today for producing hard-copy output. 

Different types of printers are described below. 

 

Dot-Matrix Printers 

Dot-matrix printers arc character printers that print one character at a time. They form 

characters and all kinds of images as patterns of dots. Figure 4.16 shows how various types 

of characters can be formed as patterns of dots. A Dot matrix printer has a print head that 

moves horizontally (left to right and right to left) across the paper. Print contains an array 

of pins that can be activated independent of each other to extend and strike against an inked 

-n to form patterns of dots on the paper. To print a character, the printer activates the 

appropriate set of pins as the print head moves horizontally. For faster printing, many dot- 

matrix printers print both ways—while the printer head moves from left to right and while 

it moves from right to left, on return. Such method is called bidirectional printing. Figure 

4.16 shows a dot-matrix printer. 

Figure 4.15: LCD Monitor 
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Inkjet printers are character printers that form characters and all kinds of images by spraying 

small drops of ink on paper. The print head of an inkjet printer contains up to 64 tiny nozzles 

that can be heated up selectively in a few microseconds by an integrated circuit resistor. When 

the resistor heats up, the ink near it vaporizes and is ejected Through the nozzle making a 

dot on the paper placed in front of the print head. To print a character, the printer selectively 

heats the appropriate set of nozzles as the print head moves horizontally. Figure 4.18 shows 

an inkjet printer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Since dot matrix printers produce printed output as patterns of dots, they can print any 

shape of character that a gram can describe. They, therefore, can print many special 

characters, different sizes of print, and also have the ability to print graphics such as charts 

and graphs. 

Dot-matrix printers are impact printers because they print by hammering the pins on the 

inked ribbon to leave ink impressions on a paper. Hence, they can be used to produce 

multiple copies by using carbon paper or its equivalent. Due to impact printing, dot-matrix 

printers are noisy as compared to non-impact printers. 

Dot-matrix printers are normally slow with printing speeds ranging from 30 to 600 characters 

per second. However, they are cheap in terms of both initial cost and cost of operation. 

Hence, they are preferred by individuals and organizations for generating printed outputs 

if the speed and quality of printing are not important factors. They are also used for 

applications requiring multi-copy output such as shipping forms and invoice that on impact 

printing for generating multiple copies. 
 

Inkjet Printers 

Figure 4.17: Formation of Characters as Patterns of Dots 

Figure 4.16: A Dot-matrix Printer 
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Inkjet printers produce higher quality output than dot-matrix printers do because they form 

characters by very tiny ink dots. A high-resolution inkjet printer has as many as 64 nozzles 

within a height of 7mm’providing print resolution of around 360 dots per inch. 

Since inkjet printers produce printed output as patterns of tiny dots, they can print any shape 

of characters that a program can describe. This allows the printer to print many special 

characters, different sizes of print, and the ability to print graphics such as charts and graphs. 

Inkjet printers are non-impact printers because they print by spraying ink on the paper. 

Hence, they are quieter in operation. Being of non-impact type, they cannot be used to 

produce multiple copies of a document in a single printing. A color inkjet printer usually 

comes with two ink cartridges—black and tri-color. The tri-color cartridge contains red, blue, 

and yellow colors in a package that can mix appropriate amount of these colors with black 

from the other cartridge to get any desired color with saturation. This makes it possible to 

get multi-colored and photo quality output from inkjet printers. 

Inkjet printers are slower than dot-matrix printers are with printing speeds ranging from 

40 to 300 characters per second. Typically, an inkjet printer is more expensive than a dot- 

matrix printer. They are preferred if speed of printing is not an important factor. 
 

Drum Printers 

Drum printers are line printers that print an entire line at a time. Recall that dot matrix and 

inkjet printers print one character at a time. Figure 4.19 shows the print mechanism of a 

drum printer. It consists of a solid cylindrical drum with characters embossed (raised 

characters) on its surface in the form of circular bands. Each band consists of all the printing 

characters supported by the printer in its character set. Total number of bands is equal to 

the maximum number of characters (print positions) that can be printed on a line. Hence, 

a drum printer with 132 characters per line and supporting a character set of 96 characters 

will have altogether 12,672 (132 x 96) characters embossed on its surface. 

In addition to the drum, the printer has a set of hammers (one opposite each band) mounted 

in front of the drum in a manner that an inked ribbon and paper can be placed between the 

hammers and the drum. The total number of hammers is equal to the total number of bands 

on the drum, which is also equal to the total print positions per line. 

Figure 4.18: An Inkjet Printer 
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The drum rotates at a high speed. A character is printed at a desired print position by 

activating the appropriate hammer when the character embossed on the band at the print 

position passes below it. Hence, the drum would have to complete one full revolution to 

print each line of output. This means that not all characters on a line are printed at exactly 

the same time, but the time required to print an entire line is so fast that it appears as if 

one line is printed at a time. 

The drum of a drum printer is expensive and cannot be changed often. Hence, drum printers 

can print a pre-defined set of characters only in a pre-defined style embossed on the drum. 

Drum printers, therefore, do not have ability to print any shape of characters, different sizes 

of print, and graphics such as charts and graphs. 

Drum printers are impact printers because they print by hammering on a paper and inked 

ribbon against the -3cters embossed on the drum. Hence, they can be used to produce 

multiple copies by using carbon paper or its equivalent. Due to impact printing, drum 

printers are noisy in operation and often use a cover to reduce the noise level. Printing 

speeds of drum printers are in the range of 300 to 2000 lines per minute. 
 

Chain/Band Printers 

Chain/band printers are line printers that print one line at a time. Figure 4.20 shows the 

print mechanism of a chain/band printer. It consists of a metallic chain/band on which 

all characters of the character set supported by the printer are embossed. A standard 

character set may have 48, 64, or 96 characters. In order to enhance printing, peed, the 

characters in the character set are embossed several times on the chain/band. For example, 

the chain/band of a 64 character set printer may have four sets of 64 characters each 

embossed on it. In this case, the chain/band will have altogether 256 (64 x 4) characters 

embossed on it. The printer has a set of hammers mounted in front of the chain/band in 

a manner that an inked ribbon and paper placed between the hammers and chain/band. 

The total number of hammers is equal to the total number of print positions. Therefore, 

a printer supporting 132 print positions will have 132 hammers. The chain/band rotates 

at a high speed. A character is printed at a desired print position by activating the 

appropriate hammer when the character embossed on the chain/band passes below it. 

Since the character set is repeated several times on the chain/band, it is not necessary to 

wait for the chain/band to make a complete revolution to position the desired character 

in the correct print position. 

Unlike the drum of a drum printer, the chain/band of a chain/band printer can be changed 

easily. This allows use of different fonts (styles of characters) and different scripts (languages) 

to be used with the same printer. Like drum printers, chain/band printers can print only pre- 

defined sets of charaLters embossed on the chain/band used with the printer. Chain/ 

Figure 4.19: Drum Printer 



 

 

band printers, therefore, do not have the ability to print any shape of characters, different 

sizes of print, and graphics such as charts and graphs. 

Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Chain/band printers are impact printers because they print by hammering on a paper and 

inked ribbon against the characters embossed on the chain/band. Hence, they can be used 

to produce multiple copies by using carbon paper or its equivalent. Due to impact printing, 

chain/band printers are noisy in operation and often use a cover to reduce the noise level. 

Printing speeds of chain/band printers are in the range of 400 to 3000 lines per minute. 
 

Laser Printers 

Laser printers are page printers that print one page at a time. Main components of a laser 

printer are a laser beam source, a multi-sided mirror, a photoconductive drum, and toner 

(tiny particles of oppositely charged ink). To print a page of outpat, the laser beam is 

focused on the electro statically charged drum by the spinning multi-sided mirror. The 

mirror focuses the laser beam on the surface of the drum in a manner to create the patterns 

of characters/images to be printed on the page. Since the drum is photoconductive, a 

difference in electric charge is created on those parts of the drum surface that are exposed 

to the laser beam. As a result, the toner, composed of oppositely charged ink particles, 

sticks to the drum in the places where the laser beam has charged the drum’s surface. The 

toner is then fused permanently on. The paper with heat and pressure to generate the 

printed output. The drum is then rotated and cleaned with a rubber blade to remove the 

toner sticking to its surface to prepare the drum for next page printing. Figure 4.21 shows 

a laser printer. 

Figure 4.20: Printing Mechanism of a Chain/Band Printer 

Figure 4.21: A Laser Printer 
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Notes Laser printers produce very high quality output because they form characters by very tiny 

ink particles. The most -common laser printers have resolution of 600 dpi (dots per inch), 

whereas some high-end laser printers have resolution. of 1200 dpi. Due to their high 

resolution, these printers give excellent graphics art quality. 

Since laser printers produce printed output as patterns generated by the laser beam, they can 

print any shape of characters that a program can describe. They, therefore, can print many 

special characters, different sizes of print, : also have the ability to print graphics such as 

charts and graphs. 

Laser printers are non-impact printers. Hence, they are very quiet in operation. Being ofnon- 

impact type, they can not be used to produce multiple copies of a document in a single 

printing. 

Although most laser printers can print in black color only because they have a single toner- 

drum arrangement, now even color laser printers are available at affordable price. A color 

laser printer like color inkjet printer four color toners, each with a drum of its own. The 

usage of drums and toners are same as earlier, but drum is charged in such a way that 

together they produce the desired color output. 

Laser printers are faster in printing speed than other printers discussed earlier. Low speed 

laser printers can print 4 = pages per minute. High-speed laser printers are also available. 

Owing to their better print quality and printing speed, laser printers are more expensive 

than other types of printers. 

4.2.2.4 Plotters 

We learnt earlier that dot matrix, inkjet, and laser printers are capable of producing 

graphics output. However, engineering design applications like architectural plan of a 

building, design of mechanical components of an air craft or a car etc., often require high- 

quality, perfectly-proportioned graphic output on large sheets. The various: types of 

printers discussed above are not suitable for meeting this output requirement of such 

applications. A special type of output device, called plotters, is used for this purpose. 

Plotters are an ideal output device for architects, engineers, city planners, and others who 

need to routinely generate high-precision, hard-copy, graphic output of widely varying 

sizes. ‘Two commonly used types of plotters are drum plotter and flatbed plotter. They 

are described below: 

Drum Plotter 

In a drum plotter, the paper on which the design is to be made is placed over a drum that 

can rotate in both clockwise and anti-clockwise directions to produce vertical motion. The 

mechanism also consists of one or more penholder mounted perpendicular to the drum’s 

surface. The pen(s) clamped in the holder(s) can move left to or right to left to produce 

horizontal motion. A graph-plotting program controls the movements of the drum and 

pen(s) that is, under computer control, the drum and pen(s) move simultaneously to draw 

designs and graphs; sheet placed on the drum. The plotter can also annotate the designs 

and graphs so drawn by using the pen to draw characters of various sizes. Since each pen 

is program selectable, pens having ink of different colors can be mounted in different 

holders to produce multi-colored designs. Figure 4.22 shows a drum plotter. 
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7. Graphic Digitizer 

8. Optical Scanners 

9. Optical Character Recognition (OCR) 

10. Optical Mark Recognition (OMR) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.3 Latest Input Devices in Market 
 

1. Keyboard 

2. Pointing Devices 

(a) Mouse 

(i) Mechanical mouse 

(ii) Optical mouse 

(b) Track Ball 

(c) Joystick 

(d) Touch Screen 

(e) Light Pen 

(f) Touch Pad 

4. Digital Camera 

5. Scanner 

6. Microphone 

Figure 4.22: A Drum Plotter 

Figure 4.23: A Flatbed Plotter 
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Notes 11. Magnetic-Ink Character Recognition (MICR) 

12 Bar Code Reader (BCR) 

 
In current market there are many local devices are available so never 

take local devices. 

 

 

4.4 Latest Output Devices in Market 
 

1. Monitor 

2. Compact Disk 

3. Printers 

4. Speaker 

5. Disk Drives 

7. Floppy Disk 

8. Headphone 

9. Projector 

 

 

 

 
 

Journey of the Evolution of Secondary Storage 

 
o you remember the last time you used the FDD drive of your computer, and 

for what? Chance is if you have used it then it would be for some emergency 

booting of the computer, or for recovery of your broken OS. In summary, you 

would have not used it as a data transfer or storage medium. 

Currently this magnetic medium is fast getting replaced by the Flash Rom drives that 

we also know by Pen Drive or USB Drive. This new medium is killing the old magnetic 

medium for its reliability, speed and ever growing capacity. 

Historically the secondary storage is always in the realm of change. Technology and 

needs are always pushing the medium smaller, faster, more reliable, secure and of 

expanding capacity. Just like some 10 years back the 5.25" dives were replaced by this 

3.5" drives for smaller size and larger capacity. 
 

History 

History of secondary storage is quiet interesting, as it has seen the use of papers to silicon 

to optical medium. With each generation it gets better, faster and smaller is size and 

always increasing the storage capacity. 
 

Paper Punch Card 

Paper Punch cards used initially as the first external storage device. It used paper card/ 

roll with holes as data. Meaning a hole was zero, and no hole was one. Programmers 

Contd... 



 

 

used to punch the card for even providing input. Printers were there to punch the output 

for storage. 
 

Floppy Drive (8") 

Once the magnetic media started to be used for storage, paper was quickly made 

obsolete. Magnetic disks of round shape emerged as the standard for secondary storage 

device. It became very popular as it was more robust and handy than the paper roll, and 

could store more data as was relatively sturdy. 
 

Floppy Drive (5.25") 

Further advancement in the material and magnetic domain provided better density and 

provided much higher storage capacity in smaller area. Now the disks also started to 

become double sided providing even more data storage area in the same size disks. 
 

Floppy Drive (3.5") 

This media peaked with the 3.5" FDD that is small and sturdy enough to carry in the jeans 

pocket. This case also provided cover even for the area that is used for reading. This 

resulted in more protection from dust etc even if the floppy is not in any cover. 
 

Zip Drive 

This drive released in 1994 by a company called Iomega was capable of holding 100MB 

of data. This also uses the magnetic coating like the other FDD, but of higher quality and 

of superior technology that needs specialized drives for reading and writing on this 

media. This made is a good backup drive (like tape drives), but not good for using it 

on any machine. Currently the Zip Disk can hold 250MB of data. 
 

Flash Drive (USB Drive) 

Also known as Pen Drive is the next revolution in secondary portable storage device. 

Starting with couple of MB storage capacity the main attraction was its solid state rugged 

construction and capable of being used on any computer equipped with USB port. 

Initially it needed specific driver to be installed on the earlier OS in order to it getting 

recognized, but later, due to its universally standard and open protocol and rise in use 

of USB port in computers, its support was provided along with the OS. (Windows/ 

Macintosh/Linux also support this natively out of the box). 

So now virtually nothing more is needed for this drive to work if you have a computer 

with USB port. Though the manufacturers are also providing additional features to the 

hardware drive like security to the data stored on it using encryption, but these features 

generally require additional software/driver to be installed in order to be used. And 

since there is not much standard for these features it is mostly device specific and is 

largely ignored for its lack of compatibility. 

This standardization of protocol has lead to not only popularity of the USB flash drives, 

but has also provided a common way for other media to act as drive via this protocol. 

So now there are storage products making use of this standard to become USB drives 

(also called USB Mass Storage). Example includes USB Hard Disk Drives, Zip Drive with 

USB interface, digital camera having a USB cable to make it an USB drive for accessing 

all the photographs clicked, even PDAs like Palm that already connect to the computer 

using USB port acts as a USB drive for accessing the data in its memory and SD/MMC 

Card present or the Mp3 player that doubles as USB drive!! The list and applications are 

Contd... 
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getting bigger and bigger, ultimately making this drive a very popular   and 

successful. 

Currently 1 GB USB flash drives are available, and bigger drives are on the horizon. 

(Interestingly HDD popular as of now is of 160GB and more). 

Card Media (SD/MMC/MS) 

It it that stamp sized media that became popular from portable devices like Cameras 

and Phones. Media started shrinking and its capacity always increasing. One can locate 

a 8 GB Micro SD Card at a reasonable price these days. It uses the same technology 

as the USB Drive internally, only the interface is differing in order for it to be used 

by various devices like Camera and Mobile Phones. Now days Card Reader for these 

type of media are getting shipped as a standard accessory from leading Computer 

manufacturers. 

Portable USB HDD 

As mentioned above this is also getting popular and is popular mainly for higher speed 

and capacity than what is currently provided by the USB flash drive. On the flip side it 

is still fragile (as having moving element) and bulkier than the flash drive. 
 

Solid State Disk (SSD) having USB Interface 

This is a semiconductor (like flash memory) based persistent data storage device that is 

having no moving parts inside, hence Solid State Disk. It emulates a Hard Disk Drive 

Interface with added bonus being more robust, faster, quieter, less space and power 

requirement, as compared to any hard disk drive. 

These devices have started to find way into high end Laptops and Computers (like Sony 

Vaio TZ Series). Though costly right now, it may become a standard secondary storage 

medium in the coming years. 
 

Holographic Drives 

Last but not the least is the future. This is the media of the future that uses technology 

that is still in its infancy and is called holography. Though holography and holograms 

are nothing new and was discovered in late 1940s, but its application for data storage 

is new. A company called In Phase Technologies is one of the forerunners in this field 

that has prototyped disks that can hold 200GB to 1.6TB of data. This technology uses lasers 

for reading and writing of data. 

 

Questions: 

1. Explain the working of Paper Punch Card. 

2. How to Portable USB HDD in computer? 

 

 

4.5 Summary 
 

• Secondary storage is a hard disk that save more data in computer. 

• Hard disk is secondary storage services. 

• Input device means that provide the input from user side in the computer. 



 

 

• Output devices is used display the result of computer. 

• Digitizer consists of a digitizing tablet (also know as graphics tablet) associated with 

a stylus. 

• A potters is special type of output device that use in computer. 

• Lager printer are non impact printer, they are very quiet in operation. Being of non- 

impact type, they can not be used to produce multiple copies of a document in a single 

printing. 
 

4.6 Keywords 

Notes 

 

Terminal: A monitor is associated usually with a keyboard and together they form a Video 

Display Terminal (VDT). A VDT (often referred to as just terminal) is the most popular 

input/output (I/O) device used with today’s computers. 

Hot-Spot of graphics: The graphics cursor, irrespective of its size and shape, has a pixel-size 

point that is considered the point of reference to decide where the cursor is positioned on 

the screen. This point is called hot-spot of the graphics cursor. 

Flush memory: Storage technology Recall that flash is non-volatile, Electrically Erasable 

Programmable Read Only Memory (EEPROM) chip. 

Plotter: A special type of output device, called plotters, is used for this purpose. Plotters are 

an ideal output device for architects, engineers, city planners, and others who need to 

routinely generate high-precision, hard-copy, graphic output of widely varying sizes. 

LCD: LCD stands for Liquid Crystal Display, referring to the technology behind these 

popular flat panel monitors. 

Digitizer: A digitizer is an input device used for converting (digitizing) pictures, maps, and 

rawings into digital form forstorage in computers. For example, the x and y coordinates of 

points in a drawing may be stored in digital form. 

 

 

1. Define output device. 

2. Define all secondary storage devices. 

 

 
 

4.7 Self-Assessment Questions 
 

1. RAM chips pluged into special sockets on the motherboard are known as <<< 

(a) SIMMs (b) SINNs 

(c) SIMNs (d) None of these 

2. The act of retrieving data from a storage location is called <<< 

(a) Memory write operation (b) Memory read  operation 

3. <<<<<. storage system consists of a rotating disk coated with a thin metal. 

(a) Memory disc (b) Optical disk 

(c) Hard disk (d) None of these 
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Notes 4. LED indicator stands for <<<<<< 

(a) Light-emitting diode (b) Level-emitting diode 

(c) Low-emitting diode (d) None of these 

5. A <<<<<.. is a pointing device similar to a roller-ball mouse. 

(a) Electronic pen (b) Trackball 

(c) All of above (d) None of these 

6. A color inkjet printer comes with two ink cartridges-black and <<.. 

(a) Tricolor (b) Blue,  green, white (c) None of these 

7. A4 size is equal to 8" × 12" page. 

(a) True (b) False 

8. CRT stands for <<<<.. 

(a) Crystal ray tube (b) Cathode ray tube 

9. The UPC bar code patterns are decoded as ............... digit. 

(a) 5 (b) 10 

(c) 12 (d) 2 
 

4.8 Review Questions 
 

1. What is a secondary storage? How does it differ from a primary storage? 

2. What are the main limitations of primary storage of a computer system? 

3. Why I/O devices are necessary for a computer system? 

4. What are peripheral devices? Why are they called so? 

5. Why I/O devices are very slow as compared to the speed of primary storage and CPU? 

6. What is an input device? Name some commonly used input devices. 

7. What are keyboard devices? 

8. What are point-and-draw devices? Name some commonly used point-and-draw devices. 

9. Explain how information is recorded on a magnetic tape. 

10. Why is the secondary storage used in most computer \stems? 

11. Name some popular secondary storage devices used in today’s computer systems. 

12. What is a sequential-access storage device? Write examples of a few applications for 

which such a storage device is suitable. 
 

13. What is a random-access storage device‘? Write examples of a few applications for 

which such a storage device is suitable. 

14. Distinguish between a sequential access, a direct access, and a random access storage 

device. Write one example of each. 

15. What factors determine storage capacity of disks? 



 

 

A Study of Computer Fundamental, Shu-Jung Yi. 
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Answers for Self-Assessment Questions Notes 

1. (a) 2. (b) 3. (b) 4. (a) 

5. (b) 

9. (b) 

6. (a) 7. (b) 8. (b) 

 

4.9 Further Readings 

 
Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister. 
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Objectives 

After studying this unit, you will be able to: 

• Understand the windows various features 

• An overview of different properties of windows 
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• Discussed about the desktop and its display 

• Explain the execution pattern of My Computer 

• Discussed the using of My Computer, also adjuster of system sittings with computer 
 

Introduction 
 

Windows is a GUI (Graphical User Interface). This replaces all the old keyword command 

and functions with a user-friendly screen. There are different version of windows which 
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includes Windows 95, windows 98, windows ME, windows XP, windows Vista and 

windows 7. Include with the windows operating system are some useful accessories 

which include wordpad, note pad paint. Although these apllication(Programs) are very 

basic in their facilities, theycan be used to accomplish sevral tasks users would like to 

performa computer. 
 

5.1 Windows Features 

Notes 

 

The hottest new features of Windows 98 are as follows: 

• Improved Setup: Within two years of introducing Windows 95, Microsoft completely 

upgraded its software. Windows 98 is a completely redesigned and speedier version. 

Windows 98 also supports direct upgrades from Windows 3.1x. Windows 98 set up uses 

the information in Windows 95 to detect the utilities and hardware already installed 

on the computer. This helps speed the initial setup process as setup then does not have 

to do full hardware detection. 

• Improved Desktop: The Windows 98 desktop includes many new enhancements, 

including floating toolbars that are accessible right from the taskbar. We can drag icons 

on to and off the Start menu. Going through Windows Explorer to manipulate Start 

menu options is no longer necessary. The Start menu now includes a ‘‘Favorites‛ 

category containing shortcuts to all our favorite resources and web sites. The Help 

facility has been improved and uses the new HTML format. 

• Integration With the Web: Windows 98 supports Microsoft Internet Explorer 4.0 which 

includes Outlook Express, Microsoft NetMeeting, NetShow, and FrontPage Express. 

Outlook Express is a new e-mail/newsgroup client that supports POP3, HTML Mail, 

and NNTP (newsgroup support). NetMeeting is an Internet conferencing tool that 

enables Internet users to perform audio, video, and text based conferences over the 

Internet with other users. NetShow is Microsoft’s networked multimedia software for on-

demand audio and video capabilities. FrontPage Express is a personal web page editing 

tool. 

• Multiple Display Support: One of Windows 98’s new features is called ‚Multiple 
Display Support‛ the capability to extend our Windows 98 desktop over two or more 
monitors. 

• Web-Based Support Tools: The Internet has allowed Microsoft to enable easier support 

in Windows 98. A new web-based utility helps reduce the cost of ownership and makes 

upgrading much easier by providing a simple update engine that helps update 

Windows 98 components and drivers easily. 

• Windows Tune-Up Wizard: Windows Tune-Up Wizard, another utility in Windows 98, 

is designed to make computing easier. It enables us to schedule and run regular tune- 

ups of the operating system easily which will help programs run faster, free space on 

hard drive, and help we achieve optimal system performance. 

• Disk Cleanup: A utility related to the Windows Tune-Up Wizard is the new Disk 
Cleanup tool. This new tool removes unnecessary files from a disk. 

• Task Scheduler: Task Scheduler provides a friendly and easy-to-use interface for 

scheduling applications. It enables us to schedule a script, a program or a document 

to be run at any time or interval—from everyday to once a year—or on events such 

as system startup, user log on, or system idle. 
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Notes • Accessibility Improvements: Windows 98 introduces a new Accessibility Settings Wizard. 

This wizard helps physically challenged people to adapt their computer’s visual settings 

to fit their needs. One feature included in the accessibility improvements is a screen 

magnifier that helps visually impaired people. 

• Windows 98 Performance: Microsoft has improved performance in many areas in 

Windows 98, including system boot time, application load time, system shutdown time 

and general system-wide performance. 

• Multimedia Enhancements: Windows 98 includes DirectShow 2.0 and DirectX 5, 

both of which provide an improved gaming and multimedia infrastructure. Many 

new games and multimedia products will take advantage of DirectX 5 and 

DirectShow 2.0. 

• Broadcast Architecture and TV Viewer: Microsoft has in this version bundled software 

for broadcast-enabled computers. This software blends television with web pages and 

computer content. It also enables us to view and use broadcast enabled computers as 

‚receive-only‛ network devices. We can receive true data broadcasts of web pages, 

multimedia streams and data packets, such as stock quotes and news feeds. The TV 

Viewer enables us to watch standard TV delivered via satellite or cable. 

Windows 7: Five Unique Features 

Other parts of this story package are dedicated to explaining how to replicate windows 

7 features on a Vista or XP machine and we offer so many suggestions that you may be 

starting to think that perhaps there’s no compelling reason to upgrade to windows 7 after 

all. If so, you should think again. Though Vista and XP users can enjoy some of the 

new operating system’s goodies, either directly or by proxy, various highly desirable 

features are available only in the genuine article. Here are five that will require you to 

roll a 7. 

1. Device Stage: Whereas Vista barely seems to recognize the presence of cameras, 

phones, printers, and other external devices, windows 7’s Device Stage treates them 

like royalty. The operating system devotes a slick-looking status window to each 

device, so you can browse files, manage media, and perform other device-specific 

tasks. 

2. Home Group: At long last, Microsoft promises to take the pain and frustration out of 

home networking for users of its operating system. Set up a Home group, and then 

add PCs and other devices and without further ado you can shares files, printers, and 

the like. Why didi it take seven versions of Windows to get this right? 

3. Jump Lists: Like souped-up Recent Documents menus, jump Lists provide quick access 

to application specific documents and/or tasks. For example, you can right-click the 

Internet Explorer taskbar icon and choose from a list of frequently visited Web sites 

or from a list of avaiable tasks (such as New Tab and Inprivate). Once you get started 

using jump lists, you will wonder how you ever got along without them. 

4. Libraries: Most of us have documents, music, pictures, and video scattered across 

multiple folders on our PCs. Libraries are specials folders in Windows 7 that catalog 

these items under a single roof, regardless of where you actuall store them on your 

hard drive. And best of all, Libraries are easy to share within your HomeGroup. 

With Windows 7, the task of choosing a Wi-Fi network connection becomes an 

effortless, one-click affair. 

5. One click Wi-Fi: Unlike windows Vista, Windows 7 makes choosing a wireless network 

to connect to simple and conveneient: Click the system-tray icon, and choose from the 
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resulting list of available hotspots. Granted, you can find third-party connection managers 

for Vista, but nothing this streamlined and unobtrusive. 

5.1.1 The Find Feature 

The Find feature can be used to locate the following: 

• Files or Folders: it helps in finding files or folders after providing their names and 

location. The file can also be searched by a distinctive word or phrase it contains. Files 

can also be searched by their date of creation or their size. 

• Computers: Using this we can find a particular computer on the network by providing 

the name of the computer. 

• On the Internet: Any information on the Internet can be searched by providing the 

required information. 

• People: Internet can be searched using this option. 

5.1.2 Properties 

Sometimes, it is important to have information about files, folders, and programs. For 

example, we might require the size and location a particular file if a certain program is not 

running. This information can be easily found in the property sheet. To invoke the property 

sheet of any item, right click its icon and choose properties from the menu that appears. The 

property sheet of that item will appear containing the characteristics of that item like color, 

size, shape, etc. 

5.1.3 Quick View 

Quick View is an interesting feature that enables us to take a quick peek at the contents of 

a file without opening a big program. It appears on the shortcut menu when an icon for a 

document is right clicked. Quick view only appears if it has been installed and only if the 

document can be viewed in that manner. 

5.1.4 Right Clicking 

The left mouse button opens an object but it is the right mouse button that really adds power 

to Windows 98. Every thing on the desktop including the desktop can be right clicked. It 

displays a shortcut menu of commands appropriate for the item on which the mouse is right 

clicked. 

 

5.2 An Overview of Different Versions of Windows 

Notes 

 

The goal of evolution of a new version is always to make each new version a bit more powerful, 

easier to learn and use. Windows 98 is definitely easier to manage than Windows 95. Ostensibly 

it is almost identical to Windows 95 but it differs slightly in the way it operates. For example, 

it includes single click launching, submenu options and tool tip’s text opens in a different 

manner, etc. 

Also Windows 98 includes facilities for new forms of communications and entertainment. 

Thus, what makes Windows 98 desirable is: 

• It is easy to learn and use. 

• It works with virtually every kind of program and gizmo available today. 

• It is ready to bring all the exciting new electronic communications and entertainment 

technologies. 
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Windows NT Workstation 3.5 

Windows NT Workstation 3.51 

Windows 95 

Windows NT Workstation 4.0 

Windows 98 

Windows 98 Second Edition 

Windows Me 

Windows 2000 Professional 

Windows XP 

Windows Vista 

Windows 7 

3.5.807 

3.51.1057 

4.0.950 

4.0.1381 

4.1.1998 

4.1.2222 

4.90.3000 

5.0.2195 

5.1.2600 

6.0.6000 

6.1.7600 

5.3 The Desktop 
 
The desktop is a large blank page, through which most activities take place, that is, it enables 

us to choose the programs that are stored on it in the form of small pictures or icons. We 

double-click on these icons to launch the desired programs. The desktop is always in the 

background even after a program is started. 

My computer 

 documents   
Desktop  

Internal 
Explorer 

 Icons   

Recycle Bin 

 Start button   
 Taskbar    Clock   

Network 
eighborhood 

Figure 5.1: Desktop 

Computer Fundamentals 

 
 

Notes 5.2.1 List of Windows Client OS with Their Version Numbers 

Window Version Number 

Windows 1.0 1.04 

Windows 2.0 2.11 

Windows 3.0 3 

Windows NT 3.1 3.10.528 

Windows for Workgroups 3.11 3.11 



 

 

• Choose View  As  Web  Page. 

In Windows 95 the operating system automatically placed the ìMy Computerî icon and the 

ìRecycle Binî on the desktop. The icons that appeared for these items were standardóthey 

could not be changed. But in Windows 98, the icons can be changed. The steps are: 

 
Figure 5.3: ìMy Computerî icon and the ìRecycle Binî on the Desktop 

Figure 5.2: Active Desktop 

Unit 5: MS Window 

 

Windows 98 supports two different desktop interfaces: the ìStandard Desktopî and the ëëActive 

Desktopî. The standard desktop was introduced in Windows 95. While using the standard 

desktop, desktop icons are activated by double clicking on them. The active desktop was 

introduced in Internet Explorer 4.0. It enables the desktop and other windows applications to 

look and act as a web page while using the active desktop, pointing the mouse pointer at an 

icon displays an explanation about the icon. The icons can be activated by only a single click. 

Steps to enable Active desktop are: 

• Right click on a blank spot on the desktop. 

• Highlight the Active Desktop  command. 

Notes 
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5.3.1 Display 

The icon unravels settings that affect the screen display, including colors, 

dialog boxes, and resolutions. 

 
 

Notes • Right click on a blank spot on the desktop and choose the ‚Properties‛ Command 

• ‚Display Properties‛ dialog box will appear. Click on the ‚Effects‛ tab 

• In the Desktop Icons box, click on the icon you want to change 

• Then click on the ‚Change Icon‛ button. From the Change Icon dialog box, select the 

icon you want on your desktop 

• Choose OK twice to close the dialog boxes 

 
 

screen savers, 

 
 

 Figure 5.4: Desktop Properties  

   

 

 

 
5.4 My Computer 

 

My Computer allows the user to explore the contents of their computer drives as well as 

manage their computer files. Microsoft changed the traditional My Computer icon to 

Computer, the bottom image to the below is an example of what this icon looks like. 

Although the name has changed this icon still acts identical to the earlier My Computer. 
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1. Get to the Windows Desktop. 

2. Double-click the My Computer icon, this icon is almost always located on the top-left 

portion of the desktop and should look similar to the icon above. Below are two 

examples of what should appear when My Computer is open. 

Figure 5.6: Browsing My Computer in Windows 98 

Figure 5.5: Drive Listing in My Computer 

 
Notes 

 

 

 

 

 
5.4.1 How to Open My Computer 
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5.4.3 Adjust System Settings with Computer 

If we wish to manage our computer or view other settings and information about our 

computer instead of double-clicking the My Computer icon to open it, right-click on the My 

Computer icon and click Properties. Performing these steps will open our System Properties 

(the same window accessible through the Control Panel). 

Iwow  25  years  back.  Windows  1.0  was  Microsoft’s  first  GuI  operating  system.  Since 

t has been 25 years since our much loved Windows Operating system came into our 

life, the history starts with Microsoft release of Windows 1.0 way back in 1985, and 

 

then Microsoft Windows has developed and now when we are standing with dazzling 

Windows 7 operating system lets look back a little from the history about the tracks 

which Windows OS followed. 

1. Window 1.0: First GUI operating system form Microsoft released in the year 1985. 

A mix of Dos and simple graphical interface. 

If we’re looking for a document such as a word processor file we’ve 

created, music file, picture, or other personal file it’s likely that it’s 

contained in our documents folder. This folder is displayed in My 

computer as a folder and usually contains your name. For example, if 

our username is Pradip, this folder would be named Pradip’s Documents. 

 
Notes 5.4.2 Using My Computer 

Once My Computer is open we’ll see all available drives on our computer. For most users 

we’ll only be concerned with the Local Disc (C:) drive. This is our hard disk drive and 

what all our files are stored on. Double-click this drive icon to open it and view of its 

contents. 

Contd... 
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2. Windows 2.0: Released on December, 1987 as a successor to Windows 1.0, Microsoft 

office products become capable, Like Word and Excel with this operating system. 

 

 

 

 

 

 

 

 

 

 

 

 

3. Windows 3.0: More enhanced graphically. 

Such as different features and properties of MS Window, and then different versions 

of Window explained in brief. Then Desktop and My computer covered which is very 

basic need to explain its working. Task bar, Start button, Title bar all are explained 

in brief, then The Control Panel covered which acts as a sort of mission control for 

Windows 98. It contains icons which are used to control various setting of the 

computer. Windows Accessories comes under which we xeplained multimedia and 

magnifier. Then at the end of the chapter file and folder searching explained. 

Questions: 

1. What was the purpose of development of MS Word? 

2. What is Window 1.0, 2.0, 3.0? 

Notes 

 
5.5 Summary 

 

• In this unit, we discussed about MS window and there are different versions of 

windows which includes windows 95, window 98, windows ME. 

• Explains the features and properties of windows. 

• Goal of evolution of a new version is always to make each new version a bit more 

powerful, easier to learn and use. 

• Desktop on monitor screen is a large blank page a, through which most activities takes 

place. 

• My computer icon on screen allows user to explore the contents of their computer 

drives as well as manage their computer files. 
 

5.6 Keywords 
 

Multiple Display Support: Multiple Display support has the capability to extend our windows 

98 desktop over two or more monitors. 

Disk Cleanup: A utility related to the windows Tune-up wizard is the new disk clean up tool. 

Quick View: It is an interesting feature that enables us to take a quick peek at the contents 

of a file without opening a big program. 
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Notes Active Desktop: It enables the desktop and other windows applications to look and act as 

a web page while using the active desktop, pointing the mouse pointer at an icon display 

an explanation about the icon. 

Standard Desktop: It was introduce in windows 95. While using the standard desktop, 

desktop icons are activated by double clicking on them. 
 

5.7 Self-Assessment Questions 
 

1. provides a friendly and easy-to-use interface for scheduling applications. 

(a) Screen schedular (b) Task schedular 

(c) Disk schedular (d) None of these 

2. One of windows 98’s new features is called 

(a) Multiple Display Support (b) Plug and play 

(c) Mousekeys (d) All of these 

3. Write the correct version number of windows NT 3.1. 

(a) 3 (b) 2.11 

(c) 1.04 (d) None of these 

4. Net show is microsoft’s networked multimedia software for on-demand audio and 

video capabilities. 

(a) True (b) False 

5. Windows 98 includes facilities for new forms of communications and entertainment. 

Thus, what makes 

(a) It is easy to learn and use 

(b) It works with virtually every kind of program and gizmo available today. 

(c) It is ready to bring all the exciting new electronic communications and entertainment 

technologies. 

(d) All of these 
 

5.8 Review Questions 
 

1. What is MS Windows? 

2. Name any five major features of Microsoft Windows 98. 

3. What are the different views available in my computers? 

4. What is Desktop? 

5. How do you put my computer in Standby mode? 

Answers for Self-Assessment Questions 

1. (b) 2. (a) 3. (d) 4. (a) 

5. (d) 
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5.9 Further Readings Notes 

 
 

A Study of Computer Fundamental, Shu-Jung Yi. 

Fundamental Computer Concepts, William S. Davis. 

 

 

http://books.google.co.in/bkshp?hl=en 
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Objectives 
 

 

After studying this unit, you will be able to: 

• Understanding of windows explorer in computer 

• Discussion of task bar and start button 

• Understanding and using process of title bar and control panel 

• Discussion of windows accessories and its use 

• Explain of and use of searching files and folders 

Notes 
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Introduction 

Windows Explorer is essentially the graphical interface that makes Windows computers easy to 

use. For example, the desktop and taskbar containing icons are part of the graphic interface. In 

fact, When the desktop or taskbar go missing, restoring them is often a simple matter of 

restarting the explore. exe process. Where Internet Explorer allows you to browse the Web, 

Windows Explorer allows you to browse Windows without having to type in DOS-like commands. 

While Windows Explorer provides  the overall  user interface,  another smaller component of 

it is also called Windows Explorer. This smaller component is Windows Explorerís file 

manager. It allows you to explore your computerís hard drive and  file  system.  You  can 

launch Windows Explorer in several ways including: 

• Click Start > My computer (or Computer) 

• Right-click Start > Explorer (or Open Windows Explorer) 

 

6.1 Working with Windows Explorer 

Windows Explorer is a folder/file-management program used to: 

• View and change the folder/file structure of disks. 

• View and change the contents of folders and files. 

• Move, copy, rename, create, and delete folders and files. 

• Start programs and open documents. 

• Find folders and files. 

• View and change the properties of folders and files. 

Figure 6.1: Windows Explorer Screen 
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Notes 6.1.1 Starting Explorer 

To start Explorer click on the Start button to open the Start menu, point to Program to open 

the program submenu, and click on the Explorer program icon. 

A typical Windows Explorer screen is as shown in below: 

The tree pane (on the left) displays the folder tree—the branching structure of the Computer’s 

drives and folders. The contents pane (on the right) displays the folders and files that are 

contained in the drive or folder selected in the Tree pane. 

 

6.1.2 Managing Folders with Explorer 

6.1.2.1 Selecting Folders 

In the Tree pane, display the folder. To do this: 

• Expand the disk drive on which the folder is stored. 

• Expand the folder’s parent folders until the folder is displayed. 

• Click on the folder. 
 

6.1.2.2 Moving and Copying Folders 

TO move or copy a folder, right-drag it from the Tree pane to the desired destination in the 

Contents pane. Both the source folder and destination folder must be displayed on screen 

at the same time. 

• Move or copy a folder: 

• Display the source folder in the Tree pane. A hidden folder can not be right-dragged. 

• Select the destination in the Tree pane so that its contents are shown in the Contents 

folder. 

• Right-drag the source folder (from the Tree pane) to a blank area of destination 

(in the Content pane) when the   right   mouse   button   is   released,   a    shortcut 

menu appears, left-click on move here (to move the folder) or Copy Here (to copy the 

folder). 
 

6.2 The Taskbar 
 

The taskbar appears, by default, at the bottom of the screen. It contains a button for each 

open window on the desktop. The active window that appears in a lighter shade of gray. 

Many windows can be opened at a time on the desktop. Windows very often overlap or 

completely cover one another. The taskbar is used to bring any open window from hiding 

simply by clicking its taskbar button. 

Sizing and positioning the taskbar involves the following steps: 

• Taskbar can be placed along any edge of the screen. 

• To move the taskbar, point to an empty area of the taskbar then drag the taskbar to 

some other edge of the screen. 

• To size the taskbar, rest the mouse pointer right on the top of the taskbar so 
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Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
• That the mouse pointer turns into a two-headed arrow. 

• Then drag the edge of the taskbar towards the centre of the screen to enlarge it or 

towards the closest edge of the screen to narrow it. 

To hide the taskbar: 

• Right click an empty part of the taskbar and then choose Properties. 

• Click the Taskbar Options tab, a ‚Taskbar Properties‛ box appears. 

• Select or clear ‚Always on top‛. If this option is selected open windows never cover 

the taskbar, if the option is cleared, open windows may cover the taskbar. 

• Select or clear ‚Auto hide‛. If we select Auto hide, the taskbar shrinks to a thin line 

along the edge of the screen when it is not in use. It this option is cleared, the taskbar 

never shrinks to a thin line. 

• Choose OK. 

Windows 98 also offers four special toolbars which can be accessed via the taskbar. These 

are: 
 

Address It displays an Address box in which we can type Internet addresses or 

the names of disk drives, folders and files. After pressing the Enter key, 

the control will be passed to that place. 

Links It displays shortcut buttons to visit handy places on the Internet. Click 

a button to visit that place. 

Desktop It displays a button for each item on desktop. 

Quick Launch It provides easy access to favorite programs. 

   

 Figure 6.2: The Taskbar  
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The Start button appears in the lower left corner of the screen. On clicking this button, the 

Start menu appears. 

The Start menu contains the following choices: 

Windows Update It checks the Internet for updates to the operating system. 

Programs It lists programs which are installed on the computer. 

Favorites It lists web pages which are designated as favorites while surfing the 
Internet. 

Documents It lists documents which were recently opened. 

Settings It lists options which can be used to change the settings of the operating 
system. 

Figure 6.3: Start Button 

 
Notes To turn any of these toolbars on or off 

• Right click some neutral area of the taskbar and point to toolbars. 

• To display or hide a toolbar, click its name. (Checked toolbars are already on display). 

• To move a toolbar out of the taskbar and onto the desktop, point to the vertical bar 

at the left edge of the toolbar, and then drag this toolbar out. 
 

6.3 The Start Button 
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Find Helps to search for files or folders stored in the computer. 

Help It provides help on the operating system. 

Run It enables us to run programs for which the executable filenames are 

known. 

Log Off It enables users who share a computer to log off but leave the computer 

running so that someone else can log on. 

Notes 

 

 

Shut Down It enables us to shut down the computer correctly, restart or restart it 
in MS-DOS mode. 

6.4 The Title Bar 
 

All windows have a title bar. It is a long narrow box that stretches across the top of a 

window. The title bar shows the system menu icon, the title of the window or name of the 

program being run and the buttons to resize and close the window. When a window is active 

or currently being used, the title bar is highlighted, meaning that its color is different from 

the color of other open windows. The title bar offers handy features given below: 

• To expand a window to full screen size or to shrink it back to its original size, double 

click its title bar. 

• To move a window from a location to other new location on the screen drag the 

window by its title bar. 

For minimizing, maximizing or closing the window, the buttons on the right side of the title 

bar can be used. The system menu icon on the left of title bar represents the ‚Program 

Control‛ menu. It is an alternate way to maximize, minimize, restore, move, resize or close 

a window. 

Figure 6.4: The Title Bar 
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Notes 6.5 The Control Panel 

 
 Figure 6.5: The Control Panel  
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The Control Panel acts as a sort of mission control for Windows 98. It contains icons which 

are used to control various settings of the computer. Some of the settings behind the icon 

can be reached from other directions but some can be reached only by the Control Panel. 

To open the Control Panel, click Start >> Settings >> Control Panel. 

The icons in the Control Panel differ from computer to computer because these represent 

software’s and hardware and each computer has different hardware and software installed. 

Generally the following icons are displayed in the Control Panel. 

6.5.1 Game Controllers 

This icon can be used to add, remove or change settings for game controllers. 

 
 Figure 6.6: Game Controllers  
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6.5.3 Modems 

Modems icon is used to install and control the various settings related to modems. 

Figure 6.7: Keyboard 

 
6.5.2 Keyboard 

This icon can be used to change keyboards, adjust the keyboard’s speed or to install a 
keyboard designed for another language. Using this icon, Repeat Delay, Repeat Rate, Cursor 
Blink Rate can be controlled. 

Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 Figure 6.8: Modems Icon  
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• Showing the pointer trail and adjusting its length. 

Figure 6.10: Mouse Properties (b) 

Figure 6.9: Mouse Properties (a) 

 
Notes 6.5.4 Mouse 

Using this icon, the following settings can be controlled: 

• Whether the left or right mouse button is to be used. 

• Adjusting the amount of time that can pass between clicks when double clicking the 

primary mouse button. 

• Changing the appearance of mouse pointers according to the available schemes. 

• Adjusting the speed at which the mouse pointer moves on the screen. 
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Figure 6.11: Mouse Properties (c) 

 
Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

6.5.5 Telephony 

If a modem is installed in the computer that supports voice as well as data, this icon is used 

to setup the software that controls the voice option of the modem’s operation. 

6.5.6 Users Accounts 

The same computer can be shared by different people. This icon helps in setting up multiple 

users for the same computer. Each user is able to save his or her own desktop settings, 

including icons and wallpaper. 

6.5.7 The Accessibility Options and Tools 

After clicking the ‚Accessibility option‛ the following dialog box appears: 

Usually people with disabilities such as poor eyesight or hearing find it necessary to install 

specialized software to make it easier to use the computer. This option eliminates the need 

to install specialized software for such purposes e.g., using ‘Accessibility’ options. 

• Caption can be displayed for sounds made by both the operating systems and application 

software. 

• Numeric keypad strokes can be substituted for mouse movements and clicks. 

• A portion of the screen can be magnified for easier reading. 

Accessibility options can be added as a Windows component to make using computer easier. 

Click the Start button and choose Settings >> Control Panel >> Accessibility options. 

A dialog box appears having tabs for keyboard, mouse, display and sound settings. 

6.5.7.1 Mouse/Keyboard Accessibility 

For easy operation of the keyboard and mouse the following options can be put to use: 

• Sticky Keys: If we have difficulty typing combination keystrokes such as CtrI+Ese, 

Shift+F1, or Alt+Z, try using the StickyKeys feature. After enabling StickyKeys option, 
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• FilterKeys: If you are double-pressing keys by holding them down for too long or 

typing extra characters because finger brushes the nearby keys, use the FilterKeys 

option to change the sensitivity of the keyboard. 

• ToggleKeys: The Caps Lock, Num Lock, and Scroll Lock keys on the keyboard act as 

toggles, meaning we can press the key to turn the feature on and off. The ToggleKeys 

options provides an auditory cue that informs us to the status of the key. When one 

of those keys is turned on, high-pitch sound is played. Turning off one of those keys 

gives a low-pitched tone. 

• MouseKeys: MouseKeys enable us to use the keyboard to move the mouse, click 

things, and so forth. When MouseKeys is activated, we can control the mouse as 

follows (be sure to use only the keys on the numeric keypad). 

• Move the pointer: Press (or hold down) the numeric keys surrounding the number 5. 

The 7, 9, 1, and 3 keys move the pointer diagonally. The 8, 4, 6, and 2 keys move the 

pointer in the direction of the arrow shown in the key. 

• Click: Press the 5 key in the middle of the keypad. 

• Double-click: Press the plus (+) sign key or press the 5 key twice, fast. 

Figure 6.12: Mouse/Keyboard Accessibility 

 
Notes we can made the modifier keys (Ctrl, Alt, and Shift keys) stick after we press them, 

so we need not hold down that key while pressing the second key in a key+key 

combination keystroke. Instead, press and release the Ctrl, Shift, or Alt key and then 

press and release the second key. The modifier (first) key is automatically released 

after press the second (non-modifier) key. 
 

• Drag (left mouse button): Point to the object, press the insert figure (0) key to begin 
dragging, use the numeric keys surrounding the 5 to move the mouse pointer and then 

press Delete (.) to complete the operation. 

• Right-click: Position the mouse pointer and press the minus (-) sign key. Then press 

the 5 key to click or the (+) sign key to double-click. 

• Right-drag (right mouse button): Point to the object you want to drag, press the minus 

(-) sign key and then press the insert figure (0) key to lock down that button. Use the 

numeric keys surrounding the 5 to drag. Then press the Delete (.) key to complete the 

drag. 



Unit 6: Working with Windows Explorer 

95 
TEERTHANKER MAHAVEER UNIVERSITY 

 

 

 
• Return to standard clicking: Press the slash (n key). This is useful if the 5 key is right- 

clicking when you want it to click. (If a shortcut menu is open, press Alt or Esc before 

pressing the slash key.) 

• Click both mouse buttons: Press and release the asterisk (*) key. 

• Jump the mouse pointer in large increments across the screen: Hold down the Ctrl key 

as you move the mouse pointer with the numeric keys. 

• Slow the movement of the mouse pointer: (as and when you need to position it 

Notes 

 

 

precisely) Hold down the Shift key as you move the mouse pointer with the numeric 

keys surrounding the number 5. 

6.5.7.2 Sound Enhancements 

For the people with impaired hearing, there is a provision to try SoundSentry or Show 

Sounds. SoundSentry puts up visual cues along with the sounds, so it can be seen when the 

sound is being played. Show Sound allows programs that use speech or other audible cues 

to provide text on the screen. 

Serial keys Alternative Input Devices: Windows 98 also provides built-in support for 

alternative input devices including System and head pointers. 

Figure 6.14: Sound Accessibility Properties (b) 

Figure 6.13: Sound Accessibility Properties (a) 
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The font is defined as a group of letters, numbers and symbols with a common typeface. 

In Windows 98: 

• We can view and print a font sample by choosing Start >> Settings >> Control Panel 

and clicking the Fonts icon and then double clicking on the desired font displayed in 

the Fonts window. 

• We can find the fonts that resemble each other by choosing View » List Fonts by 

Similarity. Windows reorders the list to display fonts based on their similarity to the 

first font in the list. 

• New fonts can also be added. In the Fonts window, choose File » Install New Font. 

A dialog box will appear. Navigate to the drive containing the font(s). Click on OK. 

Windows installs the fonts. 

Figure 6.15: Font Manager 

 
Notes It is possible to plug any such Serial key device into an available serial port without 

disconnecting the mouse first. 

To give an alternate input device its own serial port, install the device according to the 

manufacturer’s instructions. Then in the General tab of Accessibility Properties dialog box, 

select the Support Serial Keys Devices option, and click the Settings button to specify the 

serial port and baud rate for the alternative input device. 

6.5.8 Font Management 
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6.5.9 Plug and Play 

It is a standard that makes adding hardware device to a PC fairly easy. Plug and Play is a 

way for Windows 98 to setup new hardware for the computer with little or no human 

intervention. After simply plugging in the latest hardware, Windows 98 interviews it, 

checking to see what special settings it needs, and then Windows 98 automatically flips the 

right switches. 

To install new devices, there is an Add New Hardware Wizard. To start this Wizard, Click 

on the Start button and choose Settings >> Control Panel >> Add New Hardware. The wizard 

starts and Windows 98 installs the new device by asking some questions. 

There may be some devices that are not plug and play—these are termed as legacy hardware. 

This includes hardware devices designed for DOS and Windows 3.x. 

Figure 6.16: Legacy Hardware 

 
Notes 

 

 

 
 

• To delete fonts, open the Fonts window by clicking on the Fonts icon in the Control 

Panel. Select the fonts to be deleted. Choose File >> Delete. Windows asks to confirm 

the deletion. 
 

 

6.5.10 Mobile Computing 

Many features in Windows 98 make mobile computing much easier. Some of the features 

are specifically designed for newer laptops with the special plug-and-play BIOS and power 

management capabilities. The features include: 

 

 
Which font is used for Hindi typing give the step for selection of fonts. 



Unit 6: Working with Windows Explorer 

98 
TEERTHANKER MAHAVEER UNIVERSITY 

 

 

Figure 6.17: Docking Station Device 

 
Notes 6.5.11 Hot Docking and Flexible Configurations 

A docking station is an optional device that connects a laptop to a desktop PC. The idea is 

to give the storage, display and extensibility options of a desktop PC without sacrificing 

portability. To become mobile, the user simply needs to disconnect his or her PC from the 

docking station. Many laptops that ship with Windows 98 support ‚hot docking‛ which 

enables us to dock and undock the laptop without even turning it off. In general, laptops 

can be undocked by clicking the Start button and choosing Eject PC option. Windows 98 

automatically detects the impending hardware changes, takes care of any potential problems 

with open files on an external drive, and loads or unloads appropriate drivers. To redock, 

simply put the laptop back into the docking station. Windows 98 once again loads the 

appropriate drivers automatically. Unlike hot docking, cold docking (and undocking) involves 

completely shutting down the laptop before doing anything. 

It is also possible to refine the hardware settings for a particular configuration by following 

these steps: 

1. Click the Start button. 

2. Choose Settings >> Control Panel >> System. 

3. Click the Device Manager tab and click the plus (+) sign next to any device type to 

see devices within this category. 

4. Open a specific device to see its properties. 

5. At the bottom of the dialog box that appears, check the appropriate option whether the 

hardware should be disabled or removed in the current configuration and choose OK. 
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6.5.12 Power Management 

Battery life is a major concern for mobile computer users. Windows 98 supports Advanced 

Power Management (APM). It is a standard for laptop computers which supports the following 

features of Windows 98. 

• Battery indicator on the taskbar. 

• Capability to put the laptop in suspended mode by clicking the Start button and 

choosing the appropriate option from the menu. 

Notes 

 

 

 

 

 

Give the steps for managing monitor power. 

• Capability to configure power management to shut down PC when shut down 

Windows 98. 

Figure 6.18: Power Management Properties (a) 
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Figure 6.19: Power Management Properties (b) 

Figure 6.20: Windows Accessories 

 
Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Advanced power management (APM) is an API developed by Intel and 

Microsoft and released in 1992 which enables an operating system running 

an IBM-compatible personal computer to work with the BIOS (part of the 

computer’s firmware) to achieve power management. 

 

6.6 Windows Accessories 

To start a Windows 98 applet, click the Start button and choose Programs » Accessories. Then 

click the applet of your choice. Any missing Windows 98 accessories can be reinstalled by 

using the Windows Setup tab in Add/Remove Programs. The applets are identical to their 

larger counterparts but possess limited capabilities and features. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Using this window, the following settings can be controlled: 
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6.6.1 Multimedia 

Listing of audio hardware available on computer. 

Listing of different window sizes available. 

• The instruments that play MIDI output can be shown. This facility is normally used by 
games. 

• Listing of CD-ROM drives available in the system. 

Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6.6.2 Using the Accessibility Wizard 
The easiest way to select and tune accessibility options is through the Windows 98 Accessibility 
Settings Wizard. To start the Wizard, click the Start button and choose Programs: 

• > Accessories > > Accessibility > > Accessibility Wizard. 

In the first wizard screen, choose the smallest size of text you can read. Then click the Next 

button. 

Figure 3.22: Administrator 

Figure 6.21: Multimedia Properties 
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6.7 Searching Files or Folders 
 

To search for a file or folder: 

1. Click Start, and then click Search. 

Figure 6.24: Search File or Folder (a) 

Figure 6.23: Magnifier 

 

 

Explaine working of Magnifier. 

 
Notes 6.6.3 Magnifier 

In Windows 98, there is a new feature called Magnifier. To activate it, click the Start button 
and choose Programs >> Accessories >> Accessibility >> Magnifier. When this feature is 
activated, it splits the screen into two halves. The lower half displays text and graphics in 
normal size. The upper half of the screen magnifies whatever is near the mouse pointer. 

To control the regular and the magnified portion size, we can drag - up and down ‚horizontal 
bar that separates the two parts of the screen. It is also possible to control, degree of 
magnification, mouse behaviour, and screen colours using the Magnifier atalog box. 
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3. Type part or all of the name of the file or folder, or type a word or phrase that is in 

the file. 

Figure 6.26: Search File or Folder (c) 

Figure 6.25: Search File or Folder (b) 

 
2. In the Search Companion dialog box, click All files and folders. Notes 
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6. Click Search. 

If you are searching any file give the related file name other wise file will 
be not find. 

‚Search Companion‛ is the name of the left hand pane that appears in 
the Search Window under Windows XP when we select Search, For Files 

or Folders. 

Figure 6.27: Search Companion (a) 

 
Notes 4. In the Look in box, click the drive or drives, folder, or network location that we want 

to search. 

5. Choose one of  the following options: 

(a) Click When was it modified to look for files that were created or modified on 

or between specific dates. 

(b) Click What size is it to look for files that are specific size. 

(c) Click More advanced options to specify additional search criteria. 
 

 

7. Searching is finished. 
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Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Advanced power management (APM): It is an API developed by Intel and Microsoft and 

released in 1992 which enables an operating system running an IBM-compatible personal 

computer to work with the BIOS (part of the computer’s firmware) to achieve power 

management. 

Filterkeys: It is a feature of Microsoft Windows. It is an accessibility function that tells the 

keyboard to ignore brief or repeated keystrokes, in order to make typing easier for people 

with hand tremors. The feature and the keyboard shortcut that activate it (hold !Shift for 8 

seconds) can be turned off via the Accessibility icon in the Windows Control Panel. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6.8 Summary 
 

• Windows Explorer is a folder/file-management program used to view and change the 

contents of folders and files and structure of disks. 

• The task base, is used to bring any open window from hiding simply by dusking its 

taskbar button. 

• The title bare offers the handling the feature of window like expanding window etc. 

• Control panel handle the all setting of computer system. 

• Windows accessories comes under which we explained multimedia and magnifier. 

• Search folder is used for searching the files and folder in computer system memory. 
 

6.9 Keywords 

Figure 6.28: Search Companion (b) 
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Notes  Magnifier: It is a display utility that makes the computer screen more readable by people 

who have low vision by creating a separate window that displays a magnified portion of 

the screen. Magnifier provides a minimum level of functionality for people who have slight 

visual impairments. 

Mobile computing: It is a form of human–computer interaction where a computer is expected 

to be transported during normal usage. Mobile computing has three aspects: mobile 

communication, mobile hardware and mobile software. 

Multimedia: It is media and content that uses a combination of different content forms. The 

term can be used as a noun (a medium with multiple content forms) or as an adjective 

describing a medium as having multiple content forms. The term is used in contrast to media 

which only use traditional forms of printed or hand-produced material. Multimedia includes 

a combination of text, audio, still images, animation, video, and interactivity content forms. 

Search companion: It is the name of the left hand pane that appears in the Search Window 

under Windows XP when we select Search, For Files or Folders. 

Sticky keys: It is an accessibility feature to help computer users who have physical disabilities, 

but it is also used by others as a means to reduce RSI (or a syndrome called the Emacs Pinky). 

It essentially serializes keystrokes instead of pressing multiple keys at a time: StickyKeys 

allows the user to press a modifier key, such as Shift, Ctrl, Alt, or the Windows key, and 

have it remain active until any other key is pressed. 

Title bar: The title bar is the bar that runs horizontally across an application window. The 

title bar will contain either the name of the file for example, a document we are viewing 

or the website we are viewing through Internet browser. Find out how to use, customize 

and install add-ins to title bars. 

 

 

1. Explain all Windows Accessories. 

2. Search Files or Folders. 

 

 

6.10 Self-Assessment Questions 
 

1. If you are double-pressing keys by holding them down for too long or typing extra 
characters because your finger brushes the nearby keys, use the StickyKeys. 

(a) True (b) False 

2. Start menu contains 

(a) Windows Update (b) Programme 

(c) Favorites (d) All of these 

3. Which handy features the title bar offers? 

(a) To move a window to a from a location to new location on the screen drag the 
window by its text bar 

(b) To expand a window to full screen size or to shrink it back to its original size, 
double click its title bar. 

4. Explorer application window is divided into four panes: 

(a) False (b) True 

5. What is the major concern for mobile computer users? 

(a) Memory (b) Programme 

(c) Battery life (d) All of these 
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6. To control the regular and the magnified portion size, you can drag horizontal bar that 

separates the two parts of the screen. 

(a) Up and down (b) Right 

(c) Left (d) Right and left 

7. What is Search Companion? 

(a) Name of the right hand pane (b) Name of the left hand pane 

8. What is multimedia? 

(a) Media and content (b) Media 

(c) Content (d) All of these 
 

6.11 Review Questions 

Notes 

 

1. Define role of taskbar. 

2. What is the Start button used for? 

3. Explain Windows Accessories. 

4. Name the special toolbars offered by windows 98. 

5. How does Windows XP organize files and folders on drives? 

6. How do you open Windows Explorer? 

7. How do you remove an item from the Start menu or from a Program menu? 

8. How will you use Accessibility wizard? 
 

Answers for Self-Assessment Questions  

1. (a) 

5. (c) 

2. (d) 

6. (a) 

3. (b) 

7. (b) 

4. (a) 

8. (a) 

 

6.12 Further Readings 
 
 

A Study of Computer Fundamental, Shu-Jung Yi. 

Fundamental Computer Concepts, William S. Davis. 

 

 
http://books.google.co.in/bkshp?hl=en 

http://books.google.co.in/bkshp?hl=en
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Objectives 
 

After studying this unit, you will be able to: 

• Understanding and explanation of microsoft word 

• Explanation of word environment in micro soft word 

• Process of using or creating a word document 

• Explanation of editing in a word document 

• Process of saving a document in word 

• Explanation of opening a document 

• Process of finding files 

• Understanding of word document views 
 

Introduction 
 

More than 85 percent of the personal computers in existence today are equipped with word 

processing programs. Word processing programs allow you to write, edit, format, save, and print 

a document with ease. Using word processing software, you can produce a high-quality document 

in much less time than if you used a typewriter. The reason is that word processing software 

separates document creation from document printing. With a word processing program, you can 

enter your work without being concerned about how the document will appear. Editing your 

document is much easier and more efficient with a word processing program. You can use your 

creativity to format the documents. Formatting is the process of adjusting the appearance of the 

document. 

A few special features most word processing programs include are: spell-checker, chesaurus, 

style and grammar checker, mail-merge, and macros. Word Star, Word Perfect and MS Word 

are few popular word processing programs. 

 
One of the main advantages of a word processor over a conventional 

typewriter is that a word processor enables you to make changes to a 

document without retyping the entire document. 

7.10.5 Full Screen View 

7.10.6 Web Page Preview 

7.10.7 Print Preview 

7.10.8 Zoom 

7.11 Summary 

7.12 Keywords 

7.13 Self-Assessment Questions 

7.14 Review Questions 

7.15 Further Reading 
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Notes 7.1 Introduction to Microsoft Word 

 

7.1.1 Microsoft Word 2000 

Microsoft Word is a word processor, created by Microsoft Corporation, US. It is one of the 

most advanced and powerful word processing software packages in the market. It replaces 

your pen, paper, dictionary, thesaurus, and typewriter, and helps the user to create professional 

documents in record time. 

With the help of Word, users can write letters, memos, faxes, brochures, newsletters, and 

even books. Word and Microsoft Office are integrated to give greater flexibility and also 

provide a document-centric approach rather than an application-centric approach. 

Microsoft Word strives to provide more interconnectivity between the user and the world 

by linking Word documents to the Word Wide Web and between the user and other office- 

mates by allowing many people to edit the same document without confusion. 

Microsoft Word 2000 is a word processing program designed for Windows 98 and Windows 

NT 4.0 and later. Word can integrate information with other Microsoft Office products such 

as Excel and PowerPoint. For example, you can create a document in Word and send the 

documents outline to PowerPoint. 

7.1.2 Word 2000 Features 

Microsoft’s objective in this version is to make Word the easiest way to create e-mail, Web, 

or print documents anywhere in the world. The new features added in Word 2000 are 

directed at the following areas: 

• Web-centred document creation 

• Rich e-mail creation 

• Personalization based on patterns of use 

• Support for international users 
 

7.1.2.1 Web-Related Features 

• Preserved Formatting: When existing documents are saved as HTML and then reopened, 

none of Word’s formatting will be lost. 

• Improved Web Page Wizard: The Web Page Wizard gives you an easy and quick way 

to create web pages and multiple-page web sites. 

• Web Layout View: This new view replaces the old Online Layout view and makes it 

easier to create, edit, and view web pages. 

• Themes: Themes set up consistency between your web pages to unify a site. 

• Improved Web Page Preview: You can preview your web pages in your default 

browser, even if you have not saved them yet. 

• Improved Hyperlink Interface: It is easier to create, edit, follow, and remove hyperlinks 

in documents. 
 

7.1.2.2 International Features 

• Language Settings: Users can adjust the language setting in the application without 

affecting the operation of Word. 

• Proofing Tools: Users can install proofing tools for their preferred language. 

• Language AutoDetect: Word automatically detects the language users type in, so tools 

such as spelling and grammar checking adjust to accommodate the preferred language. 
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• Asian Languages: Word users can now type in Japanese, Korean, and Chinese even 

though they are using Western operating systems. 
 

7.1.2.3 General Features 

• The Office Assistant: It is a gateway to all Word Help resources. It uses an advanced 

technology that recognizes natural language patterns, not just keyword location. 

• Internet, Intranet, and WWW features: All the resources of the WWW are at the user’s 

disposal. Help files, access to new features as soon as they become available, and the 

ability to build hyperlinks right into documents are just some of the new features that 

Word offers. 

• Drawing Tools: Microsoft Word provides a rich collection of 3-D shape creation tools, 

auto shapes, shadow effects, textures, and semi-transparent fills. It includes a toolbar 

just for drawing tools. It also provides unique layering possibilities for the documents. 

❖ Editing and Proofing Tools: Word checks grammar as the user types. It provides 

tips to improve the writing skills tighten up grammar and sentence structure, 

verb agreement, and so on. It also has improved Spelling and Find capabilities. 

It recognizes many proper nouns, figures of American speech, and company 

names. 

• Template and Wizards Features: Word’s template are read-only documents containing 

styles and other design elements that you can use to create or restyle your own 

documents. Wizards are computerized assistants that are used to create documents, 

after asking some questions and making a few design decisions on their own. 

• Mail Merge Tool: Word’s Mail Merge feature allows you to quickly create personalized 

correspondence and other documents by combining (merging) information from two 

different files. 
 

7.1.2.4 Requirements for Running Word 2000 

Many people purchase Word 2000 as part of the Microsoft Office 2000 suite of applications, 

which also includes such applications as Excel, PowerPoint, and Access. If you are installing 

Word as part of Microsoft Office 2000, you have the option of installing all of the Office 

applications or some of the applications. You need to decide which applications you want to 

install before you begin. 

To install Word as part of Microsoft Office, your system must meet the following requirements: 

• The operating system on your computer must be Windows 95, Windows 98, or Windows 

NT Workstation 4.0 with Service Pack 3. 

• Your computer must be at least an x86-compatible PC that meets the minimum 

requirements to run Windows 98 or Windows NT Workstation 4.0. Microsoft 

recommends a 90 MHz Pentium or better with at least 32 MB RAM. 

• Your hard disk should have 250 MB of available space. 

• Windows NT users need 4 MB of free Registry space available. 

• If you plan to install International support for additional languages, you need an extra 

50 MB of hard disk space available for each language interface you want to install. 

• You must have a CD-ROM drive. 

Notes 
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Notes • A mouse or other pointing device. 

• A printer supported by Windows 95 or Windows 98, preferably a laser printer. 
 

7.1.2.5 Starting Word 

Use one of the following three methods to activate Word: 

• Click the Start menu button and choose Microsoft Word from the Programs menu. 

• Click the Start menu button, choose Microsoft Office from the Programs menu and then 

select MS-Word. 

• Choose Start » Run, enter the path and program name in the Open text box and then 

click the OK button to start Word. 

Word can be started automatically, whenever Windows starts, if Word is placed (WinWord.exe 

file) into Startup folder in the Start menu. 
 

7.1.2.6 Opening Documents Automatically 

To start Word and open a document named Letter.doc that is stored in a folder named Docs 

on the C drive: 

• Click the right mouse button on shortcut icon for Word. 

• Add a document filename after the program named in the Target text box: 

‚C:\Office\Winword.exe‛ ‚C:\Docs\Letter.doc‛ 

 

 

If you want to use Microsoft word make sure the MS office is successfully 

installed in your computer system. 

 

 
 

7.2 The Word Environment 
 

7.2.1 Microsoft Word 2007 

Microsoft Office Word 2007 is a sophisticated word processing program that helps you create, 

edit, and produce professional-looking documents. Word 2007 has been extensively overhauled 

and updated from the previous versions. It presents a complete set of writing tools in a new 

graphical user interface. These tools are easier to find and allow you to give your document 

a consistent look when adding styles, impressive graphics, columns, and tables. This manual 

will serve as both an introduction to Microsoft Word 2007, as well as a guide to better assist 

your transition from Word 2003 to Word 2007. 
 

7.2.1.1 Getting Started 

In order to access Word 2007, you will need to do one of the following: 

• Double-click the shortcut on your desktop (if applicable), or 

• Navigate to Word 2007 through the Start Globe button > AH Programs > Microsoft Office. 
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  Home  

What’s New 
Word 2007 presents a new user-interface which is quite different than previous versions of 

Word. This section will provide you with some basic information about the new look and 

features available in Word 2007 in order to help you get started. 

Fig. 7.1: Microsoft Word 2007 Windows 

Whats New in Word 2007 - Microsoft Word 

 
Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 Fig. 7.2: Descriptions of MS 2007 Windows  

   

Quick Access Toolbar Title bar Close button 

 
Offlce 
Button Home Insert Page Layout References Mailings Review View 

 Calibri (Body) 

   Paste Change   Edrting 

Styles Ribbon 
Clipboard Font Paragraph Styles 

 

 

 

Ruler 

Insertion 
point 

 

 
Vertical 

Document Scroll bar 

window 
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Status bar View buttons Zoom slider 
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  Print 

Layout  

Full Screen Web Outline Draft 
Reading Layout 

Document Views 

 

Notes 7.2.1.2 How to Create a New Blank Document 

In order to create a new document in Word 2007, follow the steps below: 

 
1. Click the Microsoft Office Button and select New. 

 

2. Click the Create button 

Keyboard Shortcut: CTRL+N 
 

7.2.1.3 How to Open an Existing Document 

 
1. Click the Microsoft Office Button and select Open. 

 

2. From the resulting menu, navigate to the existing document you wish to open. 

3. Once you have selected your document, click the Open button. 

Keyboard Shortcut: CTRL+O 

7.2.1.4 How to Change Document View 

1. Select the View tab. 

2. Select your preferred view option from the Document Views group; or 
 

 

3. Click a View Button on the View toolbar in the lower right corner of the Status Bar. 

 

 
      100%  

 
 

• Print Layout view A view that shows a document as it appears on a printed page. 

• Full Screen Reading view A view that displays as much of the content of the 

document as will fit in the screen. 

• Web Layout view A view that shows a document as it appears in a web 

browser. 

• Outline view A view that shows the structure of a document, which consist of 

headings and body text. 

• Draft view A view that displays the content of a document with a basic layout. 

• Zoom button The Zoom button magnifies or reduces the contents in the document 

window. 
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7.2.1.5 How to Save a File 

 
1. Click the Microsoft Office Button and select Save. 

 

2. Navigate to the location to save your file. 

3. Enter the name for the new file in the File name box. 

Keyboard Shortcut: CTRL+ S 
 

7.2.1.6 Compatibility Mode and Converting Documents 

You may find that there are times you need to access and edit files created   in previous 

versions of Word (for example, you are working on a document with a colleague who is 

still be running Word 2003). The below information will provide you with the resources you 

need while working with these documents. 

7.2.1.7 Compatibility Mode 

When you open a document created in previous versions of Word, Compatibility Mode is 

turned on and you will see Compatibility Mode in the title bar of that document window. 

While you are able to open, edit and save documents created in previous versions of Word, 

you will not be able to use any of the new or enhanced Word 2007 features. 

7.2.1.8 Convert a Document to Word 2007 

1. Click the Microsoft Office Button, and then click Convert. 

2. From the Microsoft Office Word dialog box, click OK. 

Initially, Word displays a new document that is based on a Normal template (NORMAL.DOT) 

in full-screen size. Word’s Normal template determines the initial settings. 

• The Title Bar: The title bar at the top of the screen displays the program name 

(Microsoft Word), document filename (Document1), Word control menu, and the three 

buttons on the upper-right corner of the screen to either minimize or restore, or exit 

document, respectively. 

• The Menu Bar: Just below the title bar is the menu bar. It contains drop-down menus. 

• Toolbars: By default, the Standard and Formatting toolbars are displayed just below 

the menu bar. Additional toolbars are available for different features. Choose View 

>> Toolbars to show or hide any of Word’s toolbars. 

 

 
If no toolbars are displayed, click the View menu, choose Toolbars and 

then select the desired toolbar from the list. By selecting Customize at 

the bottom of the list, you can choose to enlarge the toolbar buttons, add 

color to some of the buttons, and hide ToolTips. 

 
 

• The Ruler: The horizontal ruler is displayed across the top of the document window 

and enables to change paragraph indents, adjust margins, change the width of newspaper 

style columns, change the width of table columns and set tab stops. To display and hide 

the ruler, choose the View >> Ruler command. 

Notes 
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Figure 7.3: A Microsoft Word Window 

 

To hide the style area, drag the style area boundary to the left until the 

style names disappear. 

 
Notes • The Status Bar: The first section of the status bar shows the current page number, the 

section number and the total number of pages in the document. The next portion shows 

the distance (in inches) from the top edge of the page to the insertion point, followed 

by the insertion point’s line and column numbers. The last section displays the current 

time and modes. To turn it off choose the Tools >> Options command. Select the View 

tab and click the Status bar check box. 

• The Style Area: The vertical pane along the left edge of the document window displays 
the style name for each paragraph visible in the window. To display or hide the style 
area, follow these steps: 

Choose View >> Normal (only available in Normal and Outline views). 

Choose Tools > > Options. 

Choose Window tab, specify width in the Style Area Width box. For example, 
enter 0.5". 

Click OK button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• The Document Window: One can create, edit, format, and view the document files in 

the document window. The blinking vertical bar is called the insertion point. It 

indicates where text is to be entered into a document. 

• The Scroll Bars: The vertical and horizontal scroll bars, which are a part of the 

document window, are used to scroll the document either from top to bottom or 

bottom to top and from left to right or right to left respectively. The horizontal scroll 
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bar also contains buttons that allow to switch quickly between the four most common 

document views. 

• The Office Assistant: When Word starts, a little paper clip icon appears on the lower 

right corner of the screen. Office Assistant is best bet to get help with Word. Office 

Assistant is intelligent and specific, and it can get to the heart of   a   matter 

quickly. To change the clip icon, right click it, select and choose Assistant. To close it, 

click the Close box and clicking the question mark on the Standard toolbar brings it 

back. 

 
 

Word also has the facility of macros. Macros can be either attached to 

some function/special keys or to a tool bar or to a menu. 

 
 

Help Menu 

Show Balloons: If you are not sure what a menu does, turn on Balloons, put your cursor 

on the menu item and get a short explanation. 

Microsoft Word Help: Open Word’s Assistant and get a search box to type in. Word displays 

possible matches for you to read about. 

Contents and Index: See an index of all topics available in Word’s Help documentation. 

Help on the Web: That’s right! It is exactly what it sounds like. Select a link and a Microsoft 

help page is opened in your browser. If you are not online, Word will make the connection 

and then display the page. 

Online Registration: If you have ever installed any software application on your computer 

you have seen those reminders to register the product online. Well, Microsoft keeps the 

reminder around in case you didn’t register when you installed the software. Isn’t that 

considerate of them! 

Notes 

 

 

 

7.3 Creating a Word Document 
 

When Word opens, a new blank document called Document 1 appears on the screen, based 

on the Normal template. Template is a blueprint or pattern for all documents of a certain 

type, such as a letter, memo, or report. To begin working, just start typing. To create a new 

document with Normal template: 

1. Choose the File >> New command or click the New button on the Standard toolbar. 

2. The New dialog box appears with the Normal template selected. 

3. Click OK, or press Enter. 

 

 
 

Give the steps for opening the MS word. 
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With a new document on your screen, type in the following sentence 

about the Golden Hour Center. 

 
How to insert picture from any other place into the MS word document? 

 
Notes Word’s Normal Template (Normal. dot) Default Settings 

 

Option Default Setting 

Paper size Letter (8'/z inches x 11 inches) 

Left and right margins 1.25 inches 

Top and bottom document margins 1 inch Single 

Line spacing Align Left 

Justification Tabs 0.5 inch 

Font Times New Roman 

Point size 10 points 

View Normal 

 

7.4 Editing in a Word Document 
 

7.4.1 Typing in a Document 

When you first create a document by using the Normal.dot template, the insertion point rests 

at the top of the document, ready for you to begin typing. To add text to a document, just 

start typing. By default, Word will automatically wrap your text to the next line when the 

text reaches the right margin. The only time you need to press Enter is when you want Word 

to create a new paragraph. 

Type: The Golden Hour Senior Citizen’s center center center center center center center (that’s 

right, seven centers) is a great place to relax, meet old and new friends, and get training on 

computers and word processing. 
 

7.4.2 Displaying Nonprinting Characters 

Show/Hide button, on the Standard toolbar displays nonprinting characters, characters that 

can be displayed on-screen but do not print. Displaying nonprinting characters is a good idea 

because you can see at a glance whether you have typed an extra space or pressed Enter 

accidentally. Common nonprinting characters and their names are: 

• Line break or new line (.J ) 

• Paragraph mark ( ¶ ) 

• Space ( . ) 

• Tab (->) 
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7.4.3 Moving Around in a Document 

To make changes and corrections quickly and easily, various ways of moving around 

document are available. 

Notes 

 

 
 

7.4.3.1 Moving the Insertion Point 

Keyboard Shortcuts for Moving Around in Document 
 

Key(s) Action 
 

‹ Moves the insertion point one character to the left. 

fi Moves the insertion point one character to the right. 

› Moves the insertion point up one line. 

fl Moves the insertion point down one line. 

Home Moves the insertion point to the beginning of the line. 

End Moves the insertion point to the end of the line. 

Pg Up Moves the insertion point up one window or page. 

Pg Dn Moves the insertion point down one window or page. 
 

Ctrl + Home Moves the insertion point to the beginning of the document. 

Ctrl +End Moves the insertion point to the end of the document. 

Ctrl + E—Moves the insertion point one word to the left. 

Ctrl+-* Moves the insertion point one word to the right. 

CtrI+T Moves the insertion point up one paragraph. 

Ctrl+1 Moves the insertion point down one paragraph. 

Ctrl+Pg Up Moves the insertion point to the top of the previous page. 

Ctrl +Pg Dn Moves the insertion point to the top of the next page. 

 

7.4.3.2 Scrolling Through a Document 

Methods of scrolling by using the mouse or keyboard 

 
Methods Mouse Action Key 

Scroll up one line Click the up-arrow key of V.scroll 

bar 

 

Scroll down one line Click the down-arrow key of J, 

 V.scroll bar  

Scroll up one screen Click above the scroll box in the Pg Up 
 scroll bar  

 

You cannot have the cursor passed the end of the document using either 

the Arrows or the mouse. 
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Figure 7.4: Use of Go To Command in Microsoft Word 

 

 
Notes Scroll down one screen Click below the scroll box in the Pg Dn 

 scroll bar  

Scroll left Click the left-arrow key of H. scroll 

bar 
E-- 

Scroll right Click the right-arrow key of H. 

scroll bar 

 

Move to any specific 

location horizontally or 
Drag the scroll box Not available 

vertically   

 

7.4.4 Using Go To Command 

The Edit >> Go To command lets the user move the insertion point anywhere in the 

document. One can go to just about any location: sections, lines, footnotes, annotations, 

graphics, and tables. Refer to the following dialog box. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

7.4.5 Manipulating Windows 

Arrange All 

• To open and work with a new document window, choose File » New and then Window 

>> Arrange All. 

• It helps to work in a different view in each pane. 

Active Window 

• When the screen contains multiple documents, Word defines one document as the 

active document or active window. 

• Select a window as active by simply clicking on any portion of the window. 

Splitting a Window 

Word lets you view different parts of a document at the same time by splitting the window 

into two panes. Figure below shows a split document window. Splitting a document window 
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• Choose Window » Remove Split. 

Figure 7.5: Splitting of Window in Microsoft Word 

 

A window can’t be split when the Document Map or thumbnails are 

being displayed. 

 
can make navigating and editing of long documents easier. Changes made in one pane are 

reflected in the other. 

To split a document, choose any of the following methods: 

• Double-click the split box at the top of the vertical scroll bar. 

• Choose Window » Split. 

To remove the split, choose any of the following options: 

• Double-click the split box. 

Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.4.6 Selecting Text 

Before moving, copying, deleting, or making changes in the text, the first step is to select 

the item. The general rule is to select first and then perform any action. This rule applies 

to nearly every action performed in Word. 
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Notes Using the Mouse 

 

To Select Do This 

 

A word Double-click the word. 

 

A graphics Click the graphic. 

A line of text Click in the selection bar to the left of the line 

Multiple lines of text Click in the selection bar in the direction of the 

lines you want to select. 

 

A sentence  Hold on Ctrl, and click in the sentence you want 

to select. 

 

A paragraph Double-click in the selection bar to the left of 

the paragraph. 
 

Multiple paragraphsDrag in the selection bar in the direction of the paragraphs you want 

to select. 

Any item or amount of textClick where you want the selection to begin. Then hold down 

Shift, and click where you want the selection to end. 

An entire document Triple-click in the selection bar. 

A vertical block of text Hold down Alt, click the mouse button, and drag. 

 

With the Keyboard 
 

To Select Press 

 
One character to the right Shift + right-arrow key 

One character to the left Shift + left-arrow key 

To the end of a word Ctrl + Shift + right-arrow key 

To the beginning of a word      Ctrl + Shift + left-arrow key 

To the end of a line Shift + End 

To the beginning of a line Shift + Home 
 

To the end of the document       Ctrl + Shift + End 

The whole document Ctrl + A 

7.4.7 Editing Text 

When you type in the text, you are quite likely to make mistakes. Corrections of these 

mistakes are called ‚editing‛. Editing text is an essential feature of a word processing 

package. Word makes it easy to add a new thought, change a word, or replace one phrase 

with another. 
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Inserting Text 

Word normally works in the insert mode. The insertion point always stays within the 

workspace. Word shifts the existing text to the right to make room for the new text being 

inserted in the line. When it reaches the end of the line, Word automatically wraps the text, 

eliminating the need to press the Enter key until the user wants to start a new paragraph. 

Position cursor at desired location and start typing. 

Notes 

 

 
 

Replacing Text 

If you plan to replace text, select the text to be replaced. Type in the new text (it does not 

matter if the quantity of the new text is more or less than the old text). 

Deleting Text 

Below are the Word’s keyboard deletion options. Selected text can also be deleted using Edit 

> > Clear command. 

To Delete Press 

Selected text Backspace or Delete 

Character before the insertion point Backspace 

Character after the insertion point Delete 

A word before the insertion point Ctrl + Backspace 

A word after the insertion point Ctrl + Delete 

 

A common source of confusion for users is understanding the difference 

between the ‚Delete‛ key and the ‚Backspace‛ key. Put simply, the 

‚Backspace‛ key deletes words to the LEFT of the cursor, and the ‚Delete‛ 

key deletes words to the RIGHT of the cursor. 

 
Undoing Actions 

The Undo command is used to reverse actions. You can undo an Undo with the help of Redo 

command. Word provides three methods to undo or redo the most recent action: 

• Clicking the Undo button or Redo button on the Standard toolbar, 

• Choosing Undo or Redo from the Edit menu 

• Pressing the shortcut keys Ctrl + Z (Undo) or Ctr1+Y (Redo) 

To undo or redo multiple actions, first click the arrow beside either the Undo or Redo button 

to display a list of actions and then select or click the desired action. 
 

The Clipboard 

The clipboard is a temporary storage area maintained by Windows. Applications can put 

data into the clipboard and recall it later. In fact, one application rnay put its data into the 

clipboard and another application may read this data. This is a convenient interface to 

 

Before inserting text, switch to overtype mode by double-clicking OVR 

on the status bar or by pressing the Insert key. 
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Notes transfer data from one application to another. For example, we may copy data ‚letters finds‛ 

from DOC1 into the clipboard, then switch to Word and paste the data from the clipboard 

into the document DOC2. 
 

Moving and Copying Text 

Word supports all the usual Windows techniques for copying and moving information. It 

provides a feature called drag-and-drop, a handy one step, mouse-assisted move to take 

information frorn one place to another on the same page. Cutting removes the origina’ 

selection from the document. Copying makes a copy of the selected text and leaves the 

original selection unchanged. 
 

Smart cutting and Pasting 

When cut or paste operations are carried out, Word adjusts the spaces remaining in the 

sentence. To deactivate the Smart Cut and Paste feature, Choose Tools >> Options, select Edit 

tab, and clear the Use Smart Cut and Paste check box. 
 

Drag-And-Drop Editing 

This feature is especially convenient for copying and moving text, where the source and 

destination are visible in the same screen. 

To move or copy text by using drag-and-drop editing between Windows: 

• Select the desired text. 

• Do one of the following: 

• To move a selection, point to the selection, and hold down the mouse button until it 

becomes drag-and-drop pointer. 

• To copy a selection, hold down the Ctrl key, point to the selection, and hold down 

the mouse pointer until it becomes drag-and-drop pointer. 

• Drag the pointer to the new location. 

• Release the mouse button to drop the text into place. 
 

Using the Cut, Copy, and Paste Buttons 

Use the Cut, Copy, and Paste buttons on the Standard toolbar to move or copy text or 

graphics within a document, among different documents, or among other applications. To 

move or copy text and graphics with Standard toolbar 

• Select the text to move or copy. 

• Do one of the following: 

O To move the selection, click the Cut button on the Standard toolbar. 

O To copy the selection, click the Copy button on the Standard toolbar. 

• Position the insertion point at the new location. 

• Click the Paste button. 
 

Using Commands and Keyboard Shortcuts 

To copy a selection, choose Edit >> Copy, move the insertion point at the new location, and 

choose Edit >> Paste. To move a selection, choose Edit >> Cut and after specifying the 

location choose Edit » Paste. 



Unit 7: Microsoft Word Introduction 

125 

 

 

 
Keyboard Shortcuts for Copying and Moving 

To Do This Press 

Copy selected text to the clipboard Ctrl + C 

Move selected text to the clipboard Ctrl + X 

Paste clipboard contents in a document Ctrl + V 

7.5 Saving a Document 

Notes 

 

 

Click the Save button, or choose File >> Save. The Save As dialog box appears. By default, 
the File name text box lists the first sentence of the document. 

Enter a name of up to 255 characters for the file. A filename can contain letters, numbers, 

and spaces, as well as the following symbols: 

!, @,   #, s, %, &,   (, ),   [,   l, -,   {,   }. 

Word automatically adds the filename extension .doc to the filename. Choose OK, or press 

Enter to save the document. 

7.5.1 The Save Options: Fast Save or Full Save 

The Save As dialog box includes an Options button. Clicking the Options button is same as 

choosing the Tools > > Options and then clicking the Save tab. 

Save tab displays different options to save a file. The two most important save option are: 

• Allow fast saves 

• Always create back-up copy 

Figure 7.6: Options of Fast Save or Full Save 



Unit 7: Microsoft Word Introduction 

126 

 

 

 
Notes These two options are mutually exclusive. The Allow fast saves check box instructs Word to 

save only the changes to a document. This is faster than a full save, in which Word saves 

the complete, revised document. 

7.5.2 Saving a File With a New Name 

There are several reasons to save a file with a different name: 

• To track modification made by others. 

• To save a copy in a different folder than the original. 

 
 

Word can protect your work by saving a temporary copy of a document 

periodically as you work. To set up this option, click the Tools menu and 

select Options; then select the Save tab. Click on the AutoRecover info 

every: field and then specify a time for how often you’d like this to occur. 

You still must use the Save command on the File menu to save the 

document normally when you finish working on it. 

• To make changes to the original document but also keep the original intact in order 

to compare the different versions. 

• To save the file in a different format so another application can use it. To save a 

document with a new name: 

• Choose File >> Save As. The Save As dialog box appears. Type the new name in the 

File Name box. 

• Select the appropriate drive, if you want to save it on a different location. 

• Select the desired format by clicking the Save as Type box. 

• Click Save or press Enter. 

Figure 7.7: Saving of File with a New Name 
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7.6.1 Using Print Preview before Printing 

Print Preview command is used to view document in a variety of ways. To preview a 

document in Print Preview: 

• Choose File >> Print Preview or click the Print Preview button on the Standard 

toolbar. 

• To close Print Preview, choose the Close button. 

Button Name Action 

Print Prints the document by using default print options. 

Figure 7.8: Printing of Document in Microsoft Word 

 
7.6 Printing Documents Notes 

 

Click the Print button in the Standard toolbar, the document goes directly to the printer. To 

specify what exactly has to be printed use the File < < Print command to display Print dialog 

box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 Figure 7.9: Print Preview Toolbar  

   

 

 

The Print Preview Toolbar 

 

 

 
 

Magnifier Enlarges or reduces the document view. 

One Page Displays the document in single-page view. 

Multiple Page Views one or more pages of a document. 

Zoom Control Select different magnifications, from 10 to 500 percent 

and other options. 

View Ruler Displays or hides the horizontal and vertical rulers. 
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Use one of the following five methods to correctly exit Word. 

• Choose the File » Exit command. 

• Press Alt+F4. 

• Click the Close button in the right corner of the Word program title bar. 

• Double-click the control menu icon in the left corner of the Word program title bar. 

• Right-click in the Microsoft Word button in the taskbar, and choose Close from the pop-
up menu. 

 

As with most Windows programs, MS Word will take care of your files 

when you Exit or Close. If you have open files with unsaved changes, 

Word will prompt you to save or abandon the changes in each file that 

was open before actually exiting. 
 

7.8 Opening a Document 
 

• Choose File >> Open to display Open dialog box. 

• Select the appropriate drive and folder, using Look In combo box. 

Figure 7.10: Opening a File in the Microsoft Word 

 
Notes Shrink to Fit Shrinks document to fit on one page or less if the last page of 

document contains only a few lines of text. 

Full Screen Removes title bar and toolbars to show a full screen display of the 
document in Print Preview. 

Close Preview Closes Print Preview and returns to your document. 

Context Sensitive Provides Context-Sensitive Help for Print Preview Help options. 
 

7.7 Exiting Word 
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• Select the file on which you want to work. 

• Click on Open button or press Enter. 
 

7.9 Finding Files 

Notes 

 

The Find Files feature is a part of Open dialog box, and works by searching for a filename 

or specific words or phrases in the document. Searching of a file(s) can be done by filename, 

text or date of last modification. Searching can also be done by using the advanced button 

in the Open dialog box. 
 

7.10 Word’s Document Views 
 

Word lets the user view documents from a number of different perspectives to make them 

easier to visualize and quicker to work with. These display options are called views. Word 

provides the following views Normal, Outline, Print Layout, Web Layout, and Print 

preview. To change the view either use View menu or View buttons on the horizontal 

scroll bar. 

 

Changing the size of the margins can reformat complete document or 

part of text. 

 

 

7.10.1 Normal View 

Normal view is the default view. It is not a true WYSIWYG view because one cannot see 

headers and footers, footnotes and annotations but the formatting and layout elements of 

the document can be seen. Working with this view is relatively speedy. You should work 

in Normal view to type, edit, and format text. 

7.10.2 Print Layout View 

Print Layout view should be used to see how text, graphics, and other elements will be 

positioned on the printed page. This view is useful for editing headers and footers, for 

adjusting margins, and for working with columns and drawing objects. 

7.10.3 Outline View 

Outline view is a specialized view that one can use to organize a document. In Outline 

view, you can expand or collapse portions of the document to see only the headings of 

your choice. You can quickly and easily move and copy large portions of the document 

in Outline view. 

All paragraphs even your heading paragraphs appear in Outline view as body text 

paragraphs. But you can promote any body text paragraph to any level of heading that 

you want, and you can demote a heading to body text. In Outline view, you can collapse 

a document to see only the main headings, or you can expand it to see all headings and 

even body text. 

7.10.4 Web Layout View 

Web Layout view should be used when you are creating a Web page or a document that 

is viewed on the screen. In Web Layout view, you can see backgrounds, text is wrapped to 

fit the window, and graphics are positioned just as they are in a Web browser. 
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Each view can have a different zoom level. 

 
Notes 7.10.5 Full Screen View 

Use the Full Screen view to hide all of Word’s menus, toolbars, and rulers and have the 

whole screen to write. On selecting View >> Full Screen, nothing is displayed on the screen 

except the document and the one-button toolbar. To return to the previous view, click once 

on the button or press Esc. 

7.10.6 Web Page Preview 

In Web page preview, you can see how your document will look in a Web browser. 

Microsoft Word saves a copy of your document and then opens it in your default browser. 

If your Web browser is not already running, Word starts it automatically. You can return 

to your document in Word any time. 

7.10.7 Print Preview 

In print preview, you can display multiple pages of a document reduced in size. In this view, 

you can see page breaks, hidden text, and watermarks, and you can make editing or 

formatting changes before you print the document. 

7.10.8 Zoom 

Zooming changes the magnification of the document. The default is 100 percent. User can 

zoom up to 500 percent. Highes zooms are good for overall design checking and lower 

zooms are good for detail checking. 
 

 

 

 

 

History of Microsoft Word 
 

icrosoft Word is a well known word processing software developed by 

Microsoft. Microsoft Word or Microsoft Office Word was initially released in 

1983. It was meant for the XENIX systems in the beginning. But as it grew, 
Microsoft Word was rewritten so it can support several other platforms such as DOS, 

Macintosh, UNIX, OS/2, and Windows. In 2003, Microsoft Word became part of the 

Microsoft’s complete office suite software known as the Microsoft Office. Thus the name 

‘Microsoft Word’ officially changed to ‘Microsoft Office Word’. 
 

Microsoft Word Version Release History 
 

1983 
 

- Word 1 for MS-DOS 
 

1985 
 

- Word 2 for MS-DOS 

 

Contd... 
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- Word 1 for Macintosh 
 

1986 
 

- Word 3 for MS-DOS 
 

1987 
 

- Word 4 for MS-DOS (Titled Microsoft Word 4.0 for the PC) 
 

- Word 3 for Macintosh 
 

1989 
 

- Word 5 for MS-DOS 
 

- Word 4 for Macintosh 
 

- Word for Windows 1.0. (code name ‘Opus’) 
 

1990 
 

- Word for Windows 1.1 (code name ‘Bill the Cat’) 
 

- Word for Windows 3.1 
 

1991 
 

- Word 5.1 for MS-DOS 
 

- Word 5 for Macintosh 
 

- Word for Windows 2.0 (code name ‘Spaceman Spiff’) 
 

1992 
 

- Word for OS/2 version 1.1B 
 

1993 
 

- Word 6.0 for MS-DOS 
 

- Word 6 for Macintosh 
 

- Word for Windows 6.0 (code name ‘T3’) 
 

1995 
 

- Word for Windows 95 
 

1997 
 

- Word for Windows 97 
 

1998 
 

- Word 98 for Macintosh 

Notes 

 

Contd... 
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Notes  

1999 
 

- Word 2000 for Windows 
 

2000 
 

- Word 2001 for Macintosh 
 

2001 
 

- Word 2002 for Windows 
 

- Word v.X for Macintosh (only for Mac OS version X) 
 

2003 
 

- Word 2003 for Windows. Officially named Microsoft Office Word 2003. Also known as 

Word 11. 
 

2004 
 

- Word 2004 for Macintosh 
 

2006 
 

- Microsoft Office Word 2007. Also known as Word 12 

 
Questions: 

1. Give the name and year of first Microsoft Word Version. 

2. Give the latest version of MS word. 

 

 

7.11 Summary 
 

• Word is a word processor, created by Microsoft Corporation, US. 

• The word screen contains the title bar, Menu bar, Toolbars, Ruler and etc. 

• Microsoft word 2000 is a word Proceeding program designed for windows 98 and 

window NT 4.0 and later. 

• World 2007 presents a new user interface which is quite different than previous of 

word. 

• The word’s document views contains normal views, outline, print layout, web layout 

and print preview. 

 

7.12 Keywords 
 

Backspace: Remove characters to the LEFT of the insertion point. 

Delete: Remove characters to the RIGHT of the insertion point. 
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Insertion Point: In graphics-based programs, the insertion point is the point where the next 

characters typed from the keyboard will appear on the display screen. A blinking vertical 

line usually represents the insertion point. You can reposition the insertion point by pressing 

the arrow keys or by moving the I-beam pointer. 

Mail Merge Tool: Word’s Mail Merge feature allows you to quickly create personalized 

correspondence and other documents by combining (merging) information from two different 

files. 

Menu Bar: A horizontal menu that appears on top of a window. Usually, each option in a 

menu bar is associated with a pull-down menu. 

Office Assistant: The Office Assistant is a ‚character‛ or a ‚virtual person‛ whose main job 

is to provide instant help when using a Microsoft Office product. 

Tab: A key on computer keyboards that inserts a tab character or moves the insertion point 

to the next tab stop. Some applications respond to the tab key by inserting spaces up to 

the next tab stop. This is often called a soft tab, whereas a real tab character is called a 

hard tab. 

 
 

1. How to add the clips art in the document? 

2. How to make more copy of the same documents? 

Notes 

 

 

7.13 Self-Assessment Questions 
 

1. Word processing is by far the most widely used computer application. 

(a) True (b) False 

2. Lower zooms are good for detail checking. 

(a) True (b) False 

3. It is possible to save an existing file with a different name. 

(a) True (b) False 

4. Using Word you can search a file by specifying the text it contains more than one 

document window can be made active at one time. 

(a) True (b) False 

5. Default magnification is 75 percent. 

(a) True (b) False 

6. While working in Ms-Word you have to work with 

(a) Mouse only 

(b) Keyboard only 

(c) Both mouse and keyboard 

(d) None of these 



Unit 7: Microsoft Word Introduction 

134 

 

 

 
 

Notes 7. In Ms-Word every command is available in 

(a) Print (b) Letter 

(c) Icons (d) None of these 

8. You can go inside Ms-Word by the following way 

(a) Take the mouse pointer to START button on the task bar and click the left mouse 

button. 

(b) Take the mouse pointer to START button and click the right mouse button. 

(c) Move the mouse pointer on the screen. 

(d) All of these 
 

7.14 Review Questions 
 

1. What are the advantages of using a Word processor? 

2. What are the specific features of Word 2000? 

3. List the various requirements for running Word 2000. 

4. What are the various parts of the Word screen? 

5. Explain the various buttons displayed in the Preview window. 

6. Briefly explain the use of Formatting toolbar in Word. 

7. What is the function of the status bar in the Word? List down the information that is 

displayed in the status bar. 

8. What are the various views available to see a document in Word? 

9. How do you make a template? What is a template? What is Normal.dot? 
 

10. How will you change the default font from Times Roman New 10pt (12pt) to something 

else? 

11. How do you type roman numerals on Microsoft Word? 

12. What are some common errors that people make using Word? 

13. What do you understand by Word processing? Give examples. 

14. Describe the important features of Ms-Word. 

15. Describe the various options available in the main menu bar of Ms-Word. 

16. What are the different types of toolbar? 

17. Define two methods to start Ms-Word. 

 
Answers for Self-Assessment Questions  

1. (a) 2. (b) 3. (a) 4. (a) 

5. (a) 6. (c) 7. (c) 8. (b) 
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7.15 Further Reading Notes 

 
 

Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister 

 

 

 
http://books.google.co.in/bkshp?hl=en 

 

http://books.google.co.in/bkshp?hl=en
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• Explain the using and creating, insertion of Auto correct and Auto text. 

Introduction 

The most basic function of MS Word is to create a document/file. Once a document has been 

created, the user may enter data—for example by typing some text. At any point after the 

document has been created, the user is allowed to save the contents. The document can then 

be accessed at a later time and modified as necessary. Documents can be printed out at any 

stage in this process. 

8.1 Finding and Replacing Text 

The Find and Replace option of Word is a convenient way of searching for a particular word 

in a document and replacing it with another. It can be used in situations where an error (not 

an error in spelling) has been committed consistently in a document and has to be corrected. 

The Find command moves to a specific point in the document quickly and the Replace 

command searches for and replaces the text. 

8.1.1 Find Command 

• Choose Edit >> Find or click the Select Browse Object button in the vertical scroll bar 

and click the Find icon. 

• Enter the text to be searched in the Find What text box. 

• Specify Search option and other check options if required. 

• Choose Find Next. Word begins the search and highlights the first occurrence of the 

text it was searching. 

Figure 8.1: Find and Replace Windows 

 

If you also want to replace the text, type the replacement text  in the 

Replace with box. 

 
Objectives Notes 

 

After studying this unit, you will be able to: 

• Discussed finding and replacing the text in MS word. 

• Explain proofing of documents and working with tables. 

• Discussed about collecting of various spelling errors as will as the quick spelling 

errors. 

• Discussed synonyms thesaurus and hyphenating documents 
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• In the Replace With text box, enter the replacement text. 

• Do one of the following: 

• To confirm each replacement, choose find next. Then choose replace to replace the 

text or Find next to skip to the next occurrence. 

• To change all occurrence of the search text without confirmation, choose Replace 

All. 

• Choose Close to end the replace session. 

8.1.3 Options for Search Criteria 

Select one or more options for of Find and Replace dialoge box explained below. 

• Match case: Find only the text that matches the uppercase and lowercase Letter of 

search text. 
 

If the Match case check box is selected, Office Word searches only for 

words that match the case of the word or phrase that you typed in the 

Find what box. For example, if you search for AKA, the result includes 

Figure 8.2: Replace Command 

 

Notes 8.1.2 Replace Command 

The Replace command, like the Find command, also finds specific text. It automatically 

replaces each occurrence of the text being searched with the replacement text. To search and 

replace text in, a document: 

• Choose Edit >> Replace. 

• Enter the text to search for in the Find What text box. 

• Choose all, Up or Down Search option. 

AKA but not aka 

 
• Find whole word only: Restrict the search ro entire words that match the Sepecified 

search text. 

• Use wildcard: Allow to specify wild card symbols in search text. 

• Sound like: Used to find different spelling of word that sound similar. 
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Not all language grammar proofing files auto-register after you copy the 

grammar files to a specific location. Therefore, it is always advisable to use 

the Setup program to install the grammar proofing files (and other proofing 

tools). 

 

If you use the built-in heading styles to format the headings in your 

document, you can automatically number the headings with the 

numbering format you choose. 

 
• Find all word forms: Find different grammatical version of a specified word. 

• Search: Controls the direction of the search beginning at the insertion point. The 

default direction is All. It also includes two other search options: Up and Down. 

Notes 

 

 
 

8.2 Proofing Documents 

One of the many useful features of word is that it can automatically check out document for 

spelling mistake. It has a built in English language dictionary. This dictionary is stored in 

the hard disk of the computer and it contains commonly used words in the English language. 

Word has a Spelling-Checker and Grammar-Checker programs to check documents for 

misspelled word, duplicate words, grammar, style, punctuation, and word usage. These 

programs also offers advice to fix potential problems. The automatic checking features catch 

the misspelled words and other errors immediately. 

8.3 Bullets and Numbering 
 

Bullets are used to set-off and emphasize sections of text and are symbols such as dots or 

diamonds. 

The numbering feature also acts like the bullets only that it use the number instead of 

symbol to represent. 
 

Uses of bullets and numbering 

• Break the long sentence into points form. 

• Enhance readability and credibility. 

Grab attention and highlight important points. 

Then, here I let you know how to apply bullet or numbering in Microsoft Word. 

 

 

The best way to end a list is to click either Body Text or Normal in the 

Styles box on the Formatting toolbar. 

 

To apply default bullet formatting to a list 

• Select the list you wish to apply number of bullet formatting to. 

• Click on the Bullets icon on the Formatting toolbar. 
 

 

 
Make a document and search any name and replace the another name. 
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Figure 8.3: Bullets and Numbering 

 

Notes To apply alternate bullet formatting to a list 

• Select the text you want to add bullets to. 

• From the Format menu, click Bullets and Numbering. 

• From the Bullets and Numbering dialog box displayed, the Bulleted tab should be 

displayed, if not, select it. 

• A list of different bulleted styles will appear, select a style that you like. 

• Click on the OK button or press Enter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To remove bullet formatting from a list 

• Select the list to which the bullet formatting has been applied. 

• Click on the Bullets icon on the Formatting toolbar. 

To add numbering to a list 

• Select the text you wish to re-format as a numbered list. 

• Click on the Numbering icon on the Formatting toolbar. 

To add alternative numbering styles to a list 

• Select the text you wish to re-format as a numbered list. 

• From the Format menu, click Bullets and Numbering. 

• From the Bullets and Numbering dialog box displayed, click on the Numbered tab. 

• A list of different numbered styles displayed, select the numbering format that you 

require. 

• Click on the OK button or press Enter. 

To remove numbering from a list 

• Select the list to which the bullet formatting has been applied. 

• Click on the Numbering icon on the Formatting toolbar. 
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Figure 8.4: A Header or Footer 

 
If you want to add a paragraph between items in a bulleted or numbered 

list, turn off bullets or numbering, type the text you want, and then turn 

bullets or numbering back on. 

Notes 

 
 

8.4 Header and Footer 
 

 

Word Header and Footer allow you to insert information at the top or bottom of every page. 

This information normally consists of chapter headings, page number, etc. 

You can see header and footer information on your screen when in Print Layout View and 

Print Preview, but not in the Normal view. 
 

To create a header or footer 

• From the View menu, click Header and Footer. 

• Word changes to Print Layout view and the Header and Footer toolbar is displayed. 

• Outlines of the Header and Footer text entry boxes appear at the top (header) and 

bottom (footer) of the page. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
• Insert the text for the header or footer in the appropriate text entry box. You can just 

type any text that you like. 

• You can change between header or footer by clicking on the Switch Between 

Header and Footer icon. 

• You also can click on the appropriate Header and Footer toolbar icons to insert the 

page number, time, date, etc in the header or footer. The following options are 

available: 

 

Icon Function 

Insert AutoText Inserts the default auto text. 

Insert Page Number Inserts page number into the header or footer. 



Unit 8: Microsoft Word-II 

142 

 

 

 

The Header and Footer toolbars are identical in Word 97 and Word 2000. 

 
Notes Insert Number of Pages Inserts the total number of the document. 

Format Page Number Format the page number. 

Insert Date Inserts the current date. 

Insert Time Inserts the current time. 

Page Setup Opens the Page Setup dialog box. 

Show/Hide Document Text Displays or hides document text. 

Same as Previous Section header/footers should be the same as the previous 

section, or new. 

Switch Between Header Toggle between allowing you to edit the header and 

footer. 

and Footer 

Show Previous Shows the previous section header/footer (only useful 

where a document is made up of multiple sections). 

Show Next Shows the next section header/footer (only useful where a 
document is made up of multiple sections). 

 
When you have entered your header and footer text, click on the Close button on the 

Header and Footer toolbar. 

 
 

Using the Date button will insert an updating date that will change to the 
current date each time you print. 

 
To move text in the header or footer text entry box 

• From the View menu, click Header and Footer. 

• In the Header or Footer text entry box, press the Tab key on your keyboard to move 

the cursor to the middle or right hand side of the entry box. 

• You also can use the Align Left, Right, Center, or Justify icons on the Formatting 

toolbar to do this. 
 

 

8.5 Working with Table 
 

Word tables provide a simple way to present information in a small space and in a readable 

format. After all, we’re used to reading table data in everything from train timetables to 

bank statements. Tables are a key feature of Microsoft Word, which includes lots tools that 

help you add functionality to your tables and work with them more effectively. 



 

 

 

To manually change the width of  a table or  column  after  youíve created 

it, use the mouse to place the pointer over the vertical line you want to 

move. When the pointer turns into a double-headed arrow, drag the line 

to the  position you want it in the table. 
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Figure 8.5: Table 
Notes 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

8.5.1 Designing Tables 

In Word, you can use the table drawing tools to edit it. With your table selected, click the 

Tables and Borders button on the Standard toolbar to display the Tables and Borders 

toolbar. To add lines to your table, click the Draw Table button and draw horizontal and 

vertical lines to split table  cells  in  two  or  draw  diagonal  lines  across  a  cell.  To  join  two 

or more cells to make one large cell select the Eraser tool and draw across the line between 

the cells. 
 

 

8.5.2 Table Headings 

When you have a table with lots of narrow columns, it can be difficult to use long headings 

because they donít display properly. The Tables and Borders toolbar includes a Change Text 

Direction button which lets  you  rotate  the  text in a cell so that it appears  either horizontal 

or in one of two vertical directions.  Choose one  of the vertical options  to rotate even very 

long column headings to fit a narrow column width. 

If a table consumes more than one page of your document it is useful to have the table 

headings repeated at the top of the second and subsequent pages so you can read the 

headings once you print the document. To do this, select the table rows that comprise the 
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Figure 8.6: Table Headings 

AutoFit to Contents 

AutoFit to Window 

Fixed Column Width 

 

 
Notes table headings and choose Table > Heading Rows Repeat. Now the selected rows appear 

at the top of the table on each subsequent page. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
8.5.3 Selecting Table Elements 

Some table options work differently depending on whether a cell is selected or not. For 

example, if you have a cell selected and you adjust the divider between it and the next cell 

only this one cell’s divider moves and not the border for the entire column. So, to adjust a 

column’s width, make sure you haven’t selected any cells before you drag its left hand border. 
 

Figure 8.7: Selecting Table Elements 
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When you first begin working with tables, selecting what you need to work with can be 

difficult until you discover where to hold your mouse pointer. To select a cell, hold the 

mouse pointer over its bottom right corner until it changes to a black angled arrow, click 

once to select that cell or click-and-drag to select multiple cells. 

To select a row, position the mouse pointer in the margin well to the left of the row until 

it shows as a large hollow arrow and click to select the row or click and drag to select 

multiple rows. To select an entire column, hold the mouse pointer above the top border of 

the column until it turns into a black down-pointing arrow and click once to select the 

column or click-and-drag to select adjacent columns. 

To select the entire table, place the mouse pointer over the top left corner of the table until 

a small box with a double-headed arrow in it appears. Click this icon to select the table. 

With the table selected, you can drag to move the table or, to delete the table, press the 

Backspace key. It’s helpful to note that pressing the Delete key deletes the table contents 

while leaving the table in place, and pressing the Backspace key deletes the entire table. 

 

Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

8.5.4 Working with Rows and Columns 

To add a column to a table, click at the top of the table just to the right of the last cell where 

the mouse pointer shows as a black down-pointing arrow. This selects the invisible markers 

at the end of each table row and displays the Insert Columns button on the Standard toolbar. 

Click this button to add a column. To add a row to a table, click in its bottom right cell and 

hit the Tab key. 

When adjusting the width of a column, you can read the column width from the ruler by 

holding the Alt key as you drag on the column’s right border. 

When you need a series of columns or rows to be the same height or width, first select the 

columns or rows to alter and drag the right-most or bottom border to the point where you 

want the table to extend. Now choose Table > AutoFit > Distribute Rows Evenly or 

Figure 8.8: Selecting Elements 
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Figure 8.9: Working with Rows and Columns 

Figure 8.10: Numbering Readjusts 

 
Notes Distribute Columns Evenly and the table rows or columns will readjust accordingly to even 

widths or heights. This is much quicker than trying to set each column or row height 

individually. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

When you need to reorder the rows in the table, you can do so with a simple keystroke 

combination. Click in the row you want to move or select multiple rows and hold the Shift 

+ Alt keys while you click the Up or Down arrow keys. This moves the selected row or rows 

up or down the table. If you move a table row to the bottom or top of the table and keep 

pressing, the row will split away from the table to form a second table. 

When you need to number rows in a table, use the paragraph numbering tool. To do this, 

select the column that will hold the numbered cells and click the Numbering button on the 

Formatting toolbar. Numbers are automatically added to the cells and—if they contain 

content—the numbering appears before each cell entry. If you alter the position of a row 

in the table, the numbering readjusts automatically. 
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8.5.5 Positioning Your Table 

When your table is not as wide as the page, you can adjust its positioning on the page and 

how text wraps around it. For example, to center the table between the left and right 

margins, select the table using the marker in its top left corner and choose Table > Table 

Properties > Table tab. Select the Center option and then select how text should wrap around 

the table. When you select the Around option, click the Positioning button to fine tune the 

text wrapping options as well as to configure the distance between the table and the 

surrounding text. 

8.5.6 Working with  Table Borders 

To adjust the table borders, select the borders you want to work with or select the entire 

table and choose Format > Borders and Shading > Borders tab. Select the border options and, 

from the Apply to list, select either Table or Cells depending on what you want to format. 

Then click OK to apply the changes. If you find this dialog confusing (and it is a little), use 

the options on the Tables and Borders toolbar to select the line style and color you want 

and then use the Draw Table button to draw the desired line style onto the table. 

Notes 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

8.5.7 Images in Tables 

When you are working with images in tables, you can constrain the image so it stays inside 

the table cell. To do this, click in the cell to place the image, choose Insert > Picture and then 

choose the ClipArt or From File option. Select the image to add to the table cell—by default 

it is added with the In-line with text layout. You can change this so that text in the table 

cell wraps around the image by choosing either the Square, Tight, Through, or Top and 

Bottom option from the Text Wrapping dropdown list. All these options constrain the image 

so it stays in the table cell. The options Behind Text and In Front of Text break the image 

out of the table so it either floats below or above it. 

Figure 8.11: Working with Table Borders 
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The user can check the spelling of an entire document, a selection of text, or a single word. 

To run the spell-checker from the menu: 

• Select the word or text to be checked. To check the entire document, make sure that 

nothing is selected. 

• Choose Tools >> Spelling and Grammar. 

Word stops automatically each time it find what it consider an error and then the Spelling 

and Grammar dialog box opens showing the error highlighted in red. 

The Check spelling as you type and Check grammar as you type settings 
will affect any open documents in Word. If other people use the documents, 

you may want to notify the people that you made this change. 

Figure 8.12: Correcting Spelling Errors 

 
Notes 

 

Tables are an extremely powerful feature in Microsoft Word. 

 

 

 

8.6 Correcting Spelling Errors 
 

 

 
 

The correcting spelling option are only suggest the some default spellings 
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8.6.1 Spelling Error Options 

 

Not in Dictionary The text is not a misspelled word but is being flagged 

because it is not in the dictionary. 

 

Suggestions 
 

Displays a list of suggested corrections and puts the most 

likely one at the top. 

Ignore To keep the word as it is. However, the checker will query 

the word if it reappears. 

Ignore All If you want the checker to accept the word for the entire 

document, click this option. 

Add Adds the selected word to the active dictionary. 

Change/Delete Accept, the suggestion in the Suggestion box. If the error is 

a repeated word, this button changes to Delete which are 

moves the repeated word. 

Change All/Delete Changes all instances of the selection in the current 

document. If the error is a repeated word, this 

button changes to Delete All. 

AutoCorrect Adds the error and its correction to the AutoCorrect list 

Options Opens Options dialog box. 

Undo Undoes the last correction made during the current spell 

check session. 

Cancel/Close Closes the dialog box. The Cancel button becomes the 

Close button after at least one change takes place. 

 
 

8.7 Quick Spelling Checking 

Notes 

 

The Spelling and Grammar button on the Standard toolbar is a quick way to check the 

spelling of a single word, a paragraph or any other selection of text. 

Another way to check spelling quickly is by pressing F7. 

Word can automatically check spelling as the user types the text in. To correct the error 

immediately, right-click the offending word to open a context-sensitive shortcut menu. The 

status bar also displays three icons indicating the current spelling grammar status of 

document. 
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Figure 8.14: Automatic Spell-Check 

 
Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8.8 Using Automatic Spell-Check 

Word automatically underlines misspelled words with a red wavy line. Spell-checking and 

underlining occurs as the user types. The steps to run an automatic spell-check are: 

• Select Tools >> Options menu he Options dialog box is displayed. 

• Select the Spelling & Grammar tab. 

• Select the automatic spell-checking check box. 

Figure 8.13: Quick Spelling Checking 
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• Choose tools >> Spelling and Grammar, to begin the grammar check 

• The Spelling and Grammar dialog box appear each time, when possible error is caught. 

8.9.1 Document Statistics and Readability Estimates 

When the grammar check is finish, Readability Statistics dialog box is displayed (Unless 

show readability statistics check box of Grammar Option button is opted). 

Figure 8.16: Document Statistics and Readability Estimates 

Figure 8.15: Grammar Command 

 
8.9 Using the Grammar Command Notes 

 

Word’s grammar-checker uses rules to identify problems in the user’s writing such as passive 

verbs, pronoun errors, possessive noun errors, homonym problems (like ‚‘there‛ and ‚their‛), 

and even political incorrectness. To deactivate spell-checker while checking grammar, choose 

Tools >> Options, click the Grammar tab, and uncheck the Check Spelling option and other 

rules. To run the grammar-checker from menu: 

• Select the sentence to be checked. For entire document, do not select anything 
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Figure 8.17: Using the Thesaurus 

 
Notes Document statistic in this dialog box include the number of characters, words, sentences, and 

paragraphs in the document. They also show the average number sentences per paragraph; 

words per sentence, and characters per word. The readability level of a document is often 

measured in term, of a grade level. 
 

8.10 Using the Synonyms Thesaurus 
 

 

A Thesaurus is a tool used to find a synonym (a word that means essentially the same as 

the word it replaces).Word’s Thesaurus also displays antonyms for some words. An antonym 

a word that means the opposite of the selected word. To use the Thesaurus to find synonyms: 

• Select the word whose synonym has to be found. 

• Choose Tools >> Language >> Thesaurus. This displays the Thesaurus dialog box. 

 

 

You can also press Shift and the F7 key simultaneously to activate the 

thesaurus. The thesaurus window pops up. 

 
 

• Select the required options. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8.11 Using AutoCorrect and AutoText 
 

Both the AutoCorrect and AutoText commands quickly insert frequently used boilerplate 

text and graphics. 

With AutoCorrect, Word inserts previously created entries (by user) automatically as the 

user types. Because AutoCorrect inserts text automatically as you type, you can use it to 

automatically correct your most common typing and spelling errors. 

AutoText entries are inserted after the user chooses the AutoText command or types the entry 

name and urea a shortcut key. 
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8.11.1 Creating AutoCorrect Entries 

Word comes with a set of predefined AutoCorrect entries, for example, to correct two initial 

capitals and to capitalize first letter of each sentence. There are two ways to create an 

AutoCorrect entry: 

• Add entries to AutoCorrect during a spell-check. 

• Add entries to AutoCorrect directly. 

Notes 

 

 

• Click the Exceptions button to enter exceptions to First Letter tab or the INitial CAps 

tab (optional step). 

• Click OK twice to return to the document. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To add entries to AutoCorrect directly: 

• Choose Tools >> AutoCorrect. This displays the AutoCorrect dialog box. 

• In the Replace text box, type the desired word that is often misspelt and need to be 

corrected automatically. 

• In the With text box, type the correct spelling of that word. 

• Click on the Add button. 

Figure 8.18: Creating AutoCorrect Entries 
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Figure 8.20: Auto Correct 

 
Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Word is already set up to automatically correct some words. For example 

if you type ‚hte‛ it will be corrected to ‚the‛ when you press  the 

spacebar. Word can learn your common mis-spellings and it is relatively 

easy to add new words. 

 

 

8.11.2 Creating AutoText Entries 

To create an AutoText entry: 

• Select the text to store as an AutoText entry. 

• Use the AutoText toolbar, or select Insert >> AutoText from the menu. 
 

Figure 8.19: Auto Correct Exception 
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Auto Text entries are divided into categories such as Closing or Salutation. 

Check the Normal category for entries you’ve created unless you know 

they are stored under another category. 

 
• Accept the default name, or type a new abbreviated name in the ‚Enter AutoText 

entries here‛ box. An AutoText name can have up to 32 characters, including spaces. 

• Click on the Add button. 

Notes 

 

 
 

8.11.3 Inserting AutoText Entries 

There are three ways to insert an AutoText entry. 

• Using Keyboard Shortcut 

❖ Position the insertion point where the AutoText entry will be inserted. 

❖ Type the name of the entry or just enough letters to uniquely identify the name 

of an AutoText entry. 

❖ Press F3 function key. 

• Using the AutoText toolbar 

❖ Position the insertion point where the AutoText entry will be inserted. 

❖ Click the scroll down menu in the middle of the AutoText toolbar. 

❖ Select the desired entry to insert, and press Enter. 

• Using the AutoText- dialog box 

❖ Position the insertion point where the AutoText entry will be inserted. 

❖ Choose Insert >> AutoText or click the ‚AutoText‛ menu on the AutoText toolbar. 

❖ In the Enter AutoText entries here box, type or select an AutoText name. 
 

 
Don’t create AutoCorrect shortcuts using text that would commonly be 

used for other things. For example, you wouldn’t want to use ‚mr‛ as a 

shortcut for ‚medical records‛ because if you tried to type ‚Mr. Jones‛, 

you would get ‚medical records‛ as soon as you typed the period at the 

end of ‚Mr‛. 

 

8.11.4 Using the  AutoComplete 

Word automatically finishes the word ‚Thursday‛ if user types thur and presses Enter. 

Similarly, typing the first couple of letters in your name prompts Word to finish it. This 

feature extends to months, current date, and your own AutoText entries. 

The Plain Text and Formatted Text options are only available if you 

selected the text from your document, rather than typing it into the 

‚With‛ box. Also, if you selected text to add to AutoCorrect, and it comes 

up with the Formatted Text already marked, then you should leave it as 

Formatted Text. If you change it to Plain Text, it may not work properly. 
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• Automatically hyphenate 

• Manually hyphenate 

• Insert optional hyphens 

• Insert non-breaking hyphens 

The hyphenation options are available through the Language option on the Tools menu. 

Template for Submitting Community Success Stories 

Usave  the  document  to  your  desktop. 

Community Success Story Template 

• Required Field 

• Program Name 

• Name of Organization 

• City 

• Province/Territory 

• Population Size Served 

• Program Start/End Date 

• Contact Name 

• Contact Phone/Email 

se the Microsoft Word document Success Story Template. Fill in the template and 

Introduction (Brief- i.e. location, target groups, need for program, organization(s) involved) 

• General description of the program (i.e. how the program was initiated, who was involved 

(leaders/partners), how was it funded, what actually happened) 

• Challenges/Solutions (i.e., anything to be done differently next time or advice for other 

communities) 

• End result of the program (i.e., what was accomplished, what feedback received? 

 
Notes On the Tools menu, click AutoCorrect and then click the AutoText tab. 

Select or clear the Show AutoComplete tip for AutoText and dates check box (refer to 

previous dialog box). 

8.12 Hyphenating Documents 
 

 

Hyphenating allows more text to be fitted on a page. It tightens justified paragraphs and 

reduces the ragged appearance of unjustified text. Word offers four methods to hyphenate 

text: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Contd... 
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Notes 

 

 

 

 

 

 

 
 

8.13 Summary 
 

• MS word tells us about specific functions, which we can use in the word documents. 

• Find and Replace option of word is convenient way of searching for particular word 

in whole document. 

• Numbering feature, it acts like the bullets only which used number instead of bullets 

in the text document. 

• Spelling and grammar button is the standard Toolbars to check the spelling and any 

graphemically errors in the text document. 

• Auto correct feature inserts text in the heard document automatically. 

 

8.14 Keywords 
 

AutoComplete: AutoComplete is a feature in Microsoft Word that enables Word to guess 

what you are typing when you enter commonly used document words. This feature can save 

time if you know how to use it. 

AutoCorrect: AutoCorrect is best used for creating shortcuts for words, phrases, and even 

images. For example, if you often type Microsoft Word, you could create a shortcut such as 

‚msw‛. Then any time you typed ‚msw‛, it would expand to Microsoft Word. 

AutoText: AutoText is best used for longer phrases or paragraphs (for example, ‚boilerplate‛ 

text for disclaimers or a standard closing for a letter). AutoText is also already setup with 

several standard AutoText entries. 

Footer: One or more lines of text that appear at the bottom of every page of a document. 

Once you specify what text should appear in the footer, the application automatically inserts 

it. 

Header: A header is the text that goes on the top of each page. In MS Word you can set it 

to automatically print on each page, along with a variety of other information, like the page 

number. 

Hyphenation: Hyphenation is the process of adding hyphens to words at the beginning of 

lines so the hyphenated part will fit at the end of the previous line. The hyphens are inserted 

between syllables in a word. 

Thesaurus: A thesaurus is a collection of synonyms and antonyms to a word. When you look 

up a word in a thesaurus, it will provide alternative words that you can also use. 

• Next steps (i.e., are there any future plans for the program?) 

• Conclusion (i.e., short summary, closing words of wisdom!) 

Questions: 

1. What is the use of template in word file? 

2. How to insert tamplate in the document file? 
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Notes 8.15 Self-Assessment Questions   

 

Multiple Choice Questions: 

1. Why are headers and footers used in document? 

(a) To enhance the overall appearance of the document 

(b) To mark the starting and ending of a page 

(c) To make large document more readable 

(d) To allow page headers and footers to appear on document when it is printed., 

2. Which of the following shortcut key is used to check spelling? 

(a) F1 (b) F2 

(c) F7 (d) F9 

3. What is the minimum number of rows and columns that a word table can have? 

(a) Zero (b) 2 rows and 1 column 

(c) 2 rows and 2 column (d) 1 row and 1 column 

4. What is the Thesaurus used for? 

(a) Spelling options (b) Grammar options 

(c) Synonyms and Antonyms (d) Opposite Words 

5. Which word processing utility could you use to find the synonym of a word? 

(a) Spell checker (b) Thesaurus 

(c) Out-liner (d) Grammar checker 

6. Which of the following is not the feature of MS-Word? 

(a) Margins and page length can be adjusted as desired 

(b) Spelling can be checked and modified through the spell check facility 

(c) Provides tools such as data consolidation, goal seek, scenario etc. 

(d) Multiple document/files can be merged 

7. If you need to edit header or footer of a document which menu should you access? 

(a) Insert (b) Edit 

(c) View (d) Tools 

8. Which menu should you access to create new footnotes? 

(a) Insert (b) Edit 

(c) View (d) Tools 

9. Text in a cell of a table in Word needed to be printed vertical, how can you perform 

this? 

(a) Click the free rotate button on drawing toolbar and rotate it to make vertical. 

(b) Select Flip Vertical from Draw Menu. 
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(c) Choose Text Direction from Format Menu 

(d) None of these 

State Whether True or False 

1. A Thesaurus looks up for synonyms and antonyms. 

2. All the words highlighted during a spell-check are spelled incorrectly and must be 

changed. 

3. Spelling-checker checks only for spelling not usage. 

4. AutoText feature is used to convert numeric entries into character entries. 

5. Word highlights words that are not in its dictionary when you end the word. 

6. AutoComplete features can be used to complete the documents automatically by 

inserting specified text at specified location in the document. 
 

8.16 Review Questions   

Notes 

 

1. List some of the word proofing tools. 

2. What is the AutoText feature used for? 
 

3. How can you automate the word correction process? How will you create an 

AutoCorrect entry? 

4. What are the various spelling error options available in Word? 

5. What is the use of Grammar command? 

6. What is Thesaurus? 
 

7. In your document, you have typed the word file as ‚file‛ but you want to find and 

replace all the occurences of this word to ‚File‛. How would you do this? 

8. How will you create an AutoText entry? 
 

9. What do you understand by AutoComplete feature of Word? 

10. Briefly explain how would you search a particular character in the document and 

replace it with another. 

Answers for Self-Assessment Questions 

Multiple Choice Questions: 

 

 

 

 
 

Tru 

1. (d) 2. (c) 3. (d) 4. (c) 

5. (b) 6. (c) 7. (c) 8. (a) 

9. (c) 

e or False: 

    

1. True 2. False 3. False 4 False 

5. True 6. True    
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Notes 8.17 Further Reading   

 
Fundamental Computer Concepts, William S. Davis 
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Objectives 

After studying this unit, you will be able to: 

• Understanding of handling Graphics in MS Word 

• Explanation of setting page size and margins 

• Understanding of printing document 

• Discussion of mail merge 

• Working of mail merge 

 

Introduction 
 

Microsoft Word is part of the Microsoft Office. Its main function is for producing documents 

that can includes text, graphics, table, clip art, etc. 

 

9.1 Handling Graphics 

Adding graphics or picture to illustrate your documents makes them more appealing. 

Graphics format falls into two camps: bitmap and vector. Bitmap graphics are composed of 

small dots, called pixels. Each pixel is represented by one or more bits in the computer’s 

memory that define colour and intensity. Vector graphics, in contrast comprise of a set of 

drawing instructions that describe the dimension and shape of every line, circle, arc, or rectangle. 

9.1.1 Inserting Pictures in Documents 

In Word, a picture can be inserted in the document in one of three ways: 

• Use the Insert >> Picture command and choose either the Clip Art or From File submenu. 

• Use the Insert >> Object command to insert a picture that you plan to link to a graphics 

program. 

• Open the program used to create picture, and copy (or cut) a picture to the Windows 

clipboard. Then use the Edit >> Paste command to paste the picture into your Word 

document. 

9.1.2 Inserting Clip Art and Pictures 

Choose Insert >> Picture >> Clip Art, Microsoft Clip Callery 3"0 dialog box appears with Clip 

Art tab selected. 

• Choose Insert button after selecting the desired picture. 

• Microsoft Office and Word comes with a Clip Art library of pictures. Office stores the 

Clip Art in the folder Microsoft Office\Clipart. 

9.5 Summary 

9.6 Keywords 

9.7 Self-Assessment Questions 

9.8 Review Questions 

9.9 Further Readings 
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• To insert a picture from a file into document: 

O Position the insertion point where the picture will be inserted. 

O Choose Insert >> Picture >> From File. The Insert Picture dialog box appears. 

O From the file name list, select the picture file that you want to insert. 

O Choose Insert. 

Notes 

 

 

Search for clips: Type one or more word ...   

   Pictures  Sounds   Motion Clips   

 Categories 1 - 51 

New Category  Favorites Academic Animals Backgrounds 

Borders & Frames Buildings Business Buttons & lcons Cartoons   

9.1.3 Insert Picture Objects in Documents 
A picture object is a picture that can be edited in a Word document. It is not linked to a file 

outside the document. 

Figure 9.2: Inserting Picture Objects in Documents 

Figure 9.1: Inserting Clip Art and Pictures 

Help Clips Online Import Clips 

Insert ClipArt 
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Notes To insert a picture object into document: 

• Position the insertion point where the picture object will be inserted. 

• Choose Insert >> Object dialog box appears. 

• Do one of the following: 

O To create a new picture select Create New tab. From The Object type list, select the 

type of picture object to insert. Choose OK. 

O Select the Create from File tab, to insert an existing file. 

• Return to Word document from graphics program. 

9.1.4 Linking Graphics 

If you are using a graphic created in another Word-compatible program, you can choose 

Link to file in the Insert Picture dialog box (Insert >> Picture >> From File) or in the Create 

from File tab in the Object dialog box (Insert >> Object). To link picture file to a Word 

document: 

• Position the insertion point where the picture will appear. 

• Choose Insert >> Picture >> From File and select the picture file to insert. 

• Choose the Link to the file option and clear the Save with document option. 

• Choose Insert. If you move or edit the original picture file, you can update the link by 

positioning the insertion point on the picture placeholder and pressing F9. 

9.1.5 Resizing and Cropping Pictures 

A picture can be scaled or stretched to a smaller or larger size: proportionally or non- 

proportionally. You can crop parts of a picture that you do not want to display. 

To resize and crop a picture using the mouse: 

• Select the picture you want to resize or crop. Display the Show Picture toolbar using right 

click. 

• Do one of the following: 

O To crop the picture, click the Crop button in the Picture toolbar. 

O To resize the picture, move the mouse pointer over a selection handle. The pointer 

turns into a two-headed arrow. 

To resize and crop a picture using Picture dialog box: 

• Choose Format >> Picture or choose the Format Picture button to display the Format 

Picture dialog box. 

 

 

 
 

If the inline graphics in your document appear ‚chopped off,‛ it could be 

directly related to the formatting within the paragraph containing the 

graphic. 
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9.1.6 Drawing in Word 

Word’s drawing features are built directly into Word. Using Word, the user can create vector 

images, called ‚objects‛. A Word drawing can comprise many objects, such as lines and circles. 

These objects which you draw, appear directly on the page. You then can move them anywhere 

on the page. 

Using the Drawing Toolbar 

• In Word, a drawing can be created using the Drawing toolbar. 

• Click the Drawing button on the Standard toolbar. 

• Figure below shows a floating drawing toolbar. 
 

9.2 Setting Page Size and Margins 
 

Working with sections is essential to create a page with multiple columns. Page formatting 

includes margins, headers, footers, and page numbers. 
 

Sections 

Section breaks divide a document into sections. By default, Normal template creates and entire 

document as a single section. Sections are used for any of the following type of formatting 

• Columns 

• Headers and Footers 

• Margins 

• Page Orientation 

• Page Numbering 

Figure 9.3: Resizing and Cropping Pictures 
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Section breaks are always visible in Normal view. They appear as double-dotted lines containing 

the words ‚End of Section‛. A section break mark the point in a document where new formatting 

begins. To insert a section break: 

• Position the cursor from where a new section starts. 

• Choose Insert >> Break. 

• Choose one of the following options in the Section break types. 

O Next page radio button to insert a section break and begin the new section at the 

top of the next Page. 

O Continuous radio button to insert a section break and begin the new section on the 

same page, below the previous section. 

O Even page radio button to insert a section break and begin a new section on an even-

numbered page. 

O Odd page radio button to insert a section break and begin a new section on an 

odd-numbered page. 

Figure 9.4: Inserting Section Breaks 

 
 

Create a document and use page break. 

Notes To change the default margins, click Margins after you select a new margin, 

and then click Custom Margins. In the Page Setup dialog box, click the 

Default button, and then click Yes. The new default settings are saved in 

the template on which the document is based. Each new document based 

on that template automatically uses the new margin settings. 

 

 

9.2.1 Inserting Section Breaks 
 

• Choose OK. 

To delete a section break, select the section break and press the Del key. 
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You can also use the Horizontal alignment option buttons to position your 

graphic quickly, or you can drag the graphic to where you want it. 

9.2.2 Working with Columns 

Word enables you to create newspaper-style columns to make text more appealing and readable. 

Two methods of creating columns are: 

• Choose the Format >> Columns command. 

• Choose the Columns button on the Standard toolbar. 

The first method opens a dialog box from which the desired formatting can be selected. 

Notes 

 

 
• Position the cursor in the section for which you want to set the margins, or select the text 

or sections you want formatted. 

• Choose File >> Page Setup. The Page Setup dialog box appears. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
The second method can be used to select the number of evenly sized and spaced columns (upto 

six). Both methods automatically switch to Print Layout view. 

9.2.3 Formatting Pages 

Formatting pages means changing the margins, paper size, orientation or headers and footers. 

Word enables you to apply page setup formatting options to a selection, a section, multiple 

sections, or the entire document. 

9.2.4 Setting Margins 

Margins are the borders on all four sides of a page within which the text of the document is 

confined. Word sets default margins with a 1 inch top and bottom margins and 1.25 inch left 

and right margins. 

Setting margins by using the Page Setup dialog box: 

Figure 9.5: Working with Columns 
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Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To change the default margins, click Margins after you select a new margin, 

and then click Custom Margins. In the Page Setup dialog box, click the 

Default button, and then click Yes. The new default settings are saved in 

the template on which the document is based. Each new document based 

on that template automatically uses the new margin settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Select the Margins tab. 

• Choose the Top, Bottom, Left, or Right margin settings. 

• Choose OK after you are satisfied with the new margins. 

A convenient way to set margins for your document or for a section is to use the rule and 

mouse. You must display the document in Print Layout or Print Preview view to change the 

margins on all four sides of your document. To change margins with a ruler: 

• Position the cursor in the section where you want to set the margins. 

• Choose View >> Page layout. If your ruler does not appear, choose View >> Ruler to 

display it. 

• Position the pointer over the margin boundary that you want to change. 

• Drag the margin boundary towards the edge of the page to make the margin smaller or 

towards the centre of the page to make the margin wider. A dotted line appears showing 

you where the new margin will be. Holding down the Alt key as you drag variables you 

to see margin measurements in the ruler. 

If you change your mind about changing a margin, press Esc before you release the mouse 

button or click the Undo button (or choose Edit >> Undo) after you release the mouse button. 

Figure 9.6: Setting Margins 
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Changing Paper Size and Orientation 

Changing the paper size enables you to create documents other than the standard 8.5 x 11 

inches. Word provides several predefined standard paper sizes such as legal, executive, and 

envelope. It also gives you the option of defining your own customized paper size. To set 

paper size and orientation: 

• Position the cursor in the section for which the paper size and orientation has to be set, 

or select the text or sections. 

Notes 

 

 

• Choose OK. 

9.2.5 Changing Pagination 

Word starts a new page automatically when the current page is full. These page breaks are 

called ‚soft breaks‛. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Choose File >> Page Setup. 

• Select the Paper Size tab. 

• Do either of these: 

O Choose a predefined paper size from the Paper size list, or type the width and 

height of customized paper size. 

O Choose Landscape (horizontal, sideways page) or Portrait (default vertical, upright 

page) from Orientation group. 

Figure 9.7: Changing Paper Size and Orientation 
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9.2.6 Aligning Text Vertically on a Page 

Word provides three options for vertical alignment of text on a page: Top, Center and Justified. 

These options determine how Word aligns a partial page of text between the top and bottom 

margins. To vertically align text on the page: 

• Position the cursor inside the section containing the text for alignment. 

• Choose File >> Page Setup. 

• Select the Layout tab. 

• Choose one of the options in the Vertical alignment list. 

• Choose OK. 

Figure 9.8: Aligning Text Vertically on a Page 

Notes If you want to force a page to break at a particular place in your document, insert ‚hard page 

break‛. Word always starts text following a hard page break at the top of the next page. To 

insert a hard page break: 

• Position the cursor at the beginning of the text from where the new page is to start. 

• Do either of the following: 

O Choose Insert >> Break, choose Page break option and choose OK (refer to Break dialog 

box). 

O Press Ctrl + Enter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Creating Headers and Footers 

Headers and footers are word processing holding areas for repetitive information that must 

appear either in the top margin (header) or in the bottom margin (footer) of every page of the 

document. You can create different headers and footers for different sections of document. 

They can also be different for odd and even pages (refer Page Setup dialog box). Table below 

explains the function of the buttons on the Header and Footer toolbar. 
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9.2.7 Header and Footer Toolbar 

Button Name Description 

Insert AutoText Displays drop-down list of AutoText entries. 

Insert Page Number Inserts a page number field. 

Insert Number of Pages Inserts total number of pages in document. 

Format Page Number Open Page Number Format dialog box. 

Notes 

 

 

Insert Date 
 

 
Insert Time 

Page Setup 

Show/Hide Document Text 

 

 
Same as Previous 

Switch Between Header and 

Show Previous 

Show Next 

Close 

Inserts a date field. Uses whichever date format you 

last chose in using the Insert > > Date and Time 

command. 

Inserts a time field. 

Opens Page Setup dialog box. 

Toggles between displaying dimmed body text and 

graphics in the background or showing no text in 

background. 

Links or unlinks a header from preceding section. 

Toggles between displaying header and Footer footer. 

Shows header or footer for preceding section. 

Shows header or footer for next section. 

Closes the Header and Footer toolbar. 

To add header or footer to the entire document: 

• Choose View >> Header and Footer. \Word displays the Header and Footer toolbar. 
(See Figure 9.9). 

Figure 9.9: Header and Footer 
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9.3 Printing Documents 

Click the Print button in the Standard toolbar, the document goes directly to the printer. To 

specify what exactly has to be printed use the File < < Print command to display Print dialog 

box. 

Figure 9.10: Printing of Document in Microsoft Word 

• You can use most of the commands in the Insert, Format, Tools, and 

Tables menus to the format headers, and footers. 

• To edit a he.ader and footer, use the same command you used to 

create it, or in the Print Layout view, double-click the header or footer. 

Notes • To switch between header and footer click the Switch Between Header and Footer button. 

• Type the text for header or footer within the dashed line that surrounds the header or footer 

area. 

• Use the Header and Footer toolbar buttons to insert the fields in the header or footer. 

• Choose Close or double-click the document to close Header and Footer toolbar and 

return to document. 
 

9.3.1 Using Print Preview before Printing 

Print Preview command is used to view document in a variety of ways. To preview a document 

in Print Preview: 

• Choose File >> Print Preview or click the Print Preview button on the Standard toolbar. 

• To close Print Preview, choose the Close button. 
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Button Name Action 

Print Prints the document by using default print options. 

Magnifier Enlarges or reduces the document view. 

One Page Displays the document in single-page view. 

Multiple Page Views one or more pages of a document. 

Zoom Control Select different magnifications, from 10 to 500 percent 

and other options. 

View Ruler Displays or hides the horizontal and vertical rulers. 

Shrink to Fit Shrinks document to fit on one page or less if the last 

page of document contains only a few lines of text. 

Full Screen Removes title bar and toolbars to show a full screen 

display of the document in Print Preview. 

Close Preview Closes Print Preview and returns to your document. 

Context Sensitive Provides Context-Sensitive Help for Print Preview Help 
options. 

Most printers require a minimum width for margin settings, because they 
can’t print all the way to the edge of the page. If you try to set margins 

that are too narrow, Microsoft Word displays the message One or more 

margins are set outside the printable area of the page. 

 

 

Insert a picture from clipart and use sort key of print and print the picture. 

Notes 

 

 

 

 

 

 

 

 

9.4 Mail Merge 
 

Word’s mail merge feature helps in quickly creating documents by combining information 

from two different files. In mail-merge, you write a letter in one document, enter all your 

recipients names and addresses in another, and then merge the two to produce as many 

The Print Preview Toolbar 

Figure 9.11: Print Preview Toolbar 
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Notes copies as needed. Mail merge enables you to personalize form letters for mass mailing, 

product announcements, customer letters, reports, and invitations. With mail-merge, it is 

also possible to combine a list of names and addresses to create invoices and mailing labels. 

So, instead of typing many individual letters and changing the variable information in each 

letter, you can tell Word to merge the letter and the variable information, which saves you 

effort required to type and time. So, if you have a dozen identical letters to write, then you 

can use mail-merge feature of Word to get the desired results in no time. In this section, you 

will learn how to use the mail-merge feature to create form letters, envelopes, and mailing 

labels. 

9.4.1 Merging Letter and Address Files 

Mail Merge helps in generating multiple copies of a base document (the content of a letter) 

incorporating some variable information (the name and address of a person) such that each 

copy appears to the recipient as an original document. Mail Merge saves the user from the 

effort of typing in each copy separately. The process is called ‚merging‛, and does the following 

operations: 

• Print personalized letters addressed to any number of recipients. 

• Print envelopes for the letters. 

• Print mailing labels. 

• Print lists and catalogs. 

The Mail Merge process involves: 

• Creating a main document that contains text with some place markers embedded within 

the text. 

• Creating a data source document that lists sets of text that will replace the place markers 

in the main document. 

• Finally, when Word merges the two files, the result is a set of documents, one document 

for each set of text in the data source document. 

The best known use for merging is creating form letters. A typical main document for a form 

letter consists of the text of the letter with markers indicating positions for an addressee’s 

name/ street, address, city, state, and pin code. The data source document contains a list of the 

actual addressee’s names and addresses. Word merges the two documents together to print 

personalized letters. 

9.4.2 What is Merging 

The two main documents used by Word in the mail merge process are: 

• a main document 

• a data source document. 
 

The Main Document 

The main document for a form letter contains the text and perhaps graphics, that should be in 

every letter. The words enclosed in chevrons (<< and >>) in the main document are the field 

codes that identify data to be inserted from the data source document. Other text in the main 

document (text not enclosed in chevrons) will appear in every letter. 
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The Data Source Document 

Data sources are organized collections of information—databases—that you can create easily 

in Word table. Word can also use data from other applications, such as Microsoft Excel or 

Microsoft Access, All data sources, no matter where they come from, contain records and 

fields. Data contains the information that replaces field codes in the main document. 

Putting the Two Together 

After creating a main document and a data source document, the only thing left is to tell Word 

to merge them. The result is a set of customized letters. 

9.4.3 Writing Form Letters 

Word guides you smoothly through the process of creating a form letter. You simply follow 

the instructions in a sequence of dialog boxes. 

Building a New Merge Structure 

To begin creating a set of form letters proceed in the following manner. 

• Open an empty document, choose Tools >> Mail Merge to open the Mail Merge Helper 

dialog box. 

Notes 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Choose the Create button to open a list of the types of documents you can create. 

• Choose Form Letters open a dialog box in which you choose the Active Window or New 

Main Document. 

• Choose New Main Document option if you started the Mail Merge command before 

creating the form letter. Choose the Active Window, if you started the Mail Merge 

command after creating the form letter. 

Creating the Data Source Document 

Next, you need to create or specify the data source and arrange the fields that you want to be 

available to your main document for the merge. To define the source data: 

Figure 9.12: Building a New Merge Structure 
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Notes • Choose the Get Data button from the Mail Merge Helper dialog box, to display the list 

box given below. 

• If you already have a data source that you want to use, select Open Data Source. If you 

want to create the data source, select Create Data Source to display the Create Data 

Source dialog box. 

It offers a list of commonly used field names. Select the predefined field names, change or 

delete some of the field names, or add other field names. 

• Choose OK button of Create Data Source dialog box, a Save As dialog box appears. 

Word saves the empty data source document and displays the dialog box shown below. 

• Choose Edit Data Source to display the Data Form dialog box. 

• In Data Form box, enter the details of records in the text boxes provided in front of the 

field names. 

• Press Tab or Return key to move to the next field. 

• To add a new record, select the Add New button. 

• To delete a record, display the record then choose the Delete button. 

• The Restore button brings the entries to their previous state. 

• To search for any word or part of a word in any field, select the Find button. Type the 

text you want to search in the Find what text box, also specify in which field this text 

will be found. Then click the Find First button. 

• Click OK to close Data Source and save the changes (to save data just entered). 

Mail Merger Helper dialog box reappears where you can work on the form letter’s main 

document. Click on Edit button under Main document heading. 

• A Mail Merge toolbar appears at the top of the screen (Main document). 

9.4.4 Functions of the Mail Merge Toolbar Buttons 

Name Function 

Insert Merge Field Inserts a merge field into the main document. 

Insert Word Field Inserts a Word field into the main document. 

View Merged Data Toggles between viewing merge fields and merged data. 

First Record To go to the first record in a data source document. 

Previous Record To go to the previous record in the data source document. 

Go to Record To go to specific record in the data source document. 

Next Record To go to the next record in a data source document. 

Last Record To go to the last record in a data source document. 

Mail Merge Helper Displays the Mail Merge Helper dialog box. 

Check For Errors Check for errors in the merged document. 

Merge To New Displays merged document on-screen. 



Notes Merge To Printer Print merged documents. 
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In this step, you can choose Merge To New Document button of the Mail 

Merge toolbar for the same. 

 

Mail Merge Displays Merge dialog box. 
 

Find Record Finds a record in the data source document. 

Edit Data Source Edits the data source document. 

9.4.5 Creating the Form Letter 

In the empty main document, place two types of data: text that appears in every letter and field 

codes to mark the positions where text from the data source document will be inserted. 

9.4.6 Inserting Merge Field 

• Place the insertion point where you want to insert field name. Choose the Insert Merge 

Field button of the Mail Merge toolbar to display a list of fields in the data source 

document. 

• Select the desired field name to insert into the document. 

• The field name is enclosed in chevrons automatically. 

• Click the Insert Merge Field button again to insert each field in the document. 

• Type the body of the letter, that is, the text that is common. 

• After completing the main document, save it. 

9.4.7 Mail Merge Error Checking 

Error checking is an important step before you start printing. To check main and data source 

documents for error: 

• Choose Merge in the Mail Merge Helper dialog box to display the Merge dialog box or 

click Mail Merge tool from the Mail Merge toolbar. 

• Choose Check Errors button to display the Checking and Reporting Errors dialog box. 

• Choose the second option (the default option), or one of the other options you prefer and 

then choose OK. If \ford detects no errors, the Merge dialog box reappears, otherwise 

it displays a message box to tell the user the nature of that error. 

• Choose the New document from the Merge To list box and then click Merge button of 

the Merge dialog box to create a new document that contains all your merged documents 

as a single document as shown in the figure below. 
 

 

9.4.8 Merging Specific Records 

A query enables the user to specify conditions under which a record in the data source document 

is included when merged. A query can be quite simple, such as asking for records for people 

in one state, or more complex, such as asking for all the records that have surname ‚Singh‛ 

living in ‚Lucknow‛ city. To prepare: 

• Open the main document — Form Letter. 



Notes • Query options dialog box can be activated using one of the following: 
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• Select the Filter Records tab. 

• In the Field column choose the field you want to use as a filter, for example, City. 

• In the Comparison drop-down list, choose the appropriate comparison operator (Equals 

to, less than). 

• In the Compare to box, type the required filtering criteria, for example, Lucknow. Word 

automatically prepares for an additional query condition by adding And/Or to the 

second line for more complex queries. 

• Choose OK to return to the Mail Merge Helper or Merge dialog box. 

• Choose Merge (if using Mail Merge Helper dialog box). 

• In the Merge dialog box, select New Document or Merge to Print in the Merge to list box 

and the AII button in the Records to be merged section, and choose Merge. 

Figure 9.13: Merging Specific Records 

O Choose Tools >> Mail Merge, and from the Mail Merge Helper dialog box, choose 

Query Options button. 

O Click Mail Merge Helper button on the Mail Merge toolbar and choose Query Options 

button. 

O Choose the Merge button of the Mail Merge toolbar to display the Merge dialog box, 

choose Query Options button. 
 

 

9.4.9 Setting the Record Order 

By default, Word prints merge documents in the same order as records occur in the data source 

document. By using the Sort option, you can change this order. To sort records: 

• Display the Query Options dialog box (described above). Then display the Sort Records 

tab. 
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Notes 

 

 

 
• In the Sort By list box, select the field by which records will be sorted. 

• Choose the Ascending or Descending option according to the preference. 

• Choose OK to return to the Merge dialog box. 

9.4.10 Creating Envelopes and Mailing Labels 

You can also use Word’s Mail Merge Helper to merge labels of various kinds and envelopes. 

The procedures to merge labels and envelopes are similar to that of for letters, we will discuss 

them only briefly here. 

Using Mail Merge to Print Envelope 

The steps you follow to print envelopes, using an already—existing data source document, 

are similar to those you use to create form letters except that the envelope is the main 

document. 

Getting Ready to Print Envelope 

Preparing to print envelopes is a matter of identifying the data source document, or creating 

one if it does not already exist, and selecting the envelope size and layout. To identify the data 

source document: 

• Choose Tools >> Mail Merge. 

• Choose Create >> Envelopes, and choose New Main Document. 

• In the Mail Merge Helper dialog box, choose Get Data. 

• To use the existing data source document, select Open Data Source. If you do not have 

one, choose Create Data Source. 

Now to select an envelope size and layout: 

• Choose Set Up Main Document to display the Envelope Options tab of the Envelope 

Options dialog box. 

 Figure 9.14: Setting the Record Order  

   

 Query Options  

 
Filter Records Sort Records 

 

  Sort by   
 

 Ascending Descending 
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  Then by 

 
 Ascending Descending 

 

 
 Clear All OK Cancel  
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• In the Mail Merge Helper dialog box, choose Get Data. 

• To use the existing data source document, select Open Data Source. If you do not have 

one, choose Create Data Source. 

Now to select an envelope size and layout: 

• Choose Set Up Main Document to display the Envelope Options tab of the Envelope 

Options dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

• In the Sort By list box, select the field by which records will be sorted. 

• Choose the Ascending or Descending option according to the preference. 

• Choose OK to return to the Merge dialog box. 

Creating Envelopes and Mailing Labels 

You can also use Word’s Mail Merge Helper to merge labels of various kinds and envelopes. 

The procedures to merge labels and envelopes are similar to that of form letters, we will 

discuss them only briefly here. 

Using Mail Merge to Print Envelope 

The steps you follow to print envelopes, using an already—existing data source document, are 

similar to those you use to create form letters except that the envelope is the main document. 

Getting Ready to Print Envelope 

Preparing to print envelopes is a matter of identifying the data source document, or creating 

one if it does not already exist, and selecting the envelope size and layout. To identify the data 

source document: 

• Choose Tools >> Mail Merge. 

• Choose Create >> Envelopes, and choose New Main Document. 

Figure 9.15: Getting Ready to Print Envelope 



181 

 

 

Mailing Labels 

The process of preparing and printing mailing labels is same as that of envelopes. 

• Choose Tools >> Mail Merge. 

• Choose Create >> Mailing Labels, and choose New Main Document. 

• In the Mail Merge Helper dialog box, choose Get Data. Choose either existing data 

source document or create new data source document. 

• Word will then invite you to setup your main document. Choose Ser Up Main Document 

to display the Label Options dialog box. 

• When you have chosen the labels to use, choose OK to close the dialog box. 

Figure 9.16: Mailing Labels. 

Printing the Envelopes 

To print one or two sample envelopes: 

• Choose Merge from the Mail Merge Helper button to display the Merge dialog box. 

• In the Merge to list box, select Printer. 

• Choose Merge button, to display the Print dialog box. 

• Choose OK to print the envelopes. 

Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
• Word displays the Create Labels dialog box. Use the Create Labels dialog box to place 

merge fields from the data source document into the label. 

• Choose OK to return to Mail Merge Helper, and then select to Edit the main document. 

Word will enter your label fields into the main document. 

• To print labels, follow the same process of merging, checking, and printing labels as you 

did for envelopes. 
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Notes  

 

Overview of Creating a SmartArt Graphic 

ost content that is created by using 2007 Microsoft Office system programs is 

textual, even though the use of illustrations improves understanding and 

memory and encourages action. Creating designer-quality illustrations can 

be challenging, especially if you are not a professional designer or you cannot afford 

to hire a professional designer. If you use earlier versions of Microsoft Office, you can 

spend a lot of time getting shapes to be the same size and to be aligned properly, 

getting your text to look right, and manually formatting the shapes to match the 

document’s overall style, instead of focusing on your content. With the new 2007 Office 

release feature called SmartArt graphics, and other new features such as themes (theme: 

A set of unified design elements that provides a look for your document by using color, 

fonts, and graphics.), you can create designer-quality illustrations with only a few clicks 

of your mouse. 

You can create a SmartArt graphic in Microsoft Office Excel 2007, Microsoft Office 

PowerPoint 2007, Microsoft Office Word 2007, or in an e-mail message in Microsoft 

Office Outlook 2007. Although you cannot create a SmartArt graphic in other 2007 

Office release programs, you can copy and paste SmartArt graphics as images into 

those programs. 

Applies only to Microsoft Office PowerPoint 2007 

Because Office PowerPoint 2007 presentations often contain slides with bulleted lists, you 

can quickly convert slide text to a SmartArt graphic. In addition, you can add animation 

to your SmartArt graphic in Office PowerPoint 2007 presentations. 

When you create a SmartArt graphic, you are prompted to choose a type of SmartArt 

graphic, such as Process, Hierarchy, Cycle, or Relationship. A type is similar to a category 

of SmartArt graphic, and each type contains several different layouts. After you choose 

a layout, it is easy to change the layout for your SmartArt graphic. Most of your text and 

other content, colors, styles, effects, and text formatting are automatically carried over to 

the new layout. 

When you select a layout, placeholder text (such as [Text]) is displayed, so that you can 

see how your SmartArt graphic looks. Placeholder text is not printed, nor is it displayed 

during a slide show. However, the shapes are always displayed and printed, unless you 

delete them. You can replace the placeholder text with your own content. 

As you add and edit your content in the Text pane, your SmartArt graphic is automatically 

updated — shapes are added or removed as needed. 

You can also add and remove shapes in your SmartArt graphic to adjust the structure of 

the layout. For example, even though the Basic Process layout appears with three shapes, 

your process may need only two shapes, or it may need five shapes. As you add or 

remove shapes and edit your text, the arrangement of the shapes and the amount of text 

within those shapes is updated automatically—maintaining the original design and border 

of the layout for your SmartArt graphic. To quickly add a designer-quality look and 

polish to your SmartArt graphic, apply a SmartArt Style to it. 

 

 

Contd... 

M 
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9.5 Summary 
 

 

• The MS Word give your documents a professional look using formatting options available 

in word 2000. 

• Using character spacing feature of word it is possible to increase or decrease the amount 

of space between characters. 

• In MS word text effects facility can be used to give a blinking background to the text. 

• Using various buttons available on the formatting Toolbars, the font, font style, and front 

size can be changed. 

• Wizards are easy to use program supplied with word that enable the user to create 

documents by answering a series of questions. 

• A wizard creates a formatted documents for the user and prompts to include item the 

user may otherwise forget using a letter wizard, it is possible to create a letter by providing 

the recipients name, delivery address, sender’s name, and return address. 

• Template is just as a framework boilerplate or master pattern that defines documents, 

appearance and may define some of its contents. 

• In the mail merge process, two main documents are used by word, a main document and 

a data source document. 

• Using mail-Merge it is also possible to create and print envelops and mailing tables. 
 

9.6 Keywords 
 

Clip Art: Clip Art is a graphic or picture. Clip Arts are available in many styles and formats. 

Data Source: Data Source is also called the Data File. It stores information to be brought into 

the Main document. The data file table contains a column for each category of information, or 

data field, in the data file. The Header Row is the first row of the table. It contains field names, 

which indicate the type of information in each column. 

Form Letter: Form letter is the resultant document of the mail merge operations, which 

contains the copy of the main document along with each piece of information stored in the 

data file. 

Gutter Margin: A gutter margin is the white space formed by the adjoining inside margins of 

two facing pages in a book, or the space between columns on a page. 

Main Document: In Mail Merge, Main Document is the common letter, which contains the 

common information for each of the merged document. It also contains the field names, which 

contain the instructions for carrying out the merge. 

Page margins: Page margins are the blank space around the edges of the page. In general, you 

insert text and graphics in the printable area between the margins. 

Questions: 

1. How is SmartArt graphic useful in present era? 

2. What are the basic concepts of using SmartArt graphic in MS Word 2007? 
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Notes Sections: A portion of a document in which you set certain page formatting options. You create 

a new section when you want to change such properties as line numbering, number of columns, 

or headers and footers. 

Section break: A mark you insert to show the end of a section. A section break stores the 

section formatting elements, such as the margins, page orientation, headers and footers, and 

sequence of page numbers. 

 
1. What would you do if page numbering doesn’t restart with each 

record in completed merge? 

2. How do you amend, add or remove mail merge fields? 

 
 

9.7 Self-Assessment Questions 
 

1. Merge printing is used to generate multiple copies of the same document with personalized 

information on each copy. 

(a) True (b) False 

2. Mail merge feature of Word can be used to create greeting cards containing text and 

pictures. 

(a) True (b) False 

3. Data source contains the information that is to be sent to all the recipients. 

(a) True (b) False 

4. If errors occur during the mail-merge process, there is no way to correct those errors. 

(a) True (b) False 

5. Specific records of data source can be combined during the merge process. 

(a) True (b) False 
 

9.8 Review Questions 
 

1. What would you do if page numbering doesn’t restart with each record in completed 

merge? 

2. How do you amend, add or remove mail merge fields? 

3. If your email addresses aren’t inserted as hyperlinks in the completed merge how would 

you do that? 

4. What do you understand by Mail Merge? 

5. Define the different components of Mail Merge. 

6. How do you invoke ‘Mail Merge Helper’ window? 

7. Differentiate between Merge and Query option of ‘Mail Merge Helper’ window. 

8. How will you create a data source document? 

9. How will you merge specific records of data source? 

10. Briefly explain the process of preparing and mailing labels. 
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11. What is the difference between a hard page break and a soft page break? 

12. What do you understand by hyphenating a document? 

13. What type of text should be printed as headers and footers? 

Answers for Self-Assessment Questions 

1. (a) 2. (a) 3. (b) 4. (a) 5. (b) 
 

9.9 Further Readings 

Notes 

 
Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister. 

A Study of Computer Fundamental, Shu-Jung Yi. 

 

 
http://books.google.co.in/bkshp?hl=en 

http://books.google.co.in/bkshp?hl=en
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Objectives 

After studying this unit, you will be able to: 

• Discuss the starting of excel 

• Explain the excel window in worksheets 

• Discuss the creation of excel sheet and saving cash sheets in excel format 

• Discuss entering of data and explore number format 

• Explain the sort function and entering of dates 

• Explain cells and formality of cells 

• Discuss excel function, in date time, financial, logic, mathematical and trigonometric 

functions 
 

Introduction 

This application is one of the most useful tools to carry out most of the common scientific 

and statistical tasks in a faster way. The data once entered in to a worksheet can be 

manipulated to carry out many results and also using the same data or its output to plot 

a graph. This Application has a standard library of mathematical, scientific and statistical 

formulae and these facilities can be used to estimate the result. The following topics will 

describe how to use this application from first principles. 
 

10.1 Starting Excel 

10.1.1 Excel 2003 

1. Click the Start button in the lower-left corner. 

Figure 10.1: Starting Excel 

 
Notes 

 

 

 

 

 

 

 
 

10.9 Summary 

10.10 Keywords 

10.11 Self-Assessment Questions 

10.12 Review Questions 

10.13 Further Readings 
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Screen always might not look exactly like the screen shown. In Excel 2007, display of window 

depends on the size of the monitor and the resolution to which the monitor is set. resolution 

determines how much information the computer monitor can display. A low resolution 

means less information fits on the screen, but the size of text and images are larger. 

Inversely, a high resolution means more information fits on the screen, but the size of the 

text and images are smaller. Also, settings in Excel 2007, Windows Vista, and Windows XP 

allow you to change the color and style of your windows. 

Figure 10.2: Microsoft Excel 2007 windows Environment 

Page Break Preview 

Normal View Insert Worksheet Button 

Worksheet Navigation Tabs 

Vertical Scroll Bar 

Expand Formula Bar 
Microsoft Office Button 

Formula Bar 

Quick Access Toolbar 

Zoom 

Horizontal Scroll Bar 

The Ribbon 

 
Notes 2. Position the mouse pointer on Programs. 

3. Click Microsoft Excel. 

10.1.2 The Microsoft Excel 2007 Window 

If you have purchase a valid licensed copy of Microsoft Excel 2007 then open it following 
the instructions given below: 

1. Go to Start  Programs  Microsoft Office  Microsoft Excel 2007 

The Microsoft Excel 2007 window appears: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Pa ge Layout View  

 

 

 

 

 

 

 

 

 

 
 

10.2 Exploring the Excel Window 
 

When we start working in Excel, we begin using a workbook that contains screens called 

worksheets. They are identified as Sheet l, Sheet 2, and so on. As we become more familiar 

with the available options in Excel, we can customize the menus and add buttons to the 

toolbars just the same way as we did in M.S Word. Here is the initial screen we see when we 

open Excel Workbook. 
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Status bar 

A1 

 
Notes 

 

 

 

 
10.2.1 An Excel worksheet 

An Excel worksheet as seen in Figure 10.2 looks like a grid pattern full of cells. %1'. from 

one cell to another in Excel is quick and easy. Other ways to move from cell to cell include 

clicking a cell or using the Go To command, the scroll bars, the arrow key. or the home, 

end, page up, and page down keys. 

• Moving within a window 

(i) To select any cell, click it. For example, click cell Al. 

(ii) To move one cell to the right, press tab, or to move one cell to the left, press 

shift+tab. 

(iii) To move one cell down, right, up, or left, use the arrow keys. 

(iv) To move to the first column of the worksheet, press home. 

• Moving from window to window 

(i) To move one window down, press page down. 

(ii) To move one window up, press page up. 

(iii) To move to the uppermost-left cell, Al; press ctrl+home. 

(iv) To move to any cell, on the Edit Menu, click Go To, and type J 18 or any cell 

number. 

(v) Press ctrl+home to return to cell Al. 

 
Figure 10.3: Environment of Excel 
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Notes 10.2.2 Using Office Assistant 

Working with office assistant is a tricky affair and the productivity and usefulness of this 

facility depends on understanding the questions asked by the office assistant and answering 

them. 

10.2.2.1 Working with Office Assistant Options 

1. If the Office Assistant is not visible, click the question mark button on the Standard 

toolbar, and Office Assistant appears. 

2. Presetting topics for assistance 

(a) To display the Office Assistant dialog box, click anywhere in the Office Assistant 

image box. 

(b) Click Options, and select the check boxes next to the options we want to present. 

(c) Click Reset my tips, and then click OK. 

O Working with Office Assistant questions: we can use everyday language to ask 

specific questions, and Office Assistant gives us a choice of available 

information. 

• Asking a specific question 

O To display the Office Assistant dialog box, click anywhere in the Office Assistant image 

box. 

O Type workbook in the dialog box. 

O Click Search. 

O Click About workbooks and worksheets, and read the Help topic’ that appears. 

O Close the Help window. 
 

10.3 Creating an Excel Workbook 
 

The worksheets are used for numerous tasks such as to collect and analyze information, 

including records, notes, activity budgets, professional organization information, data, 

financial reports, nutritional diaries, and legislative voting records. 

There is a difference between a workbook and a worksheet. A workbook can contain 

many worksheets. Each worksheet can contain up to 256 columns across and 65,536 rows 

down. 

Following steps can be used to create an Excel workbook: 

(a) On the File menu, click New. 

(b) On the General tab, double-click Workbook to open a new one. 

(c) Click cell B2, and type Student List. 

(d) On the File menu, click Save, type Book 1, and click OK. 

10.3.1 Saving Our Work 

When we create a workbook, regardless of which method we use, we must save our work 

in a logical place in the computer. Just like filing a document in a file drawer, storing a 
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computer document requires some attention to how we name the document and where we 

place it so we can easily find it again. 

Unless we specify otherwise, Excel saves all workbooks to a default folder in our computer 

called My Documents. 

10.3.2 Saving for the First Time 

When we save the file for the first time, we should name the file as descriptively but as 

briefly as possible. Sometimes, we will want to name it as a particular version, or as a type 

of workbook (i.e., Hostel Record V.1.2). Follow the following steps to save a new workbook: 

• On the File menu, click Save. 

• Click the Save As arrow, and choose a location for our workbook. 

• In the File name box, type hostel Record. 

• To save the workbook, click Save. 

Notes 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
· 

 

10.3.3 Opening an Excel Workbook 

• Using the Start menu 

O Click the Start button on the desktop, and then move the mouse pointer to 

Documents. Click a file to open it. 

O On the File menu. Click Close, to close the workbook. 

10.3.4 Opening a Workbook from Inside Excel 

• On the File menu, click Open. 

• Double-click at the file to open. 

• Select the file name. and click Open. 

Figure 10.4: Saving for the First Time 
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10.3.6 Entering and Formatting  Titles 

Using titles on the worksheets makes it easier to read and understand the information shown. 

We can retain the existing styles, create our own styles, or customize our own workbook 

template. The use of Title however is not necessary but it is always good to have them to 

enhance the readability and understandability of the data. The text and the titles etc. can be 

easily entered and modified much in the same way as that it is done in MS Word. 

• With the First File worksheet open, move the pointer to cell E3, . type Amount, and 

then press enter. 

• Click cell E3. 

• On the Formatting toolbar, click the Font box, and click NIS San Serif. (%1e Mall have 

to use the down arrow next to the Font box to find Arial.) 

• On the Formatting toolbar, click the arrow next to the Font Size box, click 14, and then 

click the Bold button. 

It has created the title ‚Amount Spent‛ as shown in the Figure 10.5 below. 

Book1 - Microsoft Excel 

Figure 10.5: Entering and Formatting Titles 

 

 
How to save file to specific place give the steps? 

 
Notes 10.3.5 Entering and Manipulating Data 

Start a workbook either an existing one or a new. A new workbook can be strated following 

the steps listed below: 

Open a new worksheet. 

On the File menu, click Save As. 

Type ‚FirstFile‛ or any other file name or your choice. Click the Save button. 
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Column headings help in understanding the data or information that has been entered in 

the %worksheet. Sometimes the column heading is too large to fit into a column. Even 

though it does not show the entire title or formula, the cell still contains everything entered 

into it. This exercise, shows how to increase or decrease the column width to fit the entered 

information. 

• Using the FirstFile worksheet, click cell B5, and type Dates in cell B5 

• Press tab to go to cell C5, and then type Conveyance. 

• Press tab to go to cell D5, and then type Miscellaneous. 

• One cell will overlap the other. 

• Press enter. 

• At the top of the worksheet, position the pointer at the top of the grid between 

columns C and D until the pointer changes into a double-arrow line and then double- 

click. 

• Note The pointer becomes n double-arrow! when it is placed between columns at the 

top of a chart. 

• Repeat steps 4 and 5 between cells D and E. 

• Select the words Amount Spew, and move the + pointer to a cell line until it changes 

to an arrow. 

• Click and drag the text to begin in cell C3. 

• Save the worksheet. 

With these easy steps we can customize a template or design our own workbook to present 

our information. 

10.3.7 Arranging Text with the Copy, Paste and Cut Commands 

With Excel, it is easy to modify data. When we use the features in Excel to create a table, 

we may decide on a different order of column heads or we may want to revise them. It is 

important to make changes before we build a formula for the chart in order to maintain 

correct calculations. 

Note Usually Cut is used to move the contents of a cell or cells to a different location. Copy 

is used to duplicate the contents or a cell or cells in another location. 

• Using the Cut, Paste, and Copy commands to arrange text. 

• Using the FirstFile worksheet, right-click cell C3, and click Cut. 

• Right-click cell C1, and click Paste. 

• Right-click cell D5, and click Cut. 

• Right-click cell D10, and click Paste. 

• Right-click cell C5, and click Cut. 

• Right-click cell D5, and click Paste. 

• Right-click cell D10, and click Cut. 

• Right-click Cell C5, and click Paste. 

Notes 
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Notes • Try dragging cell C5 and cell D5 to new locations as we did in the previous exercise. 

• Close the file without saving. 3.10.7 

 

 

 

Make sure never the copy more the one other wise only last copied is 

work and all data is lost. 

 

 

 

10.4 Entering Data 
 

Excel is a powerful package to enter and display data or text easily. For example, we can 

have Excel display a date showing the month, day, and year with the time, or showing only 

the first letter of the month, followed by a two-digit year. Numbers can be displayed as 

whole numbers, numbers with decimals, or numbers written in scientific notation. 

 

 

 

 
When we enter data in a column format, we may find !t easier and faster 

to use arrow keys to move between cells. 

 

 

 

 
Entering data on expenditure under various heads: 

• Open the FirstFile workbook. 

• Starting in cell B6, type the following information into the worksheet, under the 

corresponding headings. 
 

• 

Dates Conveyance Miscellaneous 

1/1/95 85 110 

4/1/95 150 350 

7/1/95 200 375 

10/1/95 275 600 

13/1/95 350 750 

18/1/95 300 500 

21/1/95 250 875 

 

• Saving the file 



Unit 10: Microsoft Excel 

195 

 

 

 
10.4.1 Doing Simple Calculations 

Using Excel 97, we can perform a wide range of mathematical calculations and function 

according to what we need from our data. To calculate sums (totals) and percentages. the 

mathematical operation of adding numbers to get a total, and then divide each number, that 

was just added by that total. 

• Calculating the sum of schools with Web sites. 

• In the technology workbook, click cell E5, type Total Sites, and press enter. 

• Click cell E5 again, and on the Formatting toolbar, click the Bold button. 

• Click cell E6, and on the Formula toolbar click the Edit Formula (the = sign). 

• Click the Functions arrow, and choose Sum. (C6 : D6 appears in the H) 

• Click OK. 

To sum each pair of numbers, click E6 and drag the fill handle from E6 to Amount Spent 

 
 Date % on Conveyance % on Miscellaneous Conveyance 

Miscellaneous Total 

 

6 j 

 

1/1i95 

 

85 

 

110 

 

195. 

7 ! 4/1i95 150 350 500 

 

8 ‘ 
 

7/1M 
 

200 
 

375 
 

575 

 

9 ; 
 

10/1/95 
 

275 
 

600 
 

875 

 

10 
 

13/1FJS 
 

350 
 

750 
 

1100 

 

11 
 

1B/1FJ5 
 

300 
 

500 
 

600 

 

12; 
 

21/1r95 
  

875 
 

1125 

 

13 
    

 
 

Calculating the percentage of Expenditure on Conveyance 

Click cell F5, type % of Conveyance, and then press enter. 

Click cell F5 again, and then click the Bold button on the Formatting toolbar Click cell G5, 

type % of Miscellaneous, and press enter. Click cell G5 again, and on the Formatting toolbar 

click the Bold button. 

• Click F6, and click the Edit Formula button (the = sign). 

• Type C6/E6, and click OK. 

Notes 
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Notes • On the Formatting menu, click Cells. On the Number tab, choose Percentage, and then 

type 2 in the decimal places. 

• Click F6, and drag the fill handle to F12 to calculate the percentage for each pair of 

numbers. Click OK. 

• Repeat steps 3 through 8 for Secondary Schools using the formula D6/E6 to calculate 

the percentage. 

• Save the worksheet, and close it. 
 

10.5 Exploring Number Format 

• Trying different number formats. 

• Click cell B2, type 123456, press enter, and then click B2 again. 

• On the Format menu, click Cells. 

• On the Number tab, choose Currency. In Decimal places, click the down arrow until 

0 appears, and then click OK. 

• Click B2, in the Formula Bar, type . in front of 12345, press enter, right-click cell B2, 

and click Format Cells. 

• Note Another way to change, formal is to right-click the cell that we want to.formal. 
On that shortcut menu, click Format Cells. 

• On the Number tab, under Category, click Number, under Negative numbers, click 

1234 in red, and click OK. 

• Close the workbook without saving changes. 

10.5.1 Entering Dates 

For displaying numbers as dates and formatting date cells follow the steps given below: 

• Open the Technology workbook we created earlier. 

• Right-click the B column header to select the dates and all of column B. 

• On the shortcut menu, click Format Cells. 

• On the Number tab, under Category, click Date. 

• Under Type, choose 3/4/97. 

• Click OK. 

• On the File menu, click Save. 

• Close the workbook. 

10.5.2 Sorting Functions of Data 

Recording names and addresses of students, preparing comparative statement of tenders etc 

are very lengthy and time consuming jobs. More so because the number of data items are 

large and intermittent addition of data requiring up dating the record. With Excel, sorting 

the data by name, by the date etc., is quick and easy. For example during preparing the 

student’s records there are many details to track in a classroom, such as student data, grades, 

performance in seminar, student participation, homework, and other completed assignments. 
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Using Excel, we can track all this information for each student, and then organize it according 

to importance or category. Arranging names Alphabetically: 

• Open a worksheet and record the data with column headings in cell A3. 

O Select the data table. 

O On the Data menu, click Sort. 

O Under Sort by, select Name, and then click Ascending. 

O Click OK. 

O The record has been sorted (refer.figto•e-3.24) 

 

S. N. Name of Student Entail Address Seating 

1 Rajeev Jain pradip@redifmail.com Row 2-3 

2 Ashish Verma Ashishjbp@yahoo_com Rovv 2-1 

3 Ratnesh Gupta Rg1234@yahoo.com Row 1-1 

4 Akhilesh agrawal AkhileshjabaTMUrit@yahoo.com Row l-3 

5 Shirish Chile Chile S a @mailcity.com Row l-2 

6 Suresh Singh tunnukomailgi@yahoo.com Row 3-1 

7 Anil Gupta amnk@hotmail.com Row 2-2 

8 Satveer Singh satveersinh@hotmail.com Row 3-3 

9 Vikas Nema vnema a indiya.com Row 3-2 

10 Vipin Savla vipinsavla@inetwala.com Row 4-1 

 

• Save the file with the name Student Records for use later. Close the workbook. 

10.5.3 Using Formulae and Different Standard Functions 

Excel has a library of standard functions used in financial, statistical, logical and other 

mathematical calculations. When the value of a cell has to represent the output of certain 

manipulation done on data using a function then the function can be called from the 

library and can be inserted by ‚insert Function command‛. For doing this the cell where 

the function has to be put has to start with a ‚=‛ sign, followed by the insert/function/ 

financial functions. 

In case the function to use is difficult to locate then in the function category pan select all 

and then from the right pan find alphabetically. 

Notes 

mailto:pradip@redifmail.com
mailto:Rg1234@yahoo.com
mailto:Akhileshjabalpurit@yahoo.com
mailto:tunnukomailgi@yahoo.com
mailto:amnk@hotmail.com
mailto:satveersinh@hotmail.com
mailto:vipinsavla@inetwala.com
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Notes Each time a function is selected, below the in bottom of the pans the function name, its 

format and description of the function is shown. 

10.5.3.1 Order of Calculation in Excel 

There are lots of formulae that help to calculate or analyze everything from finances to 

statistical sampling plans. When several formulae are combining, they are performed in a 

specific order. Excel starts calculating from the left to the right according to the following 

order or of operations: 

• ( ) Parentheses 

• Negative number if used with one operand 

• % Percentage 

• ^ Exponentiation 

• * and/Multiplication and division 

• + and - Addition and subtraction 

• Connects two text values to produce one 

• Continuous text value 

• _, <, <_, >,  >_ , < > Comparison operators 
 

These operands are explained in details by clicking Office Assistant, and typing Operators.)r 

reference, the Comparison operators are: 
 

• = Equal to 
 

• < Less than 
 

• = Equal to or less than 
 

• > Greater than 
 

• = Equal to or greater than 
 

• <> Not equal to 

10.5.4 Copying Formulas 

Once a formula has been created, it can be quickly and easily copied into adjacent cells to 

calculate student records that contain the same type of data copying formulas 

• Click the cell containing the formula to be copied select it. 

• Click and drag the fill handle at the lower-right corner of the cell to the bottom of 
the column, and release the pointer. 

• Save your file with the name Student List 

10.5.5 Analyzing Data 

Another Exciting feature of Excel is the hide column/row format. This is particularly useful 

analysis of data. Those details that is not required for the analysis can be hidden but not 

cease to exist, so that the visibility of the relevant data is increased. 
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10.5.6 Sample Example Using Functions to Calculating Grades 

Grading of the students performance can be done very easily using excel. Suppose the 

students have been assessed by ten class test and their performance is graded by assigning 

H grade for marks between 90-100, A grade for 80-89, B for 70-79, C for 60-69 and students 

less than 60 are fail i.e. F grade. We can chose the same weight age for all the test or it can 

vary. When we give different weigh ages then the performance index may be calculated by 

the formula (e.g. 0.4*Testl+0.l*Test2+0.05*Test3+ .) or if the weight ages are equal then the 

performance index can be calculated by a simple average. For the following exercise it is 

an average. 
 

• Hide column A, C and D. 
 

• In cell M3, type Average Performance 

• Move the pointer to cell M4, and on the Standard toolbar click Paste Function. 
 

• Under the Function category, click Statistical; under Function name, select Average, 

and click OK. 
 

• It asks for the cells of which the average to be calculated. Select E4-M-i and then Click 

OK to complete the function and average one row of grades. 
 

• Click and Hold down the cursor at right-bottom of cell M4 and stretch it up to M 13. 
 

• The average for all the students has been calculated. 

Notes 

 
 Figure 10.6: Calculating Grades 
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10.6 Range of Cells 
 

• Open Excel from the Start menu. 

• Choose your cell range. For example, highlight ‚F5‛ through ‚F28.‛ (Letters represent 

columns while numbers represent rows.) To highlight cells, just click and drag. To 

select a group of cells that are not touching, click each cell separately and hold down 

the ‚Ctrl‛ key. 

• Click on the name box, which is directly above the ‚A1‛ cell. 

• Type the new cell range name. For example, on a schedule, you might name all the 

time that you are commuting to work ‚Commuting.‛ Hit the ‚Enter‛ key. 

• Use the cell range names in your next formula. These names can make your formulas 

much easier to use. 
 

10.7 Formatting Cells 
 

• Open your Excel worksheet and select the rows or columns you want to format. To 

select, hold down the left mouse button and drag. 

• Click ‚Format‛ on the top menu bar to summon a list of options for formatting your 

worksheet. 

• Click either ‚Row‛ or ‚Column.‛ The rows are horizontal, the columns are vertical. 

• If you click ‚Row,‛ a box will appear. Enter the row height. If you pick ‚Column,‛ 

enter the column’s width in the designated box. 

• When you’ve finished formatting, click ‚OK‛ and save your work. 
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10.8 Excel Function Notes 

 

ln the function dictionary that follows, the most commonly used Excel functions are listed 

with their arguments. Function definitions are grouped by typ‛ and are listed in alphabetical 

order within each group. The function groups include the following: 

• Database 

• Lookup and Reference 

• Date and time 

• Mathematical amd Trigonometic 

• Finacial 

• Statistical 

• Information 

• Text 

• Logical 

The following sections explain some important functions of Excel. 

10.8.1 Date and Time Function 

Working with dates antl times is a common worksheet task and excel includes a rich set of 

date and time functions. First, it is important to understand how Excel works with date and 

time values. 

Date and time values are numbers, regardless of how the cells are formatted. Dates and time 

are stored as serial numbers-by default. Excel uses a 1900 date. System in which serial 

numbers range from 1 to 65, 380 corresponding to dates Jan 1, 1990 through Dec 31, 2078. 

In the serial number, digits to the right of the decimal point representing time of day 

(as fraction of 24 hours); 12:00A p.m. is the equivalent of 5. 

Today Returns the serial number of today’s sheet. 

Syntax : TODAY() 

Date Returns the serial number of a particular date. 

Syntax : DATE (year, month, day) 

Year is the year number 1900 or larger. 

Month is a number representing the month of the year. 

Day is a number representing the day of the month. 

Day Convert a serial number to a day of the month. 

Syntax : DAY (serial_number) 

Seriai_number is the date_time code used by Microsoft Excel for 

date and time calculations. 

NOW Returns the serial number of the current date and time. 

Synrax : NOW 0 
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Notes TIME Returns the serial number of a particular time. 

Syntax : TIME (hour, minute, second) 

Hour is a number from ‘1 to 23 that represents the hour’ 

Minute is a number from 0 to 59 that represents the minute’ 

Second is a number from 0 to 59 that represents the second’ 

TIME (13, 50, 27) returns 0.57670389, which is equivalent to l:50:27 

PM. 

 

10.8.2 Financial Functions 

Rather than typing financial equations, you can use Excel’s financial functions’ Excel provides 

a family of functions that solve annuity problems’ An annuity is a series of regular cash 

flows over a Period of time. 

FV: Returns the future value of an investment’ 

Syntax: FV{rate, nPr, Pmt, Py type) 

Rate is the interest rate per period’ Nper is the total number of pay 

ment periods in an annuity’ Pmt is the payment made each period’. 

Pv is the present value, or the tump-sum amount that a series of future 

payments is worth right now. lf pv is omitted, it is assumed to be 0. 

Type is the number 0 or 1 and indicates when payments are due’ lf type 

is 0, payments are due at the end of the period; if type is’l’ payments 

are due at the beginning of the period’. 

FV(0"5%, 10, -200, -500, 1) returns $2581’40” 

fV(11%12,35,-2000, , 1) returns $82,846’25“ 

PMT: Returns the periodic payment for an annuiry- based on constant 

payments and a constant interest rate’ 

Syntax: PMT(rate, nper, PV fv, type) 

The following formula returns the monthly payment on * $10,000 loan at an 

annual rate of 8% that you must pay off in 10 month. PMT(8%12, 1O, 1 0000) 

returns -$1037’03“. 

For the same loan, if payments are due at the beginning of the period, 

the payment is PMT(8%12,1A,10000, 0, 1) which return -$1030.’16. 

Returns the present value of an investment (the total amount that 

series af future paynrents is worth now). For example, when ‘you 

borrow money, the loan amount is the present value to the lender. 

Syntax: PV(rate, nper, pmt, fV type) 

10.8.3 Logical Functions 

The logical functions are powerful worksheet functions that enable you to add decision- 

making and logical preferences to your worksheets results. 

IF Specifies a logical test to perform. 

Syntax: IF(logical_test, value_if_true, value_if_false) 



Unit 10: Microsoft Excel 

203 

 

 

 
Logical_test is any value or expression that can be evaluated to true or 

alse. 

Value_if_true is the value that is returned if iogical_test is true. 

Value_if_false is the value: that is returned if logical_text is false. 

Up to seven IF functions can be nested as value_if_true and value_if_false 

arguments to construct rnore elaborate tests. The result values can display 

text with an argument such as ‚Hello‛, calculate a formula such as B12*6 

or display the contents of a cell such as D35. Consider the following 

formula 

lF(834>5O, 834*2, ‚Entry tool low!‛) 

ln this example, the IF( )funcion prociucesthe answer 110 if B34 is 55. 

lf B34 is 12, however, the celi that contains the function display the text 

given below. 

Entry too low! 
 

AND The AND function joins test conditions. Returns TRUE if all its logical 

arguments are TRUE; returns FALSE if one or more logical arguments is 

FALSE. 

Syntax: AND(logical’1, logical2...) 

                    AND(TRUE, TRUE) returns TRUE. 

AND(TRUE, FALSE) returns FALSE. 

AND(2+2=4 ,2+3:5) returns TRUE. 
 

OR Returns TRUE if any argument is TRUE. 

Syntax: OR(logical1 ,logical2, ...) 

Logical1 , logical2, ... are 1 to 30 conditions you want to test that can be either 

TRUE or FALSE. 

                   OR(1 +1:1, 2*2:5) returns FALSE. 

lf A1:A3 contains the values TRUE, FALSE and TRUE, then 

OR(A1:A3) returns TRUE. 

NOT Reverses the logic of its argument. 

Syntax: NOT(logical) 

                 NOT(FALSE) returns TRUE. 

NOT(1 +1=2) returns FALSE. 

10.8.4 Mathematical and Trigonometric Function 

Mathematical and trigonometric functions provide the foundation for the majority of 

worksheet calculations. Most scientific and engineering functions are found under 

mathematical functions. 

ABS: The ABS function returns the absolute value of a number. 

Syntax: ABS(number) Number is the real number for which you want the 

absolute value. 

Notes 
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Notes                        ABS(43) returns 43-43 is the absolute value of 43. 

ABS(-105) returns 105_105 is the absolute value of -105. 

CEILING Rounds a number away from zero to the nearest integer or to the nearest 

multiple of significance. 

Syntax: CEILINC(number, significance) 

Number is the numeric value you want to round off. 

Significance is the multiple to which you want to round off. 

CEILINC (2.5,1) returns 3. 

CEILINC(0.234, O.O1) returns 0.24. 

FLOOR Rounds a number down to the level of significance that you specify. 

Syntax: FLOOR (number, significance) 

Number is the numeric value you want to round off. 

Significance is the multiple to which you want to round off. 

FLOOR(2.5, 1) returns 2. 

FLOOR(-2.5, -2) returns -2. Rounds a number down to the nearest integer. 

Syntax: INT(number) Number is the real number you want to round 

down to an integer. 

INT(8.9) returns 8. 

INT(-8.9) returns -9. 

ROUND Rounds a number to a specified number of digits. 

Syntax: ROUND(number, num_digits) 

Number is the number you want to round off. 

Num_digits specifies the number of digits to which you want to round 

off the number. 

ROUND(2.149,1) returns 2.’1. 

ROUND(-1 .475, 2) returns -1.48. 

ROUND(21 .5, -1) returns 20. 

Returns a positive square root. 

Syntax: SQRT(number) 

Number is the number for which you want the square root‛ 

             SQRT(16) returns 4. 

SQRT(-1 6) returns #NUM! 

SQRT(ABS(-16)) returns 4. 

Adds its arguments. 

Syntax: SUM(number 1, number 2, ...) 
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Massachusetts Technology Corporation (MTC) 

Mmanagers  approve  or  reject,  and  key  parties  are  notified.  Immediately  after 

TC created a web-based system to manage the entire reporting and payment 

process. With the system, new contracts are requested by account representatives, 
 

each speaking engagement, physicians request payment and expense reimbursement via 

a secure website. Required parties are notified of their need to approve or reject, and the 

system tracks the payment request each step of the way—from submission to approval 
to accounts payable to conclusion. At any point, parties can view the request status, 

thereby reducing the time needed to track down late or missed payments. No more 

sending invoices, manually entering data into Excel, searching for paper contracts, getting 

approval signatures from each manager, or manually requesting a check from accounts 

payable. As importantly, residents of states requiring reporting can visit a public website 

and search by provider name for payments made to them. From initiation to conclusion, 

it took MTC less than six months to design, develop and install the system. The web- 

database ensures regulatory requirements are met, saves time and effort via workflow 

and reporting, and eliminates redundant data entry. 

Questions: 

1. What is the purpose of MS excel in the document file? 

2. How do use mathematical function in the excel sheet? 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
10.9 Summary 
 

• In this unit we discussed about Microsoft Excel. 

• Exploring the Excel Window, in which when we start working we begin using work 

is called worksheet. 

• Creation of worksheet in which we can say the worksheet that worksheet are used for 

mummeries tasks. 

• Sorting functions of data, in which we record the menus and address of variers data. 

 
Number 1, number 2, ... are 1 to 30 arguments for which you want the 

sum. 

                   SUM(3, 2) return 

SUM (A2:C2) return 50, if cells A2:C2 contain 5, 15 and 30. 

Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
• Excel function, must commonly used excel functions are used by grasped. 

• Data and time function are stored as serial number by default. 

• Logical function are powerful worksheet functions that enablers you to add decision 

making and logic preference to your worksheet. 

• Functions that provide the foundation of the majority of worksheet calculations are 

mathematical and trigonometric function. 
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Notes 10.10 Keywords 

 

Documents: A document is a work of non-fiction writing intended to store and communicate 

information, thus acting as a recording. Documents are often the focus and concern of 

business administration and government administration. The word is also used as a verb as 

‚documenting‛ describes the process of making a document. 

Excel Worksheets: The worksheets are used for numerous tasks such as to collect and analyze 

information, including records, notes, activity budgets, professional organization information, 

data, financial reports, nutritional diaries, and legislative voting records. 

Format Cell: When you enter data into a cell in Excel, it is handled differently depending 

on what type of formatting you have assigned to the cell. For example, if you choose 

Currency formatting, Excel will automatically convert 3 into $3.00; if you choose Date 

formatting, Excel would convert 3/1 to March 1, 2002; and if you choose Percent formatting, 

Excel would change 0.3 to 30%. 

Office Assistant: The Office Assistant was a Microsoft Office feature to assist users by way 

of an interactive animated character, which interfaced with the Office help content. It used 

technology initially from Microsoft Bob and later Microsoft Agent, offering advice based 

on Bayesian algorithms. In Microsoft Office for Windows, it was included in versions 97 

to 2003. 

 
 

1. Make a table and find the average of mark column. 

2. Make the table and use the Trigonometric function. 

 

 
 

10.11 Self-Assessment Questions 
 

1. All formula in Excel start with 

(a)   % (b) + 

(c)   = (d) – 

2. You can use a function to combine text from two cells into one cell. But you can use 

an operator to do the same thing. Which operator is that? 

(a) & (ampersand) (b) = (equal sign) 

(c) (space) (d) All of these 

3. Two common wildcard characters that Excel recognizes are 

(a) * and ? (b) < and > 

(c) ^ and / (d) . + and – 

4. The divide symbol is 

(a) /. (b) D 

(c)   \. (d) ) 

5. The multiplication arithmetic operator is represented by which of the following 

symbols? 

(a)    ^. (b) *. 

(c)   /. (d) X 
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6. To add two cells (A1 and A2) together you use the following formula 

(a)    = A1   + A2 (b) = Add(A1+A2) 

(c)   = together(A1:A2) (d) A1   plus A2 

7. To make a number in cell C1 10% smaller than the number in C3 you enter 

(a)   = C3*1.10 (b) + C3*110 

(c)   = C3%10 (d) = C3*.90 

8. On an excel sheet the active cell in indicated by < 

(a) A dark wide boarder (b) A dotted border 

(c)   A blinking border (d) None of these 

9. On an Excel sheet the active cell in indicated by 

(a) A dark wide border (b) A dotted border 

(c)   A blinking border (d) None of these 

10. Using the F11 shortcut key to create a chart on chart sheet creates 

(a) A default chart (b) A 2-dimensional column chart 

(c)   A 2-dimensional bar chart (d) A 3-dimensional line chart 
 

10.12 Review Questions 

Notes 

 

1. What are some ways to use Excel? 

2. How many rows and columns are there in an excel? 

3. How many worksheets can an Excel workbook have? 

4. What is the difference between Microsoft Excel and Microsoft Word? 

5. What are the advantages of Microsoft Excel? 

6. How do you explain a Microsoft Excel? 

7. How much RAM is there in a Microsoft Excel? 

8. How do you insert rows in an Excel sheet? 

9. How many cells are there in a single Excel sheet? 

10. What do you mean by naming a cell? 

11. What are functions? 

12. What are the advantage of using names? 

13. What do you understand by Function Wizard? 

14. What does it mean by Environment of Excel? 

15. How do you create an Excel Worksheet? 

Answers for Self-Assessments Questions 

1. (c) 2. (a) 3. (a) 4. (a) 

5. (b) 6. (a) 7. (d) 8. (a) 

9. (a) 10. (b) 
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http://books.google.co.in/bkshp?hl=en 

 
Notes 10.13 Further Readings 

 
Fundamental Computer Concepts, William S. Davis. 

Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister. 

 

 

http://books.google.co.in/bkshp?hl=en
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Notes Objectives 

 

After studying this unit, you will be able to: 

• Understanding of MS Excel features 

• Discussion of Excel formulae 

• Explanation of Graph and chart in Excel 

• Understanding of Design corner 

• Process of printing Excel sheet 

 

Introduction 
 

Excel is a Window-based spreadsheet created by Microsoft Corporation, US. It includes all 

standard features of a spreadsheet package like automatic recalculation, graphs, and functions. 

It also includes several advanced utilities like the facility to include other objects within a 

spreadsheet and pivot tables and form designing’. 

Excel can be used for a variety of applications. It is commonly used to automate financial 

statements, business forecasts, inventory control, and accounting. The package provides 

statistical, financial and scientific functions. Therefore, Excel can be used in many scientific 

and engineering environments to analyze numeric data. Excel is currently the best-selling 

Windows spreadsheet. 
 

11.1 Features 
 

Excel is a feature-rich product that can be used at many different levels. 

• Multisheet files: Excel’s files (called workbooks) can consist of any number of separate 

sheets. The sheets can be worksheets, chart sheets, macro sheets, or custom dialog 

boxes. This feature makes it easy to organize the user’s work. 

• Multiple document interface: This capability of Excel makes it easy to transfer 

information between worksheets in different workbooks. 

• File compatibility: Excel can read files produced by other spreadsheet programs. It can 

also read text files, dBASE files, and HTML documents. 

• Interactive help: While working in Excel, the user can get help on-screen. Excel’s on- 

line help is excellent and extremely detailed. 

• List management: This feature makes it easy to sort, filter, summarize, and manipulate 

data stored in the worksheet. 

• Built-in functions: Excel includes an enormous collection of built-in functions. 

• Great charts: Excel’s charting features enable the user to modify and augment a wide 

assortment of graph types. 

• Integrated mapping: This feature lets the user display the data in terms of a geographic 

map. 

• Pivot tables: Using this feature, the user can view the data in summarized table form. 

• Advanced analytical tools: Goal seeking, a powerful Solver feature, and the analysis 

.ToolPak add-in features, provides extensive statistical, financial, engineering, and 

scientific functions and procedures. 



Unit 11: Operations of MS Excel 

211 

 

 

 
• Scenario management: Excel is often used for what-if analysis, that is, you can change 

one or more assumptions and observe the effects on dependent formulas. 

• Templates: Excel has a template wizard that walks the user through the steps required 

to create a custom template. 

• Internet support: Excel includes a variety of new features that make it easy to access 

Internet documents, save document as HTML files and even create hyperlinks directly 

in spreadsheet documents. 

 

11.1.1 Excel Parts 

• The Title Bar: This identifies the name of the program and also holds some control 

buttons, which can be used to modify the window. 

• Windows control menu buttons: There are three buttons which control the application 

window: minimize, restore, and close. 

• Menu bar: One way of issuing Excel commands is through the Menu bar. 

• Toolbars: It holds buttons to issue commands when clicked. 

• Formula bar: Information and formulas when entered into Excel, appear in this line. 

• Name box: Displays the name of the active cell in the current workbook. It is also used 

to quickly give a name to the selected range or cell. 

• Status bar: It usually contains mode indicator button and keyboard mode buttons. 

Notes 

 

11.2 Formulae 
 

Formulae provide the real power while doing analysis and modeling—creating functioning 

spreadsheet systems—in Excel. By using formulae, entering u number into a single cell can 

cause a ripple effect throughout a complex model. A formula entered into a cell can consist 

of any of the following elements. 

• Operators such as + (for addition) and ‚ (for multiplication). 

• Cell references 

• Values 

• Worksheet functions (such as SUM or AVERAGE) 

Formulae in Excel share some basic properties 

• All formulae begin with an equal sign (=). 

• After a formula is entered, the resulting value is displayed in a cell. 

• When a cell containing a formula is selected, the underlying formula is displayed in 

the formula bar. 

Here are a few examples of formulae 

= 150 * 5.0 

= A1 + A2 

= SUM (A’1 : A5) 

= A1 = C1 

= (B1 – B3) *50 
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Notes Operators in Excel 

Excel lets you use a variety of operators in your formulas. Table below lists the operators 
that Excel recognizes. 

 

Excel’s Built-in Functions 

Excel provides a bewildering number of built-in worksheet functions that can be used in 
formulae. These include common functions such as SUM, AVERAGE, and SQRT as well as 
functions designed for special purposes such as statistics or engineering. 

 

Using the AutoSum Tool 

The Sum function is probably the most often used function and the AutoSum   tool 
makes it very easy to enter SUM function onto worksheet. Let us consider the following 
example: 

• Enter the following data into a blank worksheet. 

• Select cell A5. 

• Click on the AutoSum tool on the Standard toolbar. 

• Press J (or click on the Enter box in the formula bar). 

 

Entering Formulae 

You can enter formulae in cells in the same way as you enter normal data values. There 

are basically two ways to enter a formula into a cell : Enter it manually or enter it by 

pointing to cell references. 

 

Entering Formulae Manually 

• Select the cell in which you want the formula to be located and begin typing. 

• Simply type an equal sign (=) followed by the formula. 

• Use all the normal editing keys while a formula. 

 

Enter Formula by Pointing 

To enter the formula =A1+A2 into A3, follow these steps: 

• Move the cell pointer to cell A3 

• Type an equal sign (=) to begin the formula. 

• Click on cell A1. 

• Type a plus sign (+). 

• Click on cell A2. 

• Press Enter to end the formula 

Excel includes the Formula Palette feature that the user can use while entering or editing 

formulae. To access the Formula Palette, click on the Edit Formula button in the edit line. 

 

Reference Operators 

Formulae can refer to cells in other worksheets. Excel uses a special type of notation to 

handle types of references. 
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Cells in other Worksheets 

To use a reference to a cell in another worksheet in the same workbook, use the following 

format 

Notes 

= Sheet Name! Cell Address 

  = A5 * Sheet2 ! A5 

Here is a formula that refers to a cell on a sheet named All Depts 

= A5 *’All Depts’ ! A5 

Cells in Other Workbooks 

To refer to a cell in a different workbook, use the following format 

= [Workbook Name] Sheet Name ! Cell Address 

                    = [Employee.xls] Sheet 4 ! A2 

If the Workbook name in the reference includes one or more spaces, enclose it in a single 
quotation marks. 

 

                   = A2 * ‘*Employee PF] Sheet1’ ! A2 

11.2.1 Tips for Working with Formulae 

• Don’t Hard Code Values Use cell references or named constant rather than constant 

values. Doing so makes it easier to modify and maintain the worksheet. 

• Using the Formula Bar as a Calculator To perform a calculation. use the formula bar 

as a calculator. You might prefer to store the formula’s result rather than the formula. 

To do so, press F9 followed by Enter. Excel stores the formula’s result rather than the 

formula. 

• Making an Exact Copy of a Formula When you copy a formula, Excel adjusts its cell 

references when you paste it to a different location. Sometime you may want to make 

an exact copy of the formula. Here’s a step-by-step example of how to make an exact 

copy of the formula in A1 and copy it to A2. 

O Double-click on A1 to get into edit mode. 

Drag the mouse to select the entire formula. 

Click on the Copy button on the Standard toolbar. 

Activate cell42. 

Click on the Paste button to paste the formula into cell42 

Press Enter to edit mode. This copies the selected text to the Clipboard. 

• Converting Formulae to values Assume that range A1:A20 contains formulae that 
have calculated a result and that will never change. To convert these formulae to 
values: 

O Select A1:A20. 

O Click on the Copy button. 

O Select the Edit > > Paste Special command. Excel displays the paste Special dialog 
box. 
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Notes O Click on the Values option button and click on OK. 

O Press Enter or Esc to cancel paste mode. 

 

11.2.2 Linking Workbooks 

Linking is the process of using references to cells in external workbooks to get data into your 

worksheet. Linking enables one workbook to share the data in another workbook. 

Link object can be one cell, a range of cells, and a named formula or constant, and sheets. 

The workbook containing the original data—the source of the information—is the ‘source 

workbook’. The workbook that receives the linked data is the ‘target workbook the source 

workbook need not be opened when you are working with the target workbook. 

 

11.2.3 Need to Link Workbooks 

The real value of linking is apparent when the source workbook is continually being 

updated. The user always has access to the most recent information. Linking workbooks can 

also be helpful if the user needs to consolidate different files. Linking is also useful as a way 

to break up a large model into smaller files. Linked data can be formatted by using the same 

formatting techniques the user use on any cell contents. 

 

11.2.4 Creating External Reference Formula 

There are several ways to create an external reference formula 

• Manually typing the cell references. 

• Standard pointing techniques, if the source workbook is open. 

• Use the Edit >> Paste Special command with the paste Link button. This also requires 

that the source workbook be open. 

 

11.3 Graph and Chart 
 

PowerPoint charts can be as simple or as complex as you like. You can create a basic chart 

right inside PowerPoint using Microsoft Graph, or you can create a full-featured chart using 

Microsoft Excel and insert it into your presentation. You can choose from common chart 

types such as column, bar, line, and pie charts; try something out of the ordinary such as 

a doughnut or radar chart; or create a chart type of your own. PowerPoint charts are 

preformatted based on the attached design template, but you can also change nearly every 

aspect of a chart—its color, text, labels, and more. 

A chart, also referred to as a graph, can be a useful tool for communicating numeric 

information in a concise format. You could create a chart illustrating sales revenue per 

region or the percentage of sales allocated to each of your products, for example. As you 

begin to work with charts, you’ll discover a multitude of uses for them. 

 

11.3.1 Understanding Charts in PowerPoint 

You can use Microsoft Graph to create charts in your presentation, or you can insert charts 

created in another application, such as Excel. Using Microsoft Graph inside PowerPoint is 

the easiest way to create a graph, but doesn’t offer any calculation or formula capabilities 

for your chart data. If you have already created a chart in Excel or you need to analyze 

complex data, it’s best to insert an Excel chart. 
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Notes 

 

 

 

 

 

 

Before you start creating a chart using Microsoft Graph from within PowerPoint, you 

should become familiar with chart terminology. Table 11.1 lists these terms and their 

definitions. 

 

 

The most powerful aspect of Excel is not the simple calculator abilities, 

but rather the ability to take values from cells to be used in your 

formulas. 

 
 

   

 Table 11.1 Chart Object Terminology  

 

 
Term Definition 

 

 
Axis A line that frames one side of the plot area. The two most 

common axes are the value axis and the category axis. 

 

 
Datasheet A grid that resembles a spreadsheet, in which you can enter 

data for your chart. 

 

 
Data label Text that describes a specific data marker or series of data 

markers. This can be a numeric value, text, a percent, or a 
combination of these items. 

 

 
Data marker A value that represents a single cell or data point in a datasheet. 

 

 Data series The main categories of information in a chart—usually reflected 
in a chart’s legend and in the first cell of each datasheet row 
or column. 

 

 
Data table A grid in the chart that lists the exact data in the datasheet. 

 

 Gridlines Lines that display across the category or value axes to 
make a chart easier to read. By   default,   major   gridlines 
are in increments of 10 and minor gridlines in increments 
of 2. 

 

 
Legend A box that lists and color-codes all data series. 

 

 
Trendline A line that forecasts future values based on current data. 

 

    

 

Figure 11.1 shows some of these chart objects. 

 

For the sake of consistency, we use the term chart throughout this 

chapter to match PowerPoint’s interface—even though the application you 

use to create charts is called Microsoft Graph. Essentially, chart and graph 

are synonyms for any kind of graphical representation of numeric 

information. 
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Figure 11.1: Learn the Basic Objects of a Chart before You Create One 

Gridline  Plot area Series 

Figure 11.2: Click the Insert Chart Button to Start Creating a Chart 

 
Notes 

 

 

 

 

 

 

 

 

 

 
 

Value axis   

 

 

 

 
    Chart area Category axis Legend  

 

11.3.2 Adding a Chart 

The fastest way to add a chart to your presentation is to add a slide and apply a layout that 

contains a chart. To do so, click the New Slide button on the Formatting toolbar and then 

choose a layout from the Slide Layout task pane. The next step varies depending on the slide 

layout you choose. 

If you choose any of the layouts in the Content Layouts or Text and Content Layouts sections, 

you need to click the Insert Chart button on the content palette that displays (see Figure 11.2) 

to activate the chart and Microsoft Graph. 
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(i) If you want to create a slide with a single chart and no other content, 

choose the Title and Chart slide layout. 

(ii) If you use the AutoContent Wizard to create your presentation, it 

might already have a slide that contains a chart. 

 
If you choose one of the layouts containing a chart in the Other Layouts section, you need 

to double-click the chart placeholder to activate the chart and Microsoft Graph. Figure 11.3 

shows a sample chart slide with a chart placeholder. 

Notes 

 

 
To learn more about how slide layouts affect your presentation, see ‚Understanding Slide 

Layouts‛ in Unit 2, ‚Creating a Basic Presentation,‛. 

You can also insert a chart into an existing slide by clicking the Insert Chart button on the 

Standard toolbar or by selecting Insert, Chart. 

Figure 11.4 shows what you see after you click the Insert Chart button on a content palette 

or double-click a chart placeholder. A sample 3D clustered column chart appears, and the 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

A chart gets your point across—fast. With a chart you turn worksheet 

data into a picture, where you can make a comparison or trend visible 

at a glance. 

Figure 11.3: You can Start Adding a Chart by Double-clicking the Placeholder 



Unit 11: Operations of MS Excel 

218 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
To learn more about object-formatting options in PowerPoint, see ‚Using the Format Dialog 

Box‛ ‚Creating and Formatting Objects,‛ 

If you don’t see these menu and toolbar options, Microsoft Graph isn’t active. To activate 

it, double-click the chart in PowerPoint and you’ll then be able to view the Data and Chart 

menus and chart toolbar options. 

Figure 11.4: PowerPoint Displays a Chart with Sample Data 

Many of these toolbar buttons act as a toggle. For example, clicking the 

View Datasheet button displays the datasheet if it’s closed, but closes it 

if the datasheet already displays. 

 
Notes related datasheet opens. The menu bar and toolbars are also customized for Microsoft Graph. 

The menu bar now includes Data and Chart menu items, and the Standard toolbar includes 

several new options, explained in Table 11.2. 
 

To determine what each object is in a chart you’ve created, place the mouse on that object 
or part of the chart and a chart tip displays its name. Figure 11.5 shows an example of a chart 

tip with the name and numeric value for a data series. 
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Notes 

 

 

 

 

 

 

 
 

   

 Table 11.2 Standard Toolbar Chart Options  

 

 
Button Name Description 

 

 
 

 
Chart Objects Lets you select a chart object such as a plot area, a 

chart area, a legend, an axis, or a series. 

 

  

 
Format Opens a Format dialog box tailored to the 

selected chart object. 

 

 
 

 
Import File Opens the Import File dialog box from which you 

can import chart data from another file, such as 

an Excel worksheet, into your chart. 

 

  

 
View 

Datasheet 

Displays the chart’s datasheet. 
 

 
 

 
By Row Displays datasheet row data as the data series 

(the default). 

 

 
 

 
By Column Displays datasheet column data as the data series. 

 

  

 
Data Table Displays a table with all the datasheet data in 

your chart. 

 

 
 

 
Chart Type Lets you apply a new chart type from a palette 

that appears. 

 

  

 
Category Axis 

Gridlines 

Displays category axis gridlines. 
 

 
 

 
Value Axis 

Gridlines 

Displays value axis gridlines. 
 

 
 

 
Legend Displays a legend on your chart. 

 

  

 
Drawing Displays the Drawing toolbar. 

 

  

 
Fill Color Lets you apply fill color and fill effects to selected 

objects. 
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Figure 11.6: PowerPoint Displays Names and Values in Chart tips by Default 

 
Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
If the chart tip doesn’t display, activate Microsoft Graph by double-clicking the chart, choose 

Tools, Options, and then verify that the Show Names and Show Values check boxes are 

selected on the Chart tab of the Graph Options dialog box (see Figure 11.6). 

 

Chart Object as well as its Value 

Figure 11.5: This Chart tip Lets you Know the Name of the 
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11.3.3 Modifying Your Chart 

You can quickly create a basic chart, and you can make numerous enhancements and 

formatting changes. After you activate Microsoft Graph to create a chart, it’s easiest to 

proceed in this order: 

1. If you don’t want a 3D column chart, change the chart type. 

2. Type the text and numbers for your chart in the datasheet. 

3. Type a title for the chart slide. 

Notes 

 

 
 

• Bar: Creates horizontal bars to compare the values of categories of data. 

• Line: Creates a line with markers for each data value. 

4. Modify and format chart objects as needed. 

11.3.4 Selecting a Chart Type 

PowerPoint offers plenty of chart types and sub-types for almost every kind of graphic 

representation you could want to create. Sub-types are variations on a basic chart type, such 

as 3D options. PowerPoint includes these basic chart types: 

• Column: Creates vertical columns to compare the values of categories of data. Column, 

bar, and line charts work well if you want to compare values over time periods such 
as months or quarters. Figure 11.7 illustrates a sample column chart. 

Figure 11.7: A Column Chart Makes it Easy to Compare Series of Data 

(i) Before creating an actual chart, design a paper sketch of the chart 

you want to create. This can help you understand which chart type 

is right for your specific chart. 

(ii) For help in using Microsoft Graph, choose Help, Microsoft Graph 

Help. This opens the help file specific to this application. 
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• XY (Scatter): Creates a chart that compares sets of values. 

• Area: Creates a chart that shows the trend of values in a single solid area. 

• Doughnut: Creates a pie chart that can contain more than one series. 

• Radar: Assigns a value axis (radiating from the center) for each category, and draws 

lines to connect all values in the same series. The chart compares the collected values 

of several data series. 

• Surface: Creates a single 3D surface that helps you finding the best combinations 

between two sets of data. Colors and patterns indicate areas that are in the same range 

of values. 

• Bubble: Compares three sets of values displayed as bubbles. 

• Stock: Shows a stock’s high, low, and close figures. 

Figure 11.8: Use pie Charts to Show Percentages of a Total Amount 

 

Notes • Pie: Creates a pie that analyzes percentages   of   a total   number.   Use a   pie   chart 
to see how items contribute to a total. For example, you might want to compare 
the year’s expenses for each department in your company. Figure   11.8   shows a 
pie chart. 

 

• Cylinder: Creates columns shaped like cylinders. 

• Cone: Creates columns shaped like cones. 

• Pyramid: Creates columns shaped like pyramids. 

If you already know that you want to create a 3D clustered column chart, which is the 

PowerPoint default, you don’t need to do anything to select a chart type. However, if you 

want to use a different chart type, you should select it before you enter any data or make 
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any other modifications. There are two ways to change the chart type in PowerPoint. You 

can click the down arrow next to the Chart Type button on the Standard toolbar and select 

the chart type you want to apply from the palette that appears. Place the mouse over a 

specific chart type to view a chart tip that tells you the chart type’s name. PowerPoint applies 

the chart type to your chart, which reformats itself in the new type. Not all chart types are 

available through the Chart Type button, however. If you can’t find what you need on the 

palette that appears, try the Chart Type dialog box (Chart, Chart Type). 

In either case, if you don’t like the new chart type you applied, click the Undo button on 

the Standard toolbar to return to your original selection. 

To apply a new chart type using the Chart Type dialog box, follow these steps: 

1. In Microsoft Graph, choose Chart, Chart Type from the menu. The Chart Type dialog 

box appears, as shown in Figure 11.9. 

Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

2. On the Standard Types tab, select the type of chart you want from the Chart Type list. 

A variety of sub-types appears in the Chart sub-type area. 

3. Click the sub-type you want. The text box below provides detailed information about 

this sub-type. 

4. To preview what an actual chart of this type looks like, click the Press and Hold to 

View Sample button. A sample chart temporarily replaces the Chart Sub-Type box, as 

shown in Figure 11.10. 

Figure 11.9: PowerPoint offers many Different Chart Types 
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Custom charts include detailed formatting, and some are customized 

specifically for a certain kind of output, such as onscreen presentations. 

The text box beneath the example indicates these details. 

 
Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
5. If you want to change this to your default, select the Set as Default Chart button. 

6. If none of the chart types in the Standard Types tab suits your needs, click the Custom 

Types tab to view more options. Figure 11.11 illustrates this tab. 

Figure 11.11: Custom Charts Provide Variety and Options 

Figure 11.10: You can Preview Changes before Making Them 
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8. Select the chart type you want to use from the Chart Type list. An example displays 

in the Sample box. 

9. Click OK to apply the chart type and return to your presentation. 

 

11.3.5 Entering Data in the Datasheet 

The default datasheet that opens when you first create a chart includes four columns 

and three rows. This is a common chart format—comparing specific categories over periods 

of time—but only one of the hundreds of possible formats. Figure 11.12 illustrates this 

datasheet. 

The first row and column of a datasheet serve as headers for the information in the datasheet. 
Therefore, the second row begins with the number 1 and the second column with the letter 
A. In this example, the columns display as the category axis, the rows display as the data 

series listed in the legend, and the cell data (A1:D3) represents the value axis. 

Figure 11.12: Enter Chart Data in a Datasheet, Similar to an Excel Worksheet 

To reverse the chart and use the column data as the data series instead 

of the row data, click the By Columns button on the Standard toolbar. 

Microsoft Graph redesigns the chart based on this change. For example, 

if you changed the default chart to display in columns, the quarters 

appear in the legend and the locations appear in the category axis. 

You can also add an active chart in your current presentation to the list 

of chart types. Simply select the User-Defined option button on the 

Custom Types tab, click the Add button, and enter details about this 

active chart to the Add Custom Chart Type dialog box that appears. 

Microsoft Graph adds this chart to its list of custom chart types. 

 

7. Click the Built-In option button to display PowerPoint’s ready made custom charts. Notes 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
To input your own data, just type over the existing information in each cell. 

11.3.6 Inserting and Deleting Datasheet Rows and Columns 

To delete a row or column, place the cursor within the appropriate row or column and 

choose Edit, Delete from the menu. To remove the contents of a cell rather than the cell itself, 

choose Edit, Clear, Contents. Clearing the contents is best when you want to remove existing 

data and replace it with new data. If you no longer need the row or column, you should 

delete it. You can delete a row or column by selecting its heading and pressing the Delete 

key. 
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Notes 

 
 
 

 
To insert a new row, select the row below where you want to place the new row and choose 

Insert, Cells. Microsoft Graph inserts  a new row directly above the selected row. 

To insert a new column, select the column heading  to the right of where  you  want to place 

the new column  and choose Insert, Cells. Microsoft Graph  inserts a new column directly  to 

the left  of the selected column. 

If you want to insert a new cell, rather than a complete row or column, select the cell where 

you want to insert a cell; choose Insert, Cells; and choose either Shift Cells Right or Shift 

Cells Down in the Insert dialog box (see Figure 11.13). 
 

Figure 11.13: Determine the Direction to move the Existing Cells 

in the Insert Dialog Box 

 
 
 
 
 
 
 
 
 
 
 

 
PowerPoint inserts a new cell and shifts the row to the right or shifts the column down, 

depending on your selection. You can undo insertions and deletions by clicking the Undo 

button or pressing Ctrl+Z. 

11.3.7 Formatting Datasheet Column Width 

To format the datasheetís column width, follow these steps: 

1. Select the heading of the column whose width you want to adjust. 

2. Choose Format, Column Width. The Column Width dialog box appears, as shown in 

Figure 11.14. 
 

Figure 11.14: You can Customize the Width of a Datasheet Column 
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You can also cut (Ctrl+X), copy (Ctrl+C), and paste (Ctrl+V) data in the 

datasheet by using keyboard commands or by choosing the appropriate 

buttons on  the Standard toolbar. 

http://www.pdfmachine.com/?cl
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3. Type a width for the column the Column Width field. To adjust to the standard width, 

select the Use Standard Width check box. Or, click the Best Fit button to have the 

columns adjust automatically based on  the existing data. 

4. Click OK to return to the datasheet. 

 
11.3.8 Formatting Datasheet Numbers 

You can format the text and numbers in your datasheet if  you want. To  format numerical 

data, select the cell or cells you want to format and choose Format, Number. The Format 

Number dialog box appears, as shown  in Figure 11.15. 

Notes 

 

11.3.9 Including and Excluding Rows and Columns 

You can include rows and columns in your datasheet, but temporarily hide them in your 

presentation. To do that, select the column or row that you want to hide, and choose Data, 

Exclude Row/Col. The row or column appears shaded in your datasheet and temporarily 

disappears from your presentation. Figure 11.16 shows an example of a hidden column in 

a datasheet. 

TEERTHANKER MAHAVEER UNIVERSITY 227 

Figure 11.15: Customize the Way Numbers Appear in this Dialog Box 

Select the type of number format you want from the Category list, such as date, time, or 

currency format. Based on your category selection, the right side of the dialog box offers 

additional formatting options related to the category. 

For example, if you choose Currency, the right side of the dialog box lets you choose the 

currency symbol such as the   dollar, pound, or   yen. Several of the   numeric categories also 

let you choose the number of decimal places you want to include. 

Click OK to accept the formatting changes and to update your chart. 

http://www.pdfmachine.com/?cl
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Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
4. Click the down arrow to the right of the Chart Type button on the Standard toolbar 

to display a palette of options. 

5. Click the Bar Chart button to change to a bar chart format (pause the mouse pointer 

over the buttons to identify the right button). 

6. For each chart object that has text, select it and set the s to match the font used in the 

slide design. 

In only a couple of minutes, you enlivened your chart and made its format better suit your 

needs. 

To include this information again, choose Data, Include Row/Col. 

11.3.10 Returning to the Presentation from the Datasheet 

When you finish formatting and modifying the datasheet, you can close it by clicking the 

View Datasheet button on the Standard toolbar. Or you can return to working on the 

presentation while the datasheet remains open by clicking on any section of the presentation. 

To reopen the datasheet, click the View Datasheet button again. 

 

11.4 Design Corner : Using Chart Formatting Options 

PowerPoint, in combination with Microsoft Graph, offers numerous chart-formatting options 

to help you create visually appealing charts. This example shows how even minor changes 

can enhance your chart. 

For example, you could create a basic column chart by choosing the Title and Chart layout 

from the Slide Layout task pane (see the “Before” figure). To liven up the chart (see the 

“After” figure), follow these steps using the techniques you learned in this chapter: 

1. With your chart active, choose Chart, Chart Options to open the Chart Options dialog 

box. 

2. On the Titles tab, enter a title for your chart. 

3. On the Legend tab, place your legend on the bottom. 

Figure 11.16: This Hidden Column will Temporarily be Removed from the Chart 

 

You can also double-click the row or column head to include or exclude 

the rows or columns. In this case, the action serves as a toggle. 
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Changed 
chart type 

Added 
chart title 

Made font match 
slide design 

Moved legend 
to bottom 

Figure 11.17: Chart Formatting Options 

Figure 11.18: Cell in horizontal 

 
Before Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After 
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Notes 11.5 Printing 

 

Excel prints only the active area of the worksheet. In other words, it will not print all four 

million cells - just those that have data in them. 

Choose File > > Page Setup, a four tabbed dialog box appears that provides access to most 

print-related settings. 

 

11.5.1 Change Header and Footer Information on Slides 

1. In Normal view or in Slide Sorter view, on the Outline tab or Slides tab, click the slide 

that you want to change the header or footer information on. 

To select more than one slide, click the first slide that you want to change, and then 

press and hold CTRL while you click the other slides. 

2. On the Insert tab, in the Text group, click Header & Footer. 

3. In the Header and Footer dialog box, on the Slide tab, make the change that you want, 

and then do one of the following: 

• To apply the changes to the information on the slide or slides that you selected, click 

Apply. 

• To apply the changes to the information on all of the slides in your presentation, 
click Apply to All. 

 

11.5.2 Change Header and Footer Information on your Notes and 

Handouts 

1. In Normal view or in Slide Sorter view, on the Outline tab or Slides tab, click the slide 

that you want to change the header or footer information on. 

To select more than one slide, click the first slide that you want to change, and then press 

and hold CTRL while you click the other slides. 

2. On the Insert tab, in the Text group, click Header & Footer. 

3. In the Header and Footer dialog box, on the Notes and Handouts tab, make the changes 

that you want, and then click Apply to All. 

 

11.5.3 Delete Header and Footer Information from  your Slides 

1. In Normal view or in Slide Sorter view, on the Outline tab or Slides tab, click the slide 

that you want to delete the header or footer information from. 

To select more than one slide, click the first slide that you want to change, and then press 

and hold CTRL while you click the other slides. 

2. On the Insert tab, in the Text group, click Header & Footer. 

3. In the Header and Footer dialog box, on the Slide tab, clear the check boxes for the 

options that you want to delete from the header or footer. 

 
 

To remove headers and footers from the title slide, select the Don’t 

show on title slide check box. 
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4. Do one of the following: 

• To remove the information from the slide or slides that you selected, click Apply. 

• To remove the information from all of the slides in your presentation, click Apply 
to All. 

 

11.5.4 Delete Header and Footer Information from your Notes and 

Handouts 

Notes 

 

 
 

The File >> Print command displays a dialog box that offers the following options: 

• What to Print: Use the drop-down list to select any of the following options: Document, 
Document Properties, Comments, Styles, AutoText entries and Key assignments. 

• Copies: To specify more than one copy of whatever you intend to print, either type a 
number in the Copies box or click on the up or down arrows next to the box to scroll 
and choose a number. 

1. In Normal view or in Slide Sorter view, on the Outline tab or Slides tab, click the slide 

that you want to delete the header or footer information from. 

To select more than one slide, click the first slide that you want to change, and then 

press and hold CTRL while you click the other slides. 

2. On the Insert tab, in the Text group, click Header & Footer. 

3. In the Header and Footer dialog box, on the Notes and Handouts tab, clear the check 

boxes for the options that you want to delete from the header or footer. 

4. Click Apply to All. 

Figure 11.19: Printing Window 
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Advanced Find and Replace for Microsoft Excel 

Aand  comfortable. 

dvanced Find & Replace for Microsoft Excel is a time-saving add-in that makes 

search through multiple Microsoft Excel spreadsheets and workbooks easy, fast 

 
With this handy add-in you can search in values, formulas, comments and hyperlinks in 
all opened workbooks at a time. No need to click ‚Find Next‛ time and again. With 
Advanced Find & Replace you see all found data and their locations at a glance. The add- 
in reduces the number of clicks to one and the search time to a second. It works fast and 
flawlessly in Microsoft Excel 2007-2000. 

Questions: 

1. Explain the advance Replacing. 

2. Give the steps to find any word in Excel. 

 
Notes • Page Range: To print the entire page range, be sure that the All button is darkened. 

Click on the little button next to All, if necessary. 

• Print All, Odd, or Even: Use the drop-down Print list at the bottom of the Print dialog 

box to specify Odd Pages or Even Pages. 

Excel offers a new way to view worksheets: Page break preview mode. To enter in this mode, 

choose the View > > Page Break Preview command. The worksheet displays changes and 

user can see exactly what will be printed and where the page breaks occur. 

 

11.6 Summary 
 

• Excel is windows-based spreadsheet created by microsoft corporation, US. 

• Excel includes several advanced utilities like the facility to include other objective 

within a spreadsheet and pivot table and form designing. 
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• In the Excel the sheets can be worksheets, chart sheets, macro sheets, or custom dialog 

boxes. 

• The Excel read text files, dBASE files, and HEML documents. 

• Excel includes an enormous collection of built in function. 

• In Excel holds bettors to issue commands when clicked. 

• The default data sheet that opens when you first create a char includes four column 

and three rows, formulating data sheet number and etc. 
 

11.7 Keywords 

Notes 

 

Access Internet documents: save document as HTML files and even create advanced analytical 

tools— Goal seeking, a powerful Solver feature, and the also used to quickly give a name 

to the selected range or cell. 

Analysis application window: minimize, restore, and close. 

Built-in functions: Excel includes an enormous collection of built-in functions. 

Buttons change: one or more assumptions and observe the effects on dependent formulas. 

Control buttons, which can be used to modify the window. 

Excel’s Built-in Functions: Excel provides a bewildering number of built-in worksheet 

Functions that can be used in formulae. These include common functions such as SUM, 

AVERAGE, and SQRT as well as functions designed for special purposes such as statistics or 

engineering Excel’s on-line help is excellent and extremely detailed. 

File compatibility: Excel can read files produced by other spreadsheet programs. 

Formula bar: Information and formulas when entered into Excel, appear in this. 

Formulae: Provide the real power while doing analysis and modeling—creating functioning 

spreadsheet systems. 

Great charts: Excel’s charting features enable the user to modify and augment a hyperlinks 

directly in spreadsheet documents. Information between worksheets in different workbooks. 

Integrated mapping: This feature lets the user display the data in terms of a Interactive help 

While working in Excel, the user can get help on-screen. 

Internet support: Excel includes a variety of new features that make it easy to. It can also 

read text files, dBASE files, and HTML documents line. 

Linking Workbooks: Linking is the process of using references to cells in external workbooks 

to get data. 

List management: This feature makes it easy to sort, filter, summarize, and manipulate data 

stored in the worksheet. 

Menu bar: One way of issuing Excel commands is through the Menu bar. 

Multiple document interface: This capability of Excel makes it easy to transfer. 

Multisheet files: Excel’s files (called workbooks) can consist of any number. 

Name box: Displays the name of the active cell in the current workbook. 

Operators in Excel: Excel lets you use a variety of operators in your formulas. 

Pivot tables: Using this feature, the user can view the data in summarized table required 

to create a custom template. 
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Notes Scenario management: Excel is often used for what-if analysis, that is, you can separate 

sheets. 

Status bar: It usually contains mode indicator button and keyboard mode 

Templates: Excel has a template wizard that walks the user through the steps 

The title bar: This identifies the name of the program and also holds some 

Toolbars: It holds buttons to issue commands when clicked. 

Using the autosum tool: The Sum function is probably the most often used function and the 

AutoSum tool makes it very easy to enter SUM function onto worksheet. Wide assortment 

of graph types. 

Windows control menu buttons: There are three buttons which control the your worksheet. 

 

 
1. Draw graph charts with the help of power point slide. 

2. How to set page layout in power point? 

 

11.8 Self-Assessment Questions 
 

1. Excel uses the ...................Function when creating a data table 

(a) Average (b) Count 

(c) Sum (d) Table 

2. 3-D reference in a formula 

(a) Cannot be modified (b) Only appears on summary worksheets 

(c) Limits the formatting options (d) Spans worksheets 

3. The chart wizard 

(a) Can place a chart on a new chart sheet or on any sheet in the workbook 

(b) Can only place a chart on new chart sheet 

(c) Can only place a chart on a new blank worksheet 

(d) Can only be used to create embedded charts 

4. What chart object is horizontal or vertical line that extends across the plot area to make 

it easier to read and follow the values? 

(a) Category axis (b) Data marker 

(c) Data point (d) Gridline 

5. What is the keyboard shorZ 

(a) F3 (b) F5 

(c) F7 (d) F11 

6. You can use the formula palette to 

(a) Format cells  containing numbers 

(b) Create and edit formulas containing functions 

(c) Entered assumptions data 

(d) Copy a range of cells 
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7. What Pivot Table toolbar button updates the data in a Pivot Table or Pivot Chart report 

if the source data character changed 

(a) Format Report (b) Pivot Table 

(c) Refresh Data (d) Show Detail 

8. Which of the following setup options can not be set in the page setup dialog box? 

(a) Printer selection (b) Vertical  or horizontal placement 

(c) Orientation (d) Row and column titles 

9. Charts tips can 

(a) Show the formatting of a data label 

(b) Show the name of a data series 

(c) Show the value of data point 

(d) Both (b) and (c) 

10. You can use the horizontal and vertical scroll bars to 

(a) Split a worksheet into two panes 

(b) View different rows and columns 

(c) Edit the contents of a cell 

(d) View different worksheets 
 

11.9 Review Questions 

Notes 

 

1. Name the elements which a formula can contain. 

2. Can a formula be removed from the worksheet without removing the calculated 

value? 

3. How will you make the cell address in a formula absolute? 

4. How is relative addressing different from absolute addressing? 

5. Discuss the different kinds of errors that could occur while working in Excel. 

6. Briefly explain the AutoSum tool available in Excel. 

7. What is a circular reference? 

8. What is formatting and why is it used? 

9. What do you understand by a cell and a range? 

10. What are the different ways to select a range? 

11. What is the difference between a contiguous and a non-contiguous selection? 

12. Explain the following in brief: 

(a) Menu bar (b) Formula bar 

(c) Status bar (d) Active window 

13. How can you cancel a print job which has already been placed in the printer queue? 

14. What are Excel Headers and Footers? 

15. How to add headers and footers to a worksheet? 
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Fundamental Computer Concepts, William S. Davis. 

Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister. 

http://books.google.co.in/bkshp?hl=en 

 
 

Notes Answers for Self-Assessment Questions   

 1. (d)  2. (d) 3. (b) 4. (d) 5. (d) 

 6. (b)  7. (c) 8. (a) 9. (d) 10. (b) 

 

11.10 Further Readings 

 

http://books.google.co.in/bkshp?hl=en
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MS PowerPoint is a very powerful means of making an effective presentation. lt generates 

presentation slides rich in graphics Audio and Video. The slides generated on power point 

can be played on a PC or their print-outs cab be projected on an over head projector. When 

played on a PC it works more like a web-page in an easy-to-move-around way. The slides 

generated in powerpoint are stored in files of extension <.ppt>. There are, although. Various 

way to create a powerpoint presentation e.g. generate the slides from MS Word or MS Excel 

and develop a presentation from PowerPoint itself. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Objectives 

After studying this unit, you will be able to: 

• Explanation of starting of MS powerpoint 

• Understand the starting power point slides 

• Process of applying different color schemes 

• Explain enhancing text in MS powerpoint 

• Understand graphics 

• Explain the autoshapes 

• Understand the printing presentation 

• Explain the process of adding multimedia content 
 

Introduction 
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12.5.3 Choosing Graph Type 

12.5.4 Editing Graph 

12.5.5 Enhancing Graph 

12.5.6 Changeable Chart Elements 

12.5.7 Setting Chart Option 

12.6 AutoShapes 

12.7 Adding Multimedia Content 

12.7.1 Insert a Movie using Clip Organizer 

12.7.2 Insert a Movie from a File 

12.8 Printing Your Presentation 

12.8.1 Setting a Default Printer 

12.8.2 Printing Slides, Outlines, Notes, or Handouts 

12.9 Summary 

12.10 Keywords 

12.11 Self-Assessment Questions 

12.12 Review Questions 

12.13 Further Reading 
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Windows of Microsoft PowerPoint 

When you start PowerPoint, the workspace opens in Normal view. Normal view is divided 

into 3 areas: 

1. Slide Pane: Shows the full layout of a slide. 

2. Slides Tab and Outline Tab: Shows slide thumbnails and text-only hierarchical versions 

of the slides. 

3. Notes Pane: Used to input text relevant a specific slide. 

Notes 

 

 
Mac OS   X   operating   system.   The   current   versions   are   Microsoft 
PowerPoint 2010 for Windows and 2011 for Mac. 

 

12.1 Getting Started 

If power point is already open or this box does not appear. Select New File from the bar. 

Otherwise, open Power Point and it will prompt with a dialog box with four choices’ 

Whereas, the ‚Open an Already Existing Presentation‛ option enables you update/modify 

an existing presentation, the other these options are explained in this section. 

Other view include Slide Sorter view which shows thumbnails of the entire presentation and 
Slide Show view where you preview your presentation. 

Microsoft PowerPoint, usually just called PowerPoint, is a closed source 
commercial presentation program developed by Microsoft. It is part of 

the Microsoft Office suite, and runs on Microsoft Windows and Apple’s 

Figure 12.1: Window of MS PowerPoint 2007 
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It prompts to select options such as Title of Presentation, number. When done with this click 

OK. 

 

12.1.2 Finish 

Should you need to make any changes in the previous steps click back and then change or 

else click finish. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Auto Content Wizard Figure 

This method creates a desired presentation in four clicks. Select Auto content wizard and 

click OK. The AutoContent Wizard provides templates and ideas for a variety of presentation 

types. Page through the wizard by clicking the Next button on the bottom of each page after 

making necessary choices. 

Presentation Types: It offers choices categorized under General/Corporate/Sales & Marketing/ 

Project. The all types’ option displays all templates available. Select appropriate type of 

template and click next. Presentation Style It then asks the options for type of presentation. 

The options include Web Presentation, On Screen Presentation, OHP (Colored or B&W) or 

35 mm film presentation. SFlect On-screen-Presentation when presenting on a PC from the 

power point direct, the web style is also the on-screen-presentation with the action more like 

a web page. When done with the choice of style click next. 
 

12.1.1 Presentation Options 

Figure 12.2: First Window of PowerPoint 
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Figure 12.3: Auto Content Wizard 

Figure 12.4: Design Template 

 
Notes 

 

   AutoContent Wizard  

 
 
 
 

The AutoContent Wizard gets you started by 
providing ideas and an organization for your 
presentation. 

 
 
 
 
 
 
 
 
 
 
 

12.1.3 Design Template 

Powerpoint provides, many templates with different backgrounds and text formatting to 

begin the presentation. There are three tabs General, Design Templates and Presentation. 

Select appropriate type of design and preview each design by highlighting the template 

name on the list. Press After choosing the design click OK. 
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Figure 12.5: Auto Layout 

 
Notes 

 

 

 
12.1.4 Blank Presentation 

From the General tab select Blank Presentation to build the presentation from scratch with 

no preset graphics or formatting. Or else select Open. An Existing Presentation to open a 

power point presentation that already exits. Select the folder the file is located in from look 

in: drop-down menu and highlight the file on the list. Click Open to open the presentation. 

12.1.5 Auto Layout 

After selecting the presentation type, it will prompt to choose the layout of the new slide. 

These layouts include bulleted lists, graphs and/or images. Click on each thumbnail image 

and a description will be displayed in the message box. Highlight the layout of choice and 

click OK. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Powerpoint provides, many templates with different backgrounds and 

text formatting to begin the presentation. There are three tabs General, 

Design Templates and Presentation. Select appropriate type of design 

and preview each design by highlighting the template name on the list. 

Press After choosing the design click OK. 
 

12.2 Starting PowerPoint 
 

To Start PowerPoint 

• Click on Start button located at the bottom left corner of your Windows environment. 

• Select Programs option from the Start menu. 

• Select Microsoft PowerPoint from Programs submenu. 

12.2.1 The Screen Elements 

The PowerPoint screen is organized so that everything you need is visible at all times. From 

the Window-style toolbars and on-screen buttons to the status bar and work area, you won’t 

have any trouble in moving from one view to next quickly. 

 
Give the steps for adding the Power point wizard. 
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Figure 12.7: Normal View 

 
Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

12.2.2 PowerPoint View 

PowerPoint provides you several views to look through your presentations. Each of these 

views is discussed in detail here. The view buttons are available at the lower left corner of 

the screen. 

12.2.3 Normal View 

Normal view is the most common view available to you. It is the default view of PowerPoint. 

It displays slide contents in the left pane while the present slide is displayed in the right 

pane. 

It shows a combination of slide, outline and notes page views. This view is helpful when 

one has to work in multiple areas at once; add text in outline and see how it appears on 

the slide; type the notes that will remain with the current slide. 
 

Figure 12.6: The Screen Elements 
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12.2.5 Slide View 

This view gives you the freedom to work on slides only, one by one, while the outlines are 

minimized on the smaller left pane. It is comparatively easier to add text or objects to a 

single slide or format only one slide at a time. 

The left pane now contains only the slide numbers, so that you can select any one from them. 

12.2.6 Slide Sorter View 

It displays miniature versions of all slides in a presentation, complete with text and graphics. 

In this view, you can reorder slides, add animation, set timings, move or delete slides, insert 

new slides or check presentation continuity. 

Figure 12.9: Slide Sorter View 

Figure 12.8: Slide View 

 
Notes To select any slide in this view, just click on the particular slide number visible in the left 

pane. 

12.2.4 Outline View 

This view displays the presentation text in outline form. It is helpful in entering text quickly, 

following a format provided by PowerPoint. It is also helpful in moving, copying or cutting 

text; spell-checking text; reading through for consistency; or printing a script for your 

presentation. 
 



Unit 12: MS PowerPoint 

245 

 

 

Perfect color combination is must for every presentation. You should decide your color 
scheme before presenting your slide. 

PowerPoint helps you to choose a color scheme from any of the available catchy schemes. 

Choose Format >> Slide Color Scheme. 

Select any color scheme for General or Custom tab. 
 

12.3.1 Running a Slide Show 

After you have finished with your creative work, its time to see the show To start the slide 

show, click on Slide Show view button, or choose Slide Show > > View Show. The keyboard 

shortcut is F5. 

Figure 12.10: Applying Different Color Schemes 

 
Notes 

 

 

 

 
 

12.3 Applying Different Color Schemes 
 

12.3.2 Entering Text 

The text of your presentation carries a lot of weight. Before preparing the text content of 

your presentation you must follow some rules: 

• Too much text should nor be placed on a slide. 

• The clearer, the better. 

• Know where you are going. 

This view displays the current slide in a reduced size with room for notes 

at the bottom of the page. It is used for adding a memo, notation or 

instruction for a slide(s). You can also use this view to design explanatory 

handouts for your audience. 
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Click the text box you want use and Type the text. 

If your text takes more than one line PowerPoint automatically wraps the text. 

Arial 

Slide Layout 

 
Apply slide Layout 

Content Layouts 

Show when insertion new slides 

Draw Autoshapes   
 

Slide 2 of 1 Default Design 

Adding New Text Boxes If you want to add more text than Slide view leaves room fo4 you 

can add new text boxes to your slide. To add a new text box: 

• Click the text box tool. 

• Move the cursor to the point on the slide where you want to add the box. 

• Hold the mouse button while dragging the mouse down and to the right. 

Microsoft PowerPoint - [Presentation3] 

Figure 12.11: Adding Text in Slide View 

File     Edit   View  Insert   Format   Tools   Side show    Flash Paper   Window      Breeze  Help   Articulate  Adobe PDF 

 
Notes • Use text to highlight, nor narrate. 

• Color and contrast are important. 

• Think about your audience. 

• Timing. 

 

12.3.3 Adding Text in Slide View 

To add the text in Slide view. 

• Release it when the text box is the size you want. 

 

12.3.4 Adding Text in Outline View 

To display presentation in Outline view click the Outline View button in the lower-left 

corner of the screen or choose View > > Outline. The displayed screen will be as follows: 
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Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

12.3.9 Formatting Text 

The way your text is positioned on a slide contributes to whether or not a viewer actually 

reads it. Once you have the text into your presentation, you may want to rearrange it to see 

what’s most effective. There are different ways in which you can change the format of your 

presentations: 

• Apply a new design template to the entire presentation. 

• Choose a new page layout for the current slide. 

File Edit   View   Insert   Format   Tools   Slide Show Window   Help 
 

  Times New Roman Common Tasks   

Click to add notes   

Outline View 

To add text in existing slide use arrow keys to move the cursor to the desired point. To 
design with new line indented to the same pot, press Enter, press Tab to indent the line 

further. To out dent the line press Shift and Tab and type your text. 

12.3.5 Editing Text 

Editing text involves the keystroke editing and block-editing. 

12.3.6 Simple Text Editing 

To make changes in only text box, first click the text box a border appears indicating that 

you have selected the box. Now position the cursor where you want to make changes. 

Modify the text. When finished, click outside the box. 

12.3.7 Selecting Text 

Some editing procedure requires that you mark the text before editing. To do this, click the 

mouse button when pointer is placed at the beginning of the text you want to mark, press 

the button and drag the mouse over the section you want to mark. 

12.3.8 Cutting, and Pasting Text 

Select the text. Click the right mouse button, choose Copy or Cut as desired. Click at 

destination. Right click the mouse and choose Paste from the shortcut menu that appears. 

Figure 12.12: Adding Text in Outline View 

 
Design Presentations 

Print speaker's notes 

Add multimedia effects 
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Choose one of the different templates and click Apply. 

12.3.11 Choosing Format with a New Layout 

The easiest way to change the format is to select a different layout for your presentation. 

You can change layout but keep the text same by clicking Slide Layout button on the 

Standard toolbar. From the Slide Layout dialog box, choose the layout you want. 

Figure 12.14: Choosing Format with a New Layout 

Figure 12.13: Applying a New Design 

Microsoft PowerPoint - [DESIGN TEMPLATES ] 
 
 
 
 

 
Slide Design 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click to add notes 

 
 

Slide 1 of 3 Promots 

Design Template 

Color Scheme 

Animation Scheme 

Apply a design template 

 
Notes • Use the ruler, tabs, indents, and alignment options to change the way elements are 

positioned on the slide. 

12.3.10 Applying a New Design 

Choose Apply Design Template commamnd from the formar Menu. The Apply Design 

Template dialog box appears. 
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12.3.12 Working with Ruler, Tabs, Indents, and Alignment  Options 

If the ruler is not visible, click View > > Ruler. Click on a placeholder or highlight a block 

of text for which you want to set new tabs. Point to and click on the Tab button at the left 

edge of the ruler until the desired type of tab appears. Point to a location on the bottom 

edge of the ruler and click where you wish to insert a tab stop. A tab symbol will appear. 

To move a tab once it has been inserted, click and drag the tab symbol to a new location 

on the ruler. To remove a tab, click and drag the tab symbol down and away from the ruler. 

To align the text select the text and click on Left, Right, Centered or Justified button on the 

Standard Toolbar. 

Notes 

 
Select a font of your choice and choose other options as desired. 

A film transition is a technique by which scenes or shots are juxtaposed. 
Most commonly this is through a normal cut to the next scene. Most 

films will also include selective use of other transitions, usually to 

convey a tone or mood, suggest the passage of time, or separate parts 

of the story. These other transitions may include dissolves, L cuts, fades 

(usually to black), match cuts, and wipes. 

12.4 Enhancing Text 
 

12.4.1 Changing Text Font and Size 

To change the font, first select the text whose font you want to change. Choose Format > 

> Font. The Font dialog box appears. 

Figure 12.15: Changing Text Font and Size 
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Notes 12.5 Graphics 

 

Open the PowerPoint application, and then open the project that you want to edit. 

Locate the slide that you want to add the graphic to in the ‚Slides‛ window and double- 

click on the slide. Your slide will open in the middle of the screen. 

• Click on the ‚Click icon to add content‛ box located on the slide. Find the ‚Insert Clip 

Art‛ icon, which is the top right icon located in the ‚Click icon to add content‛ box. 

• Find a graphic that will work for your presentation and click ‚OK.‛ 

• Resize the graphic by clicking on the small circles located around it. Move the graphic 

by clicking on it and holding down the left mouse button to Save your project. 

A graph is the pictorial representation of data. It can help you in many operations such as: 

• Comparisons Graph can help you illustrate relationships between data. 

• Trends When you need to show data trends, graphs can help your compare the 

progress of two data sets. 

 

12.5.1 An Over Graph Type 

When you are creating two-dimensional or three-dimensional graphs from scratch with 

PowerPoint, you’ve got a number of different graph types to choose from, including these: 

• Area graphs show one or more data trends over time. 

• Bar graphs show how data series ‚stack up‛ against each other. 

• Column graphs are similar to a bar graph, except that the bars are stacked on top of 

each other instead of ‚side-by-side‛. 

• Doughnut graphs plot more than one data series as part of a whole. 

• Line graphs compare data series over time. 

Pie graphs show how individual data items relate to the whole. 

• Radar graphs compare data series. 

XY (Scatter) graphs plot data points according to X and Y-axes. 

Surface graphs show data trends in a two-dimensional view. 

Bubble charts compare three sets of data. 

2-D and 3-D charts offer cylinder, pyramid and cone shapes. 

 

12.5.2 Creating a Graph 

• To create Graph in PowerPoint, firstly you need a slide with graph area. To do this 

• Click the New Slide button and choose Chart and Text layout and click OK. 

• The new slide appears on the screen with a graph area. 
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To erase sample data, highlight the information in the datasheet window and press the delete 

key. 

Type your own information into the Datasheet. Note that chart changes to reflect the data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Double-click the graph area. 

Sample chart appears on the slide along with a datasheet window congaing sample data. 

Figure 12.16: Creating a Graph 

Figure 12.17: Graph of Data 
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1. Click on Chart type button on Standard toolbar to display the drop down chart box. 

2. Select a Chart type and then choose a sub-type. 

Choose Chart >> Chart Type. 
 

12.5.4 Editing Graph 

Figure 12.18: Choosing Graph Type 

 
Notes 

 

 

 

 
 

12.5.3 Choosing Graph Type 

You can select a chart type in one of the two different ways: 
 

The Graph frame appears with handles around its outer edge. 

To resize a graph Click a handle and drag the graph to resize it horizontally or vertically. 

To cut a graph Make sure the graph is selected; then choose Edit >> Cut. 

To delete a graph Make sure the graph is selected; then press Del or choose Edit > > Clear. 

To copy a graph Select the graph; then choose Edit > > Copy. 

To paste a graph Move to the slide on which you want to paste the graph Choose Edit >> 

Paste. 

 

 
Create a graph of Data. 



Unit 12: MS PowerPoint 

253 

 

 

 

12.5.5 Enhancing Graph 

You can add select, color, background, a text note, add a title or data labels to your chart 

to enhance its look. 

 

12.5.6 Changeable Chart Elements 

You can select and change any of the following chart elements by double clicking on them: 

Notes 

 

 
 

From the dialog box, click on different tabs and select options as desired. 
 

12.6 AutoShapes 
 

To emphasize important points in your presentation, you might want to include PowerPoint 

auto shapes in addition to text. The Shapes you draw in PowerPoint are objects that can be 

sized, moved, copied, and formatted in a variety of ways to suit your needs. 

• Individual data series 

• The plot area 

• The X and Y axes 

• The legend 

• The gridlines 

12.5.7 Setting Chart Option 

You can set various chart options to enhance its look. To do this Select the chart. 

Choose Chart >> Chart Options. 

Figure 12.19: Setting Chart Option 
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12.7 Adding Multimedia Content 

 

You can insert one or more video clips—that is, movies—into any slide. You might want 

to play a video quote from your product manager. 

Most of the movie clips stored in the Clip Organizer are simply animated .gif files, small 

files that contain an animated sequence of images. If you imported your own movie files 

into the Clip Organizer, you will find them there, too, generally stored in .avid format. You 

might be able to find additional movie clips on your network, intranet, or the Internet. 

Figure 12.20: AutoShapes 

 

Before you insert video clips, think about the environment you’ll be 

presenting in. Does the computer you will use have the necessary hardware 

(such as a sound card, speakers, and an enhanced video card) for playing 

the multimedia items during your presentation? You might consider 

adding only a few multimedia elements just in case. If the machine you 

give your presentation on doesn’t support them, plan an alternate way 

to make your presentation compelling. With this basic detail considered, 

you’ll find that adding video and sound is the same as adding any other 

item to your slides, and the special effects are truly exciting. 

 
Notes PowerPoint provides several tools for creating several types of shapes including arrows, 

banners, stars, rounded rectangles, circles, squares, and more. Shapes can be worked with 

individually or they can be grouped and treated as one shape. 

To create almost any shape in PowerPoint, you click on a tool from the Drawing toolbar or from 

the PowerPoint AutoShapes menu and then drag in the location where you want the shape to 

appear. 
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To insert a movie into a slide, follow these steps: 

12.7.1 Insert a Movie Using Clip Organizer 

1. Display the slide in which you want to add a video clip. 

2. On the Insert menu, point to Movies and Sounds, and then click Movie from Clip 

Organizer. 

You can now browse the Clip Organizer for a movie clip. PowerPoint will open the 

Clip Art task pane and will select the Movies option in the Results should be drop- 

down list. 

3. Click the movie you want to add to your slide. 

Notes 

 

 
 

12.7.2 Insert a Movie from a File 

You can insert a movie from a movie file on a local disk, a shared network location, or an 

Internet site. 

1. On the Insert menu, point to Movies and Sounds, and then click Movie from File. 

2. Select the movie file in the Insert Movie dialog box, and then click the OK button. 

If you selected a movie clip in animated .gif format, the animation will run automatically 

the entire time the slide is displayed in a slide show. If, however, you selected a movie in 

another format (such as .avid), PowerPoint will display a message box letting you choose 

when the movie will play. 

• To have the movie play automatically when the slide is displayed in a slide show, click 

the Automatically button. 

• To have the movie play only after you click the movie image, click the When Clicked 

button. PowerPoint will then add the clip (?) to your slide. 

 

12.8 Printing Your Presentation 
 

When printing with PowerPoint, you can choose the format of your printed page. PowerPoint 

offers eight formats: 

• Slides 

• Notes Pages 

• Outline View 

• Handouts-1 slide per page 

• Handouts-2 slides per page 

Some of the layouts you can apply to a slide (using the Slide Layout task 

pane) add a group of buttons to the slide for inserting various types of 

objects. These are known as Content Layouts or Text and Content Layouts. 

If you have applied such a layout to your slide, you can insert a video 

clip from the Clip Organizer by clicking the Insert Media Clip button and 

selecting a video clip in the Media Clip dialog box (which displays both 

movie and sound clips). However, the Clip Art task pane (or the 

freestanding Clip Organizer program) provides more features for locating 

and inserting a video clip and usually makes the task easier. 
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Before you begin printing, it is often best to set a default printer so that your presentation 

will automatically be sent to the printer you want. 

1. From the Start menu, select Printers and Faxes The Printers and Faxes dialog box 

appears. 

2. Select the printer you wish to set as your default printer. 

3. From the File menu, select Set As Default Printer The selected printer is now the default 

printer. 

4. From the File menu, select Close. 

 

12.8.2 Printing Slides, Outlines, Notes  or Handouts 

1. Open your presentation. 

2. In the Slide Sorter view, from the File menu, select Print. 

3. The Print dialog box appears. 

4. To print more than one copy, in the Number of copies text box, type the number of 

copies. 

5. From the Print what pull-down list, select the presentation format you want to print. 

Figure 12.21: Printing Option of Slide 

 
Notes • Handouts-3 slides per page 

• Handouts-4 slides per page 

• Handouts-6 slides per page 

• Handouts-9 slides per page 

 

12.8.1 Setting a Default Printer 
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S 
ince the late 1960’s visual artists in museums and galleries have used slide shows 

as a device, either for presenting specific information about an action or research 
or as a phenomenological form in itself. According to the   introduction   of 

[Slide show] — an exhibition organized at the Baltimore Museum of Art- ‚Through the 

simple technology   of   the   slide   projector   and   35   mm   color   transparency,   artists 

discovered a tool that enabled the transformation of space through the magnification of 

projected pictures, texts, and images‛. Although some have not necessarily used 35 mm 

or color slides, and some have even exchanged images for texts (Robert Barry) the color 

slides are the most commonly used and they could be sometimes accompanied with 

written text, either on the slides or as an infertile. Some artists have also used a voice- 

over on the slide presentation (James Coleman, Robert Smithson). Slideshows have since 

also used by artist that use other mediums as painting and sculpture to present their work 

publicly. During the last few years there is a growing usage of the concept by a younger 

generation of artists. Non-profit organization Slide luck Potshot holds slideshow events 

globally featuring works by amateur and professional artists, photographers, and galleries. 

Participants in the event bring food, potluck-style, to have a social dinner before the slide 

show begins. 
 

Questions: 

1. What is the purpose of developing MS PowerPoint? 

2. How MS PowerPoint invented? 

To print a range of slides, type the beginning number, a hyphen, and the 

ending number (e.g., to print pages seven through twelve, type 7-12). 

 

To print non-consecutive slides, type their numbers separated by commas 

(e.g., to print pages seven and twelve, type 7, 12). 

 

6. To print a specific slide(s), in the Slides text box, type the slide number(s). 

7. Click OK. 

Notes 

 

 
 

 

12.9 Summary 
 

• Powerpoint is a powerful presentation package of microsoft. 

• The normal view is the default view of power point which shows a combination of 

slides, outline and notes page view. 

If you are printing handouts, three slides per page is often the best choice; 

slides are printed large enough to be easily read, and there is space on 

one side of the page for your audience to take notes. 
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Notes • Outline view displays the presentation in outline form making it easy to copy, move 

or delete slides. 

• The slide view offers one slide at time for editing. 

• The slide sorter view displays main true version of all slides in presentation. 

• The Auto content wizard provides an outline for your presentation. 

• Powerpoint’s build in templates can used as the basis for the presentation. 

 

12.10 Keywords 
 

Auto layout: After selecting the presentation type, it will prompt to choose the layout of 

the new slide. These layouts include bulleted lists, graphs and/or images. 

Blank presentation: From the General tab select Blank Presentation to build the presentation 

from scratch with no preset graphics or formatting. Or else select Open. 

 
 

1. Explain different ways to view slides in PowerPoint. 

 

2. Show slide layouts in PowerPoint. 

 

 

12.11 Self-Assessment Questions 
 

1. Which file format can be added to a PowerPoint show? 

(a) jpg (b) giv 

(c) wav (d) All of these 

2. In Microsoft PowerPoint two kind of sound effects files that can be added to the 

presentation are: 

(a) wav files and .mid files (b) wav files and .gif files 

(c) wav files and .jpg files (d) jpg files and .gif files 

3. Material consisting of text and numbers is best presented as: 

(a) a table slide (b) a  bullet slide 

(c) a title slide (d) All of these 

4. What is a motion path? 

(a) A type of animation entrance effect 

(b) A method of advancing slides 

(c) A method of moving items on a slide 

(d) All of the above 

5. What is a slide-title master pair? 

(a) The title area and text area of a specific slide 

(b) A slide master and title master merged into a single slide 
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(c) A slide master and title master for a specific design template 

(d) All of these 

6. Which of the following should you use if you want all the slide in the presentation 

to have the same ‚look‛? 

(a) The slide layout option (b) Add a slide option 

(c) Outline view (d) Presentation design template 

7. In the context of animations, what is a trigger? 

(a) An action button that advances to the next slide 

(b) An item on the slide that performs an action when clicked 

(c) The name of a motion path 

(d) All of these 

8. If you have a PowerPoint show you created and want to send using email to another 

teacher you can add the show to your email message as a (an) 

(a) inclusion (b) attachment 

(c) reply (d) forward 

9. In order to edit a chart, you can 

(a) triple click the chart object (b) click and drag the chart object 

(c) double click the chart object (d) click the chart object 

10. To exit the PowerPoint 

(a) click the application minimize button 

(b) click the document close button 

(c) double click the applications control menu icon 

(d) double click the document control menu icon 

Notes 

 

12.12 Review Questions 
 

1. What is MS PowerPoint? 

2. How do you play sounds across multiple slides? 

3. Explain different ways to view slides in PowerPoint. 

4. Explain slide layouts in PowerPoint. 

5. Make Font Colors and Styles Stand Out on PowerPoint Slides. 

6. Differentiate between a template and wizard. 

7. How can you apply a different color scheme to your presentation? 

8. What is an AutoContent wizard? 

9. What is the difference between Notes Page and Slide Sorter view? 

10. How can you run a presentation? 
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A Study of Computer Fundamental, Shu-Jung Yi. 

http://books.google.co.in/bkshp?hl=en 

 
 

Notes Answers For Self-Assessment Questions   

 1. (d) 

6. (d) 

 2. (a) 

7. (b) 

3.   (a) 

8.   (b) 

4.   (c) 

9.   (c) 

5.   (c) 

10.   (c) 
 

12.13 Further Reading 
 

 

http://books.google.co.in/bkshp?hl=en


Unit 13: Internet 

261 

 

 

CONTENTS 

Objectives 

Introduction 

13.1 Internet-Brief History 

13.2 Web Page 

13.2.1 Color, Typography, Illustration, and Interaction 

13.2.2 Dynamic Behavior 

13.3 Website 

13.3.1 Book Marking 

13.3.2 Printing 

13.3.3 To Download 

13.3.4 To Personalise the Display 

13.4 Browsers 

13.5 

13.6 

13.4.1 

13.4.2 

13.4.3 

URL 

13.5.1 

13.5.2 

13.5.3 

13.5.4 

HTML 

Elements 

Rendering 

Web Browser Environment 

Viewing 

Creation 

Saving 

Getting Started of Web Page 

13.6.1 Data Types 

13.6.2 Document Type Declaration 

13.7 Internet Service Provider (ISP) 

13.7.1 Access ISPs 

13.7.2 Locality 

13.7.3 Hosting ISPs 

13.7.4 Transit ISPs 

13.7.5 Peering 

13.7.6 Derivatives 

13.8 Summary 

13.9 Keywords 

13.10 Review Questions 

13.11 Self-Assessment Questions 

13.12 Further Reading 

 

Unit 13: Internet Notes 

 

 



Unit 13: Internet 

262 

 

 

 
Notes Objectives 

 

After studying this unit, you will be able to: 

• Explain the brierf history fo internet and Wab page 

• Discuss about the Web page its features 

• Explain browsers and URL 

• Discuss varions HTML data types and ISP’s 

• Explain variars compouents of Wabsir and its fcatures 

 

Introduction 

In the present scenario of Information Technology, Internet has become a popular mode of 

communication. It has permeated all spheres of life. Internet shares information with anybody. 

Anywhere in the world with a minimum amount of financial resources. Internet is the 

combination of millions of computers. Connected together either through phone lines. 

Ethernet ISDN or cable modems, etc. so that they can share information. The internet is really 

a big network. 

One of the scientists referred, Internet as an ‘ocean’, because of its enormity and power. Some 

people are said to ‘surf’, ‘ride’ or ‘navigate’ the ‘net’. It is probably more accurate to say most 

people begin to ‘swim’ through the Internet, until they find their own way. With the Internet, 

the possibilities are endless. Some of them are mentioned below. 

School children, for example in Delhi can ‘talk’ to their friends in Mumbai. 

Teachers and administrators can have a conference with other colleagues thousands of kilometers 

away. A professional on a business trip can access the computer in her or his home or office, 

and then dispatch hundreds of messages with a few simple clicks. The students can get 

information of any subject at anytime through Internet. The jobseekers can get information 

on different kind of jobs all over the world. The students wish to take admission for higher 

education can get information from different institutions in any part of the global. And these 

are just the beginning with the Internet. The limits are only determined by how much you 

want to take from it. 
 

13.1 Internet-Brief History 
 

The Internet was first started as an experiment by the United States Department of defense 

in 1969. The United States military needed a way for its researchers to communicate and 

share programs with one another over their computers. The defense computer researchers 

developed the first long distance network of computers, which was called ARPANET (Advanced 

Research Projects Agency—Network). Remote military sites were then ‘connected’ to one 

another, via telephone lines. Universities and scientists saw the advantage of long distance 

networking. They began to connect with ARPANET as well as to each other. Businesses and 

private individuals then started connecting through the network of computers. Eventually 

the massive network of networks developed, known as Internet. 

Today, no individual, no corporation and no government owns the Internet—it is owned, 

operated and maintained by all of those who use it. The Internet was first started as an 

experiment by the United States Department of Defence in 1969. The United States military 

needed a way for its researchers to communicate and share programs with one another over 

their computers. The defense computer researchers developed the first long distance network 

of computers, which was called ARPANET (Advanced Research Projects Agency—Network). 

Remote military sites were then ‘connected’ to one another, via telephone lines. Universities 
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and scientists saw the advantage of long distance networking. They began to connect with 

ARPANET as well as to each other. Businesses and private individuals then started connecting 

through the network of computers. Eventually the massive network of networks developed, 

known as Internet. Today, no individual, no corporation and no government owns the 

Internet—it is owned, operated and maintained by all of those who use it. 

(i) Go to a Computer Laboratory with internet connection facility. 

(ii) Connect internet by understanding how a telephone number; a user’s name and a 

password is fed into the computer for internet connection. 

Notes 

 

 
 

 

In United States military needed a way for its researchers to communicate 

and share programs with one another over their computers. 

(a) Click the icon, shortcut to Dial-up created at the desktop of the computer 

shown in Figure 13.1. 

Figure 13.1: A Desktop with Shortcut to Dial-up...Icon 
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Notes 13.2 Web Page 

 

A Web page or Webpage is a document or information resource that is suitable for the World 

Wide Web and can be accessed through a web browser and displayed on a monitor or mobile 

device. This information is usually in HTML or XHTML format, and may provide navigation 

to other web pages via hypertext links. Web pages frequently subsume other resources such 

as style sheets, scripts and images into their final presentation. 

Web pages may be retrieved from a local computer or from a remote web server. The web 

server may restrict access only to a private network, e.g. a corporate intranet, or it may 

publish pages on the World Wide Web. Web pages are requested and served from web 

servers using Hypertext Transfer Protocol (HTTP). 

Web pages may consist of files of static text and other content stored within the web server’s 

file system (static web pages), or may be constructed by server-side software when they are 

requested (dynamic web pages). Client-side scripting can make web pages more responsive 

to user input once on the client browser. 

13.2.1 Color, Typography, Illustration and Interaction 

Web pages usually include information as to the colors of text and backgrounds and very 

often also contain links to images and sometimes other types of media to be included in 

the final view. Layout, typographic and color-scheme information is provided by Cascading 

Style Sheet (CSS) instructions, which can either be embedded in the HTML or can be 

provided by a separate file, which is referenced from within the HTML. The latter case is 

especially relevant where one lengthy style sheet is relevant to a whole website: due to the 

way HTTP works, the browser will only download it once from the web server and use the 

cached copy for the whole site. Images are stored on the web server as separate files, but 

again HTTP allows for the fact that once a web page is downloaded to a browser, it is quite 

likely that related files such as images and style sheets will be requested as it is processed. 

An HTTP 1.1 web server will maintain a connection with the browser until all related 

resources have been requested and provided. Web browsers usually render images along 

with the text and other material on the displayed web page. 

13.2.2 Dynamic Behavior 

Client-side computer code such as JavaScript or code implementing Ajax techniques can be 

provided either embedded in the HTML of a web page or, like CSS style sheets, as separate, 

linked downloads specified in the HTML. These scripts may run on the client computer, if 

the user allows. 

 

Each day when browsing the Internet, we visit a lot of websites, some 

more complex, others — just simple personal pages. The term ‚website‛ 

represents a summary of all the content you have put online — each file 

takes part in what the website represents, and The driving power behind 

the website, the pillars that hold it together, are the web pages. 

 

13.3 Website 

The location bar (in Netscape Navigator) or Address bar (in IE) typically shows the address 

for the last page you accessed. You can also use the location bar to access a specific page 

by typing the address for that page into the location bar. 
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In Microsoft Internet Explorer, bookmarks are called ‚favorites‛. 

 
To enter an address in the location bar follow these steps: 

1. Point and click in the location bar. Delete the address that appears there. 

2. Type a new address. such as http://www.hotmail.com 

3. Press the Return key 

To the right hand side of the Location bar, there is a button labeled with a triangle. By 

clicking on the triangle, you will get a drop-down menu of addresses that you have visited 

recently. 

Notes 

 

 

 

13.3.1 Book Marking 

In web terminology, a bookmark is a record of Web page address. If you want to visit a 

page again and again or to visit again a browsing page or to find the page again you can 

bookmark it Most browsers also allow you to organize your bookmarks into a directory, 

similar to the file folder directories in Windows. The processes for creating, organizing, and 

accessing your bookmarks varies depending on the browser that you are using. Here are 

a few examples of how to bookmark using Netscape Navigator 3, and Microsoft Internet 

Explorer 4. 

Creating bookmarks: 

1. Select the Bookmarks menu. 

2. Select ‚Add Bookmark‛ from this menu 

Organizing bookmarks: 

1. Select the Bookmarks menu. 

2. Select ‚Go to Bookmarks‛ from this menu. The Bookmarks window will open. 

3. In the Bookmarks window, you can add or delete bookmarks, arrange bookmarks into 

file folders, and place separators between groups of bookmarks. 

Accessing bookmarks: 

1. Select the Bookmarks menu. 

2. Select the name of your bookmark from the menu, OR select ‚Go to Bookmarks‛ and 
select your bookmark from your directory of bookmarks. 

 

Use your browser’s find feature to search for words within the current page. 

1. Click the Edit menu and select “find”. A dialog box will open. 

2. Type the text that you want to find into the dialog box. This is a verbatim search, so 
you might want to keep your text brief. Notice that you may also choose whether or 
not to make the search case-specific, and you can choose to search the page upward 
or downward. 

 
Many browsers no longer require you to type ‚http://www.‛. 

http://www.hotmail.com/
http://www/
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The Web is a form of publishing. Intellectual property laws apply to it. If 

you intend to publish information that you have taken from the Web, be 

certain to give reference of the original document source and/or obtain 

copyright permission from the appropriate source. 

 
Notes 3. Click “find Next”. If the browser finds matching text, it will highlight the text and 

scroll to the text if the text appears outside the current viewing area. Clicking the ‚find 

Next‛ button again will find the next occurrence of this text. 
 

To Save and Print 

This section explains some of the ways that you can take information out of the Web. 

To Copy Text and Images 

There are several browser-specific ways to save text and images. The following techniques 

work in most browsers. 

Copying text: To copy text, simply highlight the text using the cursor, and then click the Edit 

menu and select ‚Copy‛. You can then paste the information into another application, such 

as a Word-processing application, using the paste function of that application. 

Saving images: Saving images work slightly differently for Windows. Windows users should 

click on the image that they want to copy using their right mouse button. A menu will 

appear near the cursor. Select ‚Save image as..,‛ (or ‚Save Picture As..‛ if you’re using 

Microsoft) from the menu. Your browser will prompt you to pick a file name for the image. 

 

 

13.3.2 Printing 

You can print Web pages to paper for the hard copy; however, before printing anything for 

the first time, you should probably click on the file menu and select ‚Page Setup‛. The 

interface for setting up print options varies widely between browsers. Here are some general 

guidelines for printing options: 

• Turn backgrounds off. Printing backgrounds will make your printed copy difficult to 

read. 

• Set text to black. 

• Some Web browsers have an option for printing frame pages as they appear on screen 

versus printing one page within a frameset. Be aware of how this option is set before 

printing. 

• Most browsers have a ‚Print preview‛ option in the file menu. Print preview will 

allow you to view how your printed pages will look, and you will know if some pages 

aren’t worth printing. 

After printing a page, you may notice that your browser has printed some useful information 

in the page margins. This information is particularly useful if you want to revisit the page 

later, or refer to the page in a bibliography. Typically, the information will be arranged as 

follows: 

• Web page title will appear in the top left corner of the page. 

• URL (address/location) will appear in the top right corner of the page. 

• The total number of printed pages will appear in the lower left corner of the page. 

• The date and time of printing will appear in the lower right corner of the page. 
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13.3.3 To Download 

‚Downloading‛ is a term used to describe the process of saving information, from a server 

connected to the Web, to your computer—without viewing the information. Typically, files 

that you download are not Web-viewable resources. Often these files are software applications 

such as Web browsers. Downloading can take a long time, depending on the size of the file 

and the speed of your Internet connection. 

To download a file, simply double click on a link to a download file. These links are usually 

clearly labeled. If you accidentally begin to download a file, or if the download is going 

to take longer than you are prepared to wait, you may cancel the download by clicking on 

a cancel button on the download dialog box. 

13.3.4 To Personalise the Display 

You can change the look of your browser and how it works by changing preferences. If you 

want to change your home page to a different address, hide your tool bar, or increase the 

size of the text on your screen. You can do it by following the procedures below. Your 

browser has more preference options than this section will teach you to use. The directions 

below teach you some of the more commonly used preferences. Before altering text, link, 

or background preferences, consider the affect that changing these preferences may have on 

how your browser displays pages. Preferences for display settings, such as text, size and 

color, will supersede the settings programmed into the page. Changing these settings may 

alter page layout, having an adverse effect on design and making it harder to find the 

information that you are looking for. Changing color settings may obscure text or other 

information entirely, for example, by setting text and background to the same color. If you 

would like more space on the screen to view the content of pages, you may want to consider 

changing your toolbar button preferences to ‚text only‛. Hiding some of your toolbars will 

give you even greater viewing space on the screen. 

1. Click at either of the browsers ; Internet Explorer or Netscape Navigator in the main 

windows icons. The explorer version will appear on the screen. 

2. A window with an address http://home.microsoft.com/ will appear. Change this 

address and open the following sites one by one: 

(a) www.hinducollege.edu 

(b) www.rgu.ac.uk 

(c) www.timesofindia.com 

(d) www.britcoun.org 

(e) www.af.mil 

(f) www.doe.gov 

(g) www.webduniya.com 

Notes 

 

13.4 Browsers 
 

A web browser can have a Graphical User Interface, like Internet Explorer, Mozilla Firefox, 

Chrome and Opera, or can be text-based, like Lynx or Links. Web users with disabilities 

often use assistive technologies and adaptive strategies to access web pages. Users may be 

color blind, may or may not want to use a mouse perhaps due to repetitive stress injury 

or motor-neurone problems, may be deaf and require audio to be captioned, may be blind 

and using a screen reader or braille display, may need screen magnification, etc. Disabled 

and able-bodied users may disable the download and viewing of images and other media, 

http://home.microsoft.com/
http://www.hinducollege.edu/
http://www.rgu.ac.uk/
http://www.timesofindia.com/
http://www.britcoun.org/
http://www.af.mil/
http://www.doe.gov/
http://www.webduniya.com/
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Notes to save time, network bandwidth or merely to simplify their browsing experience. Users 

of mobile devices often have restricted displays and bandwidth. Anyone may prefer not 

to use the fonts, font sizes, styles and color schemes selected by the web page designer 

and may apply their own CSS styling to the page. The World Wide Web Consortium 

(W3C) and Web Accessibility Initiative (WAI) recommend that all web pages should be 

designed with all of these options in mind. 
 

13.4.1 Elements 

A web page, as an information set, can contain numerous types of information, which is able 

to be seen, heard or interact by the end user: 

Perceived (rendered) information: 

• Textual information: with diverse render variations. 

• Non-textual information: 

❖ Static images may be raster graphics, typically GIF, JPEG or PNG; or vector 

formats such as SVG or Flash. 

❖ Animated images typically Animated GIF and SVG, but also may be Flash, 

Shockwave, or Java applet. 

❖ Audio, typically MP3, ogg or various proprietary formats. 

❖ Video, WMV (Windows), RM (Real Media), FLV (Flash Video), MPG, MOV 

(QuickTime). 

• Interactive information 

❖ For ‚on page‛ interaction: 

♦ Interactive text. 

♦ Interactive illustrations: ranging from ‚click to play‛ images to games, typically 

using script orchestration, Flash, Java applets, SVG, or Shockwave. 

♦ Buttons: forms providing alternative interface, typically for use with script 

orchestration and DHTML. 

❖ For ‚between pages‛ interaction: 

♦ Hyperlinks: standard ‚change page‛ reactivity. 

♦ Forms: providing more interaction with the server and server-side databases. 

Internal (hidden) information: 

• Comments 

• Linked Files through Hyperlink (Like DOC,XLS,PDF,etc). 

• Metadata with semantic meta-information, Charset information, Document Type 

Definition (DTD), etc. 

• Diagramation and style information: information about rendered items (like image 

size attributes) and visual specifications, as Cascading Style Sheets (CSS). 

• Scripts, usually JavaScript, complement interactivity and functionality. 

The web page can also contain dynamically adapted information elements, dependent upon 

the rendering browser or end-user location (through the use of IP address tracking and/or 

‚cookie‛ information). 

From a more general/wide point of view, some information (grouped) elements, like a 
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navigation bar, are uniform for all website pages, like a standard. These kind of ‚website 

standard information‛ are supplied by technologies like web template systems. 

13.4.2 Rendering 

Web pages will often require more screen space than is available for a particular display 

resolution. Most modern browsers will place a scrollbar (a sliding tool at the side of the 

screen that allows the user to move the page up or down, or side-to-side) in the window to 

allow the user to see all content. Scrolling horizontally is less prevalent than vertical 

scrolling, not only because such pages often do not print properly, but because it inconveniences 

the user more so than vertical scrolling would (because lines are horizontal; scrolling back 

and forth for every line is much more inconvenient than scrolling after reading a whole 

screen; also most computer keyboards have page up and down keys, and many computer 

mice have vertical scroll wheels, but the horizontal scrolling equivalents are rare). 

When web pages are stored in a common directory of a web server, they become a website. 

A website will typically contain a group of web pages that are linked together, or have some 

other coherent method of navigation. The most important web page to have on a website 

is the index page. Depending on the web server settings, this index page can have many 

different names, but the most common is index.html. When a browser visits the homepage 

for a website, or any URL pointing to a directory rather than a specific file, the web server 

will serve the index page to the requesting browser. If no index page is defined in the 

configuration, or no such file exists on the server, either an error or directory listing will be 

served to the browser. 

A web page can either be a single HTML file, or made up of several HTML files using frames 

or Server Side Includes (SSIs). Frames have been known to cause problems with web 

accessibility, copyright, navigation, printing and search engine rankings, and are now less 

often used than they were in the 1990s. Both frames and SSIs allow certain content which 

appears on many pages, such as page navigation or page headers, to be repeated without 

duplicating the HTML in many files. Frames and the W3C recommended alternative of 2000, 

the <object> tag, also allow some content to remain in one place while other content can be 

scrolled using conventional scrollbars. Modern CSS and JavaScript client-side techniques can 

also achieve all of these goals and more. 

When creating a web page, it is important to ensure it conforms to the World Wide Web 

Consortium (W3C) standards for HTML, CSS, XML and other standards. The W3C standards 

are in place to ensure all browsers which conform to their standards can display identical 

content without any special consideration for proprietary rendering techniques. A properly 

coded web page is going to be accessible to many different browsers old and new alike, 

display resolutions, as well as those users with audio or visual impairments. 

13.4.3 Web Browser Environment 

Browsers (or WWW Clients) enable to use one’s computer to look at World Wide Web 

(WWW) documents. All the top browsers are available in different versions to suit common 

operating systems. For browsing a website we should have a web browser which is a 

software application. There are two basic ways in which the browsers are classified: 

They are as follows: 

(i) Non-Graphical Web Browser Lynx is a program that allows one to access the World 

Wide Web without graphics. 

(ii) Graphical Web Browser are the two major graphic web browsers. 

Notes 
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Figure 13.2: Netscape Navigator Browser Shows a Site of home.netscape.com 

  Main :: Netscape Navigator Web Browser - Netscape Navigator  

 File Edit  View   History  Bookmarks  Tools  Help  

Cross-platform 

• Run Navigator 9 on Windows, Mac OSX, or Linuxl 

URL correction 

• Let Navigator fix common typing mistakes in Web addresses. 

Link Pad 

• Save interesting links for later without cluttering your bookmarks. 

They are much more user-friendly web browsing software programs. They require more 
memory than a system on which lynx can run. These web browsers allow people to explore 
the Internet, a worldwide network of sites from which people can read information, view 
graphics, hear sound, if the computer is equipped with the appropriate technology. You can 
print information, download it to your computer or disk, save your favorite Internet sites 
as a ‚bookmark‛ which can reside in a folder on your computer or save your bookmarks 
on a disk to have a portable list of sites. The two mentioned software; Internet Explorer and 
Netscape Navigator are the most widely used browsers. They are very similar in function. 
The latest versions of each are rich in useful features. These two browsers alone more or 
less have covered the entire market. 

URL Correction 

Did you mean www. 

 
Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
   

 Figure 13.3: Internet Explorer Browser Showing a Site of msn.com  

 

Mouse Over Buttons Test - Windows Internet Explorer 
 

Windows Live 
 

Google Links 

Mouse Over Buttons Test 
Page

 

 

 

 
Demo Project 

 

 

 

 

 
Default.aspx Trusted sites 100% 

http://www/
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Netscape Navigator was developed by Netscape Communications and was officially released 

in December 1994. lt has online help available from the help menu and provides one of the 

best web interfaces because of its features. It is also one of the fastest web browsers under 

windows. This software is used for web designing because of its window based concept. 

Microsoft Internet Explorer is one of the latest Internet browsers explored by Microsoft. 

It has a lot of features including ability to browse web documents   with   ease; create 

web documents (HTML) from scratch, convert a word documents to HTML and convert at 

HTML document to word document. HTML is an abbreviation for Hyper Text Markup 

Language. 

Notes 

 

 
(ii) The Toolbar, 

(iii) The Location or Address bar. 

The Menu Bar 

The menu bar is a list of terms that you can click. Clicking on these terms will display menus 

from which you can select actions to perform. 

Although there are differences between the two mentioned browsers, Internet Explorer and 
Netscape Navigator their function in browsing the Web and the basic interface design is 

similar. 
 

The Banner 

The interface for each of these programs consists of a banner (including buttons, menus, 

one text area, and a logo) and below that banner is an open area that displays Web 

pages. 

The banners for both these browsers are shown in Figure 13.4 (a) and (b). 

The banner is classified into the following three basic sections: 

(i) The Menu Bar, 

Figure 13.4 (b): The Banner of Microsoft Internet Explorer 4 

Figure 13.4 (a): The Banner of Netscape Navigator 3 
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Figure 13.6: The Tool Bar of Netscape Navigator 

Figure 13.7: The Location Bar from Netscape Navigator 

 
Notes 

 

 

 

 

 
 

The Toolbar 

The toolbar (shown below in Figure 13.6 is from Netscape Navigator 3) is a series of buttons 

that you can click to quickly access common tasks. 

 

 

 

 

 
 

The Location Bar 

The location bar (from Netscape Navigator 3, shown in Figure 13.7) displays the address of 

the last page that the browser has loaded. You can also use the location bar to enter the 

addresses of a page where you want to go. 

 
 

 

 

 
 

Opening a New Browser Window 

Whenever you want to open a new browser window you will have to follow these instructions: 

Click on the file menu, and select ‚New‛ from this menu. A new browser window will open 

on the screen. Use this new window for testing Web browsing techniques in the laboratory. 

Navigation Within a Page 

Most of the navigation that you will do in browsing the involves the use of mouse. The basic 

concept of using the should be clear to you. So, let us just make sure that we are the same 

terminology for the same actions and objects that in the mouse. 

Cursor : This is the object that you can move around screen by moving your mouse. 

Pointing: This is the act of moving the cursor over an on screen. 

Clicking: This is the act of pressing the button on mouse, usually after pointing. 

Selecting: The selection is done by dragging the cursor over the item’and then releasing it 

in the Windows operating system. 

Highlighting: Highlighting is the act of clicking the cursor and dragging it over a section 

of text or images to highlight. 

Scrolling: This is a method of viewing hidden parts of a page that is too large to be viewed 

on screen all at once. To scroll, point and click on either the arrows or the bar of a scrollbar. 

Scrollbars are shown in Figure 13.8. 

Figure 13.5: Menu Bar from Netscape Navigator 
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Figure 13.9: The Dropdown Menus 

 
Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Drop-down menus: Drop-down menus allow you to select a choice from a list of information 

in a small space. Click on the triangle to display the list. Drop-down menus is shown in 

Figure 13.9. 

 

 

 

 

 

 

 

 

Netscape Navigator was developed by Netscape Communications and was officially 
released in December 1994. It has online help available from the help menu and provides 
one of the best web interfaces because of its features. It is also one of the fastest web browsers 
under windows. This software is used for web designing because of its window based 
concept. 

Microsoft Internet Explorer is one of the latest Internet browsers explored by Microsoft. 

It has a lot of features including ability to browse web documents with ease; create web 

documents (HTML) from scratch, convert a word documents to HTML and convert at 

HTML document to word document. HTML is an abbreviation for Hyper Text Markup 

Language. 

Figure 13.8: The Scrollbar 
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Notes 13.5 URL 

 

 

Typically, web pages today are becoming more dynamic. A dynamic web page is one that 

is created server-side when it is requested, and then served to the end-user. These types of 

web pages typically do not have a permalink, or a static URL, associated with them. Today, 

this can be seen in many popular forums, online shopping, and even on Wikipedia. This 

practice is intended to reduce the amount of static pages in lieu of storing the relevant web 

page information in a database. Some search engines may have a hard time indexing a web 

page that is dynamic, so static web pages can be provided in those instances. 
 

13.5.1 Viewing 

In order to graphically display a web page, a web browser is needed. This is a type of 

software that can retrieve web pages from the Internet. Most current web browsers include 

the ability to view the source code. Viewing a web page in a text editor will also display 

the source code, not the visual product. 
 

13.5.2 Creation 

To create a web page, a text editor or a specialized HTML editor is needed. In order to upload 

the created web page to a web server, traditionally an FTP client is needed. 

The design of a web page is highly personal. A design can be made according to one’s own 

preference, or a premade web template can be used. Web templates let web page designers 

edit the content of a web page without having to worry about the overall aesthetics. 

Many people publish their own web pages using products like Tripod, or Angelfire. These 

web publishing tools offer free page creation and hosting up to a certain size limit. 

Other ways of making a web page is to download specialized software, like a Wiki, CMS, 

or forum. These options allow for quick and easy creation of a web page which is typically 

dynamic. 
 

13.5.3 Saving 

While one is viewing a web page, a copy of it is saved locally; this is what is being viewed. 

Depending on the browser settings, this copy may be deleted at any time, or stored 

indefinitely, sometimes without the user realizing it. Most GUI browsers provide options 

for saving a web page more permanently. These may include: 

• Save the rendered text without formatting or images, with hyperlinks reduced to plain 
text 

• Save the HTML as it was served—Overall structure preserved, but some links may be 
broken 

• Save the HTML with relative links changed to absolute ones so that hyperlinks are 
preserved 

• Save the entire web page—All images and other resources including stylesheets and 
scripts are downloaded and saved in a new folder alongside the HTML, with links to 
them altered to refer to the local copies. Other relative links changed to absolute 

• Save the HTML as well as all images and other resources into a single MHTML file. 
This is supported by Internet Explorer and Opera. Other browsers may support this 
if a suitable plugin has been installed. 

Most operating systems allow applications such as web browsers not only to print the 

currently viewed web page to a printer, but optionally to ‚print‛ to a file that can be viewed 

or printed later. Some web pages are designed, for example by use of CSS, so that hyperlinks, 

menus and other navigation items, which will be useless on paper, are rendered into print 
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with this in mind. Sometimes, the destination addresses of hyperlinks may be shown 

explicitly, either within the body of the page or listed at the end of the printed version. Web 

page designers may specify in CSS that non-functional menus, navigational blocks and other 

items may simply be absent from the printed version. 
 

13.5.4 Getting Started of  Web Page 

There are basically two ways to make a web page. The first way is to create the page(s) 

offline and then upload them to Internet Service Provider (ISP) via FTP. The second way is 

to create web page(s) online using a Telnet program by accessing UNIX account. 

For creating web page(s) offline, do so in any text editing or word processing document. 

Make sure that when you save your document, you save it as a ‚text‛, ‚plain text‛ or 

‚text only‛ document. Otherwise it will not be read properly by a web browser. Once you 

have created page(s), it will need to contact ISP about how to go about uploading them to 

server. 

In case of UNIX account, you can create your web page(s) online. First need to get a 

program that can access your UNIX account. Recommended Telnet for the Mac or Ewan for 

Windows 95/98. 

Once we can access of account, we need to make a new directory   called ‚public_html‛. 

We can do this by typing: 
 

mkdir public_html 

After this, change directory to this new directory called ‚public_html‛. 
 

cd public_html 

We can make other directories, one for all the web pages that we make, and one for all of 

the graphics that we have. Follow the same steps as above to do this. 

Next, we need to think of a filename for page (this is not a title, but what will be in the 

URL). A common filename for a main web page, is ‚index‛. Once we have decided on this, 

add ‚.html‛ to the end of it. Then type (i.e.) 
 

pico index.html 

Of course, use page’s filename, instead of this one. Next, we need to gain some knowledge 

of the many HTML commands. Follow the index below, to decide what to put on page, 

and how to do it. Once we have gotten started, exit page. We can do this by  pressing control- 

x. Then we need to type 
 

chmod 744 index.html 

Only do this with the filename of page. We only need to do this the very first time that we 

leave web page. This command will make sure that nobody else can delete page. We will 

need to do this to any other pages that we make in the future. Then, look at page on the 

WWW. Lets say that server is ‚www.domain.com‛, if username is ‚username‛, and the name 

of page is ‚index.html‛. The URL would normally  be: 

http://www.domain.com/~username/index.html 

However, we will need to contact ISP for URL. 

If we have made separate directories for pages and graphics, then we need to include that 

in the URL also. Lets say that you made a directory for all of your web pages, called ‚Pages‛. 

The new URL would be: http://www.domain.com/~username/Pages/index.html 

Notes 

http://www/
http://www.domain.com/
http://www.domain.com/~username/index.html
http://www.domain.com/~username/Pages/index.html
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Notes Title 

The first thing to put on web page, is a title. The title is what will show up in the very top 

of the  window. Let’s say that title  is  going to be ‚SNGT’s  Web Page‛, we would type: 
 

<title>SNGT’s Web Page</title> 

In HTML, every command is surrounded by <‘s, and >’s. And in most commands, we need 

to tell the web browser when to end this command. Do this by putting a back slash (/) in 

front of the ending command, as in above. Since HTML isn’t case sensitive, <title> is the same 

as <TITLE>, which is the same as <TiTLe>. Next, we need to decide what we want to put 

on page. Text, links, graphics, and text fields, are just a few ideas. Follow the table of contents 

above to decide how, and what to put on page. 

 

Text 

Headings 

HTML has six levels of headings, numbered 1 through 6, with 1 being the largest. Headings 

are displayed in larger, or smaller fonts, and usually bolder. If we wanted to type ‚Hello‛, 

this is what we would type for each heading, and what the outcome is: 
 

<h1>Hello</h1> 

Hello 

 
<h2>Hello</h2> 

Hello 

 
<h3>Hello</h3> 

Hello 

 
<h4>Hello</h4> 

Hello 

 
<h5>Hello</h5> 

Hello 

<h6>Hello</h6> 

Hello 

Paragraphs 

Whenever we have more than a sentence of writing, we should have paragraphs. 

<P>This is a web page. How do you like what I’ve done? Please e-mail me with any 

suggestions at a@a.com</P> 

The outcome is: 

This is a web page. How do you like what I’ve done? Please e-mail me with any suggestions 

at a@a.com 

mailto:a@a.com
mailto:a@a.com
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Lists 

There are two types of lists that can make in HTML, dotted, and numbered. To make a dotted 

list of: red, orange, green, blue, purple, black, and brown, type: 

<UL> 

<LI> red 

<LI> orange 

<LI> green 

<LI> blue 

<LI> purple 

<LI> black 

<LI> brown 

</UL> 

The result is: 

• red 

• orange 

• green 

• blue 

• purple 

• black 

• brown 

To make a numbered list of: red, orange, green, blue, purple, black, and brown, type: 

<OL> 

<LI> red 

<LI> orange 

<LI> green 

<LI> blue 

<LI> purple 

<LI> black 

<LI> brown 

</OL> 

The result looks like: 

1. red 

2. orange 

3. green 

4. blue 

5. purple 

Notes 
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Notes 6. black 

7. brown 
 

Forced Line Breaks 

There are many cases in which we want to end typing on one line, and start on the next. 

To do this, we can use a simple HTML command. This is one of the few commands that we 

don’t have to put an ending command on. Let’s say that we wanted to say ‚Hello, how are 

you?‛, but with each word on a separate line. All we have to type is: 

Hello,<BR>how<BR>are<BR>you? 

The outcome is: 

Hello, 

how 

are 

you? 

Horizontal Rules 

Every now and then, we might want to have a horizontal rule, or line in your page. 

Horizontal rules can be many different sizes and lengths. We can also have the line be solid 

black, by typing NOSHADE. Here are several examples of sizes and widths, and what the 

outcome is: 

<HR SIZE=1 WIDTH=100%> 

<HR SIZE=5 WIDTH=50%> 

<HR SIZE=25 WIDTH=75%> 

<HR SIZE=3 WIDTH=100%> 

<HR NOSHADE SIZE=1 WIDTH=100%> 

<HR NOSHADE SIZE=3 WIDTH=100%> 

<HR NOSHADE SIZE=10 WIDTH=20%> 
 

Character Formatting 

We may want to format some of your text differently than others using text styles. There 
are several types of styles of text that you can use: bold, italic, underline, strikeout, superscript, 

subscript, teletype, and blinking text are examples. To do these styles, surround text with the 

following commands: 

<b>, </b> for bold 

<i>, </i> for italic 

<u>, </u> for underlined 

<strike>, <strike> for strikeout 

<sup>, </sup> for superscript
 

<sub>, </sub> for subscript 

<tt>, </tt> for teletype 

<blink>, </blink> for blinking text (very annoying) 
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Links to Specific Sections 

Sometimes, you might want to have a link that will take you further down a page, or to 

a certain section of another page. If you click on the colored text and it takes you to that 

section. To do this, you need to do two things. The first, is to make the link, and the second, 

is to make where the link will lead to. 

 

Notes 

 

 
 

(1) To make the actual link, think of a name for the certain spot. Let’s say you are going 

to call it ‚spot‛. If this certain spot is on the same page that the link is, you would 

type: 

<A HREF=”#spot”>Colored Text 

Otherwise, you would add ‚#spot‛ to the end of the URL. 

(2) Now, you need to make where the link will take you. Go to the spot where you want 

the link to take you, and type: 

<A NAME = “spot”> 
 

Mailto Links 

Most people like to have a link on their web page that automatically sends e-mail to an 

address. If you want to do this, and your name is XYZ, and your e-mail address is a@a.com, 

type: 

<A HREF=”mailto:a@a.com”>XYZ</a> 

Here is the result of typing this: 
 

13.6 HTML 
 

HTML, which stands for Hyper Text Markup Language, is the predominant markup language 

for web pages. HTML is the basic building-blocks of webpages. 

HTML is written in the form of HTML elements consisting of tags, enclosed in angle brackets 

(like <html>), within the web page content. HTML tags normally come in pairs like <h1> 

and </h1>. The first tag in a pair is the start tag, the second tag is the end tag (they are also 

called opening tags and closing tags). 

The purpose of a web browser is to read HTML documents and compose them into visual 

or audible web pages. The browser does not display the HTML tags, but uses the tags to 

interpret the content of the page. 

HTML elements form the building blocks of all websites. HTML allows images and objects 

to be embedded and can be used to create interactive forms. It provides a means to create 

structured documents by denoting structural semantics for text such as headings, paragraphs, 

lists, links, quotes and other items. It can embed scripts in languages such as JavaScript which 

affect the behavior of HTML webpages. 

13.6.1 Data Types 

HTML defines several data types for element content, such as script data and stylesheet data, 

and a plethora of types for attribute values, including IDs, names, URIs, numbers, units of 

You cannot make links to specific sections within a different document 

unless either you have write permission to the coded source of that document 

or that document already contains in-document named links. 

mailto:a@a.com
mailto:a@a.com
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Notes length, languages, media descriptors, colors, character encodings, dates and times, and so on. 

All of these data types are specializations of character data. 

 

13.6.2 Document Type Declaration 

HTML documents are required to start with a Document Type Declaration (informally, a ‚doctype‛). 

In browsers, the doctype helps to define the rendering mode—particularly whether to use quirks 

mode. 

The original purpose of the doctype was to enable parsing and validation of HTML documents 

by SGML tools based on the Document Type Definition (DTD). The DTD to which the 

DOCTYPE refers contains a machine-readable grammar specifying the permitted and 

prohibited content for a document conforming to such a DTD. Browsers, on the other hand, 

do not implement HTML as an application of SGML and by consequence do not read the 

DTD. HTML5 does not define a DTD, because of the technology’s inherent limitations, so in 

HTML5 the doctype declaration, <!doctype html>, does not refer to a DTD. 

An example of an HTML 4 doctype is 

<!DOCTYPE HTML PUBLIC ‚-//W3C//DTD HTML 4.01//EN‛ ‚http://www.w3.org/TR/ 

html4/strict.dtd‛> 

This declaration references the DTD for the ‘strict’ version of HTML 4.01. SGML-based 

validators read the DTD in order to properly parse the document and to perform 

validation. In modern browsers, a valid doctype activates standards mode as opposed to 

quirks mode. 

 
 

Web pages are written in HTML (hypertext markup language) and are 

translated by your Web browser. Web pages can either be static or dynamic. 

Static pages show the same content each time they are viewed. Dynamic 

pages have content that can change each time. 

 

 

 

13.7 Internet Service Provider (ISP) 
 

An Internet service provider (ISP) is a company that provides access to the Internet, hosts 

data, or does both. Access ISPs connect customers to the Internet using copper, wireless or 

fiber connections. Hosting ISPs lease server space for smaller businesses and host other 

people servers (colocation). Transit ISPs provide large tubes for connecting hosting. 
 

13.7.1 Access ISPs 

ISPs employ a range of technologies to enable consumers to connect to their network. 

For users and small businesses, the most popular options include dial-up, DSL (typically 

Asymmetric Digital Subscriber Line, ADSL), broadband wireless, cable modem, fiber to the 

premises (FTTH), and Integrated Services Digital Network (ISDN) (typically basic rate 

interface). For customers with more demanding requirements, such as medium-to-large 

businesses, or other ISPs, DSL (often SHDSL or ADSL), Ethernet, Metro Ethernet, Gigabit 

Ethernet, Frame Relay, ISDN (BRI or PRI), ATM, satellite Internet access and synchronous 

optical networking (SONET) are more likely to be used. 

Internet connectivity options from end-user to Tier 3/2 ISP’s 

Typical home user connection 

• Broadband wireless access 

http://www.w3.org/TR/
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• Cable Internet 

• Dial-up 

❖ ISDN 

❖ Modem 

• DSL 

• FTTH 

• Wi-Fi 

Notes 

 

Typical business-type connection 

• DSL 

• Ethernet technologies 

• Leased line 

• SHDSL 

 

13.7.2 Locality 

When using a dial-up or ISDN connection method, the ISP cannot determine the caller’s 

physical location to more detail than using the number transmitted using an appropriate 

form of Caller ID; it is entirely possible to e.g. connect to an ISP located in Mexico from 

the USA. Other means of connection such as cable or DSL require a fixed registered connection 

node, usually associated at the ISP with a physical address. 

 

13.7.3 Hosting ISPs 

Hosting ISPs routinely provide email, FTP, and web-hosting services. Other services 

include virtual machines, clouds, or entire physical servers where customers can run their 

own custom software. 

 

13.7.4 Transit ISPs 

Just as their customers pay them for Internet access, ISPs themselves pay upstream ISPs for 

Internet access. An upstream ISP usually has a larger network than the contracting ISP and/ 

or is able to provide the contracting ISP with access to parts of the Internet the contracting 

ISP by itself has no access to. 

In the simplest case, a single connection is established to an upstream ISP and is used to 

transmit data to or from areas of the Internet beyond the home network; this mode of 

interconnection is often cascaded multiple times until reaching a Tier 1 carrier. In reality, 

the situation is often more complex. ISPs with more than one point of presence (PoP) may 

have separate connections to an upstream ISP at multiple PoPs, or they may be customers 

of multiple upstream ISPs and may have connections to each one of them at one or more 

point of presence. 

 

13.7.5 Peering 

Main article: Peering 

ISPs may engage in peering, where multiple ISPs interconnect at peering points or Internet 

exchange points (IXs), allowing routing of data between each network, without charging one 

another for the data transmitted—data that would otherwise have passed through a third 

upstream ISP, incurring charges from the upstream ISP. 



Unit 13: Internet 

282 

 

 

T 

 
Notes ISPs requiring no upstream and having only customers (end customers and/or peer ISPs) are 

called Tier 1 ISPs. 

Network hardware, software and specifications, as well as the expertise of network 

management personnel are important in ensuring that data follows the most efficient 

route, and upstream connections work reliably. A tradeoff between cost and efficiency is 

possible. 

 

13.7.6 Derivatives 

The following are not a different type of the above ISPs, rather they are derivatives of the 

3 core ISP types. A VISP is reselling either access or hosting services. Free ISPs are similar, 

but they just have a different revenue model. 

 

Virtual ISP 

A Virtual ISP (VISP) is an operation which purchases services from another ISP (sometimes 

called a ‚wholesale ISP‛ in this context which allow the VISP’s customers to access the 

Internet using services and infrastructure owned and operated by the wholesale ISP. 

 

Free ISP 

Free ISPs are Internet Service Providers (ISPs) which provide service free of charge. Many 

free ISPs display advertisements while the user is connected; like commercial television, in 

a sense they are selling the users’ attention to the advertiser. Other free ISPs, often called 

freenets, are run on a nonprofit basis, usually with volunteer staff. 

 

 

 

 

History of the Internet 
 

he History of the Internet has precursors that date back to the 19th century, 

especially the telegraph system, more than a century before the digital Internet 

became widely used in the second half of the 1990s. The concept of data 

communication - transmitting data between two different places, connected via some 

kind of electromagnetic medium, such as radio or an electrical wire - actually predates 

the introduction of the first computers. Such communication systems were typically 

limited to point to point communication between two end devices. Telegraph systems 

and telex machines can be considered early precursors of this kind of communication. 

Early computers used the technology available at the time to allow communication between 

the central processing unit and remote terminals. As the technology evolved, new systems 

were devised to allow communication over longer distances (for terminals) or with higher 

speed (for interconnection of local devices) that were necessary for the mainframe computer 

model. Using these technologies it was possible to exchange data (such as files) between 

remote computers. However, the point to point communication model was limited, as it 

did not allow for direct communication between any two arbitrary systems; a physical link 

was necessary. The technology was also deemed as inherently unsafe for strategic and 

military use, because there were no alternative paths for the communication in case of an 

enemy attack. 

As a response, several research programs started to explore and articulate principles of 

communications between physically separate systems, leading to the development of the 

packet switching model of digital networking. These research efforts included those of 
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the laboratories of Vinton G. Cerf at Stanford University, Donald Davies (NPL), Paul 

Baran (RAND Corporation), and Leonard Kleinrock at MIT and at UCLA. The research 

led to the development of several packet-switched networking solutions in the late 1960s 

and 1970s, including ARPANET, Telnet, and the X.25 protocols. Additionally, public 

access and hobbyist networking systems grew in popularity, including unix-to-unix copy 

(UUCP) and FidoNet. They were however still disjointed separate networks, served only 

by limited gateways between networks. This led to the application of packet switching 

to develop a protocol for internetworking, where multiple different networks could be 

joined together into a super-framework of networks. By defining a simple common 

network system, the Internet Protocol Suite, the concept of the network could be separated 

from its physical implementation. This spread of internetworking began to form into the 

idea of a global network that would be called the Internet, based on standardized 

protocols officially implemented in 1982. Adoption and interconnection occurred quickly 

across the advanced telecommunication networks of the western world, and then began 

to penetrate into the rest of the world as it became the de-facto international standard 

for the global network. However, the disparity of growth between advanced nations and 

the third-world countries led to a digital divide that is still a concern. 

Questions: 

1. How was the Internet invented? 

2. What are the benefits of Internet? 

Notes 

 
 

13.8 Summary 
 

• In this we discuss about the role of internet and its user in various different fields as 

referred by scientists as an ‘ocean’ to ‘rurf’, ‘side’ or ‘navigate’ the net. 

• Web page may be retrieved from a local computer or from remote web senses. 

• Record of web page address is a book marking. 

• In elements web page, can contain numerous types of information, which is able to 

be sun. 

• Graphical web browser are user friendly web browsing programs. 

• Lynax is the program that allows one to access the World Wide Web without graphic 

is used by Non-Graphical web Browser. 

 

13.9 Keywords 
 

Banner: The interface for each of these programs consists of a banner (including buttons, 

menus, one text area, and a logo) and below that banner is an open area that displays Web 

pages. 

Bookmark: In web terminology, a bookmark is a record of Web page address. 

Browsers: The web prowser is a medium that enable to use on’s computer to look at World 

Wide Web (WWW) documents. 

Graphical Web browser: It is a Lynax program which allows one to access world wide web 

with graphic. 

HTML: It stands for Hyper Text Markup Language, is the predominant markup language for 

web pagse. It is the basic building block of webpages. 

ISP: ISP or internet service provider is a company that provides access to the Internet, host 

datas or does both. 
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Notes Non-graphical Web browser: It is a lynax program that allows one to access the World Wlid 

Web without graphics. 

 

 
 

1. Explain video teleconference. 

2. Explain Website. 

 

 

13.10 Self-Assessment Questions 
 

1. A list of terms that displays menus to select actions to perform is located on: 

(a) Menu Bar (b) Tool Bar 

(c) Location Bar (d) Address Bar 

2. A series of buttons to quickly access common tasks is located on: 

(a) Menu Bar (b) Tool Bar 

(c) Location Bar (d) Address Bar 

3. The bar that displays the address of the last page that the browser has loaded is: 

(a) Menu Bar (b) Tool Bar 

(c) Location Bar (d) Standard Bar 

4. To return to a default page, we click on: 

(a) Home button (b) Back button 

(c) Forward button (d) Stop button 

5. What are the main elements of a web server? 

(a) Perceived information (b) Interactive information 

(b) Internal information (d) All of these 

6. The ‘Help’ option appears on a netscape nevigator on 

(a) Menu bar (b) Tool  bar 

(c) Locational address bar (d) None of these 

 

13.11 Review Questions 
 

1. What are the commonly used browsers? 

2. Explain the difference between Lynx and Internet Explorer. 

3. Explain how a banner of IE classified. 

4. What is the function of a location bar in a browser? 

5. Explain the significance of Book Marking. 

6. Give different steps to open hotmail.com home page. 

7. How can you search for computer books available on the internet in India? 

8. What are the main components of Internet browsers? 
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Excellence in Computer Education by Dr. C. K. Seth. 

www.webopedia.com/index.php/TERM/I/internet.html 

 
9. What is the use of Internet Service Providers (ISP)? 

10. What is the significance of HTML in Internet Browsers? 

 
Answers for Self-Assessment Questions  

1. (a) 2. (a) 3. (c) 4. (b) 

5. (d) 6. (a)   

 

13.12 Further Reading 

Notes 

 

 

 

http://www.webopedia.com/index.php/TERM/I/internet.html
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Unit 14: Web Server Applications 
 

 
Objectives Notes 

 

After studying this unit, you will be able to: 

• Understand the Web Server 

• Explain the use and concept of E-mail 

• Discuss instant messaging 

• Explain internet telephony 

• Understand video conference 

 

Introduction 

A web server is the combination of computer and the program installed on it. Web server 

interacts with the client through a web browser. It delivers the web pages to the client and 

to an application by using the web browser and the HTTP protocols respectively. We can 

also define the web server as the package of large number of programs installed on a 

computer connected to Internet or intranet for downloading the requested files using File 

Transfer Protocol, serving e-mail and building and publishing web pages. A web server 

works on a client server model. A computer connected to the Internet or intranet must have 

a server program. 
 

14.1 Web Server 

A web server can be referred to as either the hardware (the computer) or the software (the 

computer application) that helps to deliver content that can be accessed through the Internet. 

The most common use of Web servers is to host Web sites but there are other uses like data 

storage or for running enterprise applications. 

14.1.1 Common Features 

1. Virtual hosting to serve many Web sites using one IP address. 

2. Large file support to be able to serve files whose size is greater than 2 GB on 32 bit 

OS. 

3. Bandwidth throttling to limit the speed of responses in order to not saturate the 

network and to be able to serve more clients. 

4. Server-side scripting to generate dynamic Web pages, still keeping Web server and 

Web site implementations separate from each other. 

14.1.2 Path Translation 

Web servers are able to map the path component of a Uniform Resource Locator (URL) into: 

• A local file system resource (for static requests); 

• An internal or external program name (for dynamic requests). 

For a static request the URL path specified by the client is relative to the Web server’s root 

directory. 

Consider the following URL as it would be requested by a client: 

http://www.example.com/path/file.html 

The client’s user agent will translate it into a connection to www.example.com with the 

following HTTP 1.1 request: 

http://www.example.com/path/file.html
http://www.example.com/
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Notes GET /path/file.html HTTP/1.1 

Host: www.example.com 

The Web server on www.example.com will append the given path to the path of its root 

directory. On an Apache server, this is commonly /home/www (On UNIX machines, usually/ 

var/www). The result is the local file system resource: 

/home/www/path/file.html 

The Web server then reads the file, if it exists and sends a response to the client’s Web 

browser. The response will describe the content of the file and contain the file itself or an 

error message will return saying that the file does not exist or is unavailable. 
 

14.1.3 Load Limits 

A Web server (program) has defined load limits, because it can handle only a limited 

number of concurrent client connections (usually between 2 and 80,000, by default between 

500 and 1,000) per IP address (and TCP port) and it can serve only a certain maximum 

number of requests per second depending on: 

• its own settings; 

• the HTTP request type; 

• content origin (static or dynamic); 

• the fact that the served content is or is not cached; 

• the hardware and software limitations of the OS where it is working; 

When a Web server is near to or over its limits, it becomes unresponsive. 

14.1.4 Kernel-mode and User-mode Web Servers 

A Web server can be either implemented into the OS kernel, or in user space (like other 

regular applications). 

An in-kernel Web server (like TUX on GNU/Linux or Microsoft IIS on Windows) will 

usually work faster, because, as part of the system, it can directly use all the hardware 

resources it needs, such as non-paged memory, CPU time-slices, network adapters, or 

buffers. 

Web servers that run in user-mode have to ask the system the permission to use more 

memory or more CPU resources. Not only do these requests to the kernel take time, but 

they are not always satisfied because the system reserves resources for its own usage and 

has the responsibility to share hardware resources with all the other running applications. 

Also, applications cannot access the system’s internal buffers, which causes useless buffer 

copies that create another handicap for user-mode web servers. As a consequence, the only 

way for a user-mode web server to match kernel-mode performance is to raise the quality 

of its code to much higher standards, similar to that of the code used in web servers that 

run in the kernel. This is a significant issue under Windows, where the user-mode overhead 

is about six times greater than that under Linux. 
 

14.1.5 Overload Causes 

At any time web servers can be overloaded because of: 

• Too much legitimate web traffic. Thousands or even millions of clients connecting to 

the web site in a short interval, e.g., Slashdot effect; 

• Distributed Denial of Service attacks; 

• Computer worms that sometimes cause abnormal traffic because of millions of infected 

computers (not coordinated among them); 

http://www.example.com/
http://www.example.com/


289 

 

 

• XSS viruses can cause high traffic because of millions of infected browsers and/or Web 

servers; 

• Internet bots. Traffic not filtered/limited on large web sites with very few resources 

(bandwidth, etc.); 

• Internet (network) slowdowns, so that client requests are served more slowly and the 

number of connections increases so much that server limits are reached; 

• Web servers (computers) partial unavailability. This can happen because of required 

or urgent maintenance or upgrade, hardware or software failures, back-end (e.g., 

database) failures, etc.; in these cases the remaining web servers get too much traffic 

and become overloaded. 

14.1.6 Overload Symptoms 

The symptoms of an overloaded Web server are: 

• requests are served with (possibly long) delays (from 1 second to a few hundred 

seconds); 

• 500, 502, 503, 504 HTTP errors are returned to clients (sometimes also unrelated 404 

error or even 408 error may be returned); 

• TCP connections are refused or reset (interrupted) before any content is sent to clients; 

• in very rare cases, only partial contents are sent (but this behavior may well be 

considered a bug, even if it usually depends on unavailable system resources). 

14.1.7 Anti-overload Techniques 

To partially overcome above load limits and to prevent overload, most popular Web sites 

use common techniques like: 

• managing network traffic, by using: 

❖ Firewalls to block unwanted traffic coming from bad IP sources or having bad 

patterns; 

❖ HTTP traffic managers to drop, redirect or rewrite requests having bad HTTP 

patterns; 

❖ Bandwidth management and traffic shaping, in order to smooth down peaks in 

network usage; 

• deploying Web cache techniques; 

• using different domain names to serve different (static and dynamic) content by 

separate Web servers, i.e.: 

O http://images.example.com 

O http://www.example.com 

• using different domain names and/or computers to separate big files from small and 

medium sized files; the idea is to be able to fully cache small and medium sized files 

and to efficiently serve big or huge (over 10 - 1000 MB) files by using different settings; 

• using many Web servers (programs) per computer, each one bound to its own network 

card and IP address; 

• using many Web servers (computers) that are grouped together so that they act or are 

seen as one big Web server (see also Load balancer); 

• adding more hardware resources (i.e. RAM, disks) to each computer; 

• tuning OS parameters for hardware capabilities and usage; 

Notes 

http://images.example.com/
http://www.example.com/
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Notes • using more efficient computer programs for Web servers, etc.; 

• using other workarounds, especially if dynamic content is involved. 

14.1.8 Market Structure 

Market share of major Web servers For more details on HTTP server programs, see 

Category:Web server software. 

Below is the most recent statistics of the market share of the top web servers on the internet 

by Netcraft survey in November 2010. 
 

Vendor Product Web Sites Hosted Percent 

Apache Apache 148,085,963 59.36% 

Microsoft IIS 56,637,980 22.70% 

Igor Sysoev nginx 15,058,114 6.04% 

Google GWS 14,827,157 5.94% 

lighttpd lighttpd 2,070,300 0.83% 

 
 

14.2 E-mail 
 

Electronic mail, commonly called email, e-mail or e.mail, is a method of exchanging digital 

messages from an author to one or more recipients. Modern email operates across the 

Internet or other computer networks. Some early email systems required that the author and 

the recipient both be online at the same time, a la instant messaging. Today’s email systems 

are based on a store-and-forward model. Email servers accept, forward, deliver and store 

messages. Neither the users nor their computers are required to be online simultaneously; 

they need connect only briefly, typically to an email server, for as long as it takes to send 

or receive messages. 

An email message consists of three components, the message envelope, the message header, 

and the message body. The message header contains control information, including, minimally, 

an originator’s email address and one or more recipient addresses. Usually descriptive 

information is also added, such as a subject header field and a message submission date/ 

time stamp. 

Originally a text only (7 bit ASCII and others) communications medium, email was extended 

to carry multi-media content attachments, a process standardized in RFC 2045 through 2049. 

Collectively, these RFCs have come to be called Multipurpose Internet Mail Extensions 

(MIME). 

The history of modern, global Internet email services reaches back to the early ARPANET. 

Standards for encoding email messages were proposed as early as 1973 (RFC 561). Conversion 

from ARPANET to the Internet in the early 1980s produced the core of the current services. 

An email sent in the early 1970s looks quite similar to a basic text message sent on the 

Internet today. 

Network-based email was initially exchanged on the ARPANET in extensions to the File 

Transfer Protocol (FTP), but is now carried by the Simple Mail Transfer Protocol (SMTP), first 

published as Internet standard 10 (RFC 821) in 1982. In the process of transporting email 

messages between systems, SMTP communicates delivery parameters using a message 

envelope separate from the message (header and body) itself. 
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14.3 Instant Messaging (IM) Notes 

 

Instant messaging (IM) is a form of real-time direct text-based communication between two 

or more people using personal computers or other devices, along with shared clients. The 

user’s text is conveyed over a network, such as the Internet. More advanced instant messaging 

software clients also allow enhanced modes of communication, such as live voice or video 

calling. 
 

14.4 Internet Telephony 
 

A category of hardware and software that enables people to use the Internet as the transmission 

medium for telephone calls. For users who have free or fixed-price Internet access, Internet 

telephony software essentially provides free telephone calls anywhere in the world. To date, 

however, Internet telephony does not offer the same quality of telephone service as direct 

telephone connections. 

There are many Internet telephony applications available. Some, like CoolTalk and 

NetMeeting, come bundled with popular Web browsers. Others are stand-alone products. 

Internet telephony products are sometimes called IP telephony, Voice over the Internet (VOI) 

or Voice over IP (VOIP) products. 
 

14.5 Videoconference 
 

A videoconference or video conference (also known as a videoteleconference) is a set of 

interactive telecommunication technologies which allow two or more locations to interact 

via two-way video and audio transmissions simultaneously. It has also been called ‘visual 

collaboration’ and is a type of groupware. 

Videoconferencing differs from videophone calls in that it is designed to serve a conference 

rather than individuals. It is an intermediate form of videotelephony, first deployed 

commercially by AT&T during the early 1970s using their Picturephone technology. 

The core technology used in a videoconferencing system is digital compression of audio and 

video streams in real time. The hardware or software that performs compression is called 

a codec (coder/decoder). Compression rates of up to 1:500 can be achieved. The resulting 

digital stream of 1s and 0s is subdivided into labeled packets, which are then transmitted 

through a digital network of some kind (usually ISDN or IP). The use of audio modems in 

the transmission line allow for the use of POTS, or the Plain Old Telephone System, in some 

low-speed applications, such as videotelephony, because they convert the digital pulses to/ 

from analog waves in the audio spectrum range. 

The other components required for a videoconferencing system include: 

• Video input: video camera or webcam 

• Video output: computer monitor, television or projector 

• Audio input: microphones, CD/DVD player, cassette player, or any other source of 

PreAmp audio outlet. 

• Audio output: usually loudspeakers associated with the display device or telephone 

• Data transfer: analog or digital telephone network, LAN or Internet 

There are basically two kinds of videoconferencing systems: 

1. Dedicated systems have all required components packaged into a single piece of 

equipment, usually a console with a high quality remote controlled video camera. 
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Notes These cameras can be controlled at a distance to pan left and right, tilt up and down, 

and zoom. They became known as PTZ cameras. The console contains all electrical 

interfaces, the control computer, and the software or hardware-based codec. 

Omnidirectional microphones are connected to the console, as well as a TV monitor 

with loudspeakers and/or a video projector. There are several types of dedicated 

videoconferencing devices: 

(i) Large group videoconferencing are non-portable, large, more expensive devices 

used for large rooms and auditoriums. 

(ii) Small group videoconferencing are non-portable or portable, smaller, less 

expensive devices used for small meeting rooms. 

(iii) Individual videoconferencing are usually portable devices, meant for single 

users, have fixed cameras, microphones and loudspeakers integrated into the 

console. 

2. Desktop systems are add-ons (hardware boards, usually) to normal PCs, transforming 

them into videoconferencing devices. A range of different cameras and microphones 

can be used with the board, which contains the necessary codec and transmission 

interfaces. Most of the desktops systems work with the H.323 standard. Videoconferences 

carried out via dispersed PCs are also known as e-meetings. 

14.5.1 Conferencing Layers 

The components within a Conferencing System can be divided up into several different 

layers: User Interface, Conference Control, Control or Signal Plane and Media Plane. 

Video Conferencing User Interfaces could either be graphical or voice responsive. Many of 

us have encountered both types of interfaces, normally we encounter graphical interfaces on 

the computer or television, and Voice Responsive we normally get on the phone, where we 

are told to select a number of choices by either saying it or pressing a number. User 

interfaces for conferencing have a number of different uses; it could be used for scheduling, 

setup, and making the call. Through the User Interface the administrator is able to control 

the other three layers of the system. 

Conference Control performs resource allocation, management and routing. This layer along 

with the User Interface creates meetings (scheduled or unscheduled) or adds and removes 

participants from a conference. 

Control (Signaling) Plane contains the stacks that signal different endpoints to create a call 

and/or a conference. Signals can be, but aren’t limited to, H.323 and Session Initiation Protocol 

(SIP) Protocols. These signals control incoming and outgoing connections as well as session 

parameters. 

The Media Plane controls the audio and video mixing and streaming. This layer manages Real- 

Time Transport Protocols, User Datagram Packets (UDP) and Real-Time Transport Control 

Protocols (RTCP). The RTP and UDP normally carry information such the payload type 

which is the type of codec, frame rate, video size and many others. RTCP on the other hand 

acts as a quality control Protocol for detecting errors during streaming. 

14.5.2 Multipoint Videoconferencing 

Simultaneous videoconferencing among three or more remote points is possible by means 

of a Multipoint Control Unit (MCU). This is a bridge that interconnects calls from several 

sources (in a similar way to the audio conference call). All parties call the MCU unit, or the 

MCU unit can also call the parties which are going to participate, in sequence. There are 

MCU bridges for IP and ISDN-based videoconferencing. There are MCUs which are pure 

software, and others which are a combination of hardware and software. An MCU is 

characterised according to the number of simultaneous calls it can handle, its ability to 
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conduct transposing of data rates and protocols, and features such as Continuous Presence, 

in which multiple parties can be seen on-screen at once. MCUs can be stand-alone hardware 

devices, or they can be embedded into dedicated videoconferencing units. 

The MCU consists of two logical components: 

1. A single multipoint controller (MC), and 

2. Multipoint Processors (MP), sometimes referred to as the mixer. 

The MC controls the conferencing while it is active on the signaling plane, which is simply 

where the system manages conferencing creation, endpoint signaling and in-conferencing 

controls. This component negotiates parameters with every endpoint in the network and 

controls conferencing resources. While the MC controls resources and signaling negotiations, 

the MP operates on the media plane and receives media from each endpoint. The MP 

generates output streams from each endpoint and redirects the information to other endpoints 

in the conference. 

Some systems are capable of multipoint conferencing with no MCU, stand-alone, embedded 

or otherwise. These use a standards-based H.323 technique known as ‚decentralized 

multipoint‛, where each station in a multipoint call exchanges video and audio directly with 

the other stations with no central ‚manager‛ or other bottleneck. The advantages of this 

technique are that the video and audio will generally be of higher quality because they don’t 

have to be relayed through a central point. Also, users can make ad-hoc multipoint calls 

without any concern for the availability or control of an MCU. This added convenience and 

quality comes at the expense of some increased network bandwidth, because every station 

must transmit to every other station directly. 
 

14.5.3 Videoconferencing Modes 

Videoconferencing systems have several common operating modes that are used: 

1. Voice-Activated Switch (VAS); 

2. Continuous Presence. 

In VAS mode, the MCU switches which endpoint can be seen by the other endpoints by the 

levels of one’s voice. If there are four people in a conference, the only one that will be seen 

in the conference is the site which is talking; the location with the loudest voice will be seen 

by the other participants. 

Continuous Presence mode display multiple participants at the same time. The MP in this 

mode puts together the streams from the different endpoints and puts them all together into 

a single video image. In this mode, the MCU normally sends the same type of images to 

all participants. Typically these types of images are called ‚layouts‛ and can vary depending 

on the number of participants in a conference. 
 

14.5.4 Echo Cancellation 

A fundamental feature of professional videoconferencing systems is Acoustic Echo Cancellation 

(AEC). Echo can be defined as the reflected source wave interference with new wave created 

by source. AEC is an algorithm which is able to detect when sounds or utterances reenter 

the audio input of the videoconferencing codec, which came from the audio output of the 

same system, after some time delay. If unchecked, this can lead to several problems including: 

1. the remote party hearing their own voice coming back at them (usually significantly 

delayed) 

2. strong reverberation, rendering the voice channel useless as it becomes hard to 

understand and 

Notes 
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Notes 3. howling created by feedback. Echo cancellation is a processor-intensive task that 

usually works over a narrow range of sound delays. 

14.5.5 Problems 

Some observers argue that three outstanding issues have prevented videoconferencing from 

becoming a standard form of communication, despite the ubiquity of videoconferencing- 

capable systems. These issues are: 

1. Eye Contact: Eye contact plays a large role in conversational turn-taking, perceived 

attention and intent, and other aspects of group communication. While traditional 

telephone conversations give no eye contact cues, many videoconferencing systems are 

arguably worse in that they provide an incorrect impression that the remote interlocutor 

is avoiding eye contact. Some telepresence systems have cameras located in the screens 

that reduce the amount of parallax observed by the users. This issue is also being 

addressed through research that generates a synthetic image with eye contact using 

stereo reconstruction. 

Telcordia Technologies, formerly Bell Communications Research, owns a patent for eye- 

to-eye videoconferencing using rear projection screens with the video camera behind it, 

evolved from a 1960s U.S. military system that provided videoconferencing services 

between the White House and various other government and military facilities. This 

technique eliminates the need for special cameras or image processing. 

2. Appearance Consciousness: A second psychological problem with videoconferencing 

is being on camera, with the video stream possibly even being recorded. The burden 

of presenting an acceptable on-screen appearance is not present in audio-only 

communication. Early studies by Alphonse Chapanis found that the addition of video 

actually impaired communication, possibly because of the consciousness of being on 

camera. 

3. Signal latency: The information transport of digital signals in many steps need time. 

In a telecommunicated conversation, an increased latency larger than about 150-300 ms 

becomes noticeable and is soon observed as unnatural and distracting. Therefore, next 

to a stable large bandwidth, a small total round-trip time is another major technical 

requirement for the communication channel for interactive videoconferencing. 

The issue of eye-contact may be solved with advancing technology, and presumably the issue 

of appearance consciousness will fade as people become accustomed to videoconferencing. 

 

 

 

Success Story of Web Servers 

 

n 1989 Tim Berners-Lee proposed to his employer CERN (European Organization for 

Nuclear Research) a new project, which had the goal of easing the exchange of 

information between scientists by using a hypertext system. As a result of the 
implementation of this project, in 1990 Berners-Lee wrote two programs: 

• a browser called World Wide Web; 

• the world’s first web server, later known as CERN httpd, which ran on NeXTSTEP. 



295 

 

 

Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

E-mail: Electronic mail, commonly called email, is a method of exchanging digital messages 

from an author to one or more recipients. 

Instant Messaging (IM): Instant messaging is a form of real time direct text based 

communication between two or more people using personal computers or other devices, 

along with shared elients. 

Internet Telephony: It is a category of hardware and software that enables people to use the 

Internet as the transmission medium for telephone calls. 

Between 1991 and 1994 the simplicity and effectiveness of early technologies used to surf 
and exchange data through the World Wide Web helped to port them to many different 

operating systems and spread their use among lots of different social groups of people, 

first in scientific organizations, then in universities and finally in industry. 

In 1994 Tim Berners-Lee decided to constitute the World Wide Web Consortium (W3C) 
to regulate the further development of the many technologies involved (HTTP, HTML, 
etc.) through a standardization process. 
 

Questions: 

1. Who is the founder of Web server? 

2. Explain the web server. 

14.6 Summary 
 

• The Web server have such feature like Web sorting, Web working. 

• A Web server can be referred to as other the hardware (the computer) or the software 

that helps to deliver content. 

• Internet telephony use in web server. 

• E-mail application is used Web Server. 

• Videoconferencing differs from video phone calls in that it is designed to save a 

conference ratter than individuals. 

• The hardware or software that performs compression is called a codec (coder/decoder). 

14.7 Keywords 

Figure 14.1: The World’s First Web Server 
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Notes Multipoint Control Unit (MCU): Simultaneous videoconferencing among three or more 

remote points is possible by means of a Multipoint Control Unit (MCU). 

Video Conference: A video conference is a set of interactive telecommunication technologies 

which allow two or more locations to interact via two way video and audio transmissions 

simultaneously. 

Web server: A web server can be referred to as either the hardware (the computer) or the 

software (the computer application) that helps to deliver content that can be accessed through 

the Internet. 

Web site: A Web site is a related collection of World Wide Web (WWW) files that includes 

a beginning file called a home page. 

 

 
1. Explain video teleconference. 

 

2. Explain Website. 

 
 

14.8 Self-Assessment Questions 
 

1. To browse general topics, we use: 

(a) Subject guides (b) Search engine 

(c) Websites (d) Web browsers 

2. To get specific information, we use: 

(a) Subject guides (b) Search engine 

(c) Websites (d) Web browsers 

3. The speed of a web server is faster in 

(a) User-mode (b) Kernel-mode 

(c) Both of these (d) None of these 

4. What are the main cause of overload on web server? 

(a) Computer worms (b) XSS viruses 

(c) Internet bots (d) All of these 

5. What is not a component of multipoint video conferencing? 

(a) Multipoint controller  (MC) (b) Multipoint processor (MP) 

(c) Video input (d) Textual information 
 

14.9 Review Questions 
 

1. How can you download a particular information from the web? 

2. What are the common features of a Web server? 

3. Explain the difference between user-mode and kernel-mode web servers? 

4. What are the anti-overload techniques used in web servers? 

5. Explain significance of video conference and how it is used. 
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Answers for Self-Assessment Questions 

1. (b) 2. (c) 3.   (b) 4.   (d) 5. (d) 

Notes 

 

14.10 Further Reading 
 
 

Excellence in Computer Education by Dr. C. K. Seth. 

 

http://www.webopedia.com/index.php/TERM/I/internet.html
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